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User Manual 

1 Introduction 

1.1 Typographic Conventions 
The information we have provided in this manual will be easier to understand if you 
familiarize yourself with the following conventions: 
1. Menu names, commands, and functions generally begin with capital letters and 

are bolded. For example, File menu, Open Tag, and Help.  
2. Information you are to type in is usually in Courier font.  

For example, if the instruction in the material name field says to type in “Steel“, you 
would enter only the letters between the quotation marks, not the quotation marks 
themselves. 

1.2 Customer Service 
For customer service on Flowel 4® and other Emerson products, please contact  
us at:  

Emerson Process Management 
Hydrocarbon and Energy Industry Center 
7175 - 12th Street SE 
Calgary, Alberta 
Canada 
T2H 2S6 
e-mail: flowelsoftware@emersonprocess.com 
T +1(403) 258-6234 
F +1(403) 258-6201 
Website: http://www.flowel.com/ 

When you call in for support, please be ready to provide the customer service 
representative with the name of the application and version you are calling about, as 
well as your customer service number. Your customer service number is located 
on the inside of the Flowel binder’s front cover. Other useful information to have 
handy includes the error message that appears, the type of computer you are using, 
the type of operating system, the hard disk drive space available, and the names of 
any other programs you may have running. 

mailto:flowelsoftware@emersonprocess.com
http://www.flowel.com/
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1.3 Version 4 Features 
Flowel 4 is built on a new modern platform that is compatible with current versions of 
Microsoft Windows. 

1.3.1 Network Installation 

Flowel’s new network installation provides several benefits to the purchaser. 

First, the number of copies can be tailored to the number of simultaneous users. If a 
company or office has 10 Flowel users, but only three are using the program at any 
one time, then only three licenses are needed. The network version will keep track of 
the number of users and allow only the licensed maximum. If someone else needs to 
use the program, he/she will obtain a list of the logged-in users and then request that 
one of the users log out. 

Second, the network version will provide a centralized database. This means that all 
members of a project team will be able to access all of the jobs and tags. Flowel 4 
will allow administrators to use a variety of security settings depending on each 
user’s job, tag, and/or group requirement. 

Refer to Section 1.8 Network Server Installation for network installation instructions.  

1.3.2 Standards and Calculations 

New standards and calculations implemented include: 
• ISO 5167 (2003) (orifice meters, nozzles, and venturi tubes) 
• ASME MFC 14M (2003) (small bore precision orifice meters) 
• AGA 10 (natural gas thermodynamic properties) 
• expanded fluid database 
• orifice plate thickness (AGA-3 2000) 
• permanent pressure loss can be specified when sizing a restriction orifice 
• support for all major flow calculation standards including: 

- AGA 3 (1985 and1992) 
- ISO 5167 (1981, 1991, and 2003) 
- ISO TR 15377 
- BS 1042 
- ASME MFC 3M, 7M, 14M 

• flow rate uncertainty calculations as per ISO 5168 
• basic fluid property options 
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1.3.3 Convenience Features 

Flowel 4 convenience features include: 
• easy migration of data in Flowel 3.0g to Flowel 4 
• portable document format (PDF) of specification sheets for easy viewing, 

emailing and archiving; this provides several additional printing options, such 
as printing on A4 paper 

• creation and archiving of specification sheets for pressure, differential 
pressure, and temperature elements is available 

• enhanced job and tag management 
• standard Microsoft Windows interface 
• improved compatibility with new operating systems 
• graphical user interface (GUI), which simplifies operation and limits user entry 

errors 
• help system in PDF format 

1.3.4 Optional Package 

The Fluid Property Calculator is an optional package that is available. It includes a 
more extensive set of fluids and methods for determining viscosity, isentropic 
exponent, vapor pressure, and bubblepoint as well as additional tools for density 
calculation. The features of these options are: 

• Density Methods ─ Soave-Redlich-Kwong, Peng-Robinson, Lee-Kessler, and 
various NBS methods 

• Viscosity Methods ─ IAPS (1975) Viscosity Eqn. (water/steam only) and 
Lucas Viscosity Eqn. (gases only) 

• Isentropic Exponent Methods ─ Ideal Gas Heat Capacity Ratio, Real Gas 
with Redlich-Kwong Correction, Real Gas with Lee-Kessler Correction, and 
AGA 10  

• Vapor Pressure Method ─ Antoine 
• Bubblepoint Methods ─ Soave-Redlich-Kwong and Peng-Robinson 

1.4 Design Philosophy 

1.4.1 We Listen to Our Customers 

All of our products are the result of a collaborative effort between us, the developers, 
and you, our customers. We present the following design notes as a statement of our 
objectives for Flowel. We welcome your feedback regarding our goals and/or our 
success in achieving these goals. 
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1.4.2 Include Visual Cues for all Actions 

We include visual cues for all actions. For example, in the calculation dialog box, we 
could have automatically computed the result, but feedback from our users indicates 
that most prefer to actually tell the program to calculate; otherwise, users have to 
contend with frequent delays whenever an auto calculation occurs. 

1.4.3 Only Show Applicable Options 

Flowel can handle thousands of different combinations of devices, fluids, and 
methods, but the program makes decisions easier by showing only applicable 
choices. 

For example: 
• Flowel supports over 600 pure fluids, plus any number of user-defined 

mixtures. To limit the number of fluids presented to the user, we categorize 
fluids by types. 

• In the calculation dialog box, you are presented with a list of flow sizing 
methods. The content of that list depends upon your previous choices of fluid 
state, fluid type, and flow element. 

1.4.4 Present Mandatory Choices First 

In Flowel, each decision affects subsequent options, so Flowel presents choices in 
their proper sequence.  

For example, instrument engineers do not generally choose the process fluid, so 
fluid-related choices are made first; then, the meter run is selected, and finally, the 
actual size is chosen. 

1.5 Recommended Hardware/Software Requirements 
The following configuration is the minimum recommended hardware/software 
required for Flowel 4: 

• 266 MHz processor 
• 32 MB RAM 
• 120 MB free disk space 
• Windows ME, NT, 2000, XP, or XP Pro 
• CD-ROM drive (required only for installation from CD-ROM) 
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1.6 Basic Installation Procedure 
Flowel 4 uses a standard Windows InstallShield to install the components of the 
program. Double-click the Flowel_Setup.exe program to initiate installation. There 
are four components to the installed program: 

• Flowel calculation modules 
• MySQL database 
• GNU – Ghostscript for producing PDF files 
• CrypKey copy protection 

We recommend that users allow the above programs to install in the default 
directory. This will make program re-installations easier, if this becomes necessary. 
For a network server installation, additional steps follow the basic installation; see 
Section 1.8 Network Server Installation for those. 

To install Flowel 4, do the following: 
1. Navigate to and double-click the Setup_Flowel4.exe file. 
2. The Flowel 4 InstallShield Wizard dialog box will appear, as shown in Figure 1-1 

below. 

Figure 1-1 Basic Installation 
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3. Click Next. Review the license agreement and click I accept to continue the 
installation. 

4. Click Next, and continue to follow the InstallShield Wizard instructions to install 
Flowel.  

5. Use all default values, including destination folder locations, directories, etc. 
6. The GNU Ghostscript prompt will appear within this process, as shown in Figure 

1-2. 

Figure 1-2 GNU Ghostscript 

 
7. Click Setup. 
8. Use the default values provided, and click Install (as shown in Figure 1-3). 

Figure 1-3 Ghostscript Setup 

 
9. Wait as Ghostscript performs the setup. 
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Figure 1-4 Ghostscript Setup Log 

 

Ensure that the installation completes. The final dialogue box will require the user to 
click Finish. Note that this final dialog box may be hidden due to the installation 
procedure, and the user may have to minimize other windows to finish the 
installation. 

1.6.1.1 Site Authorization 

Once the program is installed, you will need to obtain a site key. To obtain a site key, 
start Flowel. To do so, select Flowel from the Start menu, under Programs, or 
double-click the Flowel desktop icon.  

The first time you open Flowel, a dialog box will appear with the following options: 
Get New Authorization or Transfer Authorization. If this is a new installation, select 
Get New Authorization, and the Site Key Request form will appear. 
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Figure 1-5 Site Key Request Form 

 

When the site authorization form appears, print the form and fax it to the 
Hydrocarbon and Energy Industry Center at +1(403) 258-6201. When you receive 
the site key, enter this into the site key field and click OK. You will then be authorized 
to use Flowel 4. 

1.6.2 Changing Licensing 

To change the licensing of Flowel, (e.g., from basic to a network option), do the 
following: 
1. Open Flowel. 
2. Under the Help menu, click Optional Ordering. 
3. As with the basic installation procedure, fill in the Request for Site Key form and 

print and fax it to Hydrocarbon and Energy at +1 (403) 258-6201. 
4. When you receive the new site key, enter the number into the site key form 

(under Help, Optional Ordering) and click OK. 
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5. Under the Help menu, click Optional Ordering again. Note the box on the right 
side of the form, which will identify the Type of Restrictions for the Current 
Installation (as shown in Figure 1-6). 

Figure 1-6 Type of Restriction for Current Installation 

 

1.7 Upgrading from an Earlier Version 
Before starting an upgrade, please review the following points. 

The upgrade has been designed for a standard installation of Flowel 4. If you require 
customized modifications to the Flowel setup, please contact Emerson before 
starting your upgrade.  

• When upgrading a network copy of Flowel, you will be required to upgrade 
the server first and then all of the workstations. 

• Stop running all copies of the Flowel program. You will be unable to upgrade 
to Flowel 4 if Flowel 3.0g is running. 
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• Backup/copy your database. The name of the Flowel 3.0g database is 
Flowel.db. This file should be in your Flowel folder on the server. Please 
contact Emerson if Flowel.db is not in the Flowel folder.  

• Back up all old Flowel databases created or named with an extension other 
than db. 

1.8 Network Server Installation 
In order to run Flowel 4 over a network, several additional steps are required. Once 
the server computer is selected and the basic installation procedure is complete, the 
following steps must be followed.  

Note: These installation instructions cover the basic procedure. If you have 
difficulties, please call our support line.  

To install Flowel 4 over a network, do the following: 
1. Select the computer that will be the Flowel host (server).  

This computer needs to be on and connected to the network when Flowel will be 
used. Client computers must have full read/write/modify privileges to the Flowel 
folders; therefore, it is recommended that the person installing Flowel have 
administration privileges on the server. 

2. Allow full control/change/read/write access to the folder where Flowel.exe is 
located (usually under C:/Program Files/Flowel/).  
 
To allow full control, do the following: 
(a) Navigate to C:/Program Files/Flowel/. 
(b) Right-click on the Flowel4 folder. 
(c) Click Properties. 
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Figure 1-7 Flowel 4 Folder Properties 

 
(d) Click the Sharing tab, and click Share this folder (as shown in Figure 1-7 

above). 
(e) Click the Permissions button. 
(f) Select the Allow checkbox for Full Control, and click OK. 
(g) Click OK to close. 
(h) Similarly, follow the steps above to allow full control to the folder C:/Program 

Files/MySQL/data/. 
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1.9 Client Setup 
Once Flowel has been installed, you will now have to configure the client(s). To 
configure each client, do the following at each computer: 
1. Copy Flowel_Client.msi onto the clients computer. 
2. Double-click Flowel_Client.msi. 
3. The MyODBC Setup window appears, as shown in Figure 1-8. 

Figure 1-8 MyODBC Setup 

 
4. Click Next. 
5. Review the license agreement and click I accept the license agreement (shown 

in Figure 1-9), and then click Next.  



1 Introduction  User Manual 

 13  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

Figure 1-9 Accept License Agreement 

 
6. Continue to click Next, following the wizard instructions, until the setup is 

complete and MyODBC has been successfully installed (as shown in Figure 
1-10). 
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Figure 1-10 Setup Complete 

 
7. Click Finish to close. 

The second step in client setup is to connect to the database. To connect the Flowel 
database, do the following: 
1. Under the Start menu, select Settings, then Control Panel, then 

Administrative Tools, and then click Data Sources (ODBC). 
2. The ODBC Data Source Administrator dialog box will appear (as shown in Figure 

1-11).  
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Figure 1-11 ODBC Data Source Administrator 

 
3. Click the User DSN tab, and click Add….  
4. The Create New Data Source dialog box will appear (as shown in Figure 1-12). 
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Figure 1-12 Create New Data Source 

 
5. Scroll down and select MySQL ODBC 3.51 Driver, and click Finish. 
6. The Configuration dialog box will appear, as shown in Figure 1-13. 



1 Introduction  User Manual 

 17  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

Figure 1-13 Configuration 

 
7. Enter the Data Source Name: floweluser. 
8. Enter the IP address of the host computer. To obtain the computers IP address, 

do the following: 
(a) Under the Start menu, click Run. 
(b) Type “cmd” in the Open field, as shown in Figure 1-14, and click OK. 

Figure 1-14 Run Dialog Box 

 
(c) In the DOS window that appears, type in “IPCONFIG” and press ENTER 

(shown in Figure 1-15). 
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Figure 1-15 IP Address 

 
(d) The window should provide you with additional information including the IP 

address of the computer (as shown above). 
(e) Close the window. 

9. Enter the Database Name: flowel. 
10. Enter the User and Password: root. 
11. Click Test Data Source. 
12. If the connection is successful, the following message should appear. If the 

message does not appear, contact Hydrocarbon and Energy support. 

Figure 1-16 Successful Connection Message 

 
13. Click OK. 
14. Click OK to close the configuration dialog box. 

Once the ODBC setup is complete, you can run Flowel 4 from the client computer. 
To do so, open Windows Explorer and navigate over the network to the computer 
where Flowel is installed. Within that computer, find the folder where Flowel is 
installed (most likely C:/Program Files/Flowel). Right-click Flowel.exe and click 
Create Shortcut. Move the shortcut to your desktop and double-click to open. 
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1.10 User Management Utility 
Flowel 4 has built-in security features for controlling data access under a multiple-
user environment. Flowel 4 supports three user levels: 
1. Super User – view and modify all jobs 
2. Manager – view and modify jobs created by users within the same user group 
3. User – view and modify jobs created by himself or herself or jobs assigned to the 

user by a manager 

A user group refers to one or more users defined in the same group. 

1.10.1 Accessing the User Management Utility 

The User Management program is used to administer Flowel 4 user levels. To 
access the program, under the Start menu, click Programs, click Flowel 4, and then 
click the User Management shortcut. 

The User Management utility requires a log in user name and password. Enter 
“Admin” in the User Name box. The password is available to network administrators 
(or the Flowel administrator) by emailing Flowelsoftware@EmersonProcess.com or 
calling +1(403) 258-6234. 

Figure 1-17 User Management Login 
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1.10.2 Defining a User Group 

To define a new user group, do the following: 
1. Under the File menu, click Group Management. The following dialog box will 

appear. 

Figure 1-18 User Group 

 
2. Click Add Group. A blank row will appear.  
3. Type a group name in the new text box. For example, in the following figure the 

group name is AAA Project Team. 
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Figure 1-19 User Group – Group Name 

 
4. Click Save to save the new user group. 

A user group can only be deleted when there are no users assigned to the group. To 
delete an empty user group, select the user group and click Delete Group. 

1.10.3 Managing Users 

To manage users, do the following: 
1. Under the File menu, click User Management.  
2. Click Add User to add a blank row. 
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Figure 1-20 Operate User – Add New Row 

 
3. Enter values for the User Id, Loginname, Pwd, First Name, and Last Name.  
4. Select a User Group and User Level. Note the following for the above values: 

• User ID must be a unique integer. 
• Loginname is the user name the user will enter to log in to Flowel 4. 

We recommend that the Loginname value be the same as the user’s 
network user name. This way, the user will not be prompted to enter a user 
name or password when starting Flowel 4. 

• PWD is the password the user will enter to log in to Flowel 4. 
• The First Name and Last Name values are the user’s first and last name. 
• The User Group list contains the groups defined in the user group 

management dialog and is used to determine the user's group of 
membership. 

• User Level determines the data each user can view and modify. 

To delete a user, click in any text box in that user’s row and click Delete User. 

1.11 Data Migration From Flowel 3.0g 
A separate utility program for converting Flowel version 3.0g databases into version 
Flowel 4 for Windows is included within this package. With this utility, you will not be 
required to re-enter your existing 3.0g data. 

To migrate Flowel 3.0g data, do the following: 
1. Backup the Flowel 3.0g database by copying the file C:/Flowel/Flowel.db to 

another location. 
2. Under the Start menu, select Programs, then Flowel 4, and click Data Convert. 
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3. Data is now loaded into Flowel 4.  
Note that if there are duplicate job names, the job name will be altered to avoid 
duplicates. This is done by adding a “-1” to the name (e.g., US Examples-1). To 
avoid this, delete unused job names in Flowel 3.0g before converting. Also note, 
that for this reason, it is not useful to run the Data Convert utility repeatedly. 

4. If several databases are to be converted, load one at a time into the Flowel 3.0g 
Flowel folder on the computer where Flowel 4 is located. To reduce issues with 
duplicate names, the job and tag names should be reviewed and duplicates 
eliminated where possible.  

5. To eliminate duplicate job names in Flowel 3.0g, under the File menu, click Open 
Job. 

6. Append an identifier (such as the user’s initials) to the Job No: field. In this case, 
“PB” (shown in Figure 1-21), and click OK. 

Figure 1-21 Job Name Identifier 

 
7. Once data is loaded, the jobs can be assigned to specific users. See User 

Maintenance. 

For versions older than Flowel 3.0g, data will have to be first migrated to 3.0g. If you 
are in this situation, please call support at +1 (403) 258-6234. 
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1.12 Troubleshooting 
This section describes various error messages and how to solve them, for both 
Flowel and CrypKey.  

1.12.1 Flowel 

Flowel will display appropriate error messages when performing calculations. Some 
error messages act only as warnings; they allow users to make their own judgments 
when executing calculations. 

Flowel is designed to complete the particular calculation only after the user clicks 
OK. Should you have any questions or concerns about warning messages, please 
contact the Hydrocarbon and Energy Industry Center. 

1.12.1.1 Error Message One 

“Could not back up the database”. Please ensure that the database is closed.” 

Figure 1-22 Flowel – Error Message One 

 

This message occurs because either Flowel is currently running or there is no copy 
of Flowel.db present in the Flowel folder when the user is trying to perform an 
upgrade. 

To solve this error, do the following: 
1. Stop Flowel. 
2. Place a copy of Flowel.db into the Flowel folder directory, then modify your 

registry and restart the upgrade. 

1.12.1.2 Error Message Two 

The following error message (or similar type) occurs when the system is unable to 
connect to the database. 
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Figure 1-23 Flowel – Error Message Two – Unable to Connect to Database 

 

This message occurs because the administrator installed Flowel on the computer. 
They may have logged in as an “Administrator” rather than as a “User,” so when 
another user logs in and tries to operate Flowel, this user has no database entry in 
the ODBC.ini file. 

Note: Before following the steps below to correct this error, ensure you have full 
administration permissions, as this process will make entries to the registry. 

To correct this database error, do the following: 
1. On the Start menu, select Settings, and click Control Panel. 
2. Double-click ODBC (or select Administration Tools and click Data Sources). 
3. Highlight floweluser in the ODBC Data Source Administrator (see figure below). 
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Figure 1-24 ODBC Data Source Administrator Dialog 

 
4. Click Configure. The following dialog box will appear (as shown in Figure 1-25). 
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Figure 1-25 DSN Configuration 

 
5. In the MySQL dialog box, enter the following information: 

Data Source Name: floweluser 
Description: MySQL ODBC 3.51 Driver DSN 
Host/Server Name(orIP): localhost, IP address (where database exists), or 

computer name 
Database Name: flowel 
User: root 
Password: root 
Port: 3306 
Option: Click Test Data Source 
  

6. Click Test Data Source. If the connection is successful, the following dialog will 
appear (Figure 1-26). 
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Figure 1-26 Test Data Source 

  
7. Click OK. 
8. Click OK. 

1.12.1.3 Error Message Three 

The following error message (or similar) will occur if all the Flowel licenses are in use 
(i.e., if you have one license only one user can use Flowel at any one time). The 
problem may also occur if the user did not exit properly the last time Flowel was 
open. 

Figure 1-27 Flowel – Error Message Three 

 

To solve this problem, do the following: 
1. Click Close and, as the dialog indicates, wait until the user logs out. 
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2. Or, delete the file called Flowel._tb in the Flowel folder. However, before deleting 
this file, ensure that no users are logged into Flowel. This file is a transaction log; 
it records when users are in Flowel. If users do not exit properly, this file 
becomes corrupt. The file will be re-created once Flowel is re-opened. 

1.12.1.4 Error Message Four 

“Job ‘ ’ already exists. Job not imported. Job ‘ ‘ already exists. Job not imported.” 

Figure 1-28 Flowel – Error Message Four 

 

This error occurs because the user is attempting to import the tags or fluids with 
names that already exist in the database. 

To correct this problem, the user should import tags into a job where the tag names 
do not already exist. In the case of fluids, the fluid name must be changed to a name 
that does not already exist. 

1.12.2 CrypKey 

Please contact the Hydrocarbon and Energy Industry Center at +1 (403) 258-6234 
for any CypKey or Crypserv error messages. 

1.12.3 Windows 

1.12.3.1 Error Message One – Registry Error 

“Register Directory. Unable to open service manager – Likely fixed by logging in as a 
local administrator of this machine. Reason: Access is denied.” 
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Figure 1-29 Windows – Error Message One 

 

This error occurs because the person who tried to install Flowel did not have the 
permission needed to install the drivers. 

To correct this problem, do the following: 
1. On the Start menu, click Control Panel and select Add/Remove Programs. 
2. Remove/un-install Flowel. 
3. After Flowel is un-installed, the user may log in as a local administrator and re-

install the program. 

1.12.3.2 Error Message Two 

“File FLOWEL.EXE not found!” 

Figure 1-30 Windows – Error Message Two 

 

To solve this problem, reinstall Flowel. If the problem persists, contact Hydrocarbon 
and Energy.  
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1.12.3.3 Error Message Three 

“SITE KEY FILE HAS BEEN MOVED.” 

Figure 1-31 Windows – Error Message Three 

 

This problem occurs because the flowel.exe file has been moved to a new location 
on the computer since its initial authorization or the folder it’s stored in has been 
renamed (see Copy Protection – CrypKey, Section 1.13). 

To solve this problem, move the file back and/or correct the folder name. If the 
problem still exists you will need to contact Hydrocarbon and Energy for new 
authorization. 

1.13 Copy Protection – CrypKey 
CrypKey protects Flowel from any unauthorized use. The protection scheme has two 
components: a site code and a site key. The site code is specific to your particular 
installation. The site key, when applied to your site code, unlocks Flowel so that it 
may be used. 

Note: To transfer authorization from one computer to another, follow the instructions 
provided in Chapter 3, User Reference, under the Transfer Authorization section. 

Copy protection comes into effect when Flowel is first activated. To unlock Flowel, do 
the following: 
1. The first time Flowel is activated after installation, a warning message will 

appear, as shown in Figure 1-32. 

Figure 1-32 Activation Warning Message 
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2. Click OK. 
3. A Request for Authorization dialog box appears. Select Get new authorization 

and click OK. 
4. A site key request form will appear, as shown in Figure 1-33. 

Figure 1-33 Site Key Request Form  

 
5. Enter your Customer Service Number (#). This number is found on the inside of 

the Flowel binder front cover. 
6. Complete the required fields and click Print to print the form.  
7. Fax the form to Hydrocarbon and Energy at +1 (403) 258-6201. 

By sending the site code you will register the software package and receive the 
site key to unlock the program. 

8. Close the window until you receive your site key from Hydrocarbon and Energy. 
9. Once you receive your site key, re-run Flowel and enter the site key 

alpha/numeric into the appropriate field.  
10. Click OK and Flowel will then be unlocked and available for use. 
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1.13.1 Tips and Tricks 

Some do’s and don’ts associated with CrypKey are listed below: 
• do move the program using the Transfer Authorization function only 
• do ensure your computer clock is set properly before installing the program 
• do backup the database 
• do not move the program or restore the program (flowel.exe) 
• do not change the system files 
• do not move your clock settings 

1.14 Starting Flowel 
To start Flowel, do the following: 
1. On the Start menu, click Programs, click Flowel 4, and then click Flowel 4. 
2. Or, locate the Flowel icon and double-click the icon to start the program. When 

the program has completed loading, you will see the main program screen. 

1.15 The Flowel Database 

1.15.1 MySQL Database 

Flowel is actually constructed in two main components: the Flowel GUI, which is the 
program as you see it, and the MySQL database, which contains all of the data that 
the program uses. The Flowel database is a multi-user database. Multiple 
workstations can access the data at a given time, if the correct license has been 
purchased. 

1.15.2 Backing up the Database 

The Flowel database is stored under C:/Program Files/mysql/data/flowel/. This folder 
contains all of the job, tag, fluid, and material information and should be backed up 
on a regular basis to prevent any loss of data. Data can be restored from backup by 
overwriting the current subdirectory (C:/Program Files/mysql/data/flowel/) with the 
backup version. This will completely replace the database and any tags modified 
since the backup will not be captured. Use the Import and Export functions to move 
specific tags from one database to another. 

1.15.3 Moving the Database 

The Flowel database cannot be moved. Do not move the database. 

§ 
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User Manual 

2 Tutorial Instructions 

2.1 About This Tutorial 
This tutorial is designed to serve two purposes: 

• to lead new users through the program while explaining the principles behind 
the program 

• to show users familiar with older tools how to get the job done effectively 
using this version of Flowel for Windows 

The tutorial is divided into three main components: One Time Through, Customizing 
the Program, and Examples and Applications. 

Note: If you are new to the Windows environment, we recommend that you take the 
tutorial provided by Microsoft before you run Flowel. This tutorial can be run by 
selecting the Windows Tutorial option from the Windows Program Manager Help 
menu. 

2.2 One Time Through 
Follow the instructions in this tutorial to learn how to use Flowel 4®. Through this 
process you will learn the approach that you should take to using this software in 
order to use the functions as they are intended. As a result, you will have a solid 
understanding of the most efficient and practical ways to get accurate and usable 
results with Flowel.  

2.2.1 Starting Flowel   

To start Flowel, do the following: 
1. Double-click the Shortcut to flowel4.exe on your desktop.  
2. If prompted, add your name to the user list and click OK. 
3. The main screen appears, as shown in Figure 2-1. 
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Figure 2-1 Main Flowel Screen 

 

This screen provides a summary of the completed work; there are no editable fields. 
It has some standard Windows components including the control menu and the 
min/max/restore buttons. The components that are reviewed in this manual are 
directly related to the operation of Flowel.  

2.2.2 Using the Toolbar  

The Toolbar is one of the most important components of the main Flowel screen. It 
can be set so that the function names are on the buttons (in Flowel, on the Windows 
menu, click Tool Bars, and select Show Text). This will help you learn the function 
of each button. 

Each button on the toolbar corresponds to a command. By using the toolbar from left 
to right, you follow a logical sequence. 
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Table 2-1 Toolbar 

Icon Function 

 

Open Job 

 

New Tag 

 

Open Tag 

 

Print All 

 

Print Tag 

 

Fluid  

 

Meter Run 

 

Calculate 

 

Graph 

 

Uncertainty 

 

Spec Sheets 

 

Exit 

2.2.3 Proceeding to the Next Step 

Each of the steps in performing a flow calculation within Flowel are the steps you will 
use for each new tag. These steps are necessary and are repeated every time. To 
save you some keystrokes, and to make the process consistent, we have included a 
way of easily getting to the next step in the procedure. 

At the bottom of each of the dialog boxes which are necessary to this process are 
one or two buttons. Think of these buttons as a way to travel back and forth along 
the toolbar without all of the closing and opening steps. 

We use the previous and next buttons to go forward and backward through the 
program, following the proper order of use. 
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The first dialog box to include a button of this type is the New Tag dialog box. It is 
from this point onward that you can be led through the program in the right order. On 
some of the dialog boxes, the previous button appears. This will allow you to go 
backwards in the order so that you can make changes or corrections. Once those 
changes are made, you can use the next button again to proceed forward as before. 

2.3 Create a New Job 
The first step in using Flowel is to create a new job. How you use the job number 
field is up to you but conventionally it refers to your organization’s method of keeping 
track of projects. To create a new job, do the following: 
1. On the File menu, click New Job. The New Job dialog box appears. 
2. Type the name of your job. In this case we will use the Job name Tutorial. 

Your company probably has an internal numbering system, and you will likely be 
issued a job number. This entry field accepts both numbers and letters. This 
dialog box displays any existing jobs so that you can see what has already been 
created. 

3. Fill in the remaining fields, then click OK. 

2.3.1 Setting the Default Values for the Job 

To configure the default settings for this job, set your default values as per the 
instructions in the following sections. 

2.3.1.1 Default Unit Setting 

To set the Default Unit Setting, do the following: 
1. On the Options menu, select Default Units. 
2. The Default Unit Settings option is used to set the unit type that will be used in 

the calculations for each tag. When you make selections here, all new tags that 
are created will use these settings.  

Note: any tags which already exist will not be affected, but any tags can have their 
units changed afterwards. 
3. Select a unit type for each of the options.  
4. When you have selected all of the options to be used as defaults, click OK. 

2.3.1.2 Atmospheric Pressure 

To set the Atmospheric Pressure, do the following: 
1. On the Options menu, select Atmospheric Pressure. Use the scroll bar or 

enter a value into the altitude field. The pressure for that altitude will be 
automatically calculated. 

2. Click OK to accept this setting as the default for any tags subsequently created. 
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2.3.1.3 Significant Digits 

To set the Significant Digits, do the following: 
1. On the Options menu, select Significant Digits. 
2. The Significant Digits settings are used in the display of numbers on the 

calculation screen and in the specification sheets. The settings here do not affect 
the number of digits used in the calculations, only those used for display. 

3. Use the horizontal slider bars to adjust the number of digits which are to be 
displayed for each of the available options. A sample for each is presented on 
the right-hand side of the dialog box. 

4. When you are satisfied with the settings, click OK. 

2.3.1.4 Default Base Conditions 

To set the Default Base Conditions, do the following: 
1. On the Options menu select Default Base Conditions. 
2. The program uses some information repeatedly within its calculations. By making 

a selection from the default base condition setting screen, new tags created will 
use these settings and therefore require less input later on. 

3. Select from one of the types available. In this case we will use the Standard - US 
selection, which gives us settings of 14.65 psia and 60°F. 

4. Click OK to continue. 

2.3.1.5 Default Element  

To set the Default Element Setting, do the following: 
1. From the Options Menu, select Default Element. 
2. The program will use the element defined on this screen as the default for all new 

tags created. Even though this is the default, and this information appears 
automatically on the meter run screen, you may choose a different element on 
the meter run screen. 

3. Click OK to continue. 

2.3.2 Create a New Tag 

We are now prepared to begin creating tags.  

Tags are names for specific devices. There are standards for using tag names, and 
The Instrumentation, Systems, and Automation Society (ISA) has developed a 
standard tag naming format (ISA S-20 standard) which uses four fields to pinpoint a 
device’s location within a site or system. Flowel extends the ISA tag naming standard 
by using five fields. 
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The tag name looks like this: 

 

Each of the five components can hold up to eight characters. Here is a brief review of 
the tag naming convention: 

• Prefix1 – an optional general location identifier 
• Prefix2 – an optional, more specific location identifier 
• Instrument ID – a required field which classifies the function of the device 
• Loop number – a required field, usually a grouping of instruments working 

together toward a common function 
• Suffix – additional optional identifier to distinguish between instances of a 

device in a loop 

Each tag would correspond, in the case of Flowel, to a metering device. Since a 
project may have multiple metering locations, the same relationship holds true for job 
numbers and tags within Flowel. Each job can have many tags associated with it: 

 

To create a new tag, on the Flowel toolbar, click New Tag. The Define New Tag 
dialog box appears. Click the Define New Tag button to begin data entry on this 
window, otherwise you will not be able to edit any fields. 
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Figure 2-2 Define New Tag Dialog Box 

 

There is room for a lot of information about each tag. The minimum entry required is 
the instrument ID and loop number of the tag name. We recommend filling in as 
much information as you can about a tag, since this information will used in a 
number of dialog boxes and printouts. For example, enter an Instrument ID of FE and 
a loop number of 1. After the information is entered, click OK to move to the next 
topic (or click Next to proceed directly to the next dialog box/step in this process). 

2.4 Fluid Settings 
To set your fluids, click the Fluid button on the Flowel toolbar. The Fluid Setting 
dialog box appears. Use this dialog box to configure each tag’s specific fluid. Flowel 
requires this information in order to calculate a result. 
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Figure 2-3 Fluid Setting Dialog Box 

 

The Fluid Setting dialog box is described in the following sections. 

2.4.1 Fluid State 

Select the state from the drop-down list provided. Your choices are: 
• Gas 
• Gas, Critical Flow 
• Liquid 
• Liquid, Critical Flow 
• Wet Gas 

These selections affect how the program operates, as each of these states require 
different methods and formulas. You must make a fluid state selection. For this 
example, select Liquid. 
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2.4.2 Selection Lists 

Many of the selection lists within Flowel allow for item selection in more than one 
fashion. In this example we want to select Liquid as a fluid state. We have two 
methods for making the selection: 
1. Standard Selection: 

(a) The first method is the standard selection method. Click the State drop-down 
list box to view the list of states.  

(b) Select Liquid. 
2. Alternate Method: 

(a) Type the first letter of the desired item, in this case the letter L.  
(b) If there are more than one item which begins with the letter L, the first will 

appear. 
(c) Press L again to get to the second one, and so on, until you can select 

Liquid. 

These methods apply to many areas of the program. In particular, when selecting 
pure fluids on the mixture definition function, the letter-selection method allows quick 
access to a component which might otherwise take a lot of time to scroll to in a list. 

2.4.3 Fluid Type 

Because there are over 600 fluids available in Flowel, we provide the Fluid Type 
selection to narrow down the list.  
1. To select a fluid type, click the Fluid Type drop-down.  

• There are two main fluid types: mixtures and pure components. Mixtures 
include all of the natural gas selections, plus the General Mixture option. Pure 
components are selected using the "All" or "Common Fluids" options. 

• If a mixture is selected, it must be defined before it can appear as a "Fluid" in 
the final fluid list. This procedure involves selecting the components, then 
setting the mole values for each of the components. 

• Pure components are provided by the program and do not need any further 
definition; they can be used as they are. 

2. For this example, select the Common Fluids option. 
3. Since we have selected Common Fluids, the list of these fluids is provided for us. 

We want to use water for this example, so we can either use the scroll bar to 
move to water, or type in the letter w. Since water is the first fluid that starts with 
w, it will be highlighted for us.  

4. Use your mouse to select Water and/or Steam. 
5. When you have completed these steps, click OK to move to the next topic in the 

process (or click Next to go directly to the Meter Run dialog box). 
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2.5 Meter Run Settings 
To set your meter run, click the Meter Run button on the Flowel toolbar. The Meter 
Run dialog box appears. The Meter Run function activates a dialog box in which 
specific information about the metering equipment and environment is entered. 

Figure 2-4 Meter Run Dialog Box 

 

2.5.1 Element Type, Material, Pressure Taps, and Thickness 

The first step is to select an element type. If you have set an element type in the 
Default Element Type function, this type will be entered into the fields.  

Different element types will be available depending on the fluid state selected earlier. 
If you want to select a different element type, follow the procedure as outlined below. 
1. Click the Type drop-down arrow. You can use the scroll bars to see all of the 

options on this list. In this case, select a standard orifice plate (Orifice Plate-
Standard) as the element type for this meter run location. 

2. Select a material type for this metering element. Select 316 SS. 
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3. Enter the orifice plate thickness, if required (this field will appear if required). 
Flowel will calculate and warn the user if the entered valued is less than the 
minimum thickness according to AGA-3 (2000). 

4. The next group box on the dialog is where pressure taps are defined by type and 
location. The list of differentials provided depends upon the element type 
selected. Also, the Flowel display activates only the static locations which are 
applicable for the differential selected. 

5. For this example, select Flange for the differential and leave the static as the 
default (upstream). 

2.5.2 Pipe 

As the final task on this dialog box, you must select a pipe. To select a pipe, do the 
following:  
1. Select a pipe nominal size. For this example, select 4 in. 
2. The program defaults to a pipe schedule of 40 (if there is one for that pipe). We 

need to enter a material for the pipe so that the program can compensate for 
thermal expansion in the calculations. Select Carbon Steel for the material. 
• Flowel’s database for pipe will provide the inside diameter of the pipe.  
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Figure 2-5 Meter Run Selections 

 
3. When you have completed your selections in the Meter Run dialog box (which 

will appear as shown in Figure 2-5 above), click Next. This will activate the 
Calculate dialog box. 

2.6 Calculate 
The Calculate dialog box is the area in which the final results are calculated. The 
Flowel program can solve for different variables. You select both the variable to solve 
for and the method in which that variable is solved. The list of methods available is 
dependent on your previous selections for fluid state, flow element type, differential 
pressure tap, and static pressure tap selection. 

There are five versions of the calculate screen – one for each of the fluid states. 

As you select different Solve options in the setup area, you may notice that some of 
the other fields change. This screen automatically activates the fields that are 
necessary to complete the equation. Only when the last of the required fields has 
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valid data entered into it will the program be able to perform a calculation. Until then, 
it will warn you that there are fields that are incomplete.  

The results of the calculation will be displayed in the colored field box. 

Figure 2-6 Flow Calculation Dialog Box 

 

In this example, you will set up the program to solve for Exact Bore, using the ASME 
MFC-3M method. To set this up, do the following: 
1. Select Exact Bore from the Solve For drop-down list and ASME MFC-3M from 

the Using drop-down list. 
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2. Ensure that all of the units are set for each of the fields. You do not have to use 
the default settings (even though you set them earlier). Enter the following 
values: 
• Flow Rate: 150 kg/day 
• Differential Pressure: 100 in-H20@60F 
• Static Pressure: 57 psig 
• Temperature: 175 DEG F 

3. We can calculate the density of the fluid automatically because water is defined 
in the Flowel database. The program performs the necessary calculations based 
on the data we entered, and brings the results back into the calculate screen, as 
shown in Figure 2-7 below. 

Figure 2-7 Flow Calculation Example – Solve For Exact Bore 
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2.6.1 Density Calculator 

To calculate density, do the following: 
1. On the Flow Calculation dialog box, click Density. 
2. Flowel will ask you to select a density solution method. The list which appears 

will reflect the possible options available given the current fluid state, fluid type, 
and fluid selected. 

3. The temperature and pressure of the base and flow conditions will appear as 
entered into the calculate screen. These values will be used in the density 
calculation. 

4. Scroll through the list to view the available methods. In this case, select the 
NBS/NRC Steam Eqn. method. You should normally always use this method for 
steam or water. 

5. Click Calculate to retrieve the density values (see Section 2.6.1.1 below). The 
Calculate H2O Flowing Density (NBS) Equation dialog box will appear. 

6. Click OK to bring these values back to the Density Calculator dialog box. 
7. On the Density Calculator dialog box, click OK to bring these values to the 

Calculate dialog box. 

2.6.1.1 Water and/or Steam Calculations 

The H2O density calculator with the NBS equation operates as follows: 
1. To calculate a flowing density, you are presented with three options: 

• H2O saturated, use Temperature 
• H2O saturated, use Pressure 
• H2O not saturated, use Both Temp. and Press. 
(a) If H20 saturated, use Temperature is selected, a saturated density at 

flowing temperature in the selected state (gas or liquid) is calculated. This 
state is selected in the Fluid Setting dialog box. The flowing pressure is 
changed to the pressure corresponding to the saturated temperature. 

(b) If H2O saturated, use Pressure is selected, a saturated density at flowing 
pressure in the selected state (gas or liquid) is calculated. This state is 
selected in the Fluid Settings dialog box. The flowing temperature is changed 
to the temperature corresponding to the saturated pressure. 

(c) If H2O not saturated, use Both Temp. and Press. is selected, a density at 
flowing temperature and flowing pressure is calculated. The density 
calculated may be either for a gas or a liquid depending on the temperature 
and pressure and may not correspond to the state selected in the Fluid 
Setting dialog box. Whether the calculated density is gas or liquid is 
determined by calculating the vapor pressure at the flowing temperature. If 
the flowing pressure is greater than the calculated vapor pressure, a liquid 
density is calculated. If the flowing pressure is less than the calculated vapor 
pressure, then a gas density is calculated. Neither the flowing temperature or 
pressure are changed. 
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2. To calculate the base density, always use both the base temperature and base 
pressure (no matter what method option is selected for flowing density). The 
density calculated may be either for a gas or a liquid depending on the 
temperature and pressure and may not correspond to the state selected on the 
fluid settings window. Whether the calculated density is gas or liquid is 
determined by calculating a vapor pressure at the base temperature. If the base 
pressure is greater than the calculated vapor pressure, a liquid density is 
calculated. If the base pressure is less than the calculated vapor pressure, a gas 
density is calculated. Neither the base temperature or pressure are changed. 

2.6.2 Viscosity 

Viscosity can be calculated automatically from the data entered in the program. If 
you have defined and configured the program as we have so far, click the Viscosity 
button to calculate the value. There are two occasions in which the Viscosity button 
will not appear: if the fluid properties option has not been purchased or the viscosity 
calculation is not available for the current fluid. 

2.6.3 Vapor Pressure 

The vapor pressure for the defined fluid can be automatically calculated if you have 
purchased this option.  

To calculate vapor pressure, do the following: 
1. On the Flow Calculation dialog box, click Vapor Pressure. 
2. You are now prepared to ask Flowel to calculate the result. Click Calc. 
3. The result of the calculation is shown in the Beta Ratio field. If you would like to 

know the bore size, click the Beta Ratio/Bore Size button to toggle this value. 
4. Once you have completed your calculations, you may want to look at a graph or 

specification sheet of the function. Click Next to automatically branch to the 
Select A Specification Sheet dialog box (shown in Figure 2-8). 
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Figure 2-8 Select a Specification Sheet Dialog Box 

 
5. In this case, select Graph, and click Preview to view the graph. 

2.7 Graph 
A graph is shown of the relationship between flow rate and both differential pressure 
and permanent pressure loss, as shown in Figure 2-9. 
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Figure 2-9 Graph Dialog Box 

 

This function assumes a constant upstream pressure. To set the normal flow rate, do 
the following: 
1. Adjust the percentage value which appears in the field at the bottom of the graph 

window. Adjust this value using the spin controls (up and down arrows) until the 
value which appears is the value you want. 

2. If you do not set the normal flow rate, Flowel will not perform certain calculations 
such as the normal flow reading for meter charts. 

This option displays the graph of the function in a scaleable window. Click Print to 
print the graph. 

2.8 Specification Sheets and Reports 
The Specification Sheet option allows you to view, edit, and print a specification 
sheet for the active tag. Much of the content will come directly from the information 
you have entered thus far. This dialog box will let you add the remaining type of 
information. 
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There are several sheets and reports to choose from, including: 
• Calculate Data Sheet – provides a summary of the calculated data according 

to the information you have input to the program 
• ISA S-20 Data Sheet – similar to the standards specified by ISA 
• Flowel Data Sheet – expands on the ISA standard by facilitating the addition 

of information which is relevant and important to specifications 
• Fluid Report – produces a listing of the fluid composition of the selected fluid, 

if it is a mixture 
• AGA3 Factor Report – produces a listing of the factors used in an AGA 3 

factors method, if the method being used is applicable 
• DP Transmitter, DP Transmitter 2, Pressure Transmitter, and Temperature 

Transmitter – ISA S-20 specification sheet – allows users to keep all of the 
specification sheets for the flow element in one place 

To complete a specification sheet or report, do the following: 
1. On the Worksheet menu, click Spec Sheet, and for this example, choose ISA S-

20 Data Sheet. 

Figure 2-10 ISA S-20 Data Sheet 

 
2. The program fills in all of the data it can from the information you have entered 

into the tag. All of the fields that remain to be filled in can be accessed using the 
Tab key. 

3. The first available field for editing or adding data will appear with a box around it. 
A cursor will appear in the field. Once you are satisfied with the information that 
appears in this field, press Tab. The cursor will move to the next available field.  

4. Continue until all of the information you require has been entered. 

All of the specification sheets have a zoom control for viewing the form at different 
magnifications. This will allow you to preview the entire form clearly even on the most 
basic monitor. Slide the zoom scroll bar to the left to reduce the image and to the 
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right to enlarge the image. The window itself is a standard window and is scaleable 
by dragging on any of its corners. 

Each specification sheet can be printed directly from this screen. Click Print to print 
the current sheet. 

2.9 Printing 
There are a number of printing options available for your use, depending on the 
output you require, including: 

• Print Tag – print the information associated with a specific tag 
• Print Spec – print all of the tags with the same specification number 
• Print All – print all of the tags associated with a specific job 

From the File menu, select the option which corresponds with the output you require. 
From each of these printing options, you may select the type of specification that the 
program will use, as shown in Figure 2-11. 

Figure 2-11 Output Formats 

 
5. Select the check boxes next to the specification sheets you require and click OK. 
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2.9.1 Printer Setup 

Each of the printing options allows you to activate the Window printer setup function 
by clicking on the Printer SetUp button. This permits you to make last minute 
changes to the setup, check that the printer settings are correct, or select another 
printer from those available. 

2.9.2 Print Preview 

The print dialog box also allows you to use the Print Preview function by clicking the 
Preview button. This function makes it possible to look at a representation of the 
printout before you send it to a printer. On the preview window, you will see a 
scaleable version of the form to be printed. If the preview is satisfactory, click OK. 
Printing will commence, followed by a confirmation message. 
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2.10 Customizing the Program 
The program is usable immediately following installation, but there are some tasks 
you may want to do before you start working with the program. First, you will want to 
set the default units as we have done in the One Time Through example in Section 
2.2. Doing this at the beginning means that every time you create a new job or tag, it 
will use your default units and will not require modification. Also, the program is 
shipped with an extensive database of fluids, pipe, and flow element materials. While 
this database is adequate for most users, your may require additional information.  

Flowel is designed to help create and store fluids and materials. Use the definition 
dialog boxes to make these modifications. 

2.10.1 Pipe Maintenance 

To activate the pipe maintenance function, on the User Data menu, click Pipe 
Maintenance. The Pipe Maintenance dialog box appears, as shown in Figure 2-12. 

Figure 2-12 Pipe Maintenance Dialog Box 
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Add or change pipe specifications to suit your applications. Most standard pipe sizes 
and materials are already included in Flowel, so before adding a new pipe size be 
sure to check that it does not already exist. 

2.10.2 Material Maintenance 

To activate the material maintenance function, on the User Data menu, click 
Material Maintenance. The Material Maintenance dialog box appears, as shown in 
Figure 2-13. 

Figure 2-13 Material Maintenance Dialog Box 

 

Add or change material specifications to suit your applications. A comprehensive list 
of materials is already included with Flowel, but you may add your own custom 
materials if you know the specifications. 

2.10.3 Fluid Maintenance 

To activate the fluid maintenance function, do the following: 
1. On the User Data menu, click Fluid Maintenance. The Fluid Maintenance dialog 

box appears, as shown in Figure 2-14. 
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Figure 2-14 Fluid Maintenance Dialog Box 

 
2. Add fluids that have the same composition as existing fluids, but have different 

mole fractions, or copy an existing fluid and adjust the mole fractions to suit the 
new mixture. 



User Manual  2 Tutorial Instructions 

 58  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

2.11 Examples and Applications 
The following examples describe real-world applications of Flowel. The examples 
look at sample calculations and how they are implemented in Flowel.  

Note: These examples are included with Flowel and have been installed with the 
program. 

2.11.1 Example One 

There is an existing single-loop controller on a steam line for which the flow rate will 
be increased. This example will illustrate how you can use Flowel to determine the 
new size required for the orifice plate. 

Figure 2-15 Example One 
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The tag number is FE-200. The information known about the system includes: 
• 6" schedule 40 line composed of carbon steel 
• upstream static pressure is 155 psig 
• flowing temperature is 375°F 
• normal flow rate will be about 8,500 lbs/hr 
• existing meter uses radius differential pressure taps 
• existing static pressure tap is upstream 

To complete this example, do the following: 
1. On the Flowel toolbar, click Open Job or on the File menu, click Open Job.  
2. The Define a New Job dialog box will appear. From the Existing Jobs, select US 

Examples, and click OK. 
3. Now we must retrieve the tag information. To do this, from the File menu, select 

Open Tag. 
4. The Open a Tag dialog box appears. Select the FE-200 tag, and click Next. 
5. The Fluid Setting dialog box appears. This dialog is used to select the fluid state 

and type, and to define the fluid. For this example, select water in a gas state, as 
shown in Figure 2-16. 
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Figure 2-16 Example One – Fluid Setting 

 
6. Click Next. 
7. The Meter Run dialog box appears. For this example, select a standard orifice 

plate made of 316 stainless steel, as shown in Figure 2-17. 
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Figure 2-17 Example One – Meter Run 

 
8. Note that there are fields for defining the pressure taps and the pipe used in this 

meter run. These fields have been filled out as per the information given at the 
start of this example. 

9. When all of the information is entered, click Next. The Flow Calculation dialog 
box appears. 

10. Use the beta ratio button to toggle between displaying the beta ratio and the bore 
size for the calculated result.  

11. For an orifice plate with radius taps, the options for methods available are ISO 
5167 (1980), ISO 5167 (1991) and ASME MFC-3M. In North America, select 
ASME; in Europe, select ISO 5167. 

12. If the normal flow rate is 8500 lb/hr, it is good practice to size the plate for a 
maximum flow that is 1.3 to 1.4 times larger. Lets use 11500 lb/hr. For differential 
pressure, start with a convenient value like 50 in-H2O. Use the appropriate 
calculator to calculate density, viscosity, and isentropic exponent.   

13. Fill in the appropriate values as shown in Figure 2-18. 
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Figure 2-18 Example One – Flow Calculation 

 

Note: Refer to Section 2.6.1 for details on density calculations and water and/or 
steam calculations. 
14. If you want the beta ratio to be higher, try a differential value of 100 in-H20. Click 

Calc. to recalculate the equation. The beta ratio changes.  
15. Next, you may want to use an orifice plate from your existing inventory. Stock 

plates come in 1/8 inch sizes. Solve for Rounded Bore by picking the Rounded 
Bore option from the Solve For selections. Set the “round” setting to down and 
the “to nearest” to 0.125 in. Click Calc. 

16. Click Beta Ratio to toggle the display from beta ratio to bore size. The value that 
appears is shown with its units (shown in Figure 2-19). 
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Figure 2-19 Example One – Calculated Bore Size 

 
17. Now that a bore size has been successfully calculated, click Next. 
18. The Select a Specification Sheet dialog will appear. Select the specification sheet 

you would like to preview and click Preview (or click Finish to exit).  
19. In the specification sheet preview, click OK to close the window. Now that you 

are done entering data, the program displays a summary screen which shows 
the results of your work (shown in Figure 2-20). 
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Figure 2-20 Example One – Summary Screen 

 
20. Print out a datasheet for this newly calculated tag. On the Flowel toolbar, select 

Spec. Sheet and click the Calculation Data Sheet from the specification sheets 
available. 

21. The Calculation Data Sheet window appears. This window displays a preview of 
the sheet as it will be printed, but this screen also allows you to enter additional 
information which could not be found in the data entered in so far. These fields 
appear on the screen as highlights. You can scroll around this screen, as well as 
zoom in and out. 

22. When you have completed this form, click Print to print the form. 

2.11.2 Example Two 

This situation involves an existing sales gas meter. You must validate the results of 
the meter at a certain flow rate. The flow rate will be calculated using AGA 3 (92). 
Gas density will be calculated using AGA 8 (92). Determine the volumetric flow rate 
at standard conditions and associated uncertainty. 
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Figure 2-21 Example Two 

 

The tag number in this example is FE-300. The information known about the system 
includes: 

• pipe is 8”, schedule 40 
• composition is known from lab tests done with a gas chromatograph 
• upstream pressure is 5,850 kPa 
• flowing temperature is 45 C 
• bore size is 105 mm 

To complete this example, do the following: 
1. Open the Job labeled Metric Examples and open tag FE-300, using techniques 

previously shown.  
2. On the Worksheet menu, click Fluid (or click Fluid on the Flowel toolbar).  
3. This gas has already been defined for you. Ensure the state is Gas, and select 

Fluid type Natural Gas AGA 8 (92) Component List, as shown in Figure 2-22.  
 
Note: Flowel supports more than 600 pure fluids, plus user-defined mixtures. 
The Fluid type selection is used to narrow down the number of fluids that appear 
in the Fluid list box. 
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Figure 2-22 Example Two – Fluid Setting 

 
4. Select Sales Gas from the Fluid drop-down list. 
5. Click Edit Mixture to review the gas composition. Gas composition is derived 

from lab results of gas chromatography performed on a Sales Gas sample. The 
gas composition with corresponding mole percentage values for each component 
is shown on the mixture editing dialog. The mole percentage values can be 
edited at this point. Click OK. 

6. Click Next to continue. 
7. In the Meter Run dialog, enter the required information for this example, as 

shown in Figure 2-23. 
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Figure 2-23 Example Two – Meter Run 

 
8. Click Next to continue. The Flow Calculation dialog box appears. 
9. Select and insert the values as shown in Figure 2-24 (these values were 

provided at the beginning of this example). 
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Figure 2-24 Example Two – Flow Calculation 

 
10. This flow calculation uses flow units of standard cubic meters per hour (Sm3/hr). 

Notice that the Flow Rate box appears in the base condition column. This 
indicates that the displayed flow will be at base conditions, not flowing conditions. 

11. Any time you select a normal (e.g., Nm3/hr) or standard (e.g., Sm3/hr) volumetric 
flow unit, Flowel moves the flow rate edit box to the base condition column. Also, 
edit boxes will appear for the base temperature and pressure. 

12. If you select a mass (e.g., kg/m3) or volumetric (e.g., m3/hr) flow unit, the 
program moves the flow rate edit box to the flowing condition column. The edit 
boxes for base temperature and pressure disappear. 

13. The reason for this dynamic behavior is actually quite straight forward. Internally, 
Flowel performs all flow calculations using mass flow rate. If you want to enter a 
volumetric flow rate, Flowel needs to know the density: mass flow rate = 
volumetric flow rate x density. The following table illustrates the conversion 
process. 
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Table 2-2 Conversion Process 

Flow Rate Unit Required Inputs 
volumetric flow rate such as m3/hr • flow rate at flowing conditions 

• density at flowing conditions 
mass flow rate such as kg/m3 • flow rate at flowing conditions 

• density at flowing conditions (required for calculation of 
fluid velocity, but not for volume to mass conversion) 

volumetric flow rate at a standard or 
normal conditions such as Sm3/hr or 
Nm3/hr 

• flow rate at base conditions 
• density at flowing conditions 
• density at base conditions 
• pressure at base conditions 
• temperature at base conditions 

14. Click Density to activate the density calculator. Use the AGA 8 (1992), Detailed 
method. For natural gas, this is the most accurate method available and should 
be your first choice. 

15. Close the Density Calculator dialog box and then, click OK to close the Flow 
Calculation dialog box. 

16. On the Flowel toolbar, click Uncertainty. The Uncertainty dialog appears, as 
shown in Figure 2-25. 

Figure 2-25 Example Two – Uncertainty 
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17. The uncertainty calculation uses a method described in the ISO 5168 standard. 
The uncertainties associated with the discharge coefficient and the gas 
expansion coefficient depend on the flow calculation standard method. In this 
case, the standard is AGA 3-1990. Flowel calculates these uncertainties for you. 

18. The uncertainty in pressure depends on the accuracy of the pressure sensing 
instrument. In this case, we have used a quarter percent as a typical value for a 
modern temperature transmitter. Most instrument manufacturers provide 
methods to determine instrument uncertainty. 

19. The uncertainty for the bore size and pipe diameter will be filled in by Flowel. It 
will use the minimum uncertainty values specified in the flow calculation 
standard. In this case, AGA 3-1990 states that bore size must be within 0.05% of 
the desired value. Similarly, the pipe diameter must be known within 0.5 %. The 
best way to confirm these values is to actually measure the plate and pipe. 

20. The uncertainty associated with density is a complicated issue, and a complete 
discussion is outside the scope of this manual. However, one approach would be 
to use AGA 8 to calculate density using various compositions. Vary the 
compositions to reflect the uncertainty of the chromatograph and the variations in 
compositions. The range of densities thus calculated, assuming AGA 8 is 
perfectly accurate, represents the density uncertainty. 

§ 
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User Manual 

3 User Reference 
The User Reference section of this manual describes all menus and functions found 
within Flowel 4®. This section is organized alphabetically. Please use the table of 
contents to find a topic, or the index to get to an exact page number for the subject 
matter. 

3.1 About Menu Item 
To activate the About menu item, type Alt-H-A, or on the Help menu, click About.  

This dialog box contains the program name and version, copyright notice, and logo. 
For customer support information consult the index, or use the online help system. 

 

3.2 AGA 3 Factors Report 
To access the AGA 3 Factors Report, type Alt-S-S-A, or under the Worksheet menu, 
select Spec Sheet, and click AGA 3 Factor Report. 

Description 

The AGA-3 Factors Report is a datasheet containing information related to the AGA-
3 calculation–factors approach–for a tag, including a listing of factors. The factors are 
not used to calculate flow, and are provided only for reference.  Be careful when 
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using factors to calculate the flow rate. The pressure used in the flowing equations 
must be the absolute static pressure P1. whPxCQv

'=  

Notes: 
1. When this option is selected, the factors report will print only if the method used 

for the selected tag is AGA 3 and the fluid state is gas. If a multiple-tag printing 
function is selected, only those tags using AGA 3 will have a factors report 
printed for them. 

2. The heating value will be available for natural gas with the AGA 8 method only. 
Some of the fields may be blank if not enough information is available. The 
recommended use of this report is for natural gas with a defined fluid 
composition. 

3. Job and tag related fields can be edited through the Calculate Data, ISA-S20, 
and Emerson data sheets. 

Please see Appendix A for the definitions of the factors. These definitions are 
extended over the original AGA definitions. Flowel supports all unit types for these 
factors.  

Related topics include: 
• Print All 
• Print Spec 
• Print Tag 

3.3 Atmospheric Pressure 
To change the default pressure function, type Alt-O-A, or under the Options menu, 
click Atmospheric Pressure. 

Description 

Use the Atmospheric Pressure function to set the altitude/atmospheric pressure for 
this tag. The atmospheric pressure will only be used when a gauge pressure unit is 
selected, or when changing from a gauge to absolute pressure and vice versa. The 
atmospheric pressure will be added to the gauge pressure to produce an absolute 
pressure used in the flow calculations. 

The atmospheric pressure is NOT the same as the base pressure. 
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Figure 3-1 Atmospheric Pressure Dialog Box 

 

First, select the units for altitude and atmospheric pressure if they are not correct. 
Next, you have two ways of setting the pressure: click and drag the scroll bar up or 
down until the correct values appear in the fields, or enter either altitude or 
atmospheric pressure directly into the appropriate field.  

Once the gauge pressure has been set, click OK. This value is saved and will be 
used as the new default gauge pressure for the next new tag. 

Note: Atmospheric pressure can also be changed for an individual tag on the 
Calculate dialog box. 

3.4 Calculate 
To activate the calculate function, type Alt-S-C, or under the Worksheet menu, click 
Calculate. 

Description 

This command activates the calculation window. This is a dynamic window in which 
the fields displayed depend on the variable to be "solved for", fluid state, and flow 
rate units. 
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Figure 3-2 Flow Calculation Dialog Box 

 

At the top of the window is the Flow Rate Unit selection. Available flow rate units are 
categorized into three groups: 

• Base/Normal/Standard Volumetric are units of volumetric flow at a base, 
normal, or standard condition. This condition is defined under the Options 
menu, and Default Base Condition. These base conditions can also be 
changed for each tag. 

• Actual Volumetric are units of volumetric flow at flowing conditions. 
• Mass are mass flow units. 

If the category of units is changed on the calculate screen, it is necessary to populate 
the flow rate units before the numeric value is entered. 



3 User Reference  User Manual 

 75  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

The flow rate, differential pressure, static pressure, temperature, and density fields 
under the base condition column will appear and disappear depending on the flow 
rate unit selections. These fields will show up for any normal or standard flow rate. 
Information must be entered into each of the displayed fields in order to perform a 
calculation. If a value is out of range for that field, the program will display a warning 
message and force you to enter valid data. 

If you select a mass (e.g., kg/m3) or volumetric (e.g., m3/hr) flow unit, the program 
moves the flow rate edit box to the flowing condition column. The edit boxes for base 
temperature and pressure disappear. 

Internally, Flowel performs all flow calculations using mass flow rate. If you want to 
enter a volumetric flow rate, Flowel needs to know the density: mass flow rate = 
volumetric flow rate x density. The following table illustrates the conversion process. 

Table 3-1 Flow Calculation 

Flow Rate Unit Required Inputs 
volumetric flow rate such as m3/hr • flow rate at flowing conditions 

• density at flowing conditions 
mass flow rate such as kg/sec • flow rate at flowing conditions 

• density at flowing conditions 
(required for calculation of flowing velocity, but not 
for volume to mass conversion) 

volumetric flow rate at standard or normal 
conditions such as Sm3/hr or Nm3/hr 

• flow rate at base conditions 
• density at flowing conditions 
• density at base conditions 

3.4.1 Solve For 

Flowel is capable of solving different types of flow-related calculation problems. The 
Solve For selection list lets you choose the variable to be solved for. These are as 
listed below. 

3.4.1.1 Exact Bore Size 

Calculates an exact bore diameter given the maximum flow rate and maximum 
differential pressure. 

3.4.1.2 Exact Differential Pressure 

Calculates the exact differential pressure given the maximum flow rate and element 
bore. 

3.4.1.3 Exact Flow Rate 

Calculates the exact flow rate given the element bore and differential pressure. 
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3.4.1.4 Rounded Bore Size 

Performs an exact bore calculation. However, before displaying the results, it 
determines the next nearest bore size (round up/down 1/8 in. by default, you may 
use a different value) and recalculates the maximum flow rate based upon the new 
bore size. 

3.4.2 Using 

Use the Using option to select the calculation methodology. This list will change 
depending on the fluid state and meter run settings. Some of the solve methods 
available are: 

• ISO 5167-1980 
• ISO 5167-1991 
• ISO 5167-2003 
• ASME MFC-3M 
• ASME MFC-7M-1987 
• ASME MFC-14M-2003 
• AGA 3-1985 
• AGA 3-1990 
• General 
• BS 1042 

3.4.3 Options 

A description of the available calculation options are listed in Table 3-2 below. 

Table 3-2 Options  

Name Availability Description 
Density 
Calculator 

If you have not purchased 
the Fluid Properties add-
on, the following function 
will operate for a smaller 
set of fluids: 

Press the Density button to calculate the density of 
the selected fluid based upon the static 
temperature and pressure entered into this 
calculation screen. There are a number of methods 
provided in the program. 

Viscosity If you have not purchased 
the Fluid Properties add-
on, the following function 
will not be available to you. 

This button is enabled only for gas with a defined 
composition, and liquid water or steam. 
Press the Viscosity button to calculate the 
viscosity of pure gases or gas mixtures based upon 
the static pressure and temperature provided on 
the calculation screen. 
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Name Availability Description 
Isentropic 
Exponent 

If you have not purchased 
the Fluid Properties add-
on, the following function 
will not be available to you. 

This button is enabled only for gas with a defined 
composition. 
Press Isentropic Exponent to select the Isentropic 
Exponent method to use. There are three 
calculation methods available: 

• Ideal Gas Heat Capacity Ratio 
• Real Gas with Redlich-Kwong Equation of 

State Correction 
• Real Gas with Lee-Kesler Equation of State 

Correction 
• AGA10 (natural gas only) 

Vapor Pressure/ 
Bubblepoint 

If you have not purchased 
the Fluid Properties add-
on, the following function 
will not be available to you. 

The Vapor Pressure / Bubblepoint button activates 
a function which calculates the vapor pressure of 
liquid at a static temperature. This function applies 
only to pure liquids or liquid mixtures. 
This calculation is not used in the calculation of 
flow rate, however, you can use the result to 
determine the difference between the bubble point 
of the liquid and your operating pressure. This 
value is required when performing liquid critical flow 
calculations. 
Fluid 
The Fluid button allows you to view the defined 
fluid. You can also change the composition of the 
defined fluid. It does not activate the full fluid 
definition function. To make changes other than 
adjustments to the composition, you will have to 
return and use the fluid setting screen. 
Calculate 
The Calc. button is used to perform the final 
calculation once all of the required fields have been 
filled in. The program will indicate if there are any 
fields which do not include data. 

  

Previous and Next Buttons 
The Previous button opens up the Meter run dialog 
box. You can change the meter run information 
without having to start the tag definition from the 
beginning.  
The Next button activates the Graph window. It 
displays a graph of differential pressure and 
permanent pressure loss versus flow rate. You can 
set the Normal Flow Rate on the graph screen. The 
next button is disabled for critical flow. 
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Name Availability Description 
Wet Gas Calculation 
When using wet gas, you need to remember that is 
essentially a gas calculation with a correction factor 
for a small amount of liquid. No standards 
organization (such as AGA or ISO) provides 
methods for dealing with wet gas. Flowel modifies 
the ISO 5167 method by applying a correction 
factor developed by Murdoch.  See Appendix C for 
more details. 
Internally, Flowel performs all calculations using 
mass flow. If you select flowing volumetric units 
(e.g., CFH), then Flowel calculates: 

Q Qm v= ⋅ ρ  
where 

ρ
ρ ρ

ρ ρ
=

⋅ + ⋅ −
g liq

liq gx x( )1
 

If you select Normal or Standard volumetric units 
(e.g. SCFH) then Flowel calculates mass flow = 
base volumetric flow x base density, where the 
base density is entered by you. 
Flowel uses a single, user-entered value for the 
base density because it is highly likely that a wet 
gas will be totally liquid at base conditions. 
If your calculated volumetric flow seem very high, 
please remember that a given mass of gas will 
occupy much more volume than the same mass of 
liquid. 

3.5 Calculation Data Sheet 
To activate the calculation data sheet function, type Alt-S-S-C, or under the 
Worksheet menu, select Spec Sheet, and click Calculation Data Sheet. 

This command produces a report showing the calculated data specification sheet. 
This form appears on the screen, with some of the fields already filled in by the 
program. You fill in the remaining fields. 
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Figure 3-3 Calculation Data Sheet 

 

3.5.1 Entering Data 

Data may be entered into this specification sheet. Use the Tab key to move between 
fields which allow user input. As you finish entering data into a field, press Tab to 
move to the next field.  

All of the colored fields indicate that they are editable. Some of these fields are drop 
down selection list boxes which will activate as you click on them. 

3.5.2 Zoom 

The zoom control will allow the spec. sheet page to be zoomed from 60 to 200% in 
size. To change the zoom in 1% increments, click on the arrows which appear on the 
horizontal scroll bar to the right of the zoom display. To change the zoom in 5% 
increments, click on the scroll bar, on either side of the scroll button in the direction 
you wish to zoom. Use the button on the scroll bar to click and drag the zoom factor. 

The scale you set for the specification sheet is saved for re-use, until you set it again. 
This allows scaling (normally 95%) for proper printing for European paper sizes. 



User Manual  3 User Reference 

 80  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

3.5.3 Print 

Print this sheet by clicking the Print button. A prompt will indicate printing status. You 
can change the printed sheet size by changing the zoom factor. The paper size is 
either A4 or letter, as selected under the Options menu and Print Paper Format. 

3.5.4 Save 

The data sheet can be saved to a PDF file. The paper size is either A4 or letter, as 
selected under the Options menu and Print Paper Format. 

3.5.5 Adding Your Logo to the Datasheet 

You may add your logo to the datasheets through a simple process. Do the following: 
1. Create a bitmap (.BMP) file containing your logo. This file should be a maximum 

of 1.5 inches wide and 1 inch tall. 
2. Name the file LOGO.BMP. 
3. Copy the file into the directory which contains the Flowel program. 

The logo will automatically be added to each of the datasheets. To remove the logo, 
either rename the logo filename, or move it from the Flowel directory. 

3.6 Color 
To activate the color function, type Alt-W-C, or under the Windows menu, click 
Color. 

The results field in the calculation window displays the final calculated value. This 
field is important since the result it produces is the reason for using the program. On 
some computers, notably LCD and other "gray" screens, this result may be difficult to 
read using the default colors. Use this function to select a color which allows the 
result to be clearly viewed. 

Note: All other colors in the program use the Windows colors. Use the Colors 
function in the Windows Control Panel to make changes. 
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Figure 3-4 Color Selection Dialog Box 

 

Using the scroll bars for each of the color components (red, green, and blue), adjust 
each component color until you can clearly distinguish the text from the background. 
The text line, "Set Color for Calculated Field:" is an example of the current color 
selection. 

3.6.1 Setting RGB Colors 

Setting colors using a red, green, and blue (RGB) color model can be difficult if not 
understood. Each of the colors components is defined by a number from 0 to 255. 
Zero means that none of that color component is included in the overall color; 255 is 
the maximum a color component can be assigned. 

Some values used in making standard colors are listed in Table 3-3. 

Table 3-3 Setting RGB Colors 

Color R G B 
Black 0 0 0 

White 255 255 255 

Red 255 0 0 

Green 0 255 0 

Blue 0 0 255 

Yellow 255 255 0 

Magenta 255 0 255 

Cyan 0 255 255 
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3.7 Default Base Conditions 
To activate the default base condition function, type Alt-O-B, or under the Options 
menu, click Default Base Conditions. 

The Base Condition function allows you to set the base conditions which will apply to 
the system being designed. 

Figure 3-5 Default Base Condition Setting Dialog Box 

 

The default base condition options are listed in Table 3-4. 

Table 3-4 Default Base Condition Options 

Name Description 
Standard – US This option sets the base conditions for the program to 14.65 psia at 60°F. 

Standard – Metric This option sets the base conditions for the program to 101.325 kPa at 15°C. 

Normal – US This option sets the base conditions for the program to 14.73 psia at 32°F. 

Normal – Metric This option sets the base conditions for the program to 101.325 kPa at 0°C. 

Other This option allows you to define values and units to be used throughout the 
program. 
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3.8 Default Element 
To activate the Default Element function, type Alt-O-F, or under the Options menu, 
click Default Element. 

The Default Element function is used to set the default flow element for new tags. 

Figure 3-6 Default Flow Element Setting Dialog Box 

 

The options available are the same as the settings on the Meter Run screen. All new 
tags created will use this default setting, but this setting can be altered at any point. 

3.9 Default Units 
To activate the Default Units function, type Alt-O-U, or under the Options menu, 
click Default Units. 

Use the Default Units option to set the program defaults for your preferred units. This 
function sets defaults for the whole program. You may change the units associated 
with a tag, and have those new units saved with the tag.  

Any new tags created will use the defaults, but each tag may be altered at any point. 
This setting will not alter the units you set for the existing tag. Your preferred default 
units will be saved for future use. 
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Figure 3-7 Default Units Dialog Box 

 

The following table shows the options available under each category. 
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Table 3-5 Category Options 

Density Temperature Base Pressure Viscosity Flow Rate 
g/cm3 
kg/dm3 
kg/m3 
lb/ft3 

Deg C 
Deg F 
Deg K 
Deg R 

Atm 
Bar 
in- H2O 
kg/cm2 
kPa 
mm- H2O 
MPa 
psia 

cP 
gm/cm-sec 
gmf-sec/cm2 
kg/m-hr 
lb/ft-hr 
lb/ft-sec 
lb/in-sec 
lbf-sec/m2 
mPa.S 
N-sec/m2 
P 

Static 
Pressure 

Differential 
Pressure 

Length Composition 

Atm 
atm-g 
Bar 
Bar-g 
in-H2O 
in-H2O-g 
kg/cm2 
kg/cm2-g 
kPa 
kPa-g 
mm-H2O 
mm-H2O-g 
MPa 
MPa-g 
psia 
psig 

Atm 
Bar 
in- H2O 
kg/cm2 
kPa 
mm- H2O 
MPa 
psia 

Cm 
ft 
in 
m 
micron 
mm 
yd 

Mole Fraction 
Mole Percentage 

CFD 
CFH 
CFS 
E3M3/day 
E3M3/hr 
E6M3/day  
E6M3/hr 
hL/day 
hL/hr 
IMPBPD 
IMPBPH 
IMPGPD 
IMPGPH 
IMPGPM 
IMPGPS 
kg/day 
kg/hr 
kg/min 
kg/sec 
L/day 
L/hr 
L/min 
L/sec 
lb/day 
lb/hr 
lb/min 
lb/sec 
m3/day 
m3/hr 
m3/min 
m3/sec 

NCFD 
NCFH 
NCFM 
NCFS 
Nm3/day 
Nm3/hr 
Nm3/min 
Nm3/sec 
SCFD 
SCFH 
SCFM 
SCFS 
Sm3/day 
Sm3/hr 
Sm3/min 
Sm3/sec 
ton/day 
ton/hr 
ton/min 
ton/sec 
tonne/day 
tonne/hr 
tonne/min 
tonne/sec 
USBPD 
USBPH 
USGPD 
USGPH 
USGPM 
USGPS 

Once the default settings have been selected, click OK to save the settings and 
return to the main program. 

The default unit determines the type of unit (base/normal/standard volumetric, actual 
volumetric, or mass).   

3.10 Density Calculator 
The Density Calculator will calculate the density of a fluid based upon the 
temperature and pressure entered in the flow calculation screen, and in the case of 
base conditions, those that can be entered in the density calculator. 

3.10.1 Method 

The method used to calculate density must be selected from the list provided in the 
dialog box. The methods available depend on fluid state, composition, and whether 
you have the optional fluid property calculator package with your program. 
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Some of these methods will require additional information. A prompt will 
automatically appear when you click on the Calculate button. Enter the required 
values, then click OK to return to the Density Calculator dialog box. 

Once a method has been selected, click on the Calculate button to obtain the result. 
Once the OK button has been clicked, the program will return to the flow calculation 
screen, with the calculated density value placed into the density field. 

The following sections list the calculation methods available within Flowel. 

3.10.2 Soave-Redlich-Kwong 

The Soave-Redlich-Kwong equation of state can be used for all pure component or 
fluid mixtures defined using the component lists. The fluid may be gas or liquid. If the 
fluid is in two phases, only the density for the specified fluid state will be displayed. 

The flowing temperature and pressure for this window are taken from the flow 
calculation screen, and are not editable fields. However, the base condition 
temperature and pressure, whether entered in the flow calculation screen or not, are 
editable. 

3.10.3 Peng-Robinson 

The Peng-Robinson equation of state can be used for all pure components or fluid 
mixtures defined using the component lists. The fluid may be gas or liquid. If the fluid 
is in two phases, only the density for the specified fluid state will be displayed. 

The flowing temperature and pressure for this window are taken from the flow 
calculation screen, and are not editable fields. However, the base condition 
temperature and pressure, whether entered in the flow calculation screen or not, are 
editable. 

3.10.4 Lee-Kesler BWR 

The Lee-Kesler BWR calculation method can be used for all pure components or 
fluid mixtures defined using the component lists. The fluid may be gas or liquid. If the 
fluid is in two phases, only the density for the specified fluid state will be displayed. 

The flowing temperature and pressure for this window are taken from the flow 
calculation screen, and are not editable fields. However, the base condition 
temperature and pressure, whether entered in the flow calculation screen or not, are 
editable. 
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3.10.5 Thompson-Brobst-Hankinson 

This method is also known as the COSTALD method. It was initially developed to 
correlate the density of liquid hydrocarbons. It can be used for all pure components 
or supported fluid mixtures for gas or liquid. It is not accurate for high asymmetric 
fluids at high pressure. 

The flowing temperature and pressure for this window are taken from the flow 
calculation screen, and are not editable fields. However, the base condition 
temperature and pressure, whether entered in the flow calculation screen or not, are 
editable. 

3.10.6 Modified Rackett 

The Modified Rackett equation should only be used for saturated liquids. 

The flowing temperature and pressure for this window are taken from the flow 
calculation screen, and are not editable fields. However, the base condition 
temperature and pressure, whether entered in the flow calculation screen or not, are 
editable. 

3.10.7 AGA 8 (1985), Detailed  

The AGA 8 (1985), detailed method can be used to calculate natural gas density by 
entering a detailed analysis of the composition. This method is not recommended for 
sour natural gas (see the next section).  

Whenever possible, the AGA 8 (92) detailed method should be applied, since this 
method includes the most recent compressibility factor data, and an improved 
correlation methodology (AGA Report 8, p.1, 1992). 

The flowing temperature and pressure for this window are taken from the flow 
calculation screen, and are not editable fields. However, the base condition 
temperature and pressure, whether entered in the flow calculation screen or not, are 
editable. 

3.10.8 AGA 8 (1992), Detailed 

The AGA 8 (1992), detailed method can be used to calculate natural gas density by 
entering a detailed analysis of the composition. It can be used for sweet as well as 
sour natural gas. 

Whenever possible, the AGA 8 (92) detailed method should be applied, since this 
method includes the most recent compressibility factor data, and an improved 
correlation methodology (AGA Report 8, p.1, 1992). 
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The flowing temperature and pressure for this window are taken from the flow 
calculation screen, and are not editable fields. However, the base condition 
temperature and pressure, whether entered in the flow calculation screen or not, are 
editable. 

3.10.9 Redlich-Kwong (Wichert-Aziz) 

This method was developed for sour natural gas. It uses the Redlich-Kwong equation 
of state, with a corrected critical temperatures and pressures. If no H2S or CO2 is 
present, this method becomes the same as the Redlich-Kwong equation of state. 

The flowing temperature and pressure for this window are taken from the flow 
calculation screen, and are not editable fields. However, the base condition 
temperature and pressure, whether entered in the flow calculation screen or not, are 
editable. 

3.10.10 NX-19, Detailed 

NX-19 detailed method can be used to calculate natural gas density by entering a 
detailed analysis of the composition. When possible, the AGA 8 (1992) detailed 
method should be used, since this method provides more accurate computation of 
compressibility factor over a larger range of temperature, pressure and compositions 
(AGA Report 8, p.1, 1992). 

The flowing temperature and pressure for this window are taken from the flow 
calculation screen, and are not editable fields. However, the base condition 
temperature and pressure, whether entered in the flow calculation screen or not, are 
editable. 

3.10.11 NBS/NRC Steam Equation 

This method was developed by the US National Bureau of Standards and the 
national Research Council of Canada. NBS/NRC Steam equation of state is 
available in Flowel for calculating steam and water density. It can be used for both 
superheated steam and compressed water. 

Flowel will automatically detect the phase condition according to the temperature and 
pressure regardless of the specified fluid state. 

The flowing temperature and pressure for this window are taken from the flow 
calculation screen, and are not editable fields. However, the base condition 
temperature and pressure, whether entered in the flow calculation screen or not, are 
editable. 

The H2O density calculator with NBS equation operates as follows. 
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3.10.11.1 Flowing Density 

To calculate a flowing density you are presented with three options: 
1. H2O saturated, use Temperature 
2. H2O saturated, use Pressure 
3. H2O not saturated, use Both Temp. and Press 

If “H2O saturated, use Temperature” is selected, a saturated density at flowing 
temperature in the selected state (gas or liquid) is calculated. This state is selected in 
the Fluid Setting dialog box. The flowing pressure is changed to the pressure 
corresponding to the saturated temperature. 

If “H2O saturated, use Pressure” is selected, a saturated density at flowing pressure 
in the selected state (gas or liquid) is calculated. This state is selected in the Fluid 
Setting dialog box. The flowing temperature is changed to the temperature 
corresponding to the saturated pressure. 

If “H2O not saturated, use Both Temp. and Press.” is selected, a density at flowing 
temperature and flowing pressure is calculated. The density calculated may be either 
for a gas or a liquid depending on the temperature and pressure and may not 
correspond to the state selected in the Fluid Setting dialog box. Whether the 
calculated density is gas or liquid is determined by calculating the vapor pressure at 
the flowing temperature. If the flowing pressure is greater than the calculated vapor 
pressure, a liquid density is calculated. If the flowing pressure is less than the 
calculated vapor pressure then a gas density is calculated. Neither the flowing 
temperature or pressure are changed. 

3.10.11.2 Base Density 

The base density is always calculated using both the base temperature and base 
pressure (no matter what method option is selected for flowing density). The density 
calculated may be either for a gas or a liquid depending on the temperature and 
pressure and may not correspond to the state selected on the fluid setting window. 
Whether the calculated density is gas or liquid is determined by calculating a vapour 
pressure at the base temperature. If the base pressure is greater than the calculated 
vapour pressure, a liquid density is calculated. If the base pressure is less than the 
calculated vapour pressure, a gas density is calculated. Neither the base 
temperature or pressure are changed. 

3.10.12 NBS Ammonia, NBS Nitrogen, NBS Argon, NBS Oxygen, 
IUPAC Carbon Dioxide, NBS Hydrogen, NBS Methane, NBS 
Ethane, NBS Ethylene, NBS Propane, NBS i-Butane, NBS n-
Butane 

Methods are available for each of these pure fluids. They are appropriate to both gas 
and liquid phases. Flowel will automatically detect the phase condition according to 
the temperature and pressure regardless of the specified fluid state. 
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The flowing temperature and pressure for this window are taken from the flow 
calculation screen, and are not editable fields. However, the base condition 
temperature and pressure, whether entered in the flow calculation screen or not, are 
editable. 

3.10.13 AGA 8 (1985), SG, CO2, N2 

This is an alternative gross characterization method for a fluid state of gas, and 
“Natural gas - AGA 8 (85) component list” or “None of the above” fluid types. This 
method requires specific gravity plus the mole fraction of CO2 and N2 for a natural 
gas. 

Enter the values for the components on the left-hand-side of the window. Set the 
temperature and pressure as necessary. 

Note: The entered specific gravity will be reset to null after any changes to the 
density occur. It will maintain the entered Specific Gravity until the density is 
changed, either by direct editing or re-calculation. 

3.10.14 AGA 8 (1985), SG, HV, CO2 

This is a gross characterization method for a fluid state of gas, and “Natural gas - 
AGA 8 (85) component list” or “None of the above” fluid types. This method requires 
the heating value, specific gravity, and mole fraction of CO2 for a natural gas. 

Enter the values for the components on the left-hand-side of the window. Set the 
temperature and pressure as required. 

You can set different base temperature and pressure values and units for the heating 
value and specific gravity. 

Note: The entered specific gravity will be reset to null after any changes to the 
density occur.  It will maintain the entered Specific Gravity until the density is 
changed, either by direct editing or re-calculation. 

3.10.15 AGA 8 (1985), HV, CO2, N2 

This is a gross characterization method for a fluid state of gas, and “Natural gas - 
AGA 8 (85) component list” or “None of the above” fluid types. This method requires 
the heating value and mole fractions of CO2 and N2 for a natural gas. 

Enter the values for the components on the left-hand-side of the window. Set the 
temperature and pressure as required. 

3.10.16 AGA 8 (1985), SG, CH4, CO2, N2 

This is a gross characterization method for a fluid state of gas, and “Natural gas - 
AGA 8 (85) component list” or “None of the above” fluid types. This method requires 
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the specific gravity and mole fractions of Methane, CO2 and N2 are known for a 
natural gas. 

Enter the values for the components on the left-hand-side of the window. Set the 
temperature and pressure as required. 

Note: The entered specific gravity will be reset to null after any changes to the 
density occur.  It will maintain the entered Specific Gravity until the density is 
changed, either by direct editing or re-calculation. 

3.10.17 AGA 8 (1992), SG, HV, CO2 

This is a gross characterization method for a fluid state of gas, and “Natural gas - 
AGA 8 (85) component list”, “Natural gas - AGA 8 (92) component list”, or “None of 
the above” fluid types. This method requires the heating value and mole fractions of 
CO2 for a natural gas. Enter the values for the components on the left-hand-side of 
the window. Set the temperature and pressure as required. 

You can set different base temperature and pressure values and units for the heating 
value and specific gravity. 

Note: The entered specific gravity will be reset to null after any changes to the 
density occur.  It will maintain the entered Specific Gravity until the density is 
changed, either by direct editing or re-calculation. 

3.10.18 AGA 8 (1992), SG, CO2, N2 

This is a gross characterization method for a fluid state of gas, and “Natural gas - 
AGA 8 (85) component list”, “Natural gas - AGA 8 (92) component list”, or “None of 
the above” fluid types. This method requires the specific and mole fractions of CO2 
and N2 for a natural gas. 

Enter the values for the components on the left-hand-side of the window. Set the 
temperature and pressure as required. 

Note: The entered specific gravity will be reset to null after any changes to the 
density occur.  It will maintain the entered Specific Gravity until the density is 
changed, either by direct editing or re-calculation. 

3.10.19 Ideal Gas Method, SGi, Zf 

The Ideal Gas method is to be used to calculate density when the ideal specific 
gravity and compressibility factors (flowing and base) for a gas are known. 

Ideal Specific Gravity
Molecular weight of fluid

=
28 96247.

 

Enter the ideal specific gravity and compressibility into the popup dialog box. 
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3.10.20 Real Gas Method, SGr, Zair 

The Real Specific Gravity method can be used to calculate density when the real 
specific gravity and the compressibility factor (flowing and base) of air are known. 

Real specific gravity
Molecular weight of fluid air compressibility factor at flowing conditions

fluid compressibility factor at flowing conditions
= ×

28 96247.
 

Enter the real specific gravity and compressibility into the popup dialog box. Flowel 
will fill in values for the compressibility of air. 

3.10.21 Molecular Weight Method, MW, Zf 

The Molecular Weight method can be used to calculate density when the molecular 
weight and compressibility (flowing and base) of a fluid are known. 

Enter the molecular weight and compressibility into the popup dialog box. 

3.10.22 Liquid Method, SG, Density H2O 

For liquids, the density can be calculated when the specific gravity is known. Enter 
the specific gravity and density of water at standard conditions into the popup dialog 
box. 

The reference condition used for measuring specific gravity varies. A list of the most 
commonly used reference conditions is provided for convenience. You may select 
“Other”, and enter other values for the density of water. 

3.11 Exact Bore Size 
This function calculates an exact bore diameter based on maximum flow, maximum 
differential pressure, and other user-entered information. 
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Figure 3-8 Flow Calculation Window Solving for Exact Bore Size 

 

The methods available for use to solve for exact bore size are: 
• AGA 3-1985 
• AGA 3-1990 
• ASME MFC-3M 
• ASME MFC-7M 1987 
• ASME MFC-14M-2003 (for small bore orifice only) 
• ISO 5167-1980 
• ISO 5167-1991 
• ISO 5167-2003 

The methods that are available for selection depend on fluid state, fluid type, element 
type and differential pressure tap location.  
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For this screen, the minimum data required to calculate the exact bore are: 
• flow rate – flowing conditions, or base conditions if a standard or normal 

volumetric flow rate unit was selected 
• differential pressure 
• static pressure – flowing conditions 
• temperature – flowing conditions 
• density – flowing conditions 
• viscosity 
• isentropic exponent (this field will not appear if the fluid is in liquid state) 

3.12 Exact Differential Pressure 
This function calculates the exact differential pressure based on the flow rate, 
element bore, and other user-entered information. 

The methods available for use to solve for exact differential pressure are: 
• AGA 3 – 1985 
• AGA 3 – 1990 
• ASME MFC-3M 
• ISO 5167-1980 
• ISO 5167-1991 
• ISO 5167-2003 

The methods that are available for selection depend on fluid state, fluid type, element 
type, and differential pressure tap location. For this screen, the minimum data 
required to calculate the exact differential pressure are: 

• beta ratio 
• flow rate – flow conditions 
• static pressure – flow conditions 
• temperature – flow conditions 
• density – flow conditions 
• viscosity 
• isentropic exponent (this field will not appear if the fluid is in liquid state) 

Upon entry of the values for these fields, press the Calc. button to perform the 
calculation. 

3.13 Exact Flow Rate 
Exact Flow Rate causes the program to solve for the flow rate based on the element 
bore, differential pressure, and other user-entered information. 
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The methods available for use to solve for exact flow rate are: 
• AGA 3 – 1985 
• AGA 3 – 1990 
• ASME MFC-3M 
• ASME MFC-7M 1987 
• ISO 5167-1980 
• ISO 5167-1991  
• ISO 5167-2003 

The methods that are available for selection depend on fluid state, fluid type, element 
type and differential pressure tap location. For this screen, the minimum data fields 
required for calculation are: 

• beta ratio 
• differential pressure 
• static pressure – flow condition 
• temperature – flow condition 
• density – flow condition 
• viscosity 
• isentropic exponent (this field will not appear if the fluid is in liquid state) 

Upon entry of the values for these fields, click the Calc. button to perform the 
calculation. 

3.14 Exit 
To activate the Exit function, type Alt-F-X, or under the File menu, click Exit. 

Use the Exit command to exit the FLOWEL 4.0 program. You will be prompted to 
confirm this choice. Press the Enter key or click OK to confirm. 

Note: The program will not prompt you to save any changes because any changes 
are saved as each command or function is activated. 

3.15 Export Fluid 
To activate the Export Fluid function, type Alt-U-E, or from the User Data menu, click 
Export Fluid. 

Description 

This command allows Flowel to export existing fluids mixtures to .CSV (comma 
separated value) file format for use outside the Flowel program. 
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A mixture name can include any characters except commas. Each name can be up 
to 49 characters long. Valid fluid type names:  

• All 
• Common Fluids 
• General Mixture 
• Natural Gas, AGA 8 (85) Component List 
• Natural Gas, AGA 8 (92) Component List 
• Natural Gas, NX-19 Component List 
• None of the Above (user-defined) 

Unit must be either ‘Mole Fraction’ or ‘Mole Percent’. 

The component name will be a valid fluid name from the list. Select a Fluid Type. A 
list of available fluids will appear. Select the fluid you wish to export, then click OK. 
The standard Windows file selection dialog will appear. Enter the new fluid name, 
then click OK. The program will perform the export. 

3.16 Export Job 
To activate the Export Job function, type Alt-F-J, or under the File menu, click 
Export Job. 

Description 

 This command allows exporting of job information only (no tag information is 
included when exporting Jobs). 

There are two cases when this function is important. First, there may be situations in 
the future when the Flowel database will be altered. Rather than force each user to 
re-enter each of the jobs created, this function will allow the data to be exported into 
a form that can be read by a future version. 

Second, this function allows job information to be stored into another form for backup 
purposes. Using all of the export functions (Job, Tags, and Fluids) you can archive 
this information. 

On the File Menu, select Export Job. You will be prompted to select or enter a 
filename for the export file. The program will automatically add the filename 
extension. Click OK to complete the process. The dialog box will disappear from the 
screen as the export process begins.  

3.17 Export Tag 
To activate the Export Tag function, type Alt-F-E, or under the File menu, click 
Export Tag. 
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Description 

This command allows for the exporting of tags for use elsewhere. This function 
exports tags associated with the currently open job to a comma separated value 
(*.CSV) file format. This format is commonly used by both spreadsheet and database 
programs. 

First, select the tags that are to be exported. Your options include selecting all tags, 
one tag or some tags.  

To select all of the tags, click on the Select All option in the Export Tag dialog box. If 
you click on this option again, you will deselect all of the selected tags.  

To select a single tag, scroll the list until it is visible, then click on the tag name to 
highlight it. Once highlighted, a tag is selected. 

To select tags that do not appear contiguously in the list, click on the first tag, then 
use the mouse to click on the next tag to be selected. If tags you want are down the 
list beyond view, click on the scroll buttons on the list to bring the tags you want into 
view. 

When you have made all of your selections, click OK. Once you have selected the 
tags that are to be exported, you must select a filename and location for that file. A 
standard Windows file selection dialog box will appear. 

Enter an appropriate name in the File Name field, using the standard DOS eight-
character naming convention. It is not necessary to add the three-character filename 
suffix, the program will add it for you. 

Select the drive and directory onto which the file is to be saved.  

When these steps are complete, click OK. Flowel will display a confirmation 
message indicating that the export is being performed. If an existing filename has 
been selected, a warning message will ask you to confirm an overwrite of the 
existing file. 

3.18 File Menu 
To activate the file menu, type Alt-F. 

Description 

This menu contains the commands needed to open and create new jobs and tags, 
import and export, and print. 

All of the menu items in Flowel are listed by name (alphabetically) in the reference 
section. Please look to the specific function name for information on that function. 
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3.19 Flowel Data Sheet 
Description 

This function aids in the production of a Flowel Data Sheet report. The Flowel form 
appears on screen, with as much information as possible filled in automatically by 
the program using already-entered data. You can fill in the remaining fields. 

Figure 3-9 Flowel Data Sheet Window 

 

3.19.1 Entering Data 

Data may be entered into this specification sheet. Use the Tab key to move between 
fields which allow user input. As you finish entering data into a field, press Tab to 
move to the next field.  

All of the colored fields indicate that they are editable. Some of these fields are drop 
down selection list boxes which will activate as you click on them. 
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3.19.2 Zoom 

The zoom control will allow the spec. sheet page to be zoomed from 60 to 200% in 
size. To change the zoom in 1% increments, click on the arrows which appear on the 
horizontal scroll bar to the right of the zoom display. To change the zoom in 5% 
increments, click on the scroll bar, on either side of the scroll button in the direction 
you wish to zoom. Use the button on the scroll bar to click and drag the zoom factor. 

The scale you set for the specification sheet is saved for re-use, until you set it again. 
This allows scaling (normally 95%) for proper printing for European paper sizes. 

3.19.3 Print 

Print this sheet by clicking the Print button. A prompt will indicate printing status. You 
can change the printed sheet size by changing the zoom factor. The paper size is 
either A4 or letter, as selected under the Options menu and Print Paper Format. 

3.19.4 Save 

The data sheet can be saved to a portable document format (PDF) file. The paper 
size is either A4 or letter, as selected under the Options menu and Print Paper 
Format. PDF files can be printed on all Adobe Reader supported paper sizes. 

3.19.5 Adding Your Logo to the Datasheet 

You may add your logo to the datasheets through a simple process. 
1. Create a bitmap (.BMP) file containing your logo. This file should be a maximum 

of 1.5 inches wide and 1 inch tall. 
2. Name the file LOGO.BMP. 
3. Copy the file into the directory which contains the Flowel program. 

The logo will automatically be added to each of the datasheets. To remove the logo, 
either rename the logo to another filename, or move it from the Flowel directory. 

3.20 Fluid 
To activate the fluid function, type Alt-S-F, or under the Worksheet menu, click 
Fluid. 

Description 

The Fluid Setting dialog is the first window to use after the creation of a tag name. 
This function allows you to define the fluid state and fluid type associated with this 
tag. 
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3.20.1 Fluid State 

Select the state from the dropdown list provided. Your choices are: 
• Gas 
• Gas, Critical Flow 
• Liquid 
• Liquid, Critical Flow 
• Wet Gas 

These selections affect how the program solves for each of the variables, as each of 
these states are solved for using different methods and formulas. You must make a 
fluid state selection. Critical Flow is the maximum.  

3.21 Fluid Type 
Next, select the fluid type from the provided list. The following options are available: 

• All 
• Common Fluids 
• General Mixture 
• Natural Gas, AGA 8 (85) Component List 
• Natural Gas, AGA 8 (92) Component List 
• Natural Gas, NX-19 Component List 
• None of the above (you may type in a fluid name) 

3.21.1.1 All 

The All option allows you to select from all of the fluids available including Flowel's 
built-in database of pure components and any defined mixtures. Once you have 
selected All, you can select from the dropdown list. If you know the component's 
name, you can type in the first character into the name field. As you type, the 
program automatically searches for a match. For a pure component selection, you do 
not have to define the fluid further. 

3.21.1.2 Common Fluids 

The Common Fluids option allows you to select a pure component from Flowel's 
built-in database. Once you have selected Common Fluids, you can select a pure 
component from the dropdown list. If you know the component's proper name, you 
can type in the first character into the name field. As you type, the program 
automatically searches for a match. For a pure component selection, you do not 
have to define the fluid further. 
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3.21.1.3 General Mixture 

The General Mixture option provides the means to defining your own custom fluid 
mixture. To use this option, select General Mixture from the fluid types, then click the 
Define Mixture button. The Mixture Definition dialog box will appear. 

Flowel is not necessarily able to determine if the phase is correct, or if there is any 
chemical reaction from mixing these fluids.  It is up to the user to ensure that the 
fluids can be mixed, and to know the phase of the resulting fluid. 

Figure 3-10 General Mixture Definition Dialog Box 

 

Enter a new mixture name. Select either Mole Fraction or Mole Percent, depending 
on your preference. Then use the buttons to add components to your mixture. As 
each component is added, enter either the mole value or fraction for that component. 
When you have completed adding components, click OK. For more information on 
defining mixtures, see Mixture Definition, Section 3.35. 

3.21.1.4 Natural Gas 

For any of the Natural Gas fluid types, you must define the mixture. The program 
automatically provides a short list of components for the Natural Gas fluid type 
selected. You select the desired components from this list and enter the mole values 
accordingly. 
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3.21.1.5 None of the Above 

This option allows a fluid name to be entered into the Fluid field, but no mixture 
definition is possible. Unlike the other options whereby defining the fluid sets up the 
program to automatically draw information about a fluid from the built-in database, 
this option requires that you enter this information on the Calculate screen. 

3.21.2 Define Mixture 

The Define Mixture function is used in conjunction with the fluid types other than All 
(pure substances) or Unknown Fluid. See the reference topic Mixture Definition for a 
more detailed explanation on mixtures. 

Once you have completed defining the fluid for this tag, click OK. 

3.22 Fluid Maintenance 
To activate the Fluid Maintenance function, type Alt-U-F, or under the User Data 
menu, click Fluid Maintenance. 

Description 

The Fluid Maintenance function permits some "housekeeping" to be done on the 
fluids defined in Flowel. Using this function you can copy a fluid to another name, 
delete an unused fluid, edit the mole values for the components of a fluid, and print 
the fluid composition. 

The copy function is particularly useful when you already have a fluid defined which 
is close to your desired fluid. It allows you to copy the existing fluid and make 
changes to the mole values in the copy. 

3.22.1 Copying a Fluid 

On the Fluid Maintenance dialog box select the original fluid from the list. Click the 
Copy button. The copy window will appear. 

The name of the original fluid will appear in the Copy From box. Type in the name of 
the new fluid in the To field. When the name is complete, click OK. 

3.22.2 Deleting a Fluid 

On the Fluid Maintenance dialog box, select the fluid to be deleted from the list. Click 
the Delete button. 

The program will ask you for confirmation. Click Yes to complete the deletion. 
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3.22.3 Printing a Fluid 

Click the Print button to print out a listing of the composition for the selected fluid. 

3.23 Fluid Report 
To activate the Fluid Report function, type Alt-S-S-F, or under the Worksheet menu, 
select Spec Sheet, and click Fluid Report. You can also select the function from 
printing dialog boxes. 

Description 

The Fluid Report is a datasheet detailing the fluid mixture which is attached to a tag. 
All of the components are listed with their formulas, and the mole percentage or mole 
fraction within the fluid. 

Notes: 
1. When this option is selected, the fluid report will print only if a fluid mixture is 

attached to the tag. If multiple tag printing has been selected, only those tags 
with a fluid mixture attached will have a fluid report printed for them. 

2. Job and tag related information can be edited on the Calculate Data, ISA S-2, or 
Emerson datasheets. 

3.24 Graph 
To activate the Graph function, type Alt-S-G, or under the Worksheet menu, click 
Graph. 

Description 

This displays a graph of the relationship between flow rate and both differential 
pressure and permanent pressure loss. To use this function, a flow calculation must 
have been performed for the tag. 
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Figure 3-11 Graph Window 

 

This option displays a graph of the function in a scaleable window. The graph can be 
printed using the Print button.  

You must set the scale on one of the specification sheets. The scale you set for the 
graph is saved for re-use, until you set it again. This allows scaling (normally 95%) 
for proper printing for European paper sizes. 

You may adjust the percentage of normal flow by either entering a value in the entry 
field or by clicking on the up and down arrows. If you enter the Flow Rate you must 
click the mouse on Normal Flow to get the calculated percentage. 

Flow rate, differential pressure, permanent pressure loss, and Reynolds number 
values are displayed. The flow rate value may be edited. The Reynolds number is 
automatically checked against the upper and lower limits. A message box will pop up 
if it is out of range. 

When you have finished viewing or printing the currently displayed graph, press OK 
to return to the program. 

Note: The graph is not available for critical flow. 
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3.25 Help Menu 
To activate the Help Menu function, type Alt-H. 

Description 

Use this menu to find help about the operation of the software, and the use of the 
help system itself. The About option provides information about the program. 

All of the menu items in Flowel are listed by name (alphabetically) in the reference 
section. Please look to the specific function name for information on that function. 

3.25.1 Help Content 

To activate the Help Content, type Shift+C or under the Help menu, click Help 
Content. 

Description 

Flowel help is a comprehensive on-line help system based on the reference section 
of the printed user manual. 

Any underlined topic names are called “jumps”. They link the underlined words to 
information. To get help on a particular topic, click on the topic's “jump”. The help 
program will automatically bring up the help pages associated with that topic name. 

3.25.2 Help Index 

To activate the Help Index, type Shift+I, or under the Help menu, click Help Index. 

Description 

This option provides a general index into the help topics available in Flowel. Once 
Help Index has been selected, the Help Index window will appear. 

3.25.3 How to Use Help 

To activate the How to Use Help function, type Alt-H-U, under the Help, click How to 
Use Help. 

Description 

This is an explanation of WindowsTM style of help systems. This help information is 
the same as that provided with Windows. For complete instruction on the use of help 
within Windows, and the use of Windows itself, use the help tutorial provided with 
your Windows software package. 
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3.26 Import Fluid 
To activate the Import Fluid function, type Alt-O-I, or under the User Data menu, 
click Import Fluid. 

Description 

This command allows Flowel to import fluid compositions from a file created outside 
of the Flowel program. 

A mixture name can include any characters except commas. Each name can be up 
to 49 characters long. Valid fluid type names: "Natural Gas - AGA 8 (85) Component 
List"; "Natural Gas Liquid". 

Unit must be either ‘Mole Fraction’ or ‘Mole Percent’. 

The component name must be a valid fluid name from the fluid component list. To 
check a component, use Flowel's fluid definition function, select All from the fluid 
type, and scroll through the list to confirm the exact spelling for the composition. 

3.27 Import Job 
To activate the Import Job function, type Alt-F-M, or under the File menu, click 
Import Job. 

Description 

This command allows Flowel to import jobs which were archived using the Export job 
function. The program prompts with a standard Windows file open dialog. Select the 
file which was created using the Export Job function. 

3.28 Import Tag 
To activate the Import Tag function, type Alt-F-I, or under the File menu, click Import 
Tag. 

Description 

This command allows Flowel to import tags from files of your own creation. Flowel 
can import files stored in a .CSV (comma separated value) file format. Most 
database and spreadsheet programs, as well as many other software applications, 
can save information in this format.  

The program imports the tag information into the currently open job.  

Once the proper job is open, select the Import option. You will be prompted to select 
the desired file. Flowel uses the standard Windows file selection dialog box.  
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After locating the drive/directory containing your file, select the file and click OK. The 
program will begin to import the file. 

3.29 ISA S-20 Data Sheet 
To activate the ISA S-20 Data Sheet, type Alt-S-S-I, or under the Worksheet menu, 
select Spec Sheet, and click ISA S-20 Data Sheet. 

Description 

This function produces an ISA S-20 Data Sheet report. The ISA S-20 form appears 
on screen, with as much information as possible filled in automatically by the 
program using already-entered data. You can fill in the remaining fields. 

Figure 3-12 ISA S-20 Data Sheet Window 

 

3.29.1 Entering Data 

Data may be entered into this specification sheet. Use the Tab key to move between 
fields which allow user input. As you finish entering data into a field, press Tab to 
move to the next field.  

In multi-line fields, such as the note field, use the Control-Enter keystroke 
combination to begin a new line. The program does not automatically wrap the text 
onto the next line, and pressing Enter does not go to the next line. 
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Some of the user-definable fields are actually selection lists, rather than entry fields. 
Click on the field. If a listbox appears, make your selection from the list. To set the 
Normal Flowrate use the Flow Curve graph. 

The Meter section of the sheet includes a field for the chart/scale value, and an 
associated selection list for Roots or Linear. Once these values are entered, the 
Chart Mult. field is calculated automatically. 

Figure 3-13 Chart/Scale Value 

 

3.29.2 Zoom 

The zoom control will allow the spec. sheet page to be zoomed from 60 to 200% in 
size. To change the zoom in 1% increments, click on the arrows which appear on the 
horizontal scroll bar to the right of the zoom display. To change the zoom in 5% 
increments, click on the scroll bar, on either side of the scroll button in the direction 
you wish to zoom. You may use the button on the scroll bar to click and drag the 
zoom factor.  

The scale you set for the specification sheet is saved for re-use, until you set it again. 
This allows scaling (normally 95%) for proper printing for European paper sizes. 

3.29.3 Print 

Print this sheet by clicking the Print button. A prompt will indicate printing status. You 
can change the printed sheet size by changing the zoom factor. The paper size is 
either A4 or letter, as selected under the Options menu and Print Paper Format. 

3.29.4 Save 

The data sheet can be saved to a PDF file. The paper size is either A4 or letter, as 
selected under the Options menu and Print Paper Format. 

3.29.5 Adding Your Logo to the Datasheet 

You may add your logo to the datasheets through a simple process. Do the following: 
1. Create a bitmap (.BMP) file containing your logo. This file should be a maximum 

of 1.5 inches wide and 1 inch tall. 
2. Name the file LOGO.BMP. 
3. Copy the file into the directory which contains the Flowel program. 
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The logo will automatically be added to each of the datasheets. To remove the logo, 
either rename the logo filename, or move it from the Flowel directory. 

3.30 Isentropic Exponent 
To activate the Isentropic Exponent function, click the Isentropic Exponent button 
on the Calculate dialog box. 

Description 

The isentropic exponent for a fluid can be calculated automatically in Flowel's flow 
calculation area, based upon the fluid defined. An exception to this is when 
"Unknown Fluid" is selected as a fluid. In this case, you must calculate and enter the 
isentropic exponent manually. 

Note: Flowel provides three methods for calculating Isentropic Exponent. For help on 
these options, see the online help topic “Selecting an Isentropic Exponent Method.” 

Figure 3-14 Isentropic Exponent Calculation Method Selection 

 

Three methods of calculation are possible using the isentropic exponent function: 
• Ideal Gas Heat Capacity Ratio 
• Real Gas with Redlich-Kwong Equation of State Correction 
• Real Gas with Lee-Kesler Equation of State Correction  
• AGA-10 isentropic exponent calculation 

Click on one of these methods, then click OK to complete the calculation. The 
program will automatically place the results of this calculation in the Isentropic 
Exponent entry field on the Calculate dialog box. 

The AGA-10 isentropic exponent calculation is only available on natural gas with a 
full gas composition (AGA-8 1985 or AGA-8 1992). 
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3.31 Jobs Summary 
To activate the Jobs Summary function, type Alt-U-J, under the User Data menu, 
click Jobs Summary. 

Figure 3-15 Job Summary Report 

 

Description 

This function produces a report listing all of the jobs in the Flowel database, the 
associated job information, the number of tags, and the total number of times any of 
the tags with that job number have had calculations performed on them (number of 
Runs). Use the arrows on the page to scroll up and down or from right to left to view 
the information in the report. To print the report click on the Print button. This is 
particularly important for users who have purchased Flowel on a run-calculated 
basis, and users who wish to charge the use of Flowel to their end customers.  

For users who have limited run versions of the program, and wish to reorder or 
extend their Flowel license, please see the reference topic “Options Ordering” for 
more information. 



3 User Reference  User Manual 

 111  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

Related topics include: 
• Option Ordering 

3.32 Main Menu 
The main menu is Flowel's main program menu. Use this menu, in combination with 
the toolbar, to make the most efficient use of the program and its functions. 

Figure 3-16 Main Menu 

 

The main menu options include: 
• File – the main create, open, import/export and print menu 
• Worksheet – where the calculations are performed 
• Options – allows user to set up the site-specific information 
• User Data – allows users to set up the user-specific information. 
• Windows – allows users set some of the Windows options 
• Help – allows users access to all levels of on-line help information 

The following menu diagram shows the main menu options and the commands 
which are available under each option. Please consult each. 

Figure 3-17 Menu Diagram 

 

3.33 Material Maintenance 
To activate the Material Maintenance function, type Alt-U-M, or under the User Data 
menu, click Material Maintenance. 
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Description 

The Material Maintenance option is the function used to add, delete, and maintain 
Flowel's list of materials used in defining pipe and flow elements. 

To display the list of materials available, click the material dropdown list. 

Figure 3-18 Material Maintenance Dialog Box 

 

3.33.1 Add Materials 

On the Material Maintenance dialog box, click the Add button. The Add/Edit Material 
dialog box will appear. Type in the material name (up to 27 characters long). Select 
the units for the expansion coefficient, then enter the value for this material. 

Next, select the units for the yield stress, then enter the value for the yield. Click OK 
to complete the addition of a material. 

Note: The new material name must be unique. 

3.33.2 Edit Materials 

Flowel permits editing of user-defined materials only. Flowel keeps the pre-defined 
materials safe from any changes.  

To edit a material, select the material from the Material Maintenance dialog box, then 
click the Edit button. Make the necessary changes and click OK to save the 
changes. 
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3.33.3 Delete Materials 

Flowel permits the deletion of user-defined materials. Pre-defined materials included 
with Flowel cannot be deleted.  

To delete a material, select the material from the Material Maintenance dialog box, 
then click the Delete button. A warning message appears. 

Figure 3-19 Delete Material Warning Message 

 

Click Yes to confirm and complete the deletion. 

3.34 Meter Run 
To activate the Meter Run function, type Alt-S-M, or under the Worksheet menu, 
click Meter Run. 

Description 

This option allows you to set up the meter information. 
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Figure 3-20 Meter Run Dialog Box 

 

The Meter Run dialog box is divided into three sections: Element, Pressure Taps, 
and Pipe. In each of these sections, the options pertaining to this specific tag must 
be set. 

If you make a change to the Meter Run of an existing tag, when you click Next the 
program automatically moves you to the calculation screen. 

3.34.1 Element 

Flowel supports many different pressure element types. Select the element type from 
the dropdown selection list. Included are many types of orifice plates, venturi & 
nozzles. For venturi, you will have to enter an exit angle. For elements with a 
drain/vent, you will have to set a hole size and shape. All elements require that you 
select a material. 
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3.34.2 Pressure Taps 

The options available change automatically with the selection of an element type. All 
options associated with an element are shown in the dropdown selection list. As a 
Differential option is selected, the selections available under Static will change. Most 
of the time the Upstream and Downstream static pressure taps will be available. The 
Upstream tap option will be the default in most instances. 

3.34.3 Pipe 

The Pipe section is where the nominal pipe size, schedule, and material are set.  

First, select a pipe nominal. 

Next, based upon the nominal selected, there will be a number of schedules 
available for selection. Choose a schedule from the dropdown list. The inside 
diameter will be automatically set based upon the chosen nominal and schedule. 
You can also directly type in an inside pipe diameter. The inside pipe diameter units 
may be changed using the dropdown list box to the right of the diameter value. 

Select a pipe material from the dropdown selection list. You may also type in the 
inside diameter directly. In this case, the fields for Nominal and Schedule will be set 
to a null (blank) once you click Next. 

Note: If the desired pipe nominal/schedule/material for this tag does not exist in the 
pre-configured Flowel lists, see Pipe Maintenance, Section 3.42 for the proper way to 
add information. 

Once all of the meter run information has been entered, click Next to save the 
information and move on to the next window. 
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Figure 3-21 Flowel Main Screen with Flow Element Displayed 

 

You will notice that the main Flowel window has changed. Near the top of the 
window is an illustration of the flow element you selected. Also on the screen are the 
parameters you defined regarding element, pipe, fluid, etc. 

Related reference topics include: 
• Material Maintenance 
• Pipe Maintenance 

3.35 Mixture Definition 
To activate the mixture definition, click on the Define Mixture button on the Fluid 
Setting dialog box. 
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Figure 3-22 Fluid Setting Dialog Box 

 

Description 

A mixture is any fluid other than a pure substance or an "unknown fluid". For pre-
defined fluids such as natural gas, the list of pure components that can be included 
in the mixture is restricted to only those that are applicable. 

For a general mixture fluid type, however, you may select components from the 
complete Flowel pure component listing. 

3.35.1 To Define a Mixture 

On the mixture definition dialog box, type in the mixture name. Select your 
preference of mole fraction or mole percentage.  
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Select the components to be included in this mixture, one by one, selecting from the 
component list using the Add button or by double-clicking on the selection to insert it 
into the list.  

For each component, enter the mole value. For percentage, each value must be in 
the range of 0 to 100. For fraction, this value must be between 0 and 1. 

If the total mole fraction does not add up to 1 or the total percentage does not add up 
to 100, and OK is clicked, Flowel will display the following message. 

Figure 3-23 Total Composition Error Dialog Box 

 

Click OK again to renormalize these values. The program will adjust each value 
proportionally to its weight, until the sum of the components equals 1 in the case of 
fraction and 100 in the case of percentage. 

Note: On Flowel's selection lists; many of the selection lists within Flowel allow for 
item selection in more than one fashion. In this example we want to select Gas as a 
fluid state. We have two methods of making the selection. 

The first method is the standard selection method. Press on the arrow button on the 
top-right hand of the State field. A dropdown list will appear. Select from the selection 
list by clicking on the desired item. 

The alternate method is to type the first letter of the desired item, in this case the 
letter G. If there are more than one item which begins with the letter G, the first will be 
brought up. Press G again to get to the second one, and so on. 

These methods apply to many areas of the program. In particular, when selecting 
pure fluids on the mixture definition function, the letter-selection method allows quick 
access to a component which might otherwise take a lot of time to scroll to in a list. 

3.36 New Job 
To activate the New Job function, type Alt-F-N, or under the File menu, click New 
Job. 
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Description 

Use this function to start a new job. 

Job No., Customer, Contractor, and Site Name fields can hold up to a 40 character 
description each. The Description field can hold up to 254 characters.  

The job number is the most important information needed here. At a minimum you 
must enter a job number to continue. Your organization may have standards for job 
naming and tracking. 

3.36.1 Define New Job 

You must click the Define New Job button before entering a job number and 
information. If the Delete Job button is used, you must click the Define New Job 
button before creating a new job. 

3.36.2 Delete Job 

Use this function to delete an existing job and all of the associated tags. A warning 
prompt will ask for confirmation before this action is completed. 

Note: You cannot delete a job if it is the currently open job. You must open a 
different job to be able to delete the desired job from the database. 

3.36.3 New Tag Button  

Use this button to go directly to the New Tag screen.  

3.37 New Tag 
To activate the New Tag function, type Alt-F-T, or under the File menu, click New 
Tag. 

Description 

This command creates a new tag within the currently open job. Each tag is 
associated with a real world device in the field. 
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Figure 3-24 New Tag Dialog Box 

 

The New Tag dialog box displays the current job (to which this new tag will be 
saved), and any existing tags under this job. 

3.37.1 Define New Tag 

Click the Define New Tag button to accept information on a new tag. Begin by 
entering the full tag name. Flowel is designed to use a five-part tag thereby 
conforming to the ISA-standard tag naming convention. 

Here is a brief review of the ISA tag naming convention: 
• Prefix1 – an optional general location identifier 
• Prefix2 – an optional, more specific location identifier 
• Instrument ID – a required field which classifies the function of the device 
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• Loop number – a required field, usually a grouping of instruments working 
together toward a common function 

• Suffix – additional optional identifier to distinguish between instances of a 
device in a loop 

The minimum information required fields to complete when creating a new tag are 
the Instrument ID and Loop fields. However, we do not recommend creating tags 
with only this minimum information. Be thorough here and you will likely save 
considerable time and effort later. 

The following fields are available for use: 
 
Field Characters 
Critical Statement 25 
Line No. 20 
Service 40 
Model No. 40 
Specification No. 8 
Material Req. No. 40 
Purchase Order No. 40 
Part ID No. 40 
Manufacturer 32 
Vendor 32 

When you have completed filling in the information on this dialog box, click OK to 
save the tag information, or if you are following Flowel's recommended program flow 
(see Flowel's Method, Section 3.37.4), click the Next button to get to the next 
function. 

3.37.2 Copy 

Select an existing tag from the list available, then click the Copy button. The 
information from the original tag will be copied into the fields of the new tag. You may 
then edit the information which appears in this dialog box to complete the creation of 
this new tag. 

3.37.3 Delete 

A delete command is available here for your convenience. This is the only way to 
remove tags from a job. 

Select the tag to be deleted, then click the Delete button. 

Note: The currently open tag may not be deleted. Open another tag before deleting 
a tag from the database. 
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3.37.4 Flowel's Method 

Flowel 4.0 was designed with a certain method or approach in mind. As a result, we 
have built into the program a way of following this method easily and quickly.  

A Next button appears at the bottom of the New Tag dialog box. Each subsequent 
dialog box in the recommended program flow provides a Next button, and most 
provide a Back button (to go back and change or fix something). When the process 
is completed you will have followed all of the steps necessary to add and configure a 
new tag. Any of the parameters that you set in this process can be modified after-
the-fact by recalling the particular function using the menus. 

If you are creating a new tag, the Next button calls up the next screen in the 
recommended program flow. 

3.38 Open Job 
To activate the Open Job function, type Alt-F-O, or under the File menu, click Open 
Job. 

Description 

The Open Job command is used to recall or resume work on a job that has already 
been created. 
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Figure 3-25 Open Job Dialog Box 

 

As you move between selections, the information associated with each job is 
displayed. This makes it easier to identify the job. 

Select the job's name from the window, then click OK. 

3.39 Open Tag 
To activate the Open Tag function, type Alt-F-G, or under the File menu, click Open 
Tag. 

Description 

This command opens an existing tag. Select the tag from the list by double clicking 
on it, or use the cursor keys to select the tag then press Enter or click OK. 
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Figure 3-26 Open Tag Dialog Box 

 

Information specific to each tag will appear as you select between tags, making it 
easier to identify each tag exactly. 

3.40 Optional Ordering 
To activate the Optional Ordering function, type Alt-H-O, or under the Help menu, 
click Optional Ordering. 

Description 

If your version of Flowel was purchased without the optional Fluid Property package, 
or you have a limited run version of the program and you want to order more 
days/runs, you can use this option to place your order.  

If you have a run-limited version of the program, the dialog box which appears 
indicates how many days or runs are remaining on the current installation. 
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These are the steps you need to perform: 
1. Obtain a purchase order and/or authorization to purchase the upgrade. 
2. Activate this option (under the Help menu, click Optional Ordering), enter your 

company information, then make the selection regarding the type of installation. 
Your choices are: stand alone and network. 
• Stand Alone: A stand alone installation means that you will be running Flowel 

on one PC only (not from a server or over a network). Most installations will 
be of this type. 

• Network: If you will be running Flowel from a network server, or if you are 
installing Flowel on one computer but occasionally running it from another 
networked computer, you should select the network option. 

3. Click the Order button. 
4. A form will be printed on your printer. Fax this form to Hydrocarbon and Energy, 

at the number which appears on the form. 
5. Hydrocarbon and Energy will fax back a site key. This key is used to enable the 

Fluid Properties package, or add additional runs/days. 
6. Re-run this Optional Ordering function. On the screen where you entered the 

ordering information, enter the Site Key, then click OK. 
7. Exit the program. When you restart Flowel, the Fluid Properties package, or the 

new number of days/runs will be enabled. In the case of the fluid properties 
option, all of the options will now be available to you. 

3.41 Options Menu 
To activate the Options menu, type Alt-O. 

Description 

The Options Menu contains functions to set the default units for the program, and for 
setting atmospheric pressure for each tag site. 

All of the menu items in Flowel are listed by name (alphabetically) in the reference 
section. Please look to the specific function name for information on that function. 

3.42 Pipe Maintenance 
To activate the Pipe Maintenance function, type Alt-U-P, or under the User Data 
menu, click Pipe Maintenance. 
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Description 

The Pipe Maintenance function allows new pipe information to be added to the pipe 
database included with Flowel. 

For each nominal pipe size, there may be many pipe schedules defined. You may 
add to both the nominals as well as schedules for each nominal. 

Figure 3-27 Pipe Maintenance Dialog Box 

 

3.42.1 Add a Nominal Diameter 

Click the Add button which appears to the right of the pipe nominal field.  
The Pipe Nominal Name dialog box appears. Enter a name for this new pipe. The 
name may be up to 15 characters long. Click OK to continue. 

3.42.2 Add a Pipe Schedule 

After entering a pipe name, click the Add button which appears to the right of the 
schedule information field.  
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Figure 3-28 Pipe Schedule Dialog Box 

 

The Pipe Schedule dialog box appears. Enter the schedule name. You may use up 
to 24 characters for the name. Next, set the units for the measurement and then 
enter a pipe diameter (ID). 

When all of this information has been entered, click OK.   

Note: You may add schedules to the nominals supplied by Flowel. These new 
schedules may be edited and deleted since they are user-defined. Any changes 
made here will not affect the Flowel-supplied nominals/schedules. 

3.42.3 Edit a Pipe Schedule 

Select the schedule to be changed from the Pipe Maintenance dialog box. Click the 
Edit button. The Pipe Schedule dialog box appears with the schedule name, 
diameter and units displayed in the fields. Make changes to any of these fields as 
necessary. Click OK when your changes are complete. 

Note: You cannot edit the schedules provided by Flowel. Only the user-defined 
nominals and schedules may be edited or deleted. 

3.42.4 Delete a Nominal Diameter 

Only nominal diameter that you have added may be deleted. Flowel does not allow 
the nominal diameters and pipe schedules with which it was supplied to be altered or 
deleted. 

To delete a user-defined nominal diameter, select the nominal from the Pipe 
Maintenance dialog box, then click the Delete button. A warning prompt will appear 
requesting confirmation of this action. Click Yes to complete the operation. 

Note: All pipe schedules defined under this nominal diameter must be deleted before 
the nominal can be deleted. 
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3.42.5 Delete a Pipe Schedule 

Only pipe schedules that you have added may be deleted. Flowel does not allow the 
nominal diameters or pipe schedules with which it was supplied to be altered or 
deleted. 

To delete a user-defined pipe schedule, select the schedule from the Pipe 
Maintenance dialog box, then click the Delete button.  

A warning prompt will appear requesting confirmation of this action. Click Yes to 
complete. 

3.43 Print All 
To activate the Print All function, type Alt-F-A, or under the File menu, click Print All. 

Description 

This command prints all tags which are associated with the current job. 
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Figure 3-29 Print All Dialog Box 

 

The Print All dialog box appears, displaying the current job name. Underneath the 
name is a list of tags which will be printed. 

Select a specification sheet format from those available. Click on the checkboxes for 
the options you want. 

Note: Only those reports which are appropriate for each tag will be printed. For 
example, a tag which does not use the AGA 3 method will not have an AGA 3 factors 
report printed for it. 
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3.43.1 Print Paper Format 

The Print Paper Format option allows the user to select Letter or A4 paper size. This 
will affect the print and save functions of the specification sheets. 

To activate click the Options menu and select Print Paper Format. 

3.43.2 Printer Setup 

The program uses the standard Windows printer setup dialog. You will be familiar 
with this dialog box if you have operated other Windows applications. 

Figure 3-30 Printer Setup Dialog Box 

 

The printers which have been set up on your computer will appear in this list. Select 
the desired printer for your print job. Use the Setup option from this dialog box to 
make last-minute changes to your selected printer's configuration. 

Once all of the selections have been made, click OK to start the printing process. A 
message on the screen will indicate the progress of the printing function. 

3.44 Print Preview 
To activate the Print Preview function, click the Print Preview button. 

Description 

The Preview function provides you with a method of proofing the look of your 
document before it is printed. 

On the Print Preview dialog box, select the zoom factor for previewing, then click OK. 
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3.45 Print Spec. 
To activate the Print Spec. function, type Alt-F-S, or under the File menu, click Print 
Spec. 

Description 

Use the Print Spec. function to print all of the specification sheets which have the 
same specification number defined as part of a tag's information. This number is 
defined on a tag by tag basis. 

The Print Spec. dialog box displays the current job name. Select a specification 
number from the dropdown list provided. Once this has been done, the program will 
create a list of tags which will be printed. This list is displayed for you. 

Select a specification sheet format from those available. Click on the checkboxes for 
the options you want. 

Note: Only those reports which are appropriate for each tag will be printed. For 
example, a tag which does not use the AGA 3 method will not have an AGA 3 factors 
report printed for it. 

For print paper format options, refer to Print Paper Format, Section 3.43.1. For 
printer setup and preview options refer to Printer Setup, Section 3.43.2 and Print 
Preview, Section 3.44. 

3.46 Print Tag 
To activate the Print Tag function, type Alt-F-P, or under the File menu, click Print 
Tag. 

Description 

The Print Tag option prints the specification sheets for the current tag using the 
format selected on this print dialog box. 
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Figure 3-31 Print Tag Dialog Box 

 

The Print Tag dialog box displays the current job and tag name.  

Select a specification sheet format from those available. Click on the checkboxes for 
the options you want. The preview button will be enabled if only one type of 
specification sheet is selected. 

Note: Only those reports which are appropriate for each tag will be printed. For 
example, a tag which does not use the AGA 3 method will not have an AGA 3 factors 
report printed for it. 

For print paper format options, refer to Print Paper Format, Section 3.43.1. For 
printer setup and preview options refer to Printer Setup, Section 3.43.2 and Print 
Preview, Section 3.44. 



3 User Reference  User Manual 

 133  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

3.47 Rounded Bore Size 
The Rounded Bore Size option applies to concentric orifice plates. When this option 
is selected, you can specify whether you want to round up or down to the specified 
increment. 

Figure 3-32 Flow Calculation Dialog Box – Solving for Rounded Bore 

 

The minimum information fields that are required to calculate the rounded bore are: 
 
Flow Rate flowing conditions, or base condition if a normal or 

standard volumetric flow rate is selected 
Differential Pressure  
Static Pressure flowing conditions, or base condition if a normal or 

standard volumetric flow rate is selected 
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Temperature flowing conditions, or base condition if a normal or 
standard volumetric flow rate is selected 

Density flowing conditions, or base condition if a normal or 
standard volumetric flow rate is selected 

Viscosity  
Isentropic Exponent (this field will not appear if the fluid is in liquid state) 
Round Direction Round to the nearest value and unit. The unit will be set 

to the pipe diameter unit automatically. 

The program will calculate the beta ratio first, then adjust bore diameter according to 
the round setting. The program then uses the adjusted bore diameter to recalculate 
the flow rate. 

3.48 Significant Digits 
To activate the Significant Digits function, type Alt-O-D, or under the Options menu, 
click Significant Digits. 

Figure 3-33 Significant Digits Setting Dialog Box 
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Use this option to set the number of decimal places for the following variables: 
• temperature 
• pressure 
• diameter 
• flow rate 
• compressibility 
• density 
• viscosity 
• beta 

Each of these fields can be set to display from 1 to 10 digits after the decimal (the 
exception is a range of 0 to 10 for flow rate). Either use the horizontal scroll bar to 
change the value, or enter the number of digits directly into the corresponding field. 
This will affect the number of decimal places displayed on a spec. sheet printout and 
the calculation screen. It does not affect the number of decimal places used in the 
calculations. 

3.49 Spec. Sheet 
To activate the Spec. Sheet function, type Alt-S-S, or under the Worksheet menu, 
click Spec. Sheet. 

Description 

The Spec Sheet option is used to create specification sheets for a tag. By selecting 
one of the three formats, you activate an entry screen which will include data filled in 
by the program for you. The remaining fields may be filled in as required. Each of the 
spec sheet types will have data fields unique to that type.  

The scale you set for the specification sheet is saved for re-use, until you set it again. 
This allows scaling (normally 95%) for proper printing for European paper sizes. You 
may print each of the specification sheets from this display, including: 

• Calculate Data Sheet 
• ISA S-20 Data Sheet 
• Flowel Data Sheet  
• Fluid Report 
• AGA 3 Factor Report  
• DP Transmitter 
• DP Transmitter 2 
• Pressure Transmitter 
• Temperature Transmitter 

Create specification sheets of the selected type for viewing or printing of the current 
tag. 
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3.50 Toolbars 
To activate the Toolbars function, type Alt-W-B, or under the Windows menu, click 
Tool Bars. 

Description 

The Toolbars prompt allows for the convenient positioning of tools within the window 
area. Options include standard toolbars, a floating toolbar, toolbars with text titles, 
and the ability to hide toolbars completely. 

3.50.1 Use 

The Toolbar provides a recommended method of program flow when each of the 
options are activated in order from left to right. This is the same process described in 
the New Tag topic but instead of using the Next button, the toolbar items are used. 

Figure 3-34 Toolbars Dialog Box 

 

An alternate method of activating the toolbar commands is to click anywhere on the 
toolbar using the right mouse button. This activates the following menu, shown in 
Figure 3-35. 
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Figure 3-35 Toolbar Menu 

 

Checkmarks indicate the currently active options. You can select any option here as 
you would from the Toolbars popup dialog box. The Left, Right, Top and Bottom 
options move the toolbar to the outer edge of the screen in the position selected. 

Figure 3-36 Floating Toolbar 

 

The Floating option (Figure 3-36 above) allows the toolbar to be dragged anywhere 
in the window. 

Figure 3-37 Toolbar with Show Text Selected 

 

The "Show Text" option may be toggled on or off by clicking on the checkbox next to 
the option. This will display a text title underneath each toolbar option making it 
easier to remember each button's function, as shown in Figure 3-37.  

To remove the toolbar from the window completely, press the Hide button. The 
toolbar will not appear at any time unless the toolbar function is reactivated and the 
Show button selected. 

Once all of the options have been set, click OK. 
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3.51 Transfer Authorization 
To activate the Transfer Authorization function, type Alt-F-Z, or under the File menu, 
click Transfer Authorization. 

Description 

This option is used to transfer the CrypKey copy protection when moving the 
program from one computer to another. You will not be able to transfer the site key 
from a 16 bit operating system to a 32 bit. 

The transfer of your site key from one PC to another is a four step process. This 
process is required if you are moving Flowel from one computer to another. A new 
site key will not be generated for the new computer. 
1. Install Flowel on the destination computer.  

Note: You must install. It is not sufficient to copy. 
2. Prepare a blank floppy disk for the transfer by the destination computer. 
3. Insert the floppy into the computer on which Flowel currently resides, and the 

transfer is initiated. 
4. Place the completed floppy into the destination computer and the site key is 

transferred onto it. 

The details for the site key transfer are as follows: 
1. Prepare by having a blank, formatted floppy disk ready. 
2. After Flowel has been installed on the destination computer, run the program 

(double-click on the Flowel icon from the Windows Program Manager.) 
3. An Authorization Warning Message will appear. Click OK. 
4. A Request for Authorization dialog will appear. Since this is not a new 

installation, select Transfer from floppy. 
5. Click OK. The program will now prompt you to insert the floppy in to your floppy 

disk drive and select the drive letter from the selection box. Once the floppy is 
inserted in the drive, and the correct drive letter has been selected, click the 
Register Transfer button. 

6. The program will prepare the floppy and an information message will appear. 
Click OK. 

7. Now, bring the prepared floppy disk to the computer onto which Flowel is 
currently installed. Run Flowel. 

8. On the File menu, select Transfer Authorization. 
9. The program will prompt you to place the prepared floppy disk into this computer 

and select the floppy drive letter. Do so and click OK. 
10. Move the floppy to the destination computer. Start Flowel.  
11. A warning message may appear, if so, click OK. 
12. The Request for Authorization screen appears. Select Transfer from floppy, 

and click OK. 
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13. The Transfer In Authorization screen appears. Select the drive. 
14. Click Transfer In.  
15. Once the transfer of the site key is complete, the prompt will disappear. Remove 

the floppy disk from this computer.  
16. Once the site key has been successfully transferred from the floppy disk, Flowel 

will start. 

3.52 Uncertainty 
To activate the Uncertainty function, type Alt-S-U, or under the Worksheet menu, 
click Uncertainty. 

Description 

Use this option to enter the uncertainty values for some of the variables used in ISO 
5168 flow rate uncertainty calculations. 

Figure 3-38 Uncertainty Dialog Box 

 



User Manual  3 User Reference 

 140  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

Uncertainties in discharge coefficient and gas expansion coefficient as provided by 
the displayed standard (e.g. AGA 3-1985). These values are calculated based upon 
standards and flow conditions. These two values cannot be changed. Uncertainties 
in bore size and pipe inside diameter are also provided by Flowel according to the 
standard specified, however, you may overwrite these values.  

It is recommended that you provide uncertainties in pressure and density. The 
program will use 0 (zero) for these values if they are not provided. 

Once each of the values has been entered, click on the Calculate button and Flowel 
will calculate the flow rate uncertainty. Click OK to return to the main screen. 

3.53 Used Resources 
To activate the Used Resources function, type Alt-H-R, or under the Help menu, 
click Used Resources. 

Description 

This function displays a graph of the percentage of free resources available while 
you are running Flowel. This can be a useful indicator if you find your system is 
running slow or incorrectly. Check to see that there are adequate resources 
available. If not, try running fewer applications at one time. 

Figure 3-39 Free Resources Dialog Box 
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3.54 User Data Menu 
To activate the User Data menu, type Alt-U. 

Description 

Use this menu to set the user-specific parameters for the program. 

3.54.1 Pipe Maintenance 

Allows new pipe nominal diameters and schedules to be added and maintained. 

3.54.2 Material Maintenance 

Allows new pipe and flow element materials to be added and maintained. 

3.54.3 Fluid Maintenance 

Allows fluids to be copied, user-defined fluids to be deleted, and mole fractions to be 
adjusted. 

3.55 User Factor 
The User Factor is an independent factor for the user to modify the flow equation. In 
most situations the User Factor will be 1.0. 

3.56 Vapor Pressure/Bubblepoint 
To activate the Vapor Pressure function, click the Vapor Pressure button on the 
Flow Calculation window (the Bubblepoint button if the current fluid is a mixture). 

Description 

This function calculates the vapor pressure or bubblepoint of fluids.  

This calculation is not used in the calculation of flow rate, however, you can use the 
result to check for possible cavitation or flashing. If the bubblepoint is close to the 
downstream pressure, you can expect vaporization to occur. 

3.56.1 Bubblepoint 

The Bubblepoint button, when clicked, produces a dialog box that prompts the user 
to select a calculation method. The following methods are available: Soave-Redlich-
Kwong and Peng-Robinson. 
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These methods provide comparable bubblepoint calculations. The results should be 
very close for most hydrocarbon systems. Please be aware that neither method will 
provide reliable results for polar systems. 

3.57 Viscosity 
To activate the Viscosity function, click the Viscosity button on the Flow Calculation 
dialog box. 

Description 

Use this function to calculate the viscosity of a gas (pure or defined mixture) and 
water or steam. Static pressure and temperature must be entered on the flow 
calculation screen for this operation to be successful. 

3.58 Windows Menu 
To activate the Windows menu, type Alt-W. 

Description 

This is a Windows housekeeping menu which allows you to make changes to the 
specific configuration of the program. The options available under this menu include 
Color and Tool Bars. 

3.59 Worksheet Menu 
To activate the Worksheet menu, type Alt-S. 

Description 

It is under this menu that the important calculations within Flowel are made, including 
Fluid, Meter Run, Calculate, Graph, Specification Sheets, and Uncertainty 
calculations. 

§ 
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User Manual 

A Nomenclature ─ Glossary of Terms 
Variable names and meanings for the purposes in the Flowel program are shown 
below. 

B AGA 3 simplification term 
C Flow element discharge coefficient 
C' Meter coefficient 
d Flow element actual or effective diameter (m) at flowing conditions 
dmeas Flow element actual or effective diameter (m) at 20°C 
D Pipe inside diameter (m) at flowing conditions 
Dmeas Pipe inside diameter (m) at 20°C 
Ddh Drain or vent hole diameter (m) 
∆P Differential pressure = P1-P2 (kPa) 
E Velocity of approach factor & AGA 3 simplification term 
Fa Material temperature correction factor 
Fae Pipe temperature correction factor used in ISO 
Fap Element temperature correction factor used in ISO 
Fb Basic orifice factor (AGA 3) 
Fdh Drain hole correction factor 
Fgr Specific gravity correction factor 
Fpb Base pressure correction factor 
Fpv Super compressibility factor 
Fr AGA 3 Reynolds number factor 
Ftb Base temperature correction factor 
Ftf Flowing temperature correction factor 
FTp Static total pressure correction factor 
Fx Two-phase flow correction factor 
Fusr User factor 
hw Differential pressure 
K AGA 3 flow coefficient 
Ke AGA 3 flow coefficient when Rd=d(106)/15 
Ko AGA 3 flow coefficient when Rd is infinite 
L1 ISO relative pressure tap spacing upstream 
l1 Pressure tap spacing upstream 
L2 Relative pressure tap spacing downstream 
l2 Pressure tap spacing downstream 
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Mw Molecular weight of flowing fluid (kg/kmol) 
P Static  
P1 Upstream flowing pressure (kPa-a) 
P2 Downstream flowing pressure (kPa-a) 
Pb Pressure of base reference flowing conditions (kPa-a) 
Pf Flowing pressure - same as P1 (kPa-a) 
Qm Mass flow rate (kg/s) 
Qv Volumetric flow rate 
R Universal Gas Constant 
Rd Reynolds number at the bore diameter 
RD Reynolds number upstream in the pipe 
SG Ideal specific gravity of flowing fluid 
SGr Real specific gravity of flowing fluid 
T Flowing temperature (Kelvin) 
Tb Temperature at base conditions (Kelvin) 
Tf Same as T 
W Speed of sound 
x Vapor quality 
X Mass of gas/total mass of mixture 
Y Expansion coefficient – this is the ε term in the ISO 5167 standard 

documentation. Y is used here for the sake of similarity with AGA 3 and 
Flowel version 1.3 

Y1 Expansion coefficient referenced to upstream tap 
Y2 Expansion coefficient referenced to downstream tap 
Ycr Expansion coefficient at critical flow conditions 
Z Compressibility at flowing conditions 
Zair Compressibility of air at flowing conditions 
Zb Compressibility of flowing fluid at base conditions 
α1 Thermal expansion coefficient of pipe material 
α2 Thermal expansion coefficient of element material 
β Bore to diameter ratio = d/D 
φ Divergent angle of venturi 
κ Operating isentropic expansion coefficient (Cp/Cv) 
κi Ideal isentropic expansion coefficient 
µ Viscosity of flowing fluid at flowing conditions 
π PI with a value = 3.1415927654 
ρ Density of flowing fluid 
ρf Density of liquid component in wet vapor 
ρg Density of gas component in wet vapor 
τ Pressure ratio of P1/P2 
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ϖ Permanent pressure loss 
x1 ∆P/P1 
x2 ∆P/P2 

§ 
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User Manual 

B Fluid Property Calculation Methods 

B.1 Introduction 
The purpose of this chapter is to describe the equations used by Flowel to calculate 
density, viscosity, vapor pressure, and isentropic exponent. 

B.1.1 PVT Properties 

The pressure-volume-temperature (PVT) relationship is one of the most important 
properties for fluid flow measurement. Density and specific gravity are calculated 
from PVT data. 

For example, density 
1 P
V ZRT

ρ = =  

For most applications, temperature and pressure are known conditions. However, 
most equations of state use temperature and volume as independent variables. 
Therefore, an iteration is required for complicated equations of state, which is simple 
for those equations of state that are cubic in volume. An analytical solution can be 
obtained for those so-called cubic equations of state. 

The PVT property methods are divided into two parts. The first is the generalized 
methods. These methods are expected to be useful for most systems and T, P, and 
composition conditions. The second is the more specialized methods. These 
methods are more accurate within the systems and conditions specified. However, 
these methods should not be used beyond the specified systems and conditions. 

B.1.1.1 Generalized Methods 

The generalized method can be used to calculate the properties of most substances 
over a wide range of conditions.  

The generalized equations of state include: 
• Redlich-Kwong equation 
• Soave-Redlich-Kwong (SRK) equation with volume translation 
• Peng-Robinson (PR) equation with volume translation 
• Lee-Kesler BWR equation 
• Thomson-Brobst-Hankinson and Modified Rackett equations 
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B.1.1.1.1 Redlich-Kwong and Soave-Redlich-Kwong 

The Redlich-Kwong (RK) equation of state was proposed to give a better description 
of PVT over the van der Waals equation. The corresponding state principle was 
applied to obtain Redlich-Kwong equation parameters. Therefore, the two 
parameters of the RK equation can be calculated from the critical temperature and 
pressure. Redlich-Kwong equation of state is only applicable to the gas phase, with 
limited accuracy. 

The Soave-Redlich-Kwong (SRK) equation was proposed by Soave in 1972. It is the 
first cubic equation of state with the capability of describing both liquid and vapor 
phases. With Peneloux's volume translation technique, the SRK equation will give 
more accurate liquid volumes. Besides the critical properties for SRK equation 
parameters, an acentric factor is needed. For Peneloux's volume translation form, an 
additional parameter, Rackett volume constant ZRA, is needed. The details of the 
SRK equation are provided later in the appendix. 

The correlation of binary interaction parameter for the SRK equation is used here, 
although the binary parameter is not important for volumetric calculations. 

B.1.1.1.2 Peng-Robinson 

The Peng-Robinson (PR) equation was proposed in 1976. It gives a better 
description of liquid density over the original SRK equation. With Peneloux's volume 
translation technique, the PR equation is essentially equivalent to the SRK equation. 
However, the PR equation is widely used in North America, while the SRK equation 
is preferred by European engineers.  

Yu's volume translated PR equation is used here. Only critical temperature, 
pressure, and acentric factor are needed to obtain the parameters of volume 
translated PR equation.  

B.1.1.1.3 Lee-Kesler BWR 

As recommended by Reid et al., the Lee-Kesler BWR equation should be used for an 
expanded range of temperature and pressure, although the simple SRK and PR 
equations give a reasonable description of liquid density for non-polar molecules 
near saturated conditions. The Lee-Kesler BWR equation will also be used to provide 
an isentropic exponent (together with ideal gas heat capacity). 

The Lee-Kesler BWR equation is highly nonlinear in volume. An Newton-Raphson 
iteration method is needed to solve volume for given temperatures and pressures. 
Although Lee-Kesler BWR may give several volume roots for given temperatures 
and pressures, only three of them will be within a physically meaningful range. 
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B.1.1.1.4 Thomson-Brobst-Hankinson and Modified Rackett 

The correlation's for liquid density are: 
• Thomson-Brobst-Hankinson equation 
• Modified Rackett equation 

The Thomson-Brobst-Hankinson equation is also known as the COSTALD 
(COrresponding STAtes Liquid Density) equation. The COSTALD equation extended 
the Tait equation to a generalized form with corresponding states formulation for the 
parameters. It is applicable to saturated liquid density and compressed liquid density, 
to pure fluid and fluid mixtures, and to non-polar and polar substances. This equation 
was developed from 6,338 density points for pure, non-polar liquids, 1,352 points for 
polar and quantum liquids, and 6,926 mixture density points including 319 points for 
LNG/LPG mixtures. Average absolute errors in densities calculated using this 
equation were 0.446% and 2.57% for pure non-polar and polar liquids respectively. It 
gave 0.3669% and 1.6% average absolute error for LNG/LPG mixtures and for all 
mixtures. 

This equation needs critical pressure, critical temperature, and two additional 
characteristic parameters as inputs. These two characteristic parameters are 
available for about 400 substances. 

The Spencer and Danner modified Rackett equation will be used here. The Rackett 
equation can only be used to calculate the saturated liquid volume (density). It is very 
simple and only needs critical temperature, critical pressure, and ZRA as input. When 
ZRA is not available, it can be estimated from the acentric factor. 

In addition to the equation specific parameters, the above generalized equations 
need substances dependent on critical properties and acentric factors. Flowel 
provides these parameters for more than 600 substances. Two additional 
parameters are required for the Thomson-Brobst-Hankinson and the Modified 
Rackett equations, respectively. These two parameters are listed in the Table 3-10 of 
the book "The Properties of Gases and Liquids"1 for more than 300 substances. 
There are also rules to estimate these two parameters when they are not available in 
the table. 

Proper mixing rules are applied to extend the above equations to gas or liquid 
mixtures. 

B.1.1.2 Specialized Method 

The generalized methods are well known and have been extensively tested by many 
researchers. These methods usually provide reasonable accuracy, in most cases. 
However, more accurate methods are also necessary when you are more concerned 
with accuracy. 

                                                 
1 Walas, “Phase Equilibrium in Chemical Engineering”. Butterworth Publisher, Boston, 1985. 
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The specialized methods include: 
• AGA 8 (versions 1985 and 1992). 
• Redlich-Kwong equation with Wichert-Aziz correction for sour natural gases 
• NX-19 
• NBS/NRC Steam equation 
• Ammonia equation 
• Carbon Dioxide equation 
• Nitrogen equation 
• Oxygen equation 
• Hydrogen equation 
• Argon equation 
• Methane equation 
• Ethane equation 
• Ethlyene equation 
• Propane equation 
• i-Butane and n-Butane equation 
• Air 

There are two versions of the AGA 8 equation. One was proposed in 1985 and the 
other in 1992. The new data available between 1985-1990 was included to obtain 
the new version of the AGA equation. The new version of the AGA 8 equation can 
replace the old version AGA 8 equation. However, in consideration for those users of 
the previous versions of Flowel, both versions of the AGA 8 equations are included in 
this property library. 

AGA 8 equations can be used over a wide range of temperature and pressure for 
natural gas systems. However, the AGA 8 compressibility equation is only applicable 
for the gas phase. 

Wichert-Aziz proposed an empirically modified Redlich-Kwong equation for sour 
natural gases. They proposed a set of pseudo-critical temperatures and pressures 
for the Redlich-Kwong equation. Therefore, the original Redlich-Kwong equation 
program can be directly used here with the special pseudo-critical pressure and 
pseudo-critical temperature. 

NX-19 is the first effort to represent natural gas data in an equation of state form. It is 
old but still popular in the natural gas industry. Therefore, this equation is included as 
an additional option for users. 

The U.S. National Bureau of Standards under the auspices of the Office of Standard 
Reference Data, and in collaboration with the National Research Council of Canada, 
undertook the task of correlating the large body of thermodynamic measurements for 
water and steam. The result of that program is a new formulation that is more 
accurate and has a much wider range of validity than previously existing 
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formulations. The International Association for the Properties of Steam (IAPS) 
granted this formulation provisional acceptance in September 1982. 

In this formulation, all of the thermodynamic properties are derived from the analytic 
Helmholtz function: A A T= ( , )ρ  

An analytical equation of state derived from the Helmholtz function is used for our 
PVT calculation. The vapor pressure equation of steam provided in the NBS/NRC 
steam table is used for steam phase status checking purposes. 

ASME/ANSI MFC-7M-1987 recommended equations of state for the thermodynamic 
properties of Nitrogen, Oxygen, and Ammonia are used. The NBS monograph on 
thermophysical properties of Ethane and Propane, and the recently published results 
on Methane, i-Butane, and n-Butane are used as well. The IUPAC international 
thermodynamic tables of fluids for Carbon Dioxide and Argon are used. 

B.1.2 Bubblepoint 

Bubblepoint is necessary to check the phase status of a fluid at certain conditions. 
The two phase regions are avoided in normal metering operations. It is important to 
predict the cavitation conditions for liquid flow metering.  

B.1.2.1 Pure Substances 

For pure substances, it is easy to check the phase status by comparing system 
pressure (operation pressure) with vapor pressure. The modified Antoine equation is 
used for this purpose. The coefficients for modified Antoine equations for more than 
500 substances are available in the book "The Properties of Gases and Liquids." 

B.1.2.2 Mixtures 

Equations of state are used to check the phase status of fluid mixtures. As Peng-
Robinson and Soave-Redlich-Kwong equations of state are cubic in volume, they are 
relatively easy to use. These two equations of state are among the most extensively 
tested simple equations for phase behavior calculation. It also should be noted that 
these two simple equations perform equally or better than complicated Lee-Kesler 
BWR and BWRS equations for phase behavior purposes. 

The binary interaction parameter is very important for phase behavior calculation. 
There are also extensive compilations of binary interaction parameters for both 
Peng-Robinson and Soave-Redlich-Kwong equations. The correlated form of binary 
interaction parameters is used in the program. 

The phase equilibrium calculation methods include a constant temperature and 
pressure flash calculation, dew-point calculation, and bubble-point calculation.  

The phase status checking is done automatically or as an option the user can select. 
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B.1.3 Viscosity 

Viscosity is also an important property for Flowel calculations. The low pressure gas 
viscosity can be estimated within about 1% error for most substances. There are 
several correlation's available for calculating the temperature and pressure 
dependence of viscosity. Among them, the Lucas method can be used to calculate 
the viscosity of non-polar and polar substances over a wide range of temperatures 
and pressures. The Lucas method is also tested for gas mixtures, and the Lucas 
method only needs critical properties as input for substance dependent parameters.  

IAPS approved (1975) viscosity equations for steam will be adopted here for pure 
water viscosity calculations. 

B.1.4 The Isentropic Exponent 

The isentropic exponent of a substance is defined as: 

ln
P

S TV

CP P Vk
V C V P

∂ ∂
∂ ∂

⎛ ⎞ ⎛ ⎞= = −⎜ ⎟ ⎜ ⎟
⎝ ⎠ ⎝ ⎠

 

The ratio of specific heat capacity at temperature (T) and pressure (P) can be used 
as an approximation. For perfect gases, the specific heat capacities are constant; 
therefore, the isentropic exponent is constant. For ideal gases, heat capacity can be 
correlated as a simple function of temperature. The coefficients of such correlations 
are given in the book "The Properties of Gases and Liquids". For real gases, an 
equation of state can be used to derive the isentropic exponent. The Redlich-Kwong 
equation can be used for general purposes. The Lee-Kesler BWR equation is 
expected to give better results for an isentropic exponent. 

The isentropic exponent is also related to the speed of sound and can be calculated 
using equations in AGA-10-2003 (Speed of Sound in Natural Gas and Other Related 
Hydrocarbon Gases). 

B.2 PVT Property-Generalized Methods 

B.2.1 Redlich-Kwong Equation of State 

B.2.1.1 Symbol Table 

The symbol table for the Redlich-Kwong equation of state is shown in Table B-1. 

Table B-1 Redlich-Kwong Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

y I - 0 < y 0 < y y ≤ 1 y ≤ 1 

P I kPa 0 < P    
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Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Pc I kPa     

T I K 0 < T    

Tc I K     

a - -     

b - -     

A - -     

B - -     

R - kJ
kmol - K

 
8.31441    

Z O - 0 < Z   Z<5 

Subscript “i” denotes a component property. 

B.2.1.2 Calculations 

The following information was taken from the book "Phase Equilibria in Chemical 
Engineering", by Walas, page 44. 

The compressibility factor, Z, is found by solving the following equation: 
 

( )3 2 2Z 0Z A B B Z AB− + − − − =  (Table 1.9, eq. 7) 

1 1 1 1
2 2.5 2 2.5 2 2.5

n n n n

i j ij i j i j
i j i j

y y a P y y a a P
aP

R T R T R T
= = = =

⎡ ⎤ ⎡ ⎤
⎢ ⎥ ⎢ ⎥
⎣ ⎦ ⎣ ⎦= =
∑∑ ∑∑

 

(Table 1.9, eq. 15) 

2 2.5
i

i

a c
i

c

R T
a

P
Ω

=  
(Table 1.9, eq. 2) 

Combining equation 2 and equation 15 yields: 
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T
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1
3

1 0.42748
9(2 1)

aΩ = =
−

 
(p. 43, eq. 1.111) 
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1

n

i i
i

y b P
bPB
RT RT

=

⎡ ⎤
⎢ ⎥
⎣ ⎦= =
∑

 

(Table 1.9, eq. 5) 

ib c
i

RT
b =

icP
Ω

 
(Table 1.9, eq. 3) 

1

i

i

n
r

b i
i r

P
B y

T=

⎡ ⎤
= Ω ⎢ ⎥
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∑  

 

1
32 1 0.08664
3b
−

Ω = =  
(p. 43, eq. 1.112) 

B.2.1.3 Restriction and Uncertainty 

The Redlich-Kwong equation is not recommended for liquid phase (normally error 
will be more than 10%) or high pressure. As depicted in Figure 3-6 in the book “The 
Properties of Gases and Liquids” (R.C. Reid. J.M. Pranstitz, and B.Z. Poling, Fouth 
Edition, McGraw-Hill, 1987), for Pr<1, the percentage error in molar volume is less 
than 2%, for 1<Pr<10, the percentage error in molar volume is from 2% to 5%. 

B.2.2 Modified Soave Equation of State 

B.2.2.1 Symbol Table 

The symbol table for the Modified Soave equation of state is shown in Table B-2. 

Table B-2 Modified Soave Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

kij I - 0  1  

R - J/mol K 8.314    

P I Pa     

Pc I Pa     

T I K 40  1,000  

Tc I K 40  1,000  

V O cm3/mol     

y I - 0.0  1.0  

ω I - 0.0  3  
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B.2.2.2 Equations 

The volume translated Soave equation of state proposed by Peneloux and Rauzy is: 
 

( )( 2 )
RT aP

V b V c V b c
= −

− + + +
 

( eq.(5)) 

 
Where: 

 

2 2 20.42748 1 ( )(1 )c
r

c

R Ta f T
P

ω⎡ ⎤= + −⎣ ⎦  
(PGL, Table 3-5, page 43) 

0.08664 c

c

RTb c
P

= −  
(PGL, Table 3-5,page 43, 
under eq. (6)) 

0.40768 (0.29441 )c
RA

c

RTc Z
P

= −  
( eq.(8)) 

2( ) 0.48508 1.55171 0.15613f ω ω ω= + −  (ℑ,eq.(6-54), page 307) 

 
For mixtures: 

 

(1 )m i j i j ij
i j

a y y a a k= −∑∑  (PGL, eq.(4-5.1)) 

m i i
i

b y b= ∑  (PGL, eq. (4-5.2)) 

m i i
i

c y c= ∑  (  under equation (6)) 

 
For Nitrogen systems: 

 

0.107089 2.9776ij ijk k∞= +  ( eq.(6-57)) 

 
For CO2 systems: 

 

20.08058 0.77215 1.8407( )ij ij ijk k k∞ ∞= − −  ( eq.(6-58)) 

 
For H2S systems: 

 

0.07654 0.017921ij ijk k∞= +  ( eq.(6-59)) 

 
For Methane systems: 

 

20.17985 2.6958 10.853( )ij ij ijk k k∞ ∞= + +  ( eq.(6-60)) 
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Where: 

 

2( ) /(2 )ij i j i jk ε ε ε ε∞ ⎡ ⎤= − −⎣ ⎦  ( eq.(6-61)) 

 
And: 

 

0.5[ ln 2] /i i ia bε =  ( eq.(6-62)) 

  
  Peneloux, A. and Rauzy, E., "A Consistent Correction for Redlich-Kwong-Soave 

Volumes", Fluid Phase Equilibria, 8,7-23,(1982). 
  Ahmed, T. "Hydrocarbon Phase Behavior", Gulf Publishing Company, Houston, 

1989. 

B.2.3 Modified Peng-Robinson Equation of State 

B.2.3.1 Modified Peng-Robinson Symbol Table 

The symbol table for the Modified Peng-Robinson equation of state is shown in Table 
B-3. 

Table B-3 Modified Peng-Robinson Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

kij I - 0  1  

R - J/mol K 8.314    

P I Pa     

Pc I Pa     

T I K 40  1,000  

Tc I K 40  1,000  

V O cm3/mol     

y I - 0.0  1.0  

ω I - 0.0  3  

B.2.3.2 Equations 

The volume translated Peng-Robinson equation is: 
 

2 2 2(2 4 ) (2 )
RT aP

V b V b c V c b
= −

− + − + −
 

( eq.(1)) 
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Where: 

 

2 2 20.45724 1 ( )(1 )c
c r

c

R Ta a f T
P

α ω⎡ ⎤= = + −⎣ ⎦  
(PGL,Table3-5) 

0.3112
(2 )

c

c

RTb
u P

=
+

 
(  in the paragraph under 
eq.(2), ) 

2
4

uc b−
=  

(  in the paragraph under 
eq.(2), ) 

f ( ) . . .ω ω ω= + −0 37464 1 54226 0 26992 2  for 0 0 2≤ ≤ω .  

f ( ) . . . .ω ω ω ω= + − +0 37964 1 48503 0 16442 0 016672 3 for 0 2 2 0. .≤ ≤ω  
u = + +1 5251 1 1146 1 1538 2. . .ω ω  (  eq.B3 ) 
 
For mixture: 

 

(1 )m i j i j ij
i j

a y y a a k= −∑∑   

m i i
i

b y b= ∑   

m i i
i

c y c= ∑   

 
Generalized form of binary interaction parameter: 

 

2
0 1 2ij rj rjk T Tδ δ δ= + +  ( p.313,eq.6-76) 

 
For Nitrogen-Hydrocarbons: 

 

δ ω ω0
20 1751787 0 7043 0 862066= − −. . log . (log )j j  ( p.313,eq.6-76) 

δ ω ω1
20 584474 1 328 2 035767= − − +. . log . (log )j j  ( p.313,eq.6-77) 

δ ω ω

ω
2

2

3

2 257079 7 869765 1350466

8 3864

= + +

+

. . log . (log )

. (log )
j j

j

 
( p.313,eq.6-78) 

 
For Methane-Hydrocarbons: 

 

δ ω ω0
20 01664 0 37283 1 31757= − − +. . log . (log )j j  ( p.313,eq.6-80) 

δ ω ω1
20 48147 3 35342 1 0783= + −. . log . (log )j j  ( p.313,eq.6-81) 

δ ω ω2
20 4114 3 5072 0 78798= − − −. . log . (log )j j  ( p.313,eq.6-82) 

 
For CO2-Hydrocarbons: 

 

δ ω0 0 4025636 0 1748927= +. . log j  ( p.313,eq.6-83) 
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δ ω1 0 94812 0 6009864= − −. . log j  ( p.313,eq.6-84) 
δ ω2 0 741843368 0 441775= +. . log j  ( p.313,eq.6-85) 
 

  Sheng, W. and Lu, B. C.-Y. "A Modified Volume Translated Peng-Robinson 
Equation with Temperature Dependent Parameters", Fluid Phase Equilibria, 56, 71-
80,(1990). 

  Yu, J.M. and Lu, B. C.-Y., "A Three-parameter Cubic Equation of State for 
Asymmetric Mixture Density Calculations", Fluid Phase Equilibria, 31, 1-19, (1987). 

  Ahmed, T. "Hydrocarbon Phase Behavior", Gulf Publishing Company, Houston, 
1989. 

B.2.4 Lee-Kesler BWR Equation 

B.2.4.1 Lee-Kesler BWR Symbol Table 

The symbol table for the Lee-Kesler BWR equation is shown in Table B-4. 

Table B-4 Lee-Kesler BWR Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

R - J/mol K 8.314    

P I Pa 0 0   

Pc I Pa     

T I K 40  1,000  

Tc I K 40  1,000  

V O cm3/mol     

y I - 0.0  1.0  

Z O - 0.0  5  

ω I - 0.0  3  

ω(r) - - 0.3978    

The meaning of the symbols above are shown in Table B-5. 

Table B-5 Meaning of Symbols 

Symbol Description 
R Gas constant 

P Pressure 

Pc Critical pressure 

T Temperature 

Tc Critical temperature 

V Molar volume 

y Mole fraction 
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Symbol Description 
Z Compressibility factor 

ω Acentric factor 

ω(r) Acentric factor of reference fluid 

(0) Superscript represents simple fluid property 

(r) Superscript represents reference fluid property 

m Subscript represents mixture property 

i Component index 

B.2.4.2 Equations 

Lee and Kesler developed a modified BWR equation within the context of Pitzer's 
three-parameter correlation. The compressibility factor equation is simply as follows: 

Z Z Z Zr
r= + −( )

( )
( ) ( )( )0 0ω

ω
 (* eq.(2)) 

Where superscript (0) and (r) represent a simple fluid and a complex reference fluid 
respectively. The compressibility factors of both the simple and reference fluids have 
been represented by the following reduced form of a modified BWR equation of 
state: 
 

2
4

2 5 3 2 21 rV

r r r r r r

cB C DZ e
V V V T V V

γ
γβ

⎛ ⎞
−⎜ ⎟⎜ ⎟

⎝ ⎠⎛ ⎞
= + + + + +⎜ ⎟

⎝ ⎠
 

( eq.(3)) 

Where:  
B b b T b T b Tr r r= − − −1 2 3

2
4

3/ / /  ( eq.(4)) 

C c c T c Tr r= − +1 2 3
3/ /  ( eq.(5)) 

D d d Tr= +1 2 /  ( eq.(6)) 

T T
Tr

c

=  (  paragraph 1 left up 
corner page 513) 

V VP
RTr

c

c

=  (  paragraph 1 left up 
corner page 513) 

The equation details are shown below. 

Table B-6 Equation Details 

Constant Simple Reference Constant Simple Reference 
 Fluids Fluids  Fluids Fluids 

b1 0.1181193 0.2026579 c3 0.0 0.016901 

b2 0.265728 0.331511 c4 0.042724 0.041577 

b3 0.154790 0.027655 d1x104 0.155488 0.48736 
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Constant Simple Reference Constant Simple Reference 
b4 0.030323 0.203488 d2 x104 0.623689 0.0740336 

c1 0.0236744 0.0313385 β 0.65392 1.226 

c2 0.0186984 0.0503618 γ 0.060167 0.03754 

B.2.4.3 Mixing Rules 

Plocker, et al., suggested the following mixing rules for the Lee-Kesler BWR 
equation: 
 

T
V

y y V Tcm
cm

i
ji

j cij cij= ∑∑1
1 4

1 4
/

/  ( eq.(9)) 

(with *=1/4, PGL Table 4-3, page 84 )  
V y y Vcm i

ji
j cij= ∑∑  ( eq.(10)) 

ω ωm i
i

iy= ∑  ( eq.(11)) 

T T T kcij ci cj ij= ( ) /1 2  ( eq.(12)) 

V V Vcij ci cj= +
1
8

1 3 1 3 3( )/ /  ( eq.(13)) 

P RT Vcm m cm cm= −( . . ) /0 2905 0 085ω  ( eq.(14)) 

It is a reasonable assumption to let the binary interaction parameter kij = 1.0 for a 
PVT calculation. 

B.2.4.4 Restrictions and Uncertainties 

The Lee-Kesler BWR equation has been tested over a wide range in temperature 
and pressure. It can be used for polar and non-polar compounds. The general 
expectation of errors are around 1%. 

B.2.4.5 References 

The references used for the above equations are: 
  Lee, B.I. and Kesler, M.G. "A Generalized Thermodynamic Correlation Based on 

Three-Parameter Corresponding State", AIChE J. 21, 510-527. (1975). 
  Plocker, U, Knapp, H and Prausnitz, J.M. "Calculation of High-pressure Vapor-

Liquid Equilibria from a Corresponding-State Correlation with Emphasis on 
Asymmetric Mixtures", Ind.Eng. Chem. Process Des. Dev., 17,324-332,(1978). 

B.2.5 Thomson-Brobst-Hankinson Equations 

B.2.5.1 Thomson-Brobst-Hankinson Symbol Table 

The Thomson-Brobst-Hankinson symbol table is shown in Table B-7. 
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Table B-7 Thomson-Brobst-Hankinson Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

R - J/mol K 8.314    

P I Pa 0 0   

Pc I Pa     

T I K 40  1,000  

Tc I K 40  1,000  

V O cm3/mol     

Vs O cm3/mol     

y I - 0.0  1.0  

Z O - 0.0  5  

V* I L/mol 0.01  2.0  

ωSRK I - 0.0  3  

B.2.5.2 Equations 

Hankinson and Thomson present the following correlation for saturated densities of 
liquids: 
 

V
V

V Vs
R SRK R*
( ) ( )= −0 11 ω  (*eq.(16)) 

V a T b T c T d TR r r r r
( ) / / /( ) ( ) ( ) ( )0 1 3 2 3 4 31 1 1 1 1= + − + − + − + −  (*eq.(17)) 

V e fT gT hT TR r r r r
( ) / ( . )1 2 3 1 00001= + + + −  (*eq.(18)) 

 
a -1.52816 b 1.43907 
c -0.81446 d 0.190454 
c -0.81446 d 0.190454 
e -0.296123 f 0.386914 
g -0.0427258 h -0.0480645 

 
For compressed liquids:  

1 lns
vp

PV V c
P

β
β

⎛ ⎞+
= −⎜ ⎟⎜ ⎟+⎝ ⎠

 
( eq.(5)) 

β / ( ) ( ) ( ) ( )/ / /P a T b T d T e Tc r r r r= − + − + − + − + −1 1 1 1 11 3 2 3 4 3 ( eq.(6)) 

e f g hSRK SRK= + +exp( )ω ω2

 
( eq.(7)) 

c j k SRK= + ω  ( eq.(8)) 
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a -9.070217 b 62.45326 
d -135.1102 f 4.79594 
g 0.250047 h 1.14188 
j 0.0861488 k 0.0344483 

The mixing rules used for mixtures are: 

T
y y V T

Vcm

i j
j

ij cij
i

m

=
∑∑ *

*  

( eq.(19)) 

V T V T V Tij cij i ci j cj
* * * /( )= 1 2  ( eq.(20)) 

* * *2 /3 *1/31
4 3m i i i i i i

i i i
V yV yV yV

⎡ ⎤⎛ ⎞⎛ ⎞
= +⎢ ⎥⎜ ⎟⎜ ⎟

⎝ ⎠⎝ ⎠⎣ ⎦
∑ ∑ ∑  

( eq.(21)) 

 
And: 

 

ω ωSRKm i SRKi
i

y= ∑  ( eq.(24)) 

P Z RT Vcm cm cm m= ( ) / *  ( eq.(17)) 

Zcm SRKm= −0 291 0 080. . ω  ( eq.(18)) 

log ( ) ( )P P PRm Rm SRKm Rm= +0 1ω  ( eq.(19)) 

P TRm Rm
( ) . log .0 58031817 0 07608141= + α  ( eq.(20)) 

PRm
( ) .1 4 86601= β  ( eq.(21)) 

α = − − +35 0 36 0 96 736 6. . / . logT T TRm Rm Rm  ( eq.(22)) 

β α= +log .TRm 0 03721754  ( eq.(23)) 
 
Where: 

 

T T TRm cm= /   
 

  Hankinson, R.W. and Thomson, G.H. "A New Correlation for Saturated 
Densities of Liquids and Their Mixtures", AIChE J.,25,653-663,(1979). 

  Thomson, G.H., Brosbst, K.R. and Hankinson, R.W., "An Improved Correlation 
for Densities of Compressed Liquids and Liquid Mixtures", AIChE J., 28,671-
676,(1982). 

The substances dependent constant ωSRK and V* are given in Table 3-10, page 57-66 
of "The Properties of Gases and Liquids" for about 400 substances. 
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B.2.5.3 Restrictions and Uncertainties 

The Thomson-Brobst-Hankinson equation is only applicable to the liquid phase. It 
can be used for saturated liquids as well as compressed liquids. It also can be used 
for liquid mixtures. The expectation of error is normally less than 1%. 

It is not recommended for high asymmetric mixtures at high pressure. 

B.2.6 Modified Rackett Equation 

B.2.6.1 Modified Rackett Symbol Table 

The Modified Rackett equation symbol table is shown in Table B-8. 

Table B-8 Modified Rackett Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

R - J/mol K 8.314    

Pc I Pa     

T I K 40  1,000  

Tc I K 40  1,000  

Vs O cm3/mol     

y I - 0.0  1.0  

Vc I cm3/mol 0.01  2.0  

ZRA I - 0.15  .3  

ω I - 0.0  3  

B.2.6.2 Equations 

The Spencer and Danner modified Rackett equation is: 
 

V RT
P

Zs
c

c
RA

Tr= + −[ ( ) ]/1 1 2 7

 ( eq.(9)) 

 
Where ZRA is a substance dependent constant and can 
be estimated by: 

 

ZRA = −0 29056 0 08775. . ω  ( eq.(1)) 
 
The modified Rackett equation for mixtures at their 
bubble points is: 

 

2 / 7[1 (1 ) ]rTi ci
m RAm

i ci

y TV R Z
P

+ −⎛ ⎞
= ⎜ ⎟

⎝ ⎠
∑  

( eq.(10)) 
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Z y ZRAm i RAi
i

= ∑  ( eq.(11)) 

 
Where Tr

T
Tcm

=  and mixing rules for critical properties: 
 

T Tcm i
ji

j cij= ∑∑ φ φ  ( eq.(14)) 

φi
i ci

i ci
i

y V
y V

=
∑

 ( eq.(13)) 

T k T Tcij ij ci cj= −( )( ) /1 1 2 ( eq.(15)) 

1
8 1 2

1 3 1 3 3− =
+

k
V V

V Vij
ci cj

ci cj

( )
( )

/

/ /  
( eq.(16)) 

 
  Spencer, C.F. and Danner, R. "Prediction of Bubble-point Density of Mixtures", 

J. Chem. Eng. Data, 18, 230-234, (1973). 
  Yamada, T. and Gunn, R., "Saturated Liquid Molar Volumes. The Rackett 

Equation", J. Chem. Eng. Data, 18, 234-236,(1973). 

B.2.6.3 Restrictions and Uncertainties 

The modified (and the original) Rackett equation is only applicable to saturated liquid 
density. The expectation of error is normally less than 0.5% for pure fluids and 
around 2% for mixtures. 

B.2.7 Density Calculations 

B.2.7.1 Density Calculations Symbol Table 

The density calculations symbol table is shown in Table B-9. 

Table B-9 Density Calculations Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

MW I kg
kmole

 
0 < MW  500  

SG I - 0 < SG    

Z I - 0 < Z    

T I K 0 < T    

P I kPa 0 < P    

SGr I - 0 < SGr    

Zair I - 0 < Zair    

SGliq I - 0 < SGliq    
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Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

ρH2O I kg/m3 0 < ρH2O Default base density 999.01211 kg/m3 

ρ O kg/m3 0 < ρ    

B.2.7.2 Calculations 

Standard conditions are 15.6 oC and 101.325 kPa-abs (60 oF and 14.696 psia). 

B.2.7.2.1 Gas/Vapor Density 

B.2.7.2.1.1 Ideal Specific Gravity Method 

ρ  =   
3.483407 SG P

Z  T
 

B.2.7.2.1.2 Molecular Weight Method 

ρ  =   
MW P

8.31441 Z T
 

B.2.7.2.1.3 Real Specific Gravity Method 

ρ  =   
3.483407 SGr P

 Zair T
 

B.2.7.2.2 Liquid Density 

2SGliq H Oρ ρ= ×  

B.2.7.3 References 

"Flow Measurement Engineering Handbook", Second Edition, R.W. Miller, McGraw-
Hill, 1989. 

Perry's Chemical Engineering Handbook, Sixth Edition, page 3-75. 
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B.2.8 Specific Gravity Calculations 

B.2.8.1 Specific Gravity Calculations Symbol Table 

The specific gravity calculations symbol table is shown in Table B-10. 

Table B-10 Specific Gravity Calculations Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper Limit Upper 
Domain 

MW I kg
kmole

 
0 < MW    

MWair I kg
kmole

 
0 < MWair Default molecular weight is 28.96247 

kg/kmol 

Zgas I - 0 < Zgas    

Zair I - 0 < Zair    

ρliq I kg/m3 0 < ρliq    

ρbase I kg/m3 0 < ρbase    

ρH2O I kg/m3 0 < ρH2O Default base density 999.01211 kg/m3 

SGgasi O - SGgasi    

SGgasr O - SGgasr    

SGliqb O - SGliqb    

SGliq O - 0 < SGliq    

B.2.8.2 Calculations 

B.2.8.2.1 Gases/Vapors 

B.2.8.2.1.1 Ideal Specific Gravity 

igas
air

MWSG   =  
MW

 

B.2.8.2.1.2 Real Specific Gravity 

ir

gas
gas gas

air

Z
SG   =  SG    

Z
⎛ ⎞
⎜ ⎟
⎝ ⎠

 

B.2.8.3 Liquids 

B.2.8.3.1 Base Specific Gravity 

SG   =   liq
H O

b

base

2

ρ
ρ

⎛

⎝
⎜

⎞

⎠
⎟  
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B.2.8.3.2 Liquid Specific Gravity at Flowing Conditions 

SG   =   liq

ρ
ρH O2

⎛

⎝
⎜

⎞

⎠
⎟  

B.2.8.4 References 

AGA Report No.3 Orifice Metering of natural gas and other hydrocarbon fluids Part 3. 
Natural Gas Applications. Third Edition, August 1992. 

CRC Handbook of Chemistry and Physics, 64th Edition. CRC Press, 1982-84. Page 
F104.  

B.3 PVT Property-Specialized Methods 

B.3.1 Redlich-Kwong Equation with Wichert-Aziz Correction for 
Sour Natural Gases 

B.3.1.1 Redlich-Kwong Equation with Wichert-Aziz Correction Symbol Table 

The Redlich-Kwong equation, with Wichert-Aziz Correction, symbol table is shown in 
Table B-11. 

Table B-11 Redlich-Kwong Equation with Wichert-Aziz Correction Symbol 
Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper Limit Upper 
Domain 

A I - 0 ≤ A   A ≤ 1 

B I - 0 ≤ B   B ≤ 1 

ε - K 0 < ε    

Tci I K 0 < Tci    

Tci
' O K 0 ≤ Tci

'   Tci
' ≤ Tci 

Pci I bar 0 < Pci    

Pci' O bar 0 ≤ Pci'   Pci'
 ≤ Pci 

P I bar 0 ≤ P    

T I K 0 < T    

T ' O K 0 < T '    

B.3.1.2 Calculations 

The critical temperature and critical pressure for each component are adjusted in the 
following manner. 
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( ) ( )ε  =   15 A -  A  +  4.1666667 B  -  B2 1
2 2  (p. 51, eq. 74) 

′T   =   T   -   ci ci ε  (p. 51, eq. 75) 

′
′

P   =   
P  T

Tci
ci ci

ci
 

(p. 51, eq. 76) 

 
Where: 

• A is the mole fraction of carbon dioxide and hydrogen sulfide 
• B is the mole fraction of hydrogen sulfide 

For 0 <  P <  173bar T   =   T  +  1.94444444 
P

27.579
  -   0.0002103 P2⇒ ′

⎛
⎝
⎜

⎞
⎠
⎟  

 (p. 51, eq. 77) 

These values of ′Tci , ′Pci , and ′T  are used in the Redlich-Kwong equation of state to 
calculate the compressibility of a natural gas mixture. 

Note: The coefficients of the above equations have been converted to the SI unit 
system.  

B.3.1.3 Restriction and Uncertainty 

As reported in Wichert's thesis, the expected percent error of this method is around 
1% or less. It is only applicable for a sour natural gas system. 

B.3.1.4 References 

The acid gas corrections are taken from "Compressibility Factor of Sour Natural 
Gases", Edward Wichert, Thesis Submitted to the Faculty of Graduate Studies, 
Department of Chemical Engineering, University of Calgary, 1970. 

B.3.2 AGA 8 – 1985 Compressibility 

B.3.2.1 AGA 8 – 1985 Compressibility Symbol Table 

The AGA 8 – 1985 compressibility symbol table is shown in Table B-12. 

Table B-12 AGA 8 – 1985 Compressibility Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

P I Pa 0< P  P <_ 138x106  

R I kJ
kmol K⋅

 
8.31448    

T I K 0 < T 145 478  

d - kmol/m3 0 < d    



User Manual  B Fluid Property Calculation Methods 

 168  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Z O -     

Mr I kg/kmol 0 < Mr    

ρ O kg/m3     

Zb O - 0 < Zb    

Pb I Pa 0 < Pb    

Tb I K 0 < Tb    

Tci I oR 0 < Tci    

Fpv O - 0 < Fpv    

B - -     

C - -     

D - -     

E - -     

A1 - -     

A2 - -     

yi I - 0 ≤ yi   yi ≤ 1 

ak I -     

n I - 1 ≤ n    

wij I -     

εi I °R 0 < εi    

γi I - 0 < γi    

σi I ft
lbmol

3

3  
0 < σi    

vij I - 0 < vij    

uij I - 0 < uij    

Gr I - 0 < Gr    

HV I Btu/ft3 0 < HV    

yCO2 I - 0 ≤ yCO2   yCO2 ≤ 1 

yN2 I/O - 0 ≤ yN2   yN2 ≤ 1 

yCH4 I/O - 0 ≤ yCH4   yCH4 ≤ 1 

yC2H6 O - 0 ≤ yC2H6   yC2H6 ≤ 1 

yC3H8 O - 0 ≤ yC3H8   yC3H8 ≤ 1 

yn-C4H10 O - 0 ≤ yn-C4H10   yn-C4H10 ≤ 1 

yi-C4H10 O - 0 ≤ yi-C4H10   yi-C4H10 ≤ 1 

ySC5 O - 0 ≤ ySC5   ySC5 ≤ 1 

ySC6P O - 0 ≤ ySC6P   ySC6P ≤ 1 

ySDIL O - 0 ≤ ySDIL   ySDIL ≤ 1 
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The allowable composition range is shown below. 

Table B-13 Allowable Composition Range 

Component Mole Percent 
Allowed 

Methane 50 - 100% 

Nitrogen 0 - 50% 

Carbon Dioxide 0 - 50% 

Ethane 0 - 20% 

Propane 0 - 5% 

Butanes 0 - 3% 

Pentanes 0 - 2% 

Hexanes and heavier 0 - 1% 

H2O + H2S + H2 + O2 + He + Ar 0 - 1%  

B.3.2.2 AGA 8 Equation of State Parameters 

The AGA 8 generalized equation of state parameters are shown in Table B-14. 

Table B-14 Generalized Equation of State Parameters 

k ak k ak 
1 0.25837 15 21.35631 

2 7.04794 16 14.15528 

3 -19.53600 17 2.03047 

4 14.43903 18 9.96509 

5 -7.36355 19 4.55053 

6 -0.18877 20 6.51706 

7 0.03392 21 -12.33577 

8 -0.28112 22 -4.82222 

9 2.62998 23 12.22885 

10 1.88315 24 -16.83781 

11 -7.15823 25 0.55906 

12 0.05833 26 18.25211 

13 18.02809 27 11.79425 

14 -40.20412   

The characterization parameters for use in correlation are shown in Table B-15. 
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Table B-15 Characterization Parameters for Use in Correlation 

Compound Molar Mass Mr 
(lb/lb-mole) 

Energy 
Parameter 

ε (°R) 

Size Parameter 
σ (ft3/lbmole)1/3 

Orientation 
Parameter 

γ 
Nitrogen 28.0134 180.386 0.772480 0.0404 

Carbon Dioxide 44.0100 434.820 0.784121 0.1923 

Hydrogen Sulfide 34.0800 533.439 0.795372 0.1000 

Water 18.0153 925.228 0.658903 0.3440 

Helium 4.0026 7.418 0.663962 0.0000 

Methane 16.0430 272.373 0.798064 0.0115 

Ethane 30.0700 436.514 0.910959 0.0915 

Propane 44.0970 528.651 1.010207 0.1520 

n-Butane 58.1230 607.766 1.092139 0.1957 

i-Butane 58.1230 583.324 1.103425 0.1760 

n-Pentane 72.1500 671.381 1.170828 0.2637 

i-Pentane 72.1500 658.080 1.160552 0.2270 

n-Hexane 86.1770 725.117 1.229673 0.2988 

n-Heptane 100.2040 769.570 1.292305 0.3577 

n-Octane 114.2310 811.165 1.352288 0.4026 

n-Nonane 128.2580 849.815 1.404927 0.4342 

n-Decane 142.2850 879.774 1.444874 0.4980 

Oxygen 31.9988 220.980 0.721091 0.0210 

Carbon Monoxide 28.0100 189.963 0.780565 0.0402 

Hydrogen 2.0159 47.455 0.692463 0.0000 

The binary interaction parameter values for use in correlation are shown in Table 
B-16. 

Table B-16 Binary Interaction Parameter Values for Use in Correlation* 

Component Pair uij vij wij 
Methane-Ethane 1.0414 0.9982 1.0015 

Methane-Propane 1.0014 1.0041 0.9904 

Methane-i-Butane 1.0000 1.0000 0.9779 

Methane-n-Butane 1.0000 1.0000 0.9795 

Methane-i-Pentane 1.0000 1.0000 0.9691 

Methane-n-Pentane 1.0116 0.9738 0.9695 

Methane-n-Hexane 1.1028 0.9681 0.9561 

Methane-n-Heptane 0.9913 0.9793 0.9432 

Methane-n-Octane 0.9673 0.9790 0.9321 

Methane-n-Nonane 0.9433 0.9790 0.9205 
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Component Pair uij vij wij 
Methane-n-Decane 0.9193 0.9789 0.9084 

Carbon dioxide-Methane 0.9642 1.0253 0.9559 

Carbon dioxide-Ethane 0.8614 1.0159 0.9159 

Carbon dioxide-Propane 0.7957 1.0126 0.8935 

Carbon dioxide-i-Butane 1.0000 1.0000 0.8454 

Carbon dioxide-n-Butane 1.0000 1.0000 0.8517 

Carbon dioxide-i-Pentane 1.0000 1.0000 0.8115 

Carbon dioxide-n-Pentane 1.0000 1.0000 0.8131 

Carbon dioxide-n-Hexane 1.0000 1.0000 0.7620 

Carbon dioxide-n-Heptane 1.0000 1.0000 0.7124 

Carbon dioxide-n-Octane 1.0000 1.0000 0.6698 

Carbon dioxide-n-Nonane 1.0000 1.0000 0.6252 

Carbon dioxide-n-Decane 1.0000 1.0000 0.5786 

Nitrogen-Methane 0.9555 1.0166 0.9757 

Nitrogen-Ethane 1.0751 1.0118 0.9707 

Nitrogen-Propane 1.0000 1.0000 0.9416 

Nitrogen-i-Butane 1.0000 1.0000 0.9274 

Nitrogen-n-Butane 1.0000 1.0000 0.9297 

Nitrogen-i-Pentane 1.0000 1.0000 0.9155 

Nitrogen-n-Pentane 1.0000 1.0000 0.9161 

Nitrogen-n-Hexane 1.0000 1.0000 0.8981 

Nitrogen-n-Heptane 1.0000 1.0000 0.8806 

Nitrogen-n-Octane 1.0000 1.0000 0.8656 

Nitrogen-n-Nonane 1.0000 1.0000 0.8499 

Nitrogen-n-Decane 1.0000 1.0000 0.8335 

Nitrogen-Carbon dioxide 1.0102 1.0494 1.0096 

* For component pairs not shown in this table, use 1.0 for each binary interaction parameter value. 

B.3.2.3 AGA 8 Equation of State Calculations 

B.3.2.3.1 Supercompressibility Factor (§5.1) 

The supercompressibility factor, Fpv, is computed by: 

Fpv  =  ⎝
⎛

⎠
⎞Zb

Z

0.5

 
(p. 6, eq. 1) 

B.3.2.3.2 Compressibility Factor, Z (§5.1) 

The compressibility is determined from: 

Z =
PV

nR T
=

P
dR T

=
M P
 R T

r

ρ
 

(p. 7, eq. 2, eq.5, eq. 6) 
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B.3.2.3.3 Equation of State for Pressure (§5.3) 

When the system pressure, temperature, and composition are known, the molar 
density of the gas is determined from the equation: 

( )
2

2-A d2 3 4 6 3 2
1 2P=RTd+BRTd +CRTd +DRTd +ERTd + A RTd 1+A d e

⎡ ⎤
⎣ ⎦  

 (p. 9, eq. 8) 

B.3.2.3.4 The Coefficient B – The Second Virial Coefficient (§5.4) 

B y y Bi
j

n

i

n

j ij=
==

∑∑
11

 
(p. 9, eq. 9) 

( ) 33 5 71 11 2 4 2 22 2 2 2 2
1 2 3 4 5 6 7 8 20 21ij ij ij ij ij ij ij ij ij ij ij i jB a a t a t a t a t a t a t a t a t a tγ σ σ

− − −− −− − − −⎡ ⎤ ⎡ ⎤= + + + + + + + + + ⎣ ⎦⎢ ⎥⎣ ⎦
 (p. 9, eq. 10) 

The constant coefficients, ak, are given in Table B-14. 

The size parameters, σ, for twenty compounds are given in Table B-15. For other 
compounds the size parameter can be estimated using the following equation: 

σi
cid

3 0 3189
=

.  (p. 9, eq. 11) 

t
T
eij

ij

=  (p. 10, eq. 12) 

e wij ij i j= ε ε
1

2  (p. 10, eq. 13) 

The binary temperature interaction parameters, wij, for 36 binaries are given in Table 
B-16. For component pairs not shown in the table, use 1.0 for the binary interaction 
parameter. 

The characteristic energy parameters, εi, for twenty components are given in Table 
B-15. For other compounds, the characteristic energy parameter is estimated using 
the following relation: 

εi
ci =  

T
1.2593

 (p. 11, eq. 14) 

The binary orientation parameter, γij, is calculated using the following equation: 

( )ij i = 0.5 jγ γ γ+  (p. 11, eq. 15) 

The component orientation parameters, γi, for twenty components are given in Table 
B-15. For other compounds, the component orientation parameter is estimated as 
equal to the acentric factor. 
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For equations 9 through 15, the following applies to all doubly subscripted variables: 

B Bij ji=  

B.3.2.3.5 Mixture Size Parameter, σ 
1

6
6

1 1
ij

n n

i j
i j

y yσ σ
= =

⎡ ⎤
= ⎢ ⎥

⎣ ⎦
∑∑  

(p. 12, eq. 21) 

( )ij ij i jvσ σ σ=  (p. 12, eq. 22) 

B.3.2.3.6 Mixture Dimensionless Temperature, Tr 

T
T

r =
ε

 (p. 12, eq. 23) 

6 6

1 1
ij

n n

i j ij
i j

y yε σ ε σ−

= =

⎡ ⎤
= ⎢ ⎥

⎣ ⎦
∑∑  

(p. 12, eq. 24) 

( )ij ij i juε ε ε=  (p. 12, eq. 25) 

B.3.2.3.7 Mixture Orientation Parameter, γ 

3 3

1 1

n n

i j ij ij
i j

y yγ ε ε γ−

= =

⎡ ⎤
= ⎢ ⎥

⎣ ⎦
∑∑  

(p. 12, eq. 26) 

B.3.2.3.8 Coefficient C 

( )C a T a T a T a T a a Tr r r r r= + + + + +⎡
⎣⎢

⎤
⎦⎥

− − − − −
9

1
2

10
2

11

5
2

12
5

22 23
2 6γ σ (p. 12, eq. 16) 

B.3.2.3.9 Coefficient D 

D a T a T a T a T a Tr r r r r= + + + +⎛
⎝⎜

⎞
⎠⎟

⎡
⎣⎢

⎤
⎦⎥

− − − − −
13

1
2

14
1

15

3
2

24
2

25

5
2 9γ σ

(p. 12, eq. 17) 

B.3.2.3.10 Coefficient E 

( )1 3 1 15
16 17 26r r rE a T a T a Tγ σ− − −⎡ ⎤= + +⎣ ⎦  (p. 12, eq. 18) 

B.3.2.3.11 Coefficient A1 

( )3 3 6
1 18 27r rA a T a Tγ σ− −⎡ ⎤= +⎣ ⎦  (p. 12, eq. 19) 

B.3.2.3.12 Coefficient A2 

[ ] 6
2 19A a σ=  (p. 12, eq. 20) 



User Manual  B Fluid Property Calculation Methods 

 174  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

B.3.3 AGA 8 Gas Mixture Characterization 

For computation purposes, when determining the equation coefficients, the following 
properties may be assumed: 

Table B-17 Properties 

Pseudo-Component Composition (mole %) 
 ySDIL 100% helium 

 ySC5 50% normal pentane, 50% isopentane 

 ySC6P 85% normal hexane, 12% normal heptane, 3% normal octane 

B.3.3.1.1 The Gravity, Carbon Dioxide, Nitrogen Method (§5.6.2) 
 
yCH4 = 1.63289 - 1.1458 Gr + 0.13596 yCO2 - 0.59633 yN2 (p. 14, eq. 27) 
yC2H6 = -0.31521 + 0.5816 Gr - 0.60593 yCO2 - 0.24416 yN2 (p. 14, eq. 28) 
yC3H8 = -0.18262 + 0.3236 Gr - 0.30510 yCO2 - 0.09545 yN2 (p. 14, eq. 29) 
ynC4H10 = -0.05417 + 0.0954 Gr - 0.0892 yCO2 - 0.02983 yN2 (p. 14, eq. 30) 
yiC4H10 = -0.03223 + 0.0579 Gr - 0.05581 yCO2 - 0.02846 yN2 (p. 14, eq. 31) 
ySC5 = -0.02925 + 0.0520 Gr - 0.04805 yCO2 - 0.02169 yN2 (p. 14, eq. 32) 
ySC6P = -0.01503 + 0.0284 Gr - 0.02561 yCO2 - 0.02192 yN2 (p. 14, eq. 33) 
ySDIL = -0.00291 + 0.0044 Gr - 0.00408 yCO2 + 0.04479 yN2 (p. 14, eq. 34) 

B.3.3.1.2 The Gravity, Heating Value, Carbon Dioxide, Nitrogen Method (§5.6.2) 
 
yCH4 = 1.64569 - 1.0159 Gr - 0.00008368 HV - 0.07449 yCO2 - 
0.73631 yN2 

(p. 14 eq. 35) 

yC2H6 = -0.32750 + 0.4569 Gr + 0.0000803 HV - 0.40397 yCO2 - 
0.10982 yN2 

(p. 14 eq. 36) 

yC3H8 = -0.18843 + 0.2648 Gr + 0.00003790 HV - 0.20981 yCO2 
- 0.03213 yN2 

(p. 14 eq. 37) 

ynC4H10 =-0.05619 + 0.075 Gr + 0.00001313 HV - 0.05618 yCO2 
- 0.00789 yN2 

(p. 14 eq. 38) 
 

yiC4H10 = -0.03245 + 0.0557 Gr + 0.00000142 HV - 0.05224 
yCO2 - 0.02609 yN2 

(p. 14 eq. 39) 

ysC5 = -0.02958 + 0.0486 Gr + 0.0000022 HV - 0.04252 yCO2 - 
0.01802 yN2 

(p. 14 eq. 40) 

ySC6P = -0.0169 + 0.0094 Gr + 0.00001220 HV + 0.00506 yCO2 
- 0.00152 yN2 

(p. 14 eq. 41) 

ySDIL = 0.0122 + 0.1602 Gr - 0.00010008 HV - 0.25612 yCO2 - 
0.12296 yN2 

(p. 14 eq. 42) 

B.3.3.1.3 The Gravity, Heating Value, Carbon Dioxide Method (§5.6.2) 
 
yN2 = 0.08728 + 0.9272 Gr - 0.00059325 HV - 1.4984 yCO2 (p. 14, eq. 43) 
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yCH4 = 1.57921 - 1.7003 Gr + 0.000356 HV + 1.0272 yCO2 (p. 14, eq. 44) 
yC2H6 = -0.3272 + 0.3526 Gr + 0.00013769 HV - 0.2379 yCO2 (p. 14, eq. 45) 
yC3H8 = -0.19828 + 0.2379 Gr + 0.0000621 HV - 0.1579 yCO2 (p. 14, eq. 46) 
ynC4H10 = -0.06061 + 0.0692 Gr + 0.00002052 HV - 0.043 yCO2 (p. 14, eq. 47) 
yiC4H10 = -0.03237 + 0.0309 Gr + 0.00001499 HV - 0.0146 yCO2 (p. 14, eq. 48) 
ysC5 = -0.03174 + 0.0322 Gr + 0.00001324 Hv - 0.0158 yCO2 (p. 14, eq. 49) 
ySC6P = -0.01579 + 0.0073 Gr + 0.0000123 HV + 0.0058 yCO2 (p. 15, eq. 50) 
ySDIL = 0.00235 + 0.0468 Gr - 0.0000283 HV - 0.0735 yCO2 (p. 15, eq. 50) 

B.3.3.1.4 The Heating Value, Carbon Dioxide, Nitrogen Method (§5.6.2) 
 
yCH4 = 1.73734 - 0.00073023 HV - 1.7181 yCO2 - 1.8295 yN2 (p. 15, eq. 52) 
yC2H6 = -0.35947 + 0.00036249 HV + 0.3307 yCO2 + 0.3782 
yN2 

(p. 15, eq. 53) 

yC3H8 = -0.2203 + 0.00021399 HV + 0.226 yCO2 + 0.2552 yN2 (p. 15, eq. 54) 
ynC4H10 = -0.06702 + 0.00006469 HV + 0.0686 yCO2 + 0.0742 
yN2 

(p. 15, eq. 55) 

yiC4H10 = -0.03521 + 0.00003471 HV + 0.0353 yCO2 + 0.0331 
yN2 

(p. 15, eq. 56) 

ysC5 = -0.0347 + 0.00003377 HV + 0.0361 yCO2 + 0.0345 yN2 (p. 15, eq. 57) 
ySC6P = -0.01644 + 0.00001694 HV + 0.0175 yCO2 + 0.0078 
yN2 

(p. 15, eq. 58) 

ySDIL = -0.00175 + 0.00000135 HV + 0.0017 yCO2 + 0.0498 yN2 (p. 15, eq. 59) 

B.3.3.1.5 The Gravity, Methane, Carbon Dioxide, Nitrogen Method (§5.6.2) 
 
yC2H6 = 1.73468 - 0.85995 Gr - 1.2539 yCH4 - 0.42978 yCO2 - 
0.9886 yN2 

(p. 15, eq. 60) 

yC3H8 = 0.11444 + 0.12969 Gr - 0.1907 yCH4 - 0.3027 yCO2 - 
0.2283 yN2 

(p. 15, eq. 61) 

ynC4H10 = -0.21867 + 0.21578 Gr + 0.0977 yCH4 - 0.10984 
yCO2 + 0.02132 yN2 

(p. 15, eq. 62) 

yiC4H10 = -0.13919 + 0.12532 Gr + 0.0703 yCH4 - 0.05272 yCO2 
+ 0.02361 yN2 

(p. 15, eq. 63) 

ysC5 = -0.22604 + 0.18802 Gr + 0.1219 yCH4 - 0.06107 yCO2 + 
0.05276 yN2 

(p. 15, eq. 64) 

ySC6P = -0.11848 + 0.09655 Gr + 0.0658 yCH4 - 0.02962 yCO2 
+ 0.02376 yN2 

(p. 15, eq. 65) 

ySDIL = 0.06180 - 0.04167 Gr - 0.0394 yCH4 + 0.00265 yCO2 + 
0.02480 yN2 

(p. 15, eq. 66) 
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B.3.3.2 Restriction and Uncertainty 

This method is only applicable to the gas phase of natural gas systems. For the 
applicable composition range please refer to the table following the symbol table. 
The applicable pressure and temperature ranges are given in the symbol table. 

The uncertainties in the computed compressibility factor for most natural gases at 
typical pipeline conditions are expected to be less than 0.1% on the average, 
provided the composition of the natural gas is known accurately. Uncertainty in the 
computed compressibility factor is expected to exceed 0.1% at a pressure higher 
than 500 psia (35 bar) or the natural gas composition is not accurately known. The 
uncertainty in the computed supercompressibility factor is about 0.7%, on average. 

B.3.3.3 Reference 

AGA Transmission Measurement Committee Report No.8, Compressibility and 
Supercompressibility for Natural Gas and other Hydrocarbon Gases., December 
1985. 

B.3.4 AGA 8-1992 Compressibility 

B.3.4.1.1 AGA 8-1992 Compressibility Symbol Table 

The AGA 8-1992 compressibility symbol table is shown in Table B-18. 

Table B-18 AGA 8 – 1992 Compressibility Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

B -      

Bmix -      

Bij -      

Cijk -      

Cmix -      

C*n -      

d -      

D -      

F -      

Fpv O - 0< Fpv    

G -      

Gr I - 0< Gr    

HCH O MJ/mol     

HN° O MJ/mol     

HV I Btu/ft3 0<HV    

K - -     



B Fluid Property Calculation Methods  User Manual 

 177  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Mr I kg/kmol 0<Mr    

Mr(air) I kg/kmol 0<Mr    

N I - 1   18 

P I Pa 0<P  P≤280×106  

Q - -     

R 8.3145 kJ/kmol K     

U - -     

V° - -     

xi I - 0≤xi   xi≤1 

Z O -     

Zair - - 0   5 

Zh - -     

ρ O kg/m3 0    

ρair O kg/m3 0    

The symbols used above are described in Table B-19. 

Table B-19 Symbol Descriptions 

Symbol Meaning 
B second virial coefficient 

Bmix second virial coefficient for the mixture 

Bij the individual component interaction second 
virial coefficient 

Cijk the individual component interaction third virial 
coefficient 

Cmix third virial coefficient for the mixture 

C*n coefficients which are functions of composition 

d molar density of gas 

D reduced density of gas 

F mixture high temperature parameter 

Fpv supercompressibility factor 

G mixture orientation parameter 

Gr relative density of gas mixture  

HCH molar gross heating value of the equivalent 
hydrocarbon 

HN° molar ideal gross heating value 

HV volumetric gross heating value 

K mixture size parameter 

Mr molar mass for the gas mixture 
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Symbol Meaning 
Mr(air) molar mass of air 

N number of components in gas mixture 

P absolute pressure 

Q mixture quadruple parameter 

R gas constant 

T absolute temperature 

U mixture energy parameter 

V° the ideal gas specific volume 

xi mole fraction of gas component i 

Z compressibility factor of gas mixture 

Zair compressibility factor of air 

Zh Compressibility factor at 60 °F, 14.73 psia 

ρ mass density of gas mixture  

ρair mass density of air 

Pgr reference pressure for relative density 

Tgr reference temperature for relative density 

Td, Pd, Th, Ph reference conditions 

B.3.4.2 AGA 8 Equation of State Calculations 

B.3.4.2.1 The Supercompressibility Factor, Fpv 

( )0.5h
pv

ZF
Z

=  
(p.11,eq.8) 

B.3.4.2.2 Relative Density Reference Condition 

The gas relative density (specific gravity) at the reference condition Tgr, Pgr is defined 
by the relation: 

G T P
T P

air T Pr gr gr
gr gr

gr gr

( , )
( , )

( , , )
=

ρ
ρ

 
(p.12,eq.9) 

Using the mass density of both the gas mixture and air, the following relation exists: 

G T P
M Z air T P
M air Z T Pr gr gr

r gr gr

r gr gr

( , )
( , , )

( ) ( , )
=  

(p.12,eq.10) 

B.3.4.2.3 Heating Value Reference Condition 

The volumetric gross heating value is the product of the molar ideal gross heating 
value and the molar density of the gas mixture: 

HV T P T P HN T P d T Ph h d d h h d d( , , , ) ( , ) ( , )= o  (p.13,eq.11) 
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B.3.4.2.4 Detail Characterization Method 

The equation of state: 

18 58
* *

3
13 13

1 ( ) exp( )n n n n n
n n n n n n

n n

DB u u k b kZ D C C b c k cT T D D DK
− −

= =

= + − + − −∑ ∑  

 (p.17,eq.12) 

Where: 
D K d= 3  (p.18,eq.13) 

And:  

5
2

2 51
5 5 2

1 1 1
2 ( 1)( )

N N N

i i i j ij i j
i i j i

K x K x x K K K
−

= = = +

⎡ ⎤
= + −⎢ ⎥

⎣ ⎦
∑ ∑ ∑  

(p.18,eq.14) 

Second virial coefficient B: 

B a T x x E K K Bn
n

u
i

j

N

i

N

j ij
u

i j nij
n n=

=

−

==
∑ ∑∑

1

18

11

3
2( ) *  

(p.18,eq.15) 

B G g Q Q q F F f S S S W W Wnij ij n
g

i j n
q

i j n
f

i j n
S

i j n
Wn n n n n* ( ) ( ) ( ) ( ) ( )= + − + − + − + − + −1 1 1 1 1

1
2

1
2

 
 (p.18,eq.16) 

With: 

E E E Eij ij i j= * ( )
1
2  

(p.19,eq.17) 

And: 

G
G G G

ij
ij i j=

+* ( )
2

 
(p.19,eq.18) 

The coefficients C*n (n=13 to 58) are given by the equation: 
C a G g Q q F f Un n n

g
n

q
n

f un n n n* ( ) ( ) ( )= + − + − + −1 1 12  (p.20,eq.19) 
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The mixture parameters U, G, Q, and F are calculated using the following equations, 
where in the double sums, i ranges from 1 to N-1 and, for each value of i, j ranges 
from i+1 to N: 

2 5155 5 22

1 1 1
2 ( 1)( )

N N N

i i ji i j ij
i i j i

U x x x UE E E
−

= = = +

⎡ ⎤
= + −⎢ ⎥

⎣ ⎦
∑ ∑ ∑  

(p.20,eq.20) 

G i
i

N

i i
j i

N

i

N

j ij i jx G x x G G G= + − +
= = +=

−

∑ ∑∑
1 11

1

1( )( )*  
(p.20,eq.21) 

Q i
i

N

ix Q=
=
∑

1

 
(p.20,eq.22) 

F i
i

N

ix F=
=
∑ 2

1

 
(p.20,eq.23) 

B.3.4.2.4.1 Detail Characterization Method Equation of State Parameters 

The following table shows the detail characterization method equation of state 
parameters. 

Table B-20 (AGA 8, 1992, p.22-23, Table 4) 

n an bn cn kn un gn qn fn sn wn 
1 0.153832600 1 0 0 0.0 0 0 0 0 0 

2 1.341953000 1 0 0 0.5 0 0 0 0 0 

3 -2.998583000 1 0 0 1.0 0 0 0 0 0 

4 -0.048312280 1 0 0 3.5 0 0 0 0 0 

5 0.375796500 1 0 0 -0.5 1 0 0 0 0 

6 -1.589575000 1 0 0 4.5 1 0 0 0 0 

7 -0.053588470 1 0 0 0.5 0 1 0 0 0 

8 0.886594300 1 0 0 7.5 0 0 0 1 0 

9 -0.710237000 1 0 0 9.5 0 0 0 1 0 

10 -1.471722000 1 0 0 6.0 0 0 0 0 1 

11 1.321850000 1 0 0 12.0 0 0 0 0 1 

12 -0.786659300 1 0 0 12.5 0 0 0 0 1 

13 2.291290E-09 1 1 3 -6.0 0 0 1 0 0 

14 0.157672400 1 1 2 2.0 0 0 0 0 0 

15 -0.436386400 1 1 2 3.0 0 0 0 0 0 

16 -0.044081590 1 1 2 2.0 0 1 0 0 0 

17 -0.003433888 1 1 4 2.0 0 0 0 0 0 

18 0.032059050 1 1 4 11.0 0 0 0 0 0 

19 0.024873550 2 0 0 -0.5 0 0 0 0 0 

20 0.073322790 2 0 0 0.5 0 0 0 0 0 

21 -0.001600573 2 1 2 0.0 0 0 0 0 0 
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n an bn cn kn un gn qn fn sn wn 
22 0.642470600 2 1 2 4.0 0 0 0 0 0 

23 -0.416260100 2 1 2 6.0 0 0 0 0 0 

24 -0.066899570 2 1 4 21.0 0 0 0 0 0 

25 0.279179500 2 1 4 23.0 1 0 0 0 0 

26 -0.696605100 2 1 4 22.0 0 1 0 0 0 

27 -0.002860589 2 1 4 -1.0 0 0 1 0 0 

28 -0.008098836 3 0 0 -0.5 0 1 0 0 0 

29 3.150547000 3 1 1 7.0 1 0 0 0 0 

30 0.007224479 3 1 1 -1.0 0 0 1 0 0 

31 -0.705752900 3 1 2 6.0 0 0 0 0 0 

32 0.534979200 3 1 2 4.0 1 0 0 0 0 

33 -0.079314910 3 1 3 1.0 1 0 0 0 0 

34 -1.418465000 3 1 3 9.0 1 0 0 0 0 

35 -5.99905E-17 3 1 4 -13.0 0 0 1 0 0 

36 0.105840200 3 1 4 21.0 0 0 0 0 0 

37 0.034317290 3 1 4 8.0 0 1 0 0 0 

38 -0.007022847 4 0 0 -0.5 0 0 0 0 0 

39 0.024955870 4 0 0 0.0 0 0 0 0 0 

40 0.042968180 4 1 2 2.0 0 0 0 0 0 

41 0.746545300 4 1 2 7.0 0 0 0 0 0 

42 -0.291961300 4 1 2 9.0 0 1 0 0 0 

43 7.294616000 4 1 4 22.0 0 0 0 0 0 

44 -9.936757000 4 1 4 23.0 0 0 0 0 0 

45 -0.005399808 5 0 0 1.0 0 0 0 0 0 

46 -0.243256700 5 1 2 9.0 0 0 0 0 0 

47 0.049870160 5 1 2 3.0 0 1 0 0 0 

48 0.003733797 5 1 4 8.0 0 0 0 0 0 

49 1.874951000 5 1 4 23.0 0 1 0 0 0 

50 0.002168144 6 0 0 1.5 0 0 0 0 0 

51 -0.658716400 6 1 2 5.0 1 0 0 0 0 

52 0.000205518 7 0 0 -0.5 0 1 0 0 0 

53 0.009776195 7 1 2 4.0 0 0 0 0 0 

54 -0.020487080 8 1 1 7.0 1 0 0 0 0 

55 0.015573220 8 1 2 3.0 0 0 0 0 0 

56 0.006862415 8 1 2 0.0 1 0 0 0 0 

57 -0.001226752 9 1 2 1.0 0 0 0 0 0 

58 0.002850908 9 1 2 0.0 0 1 0 0 0 
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B.3.4.2.4.2 Characterization Parameters for Use in the Detail Characterization Method 

The following table shows the characterization parameters for use in the detail 
characterization method. 

Table B-21 (AGA8, 1992, p.24,Table 5) 

CID Compound Molar  
Mass Mr 

Energy  
Parameter 

E (K) 

Size 
Parameter 
K(m3/kg-
mole)1/3 

Orientation 
Param. G 

Quadrupole 
Param. Q 

High  
Temp.  

Param. F 

Dipole  
Param. S 

Ass.  
Param. 

W 

1 Methane 16.0430 151.318300 0.4619255 0.0 0.0 0.0 0.0 0.0 

2 Nitrogen 28.0135 99.737780 0.4479153 0.027815 0.0 0.0 0.0 0.0 

3 Carbon 
Dioxide 

44.0100 241.960600 0.4557489 0.189065 0.690000 0.0 0.0 0.0 

4 Ethane 30.0700 244.166700 0.5279209 0.079300 0.0 0.0 0.0 0.0 

5 Propane 44.0970 298.118300 0.5837490 0.141239 0.0 0.0 0.0 0.0 

6 Water 18.0153 514.015600 0.3825868 0.332500 1.067750 0.0 1.582200 1.0 

7 Hydrogen 
Sulfide 

34.0820 296.355000 0.4618263 0.088500 0.633276 0.0 0.390000 0.0 

8 Hydrogen 2.0159 26.957940 0.3514916 0.034369 0.0 1.0 0.0 0.0 

9 Carbon 
Monoxide 

28.0100 105.534800 0.4533894 0.038953 0.0 0.0 0.0 0.0 

10 Oxygen 31.9988 122.766700 0.4186954 0.021000 0.0 0.0 0.0 0.0 

11 i-Butane 58.1230 324.068900 0.6406937 0.256692 0.0 0.0 0.0 0.0 

12 n-Butane 58.1230 337.638900 0.6341423 0.281835 0.0 0.0 0.0 0.0 

13 i-Pentane 72.1500 365.599900 0.6738577 0.332267 0.0 0.0 0.0 0.0 

14 n-Pentane 72.1500 370.682300 0.6798307 0.366911 0.0 0.0 0.0 0.0 

15 n-Hexane 86.1770 402.636293 0.7175118 0.289731 0.0 0.0 0.0 0.0 

16 n-Heptane 100.2040 427.722630 0.7525189 0.337542 0.0 0.0 0.0 0.0 

17 n-Octane 114.2310 450.325022 0.7849550 0.383381 0.0 0.0 0.0 0.0 

18 n-Nonane 128.2580 470.840891 0.8152731 0.427354 0.0 0.0 0.0 0.0 

19 n-Decane 142.2850 489.558373 0.8437826 0.469659 0.0 0.0 0.0 0.0 

20 Helium 4.0026 2.610111 0.3589888 0.0 0.0 0.0 0.0 0.0 

21 Argon 39.9480 119.629900 0.4216551 0.0 0.0 0.0 0.0 0.0 

B.3.4.2.4.3 Binary Interaction Parameter Values for Use in the Detail Characterization 
Method 

The following table shows the binary interaction parameter values for use in the 
detail characterization method. 
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Table B-22 (AGA8 -1992, p25-26, Table 6) 

CID 
(i) 

CID 
(j) 

Component Pair E*ij Uij Kij G*ij 

1 2 Methane Nitrogen 0.971640 0.886106 1.003630  

 3  Carbon 
Dioxide 

0.960644 0.963827 0.995933 0.807653 

 4  Ethane     

 5  Propane 0.994635 0.990877 1.007619  

 6  Water 0.708218    

 7  Hydrogen 
Sulfide 

0.931484 0.736833 1.000080  

 8  Hydrogen 1.170520 1.156390 1.023260 1.957310 

 9  Carbon 
Monoxide 

0.990126    

 10  Oxygen     

 11  i-Butane 1.019530    

 12  n-Butane 0.989844 0.992291 0.997596  

 13  i-Pentane 1.002350    

 14  n-Pentane 0.999268 1.003670 1.002529  

 15  n-Hexane 1.107274 1.302576 0.982962  

 16  n-
Heptane 

0.880880 1.191904 0.983565  

 17  n-Octane 0.880973 1.205769 0.982707  

 18  n-Nonane 0.881067 1.219634 0.981849  

 19  n-Decane 0.881161 1.233498 0.980991  

2 3 Nitrogen Carbon 
Dioxide 

1.022740 0.835058 0.982361 0.982746 

 4  Ethane 0.970120 0.816431 1.007960  

 5  Propane 0.945939 0.915502   

 6  Water 0.746954    

 7  Hydrogen 
Sulfide 

0.902271 0.993476 0.942596  

 8  Hydrogen 1.086320 0.408838 1.032270  

 9  Carbon 
Monoxide 

1.005710    

 10  Oxygen 1.021000    

 11  i-Butane 0.946914    

 12  n-Butane 0.973384 0.993556   

 13  i-Pentane 0.959340    

 14  n-Pentane 0.945520    

3 4 Carbon  
Dioxide 

Ethane 0.925053 0.969870 1.008510 0.370296 
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CID 
(i) 

CID 
(j) 

Component Pair E*ij Uij Kij G*ij 

 5  Propane 0.960237    

 6  Water 0.849408   1.673090 

 7  Hydrogen 
Sulfide 

0.955052 1.045290 1.007790  

 8  Hydrogen 1.281790    

 9  Carbon 
Monoxide 

1.500000 0.900000   

 10  Oxygen     

 11  i-Butane 0.906849    

 12  n-Butane 0.897362    

 13  i-Pentane 0.726255    

 14  n-Pentane 0.859764    

 15  n-Hexane 0.855134 1.066638 0.910183  

 16  n-
Heptane 

0.831229 1.077634 0.895362  

 17  n-Octane 0.808310 1.088178 0.881152  

 18  n-Nonane 0.786323 1.098291 0.867520  

 19  n-Decane 0.765171 1.108021 0.854406  

4 5 Ethane Propane 1.022560 1.065173 0.986893  

 6  Water 0.693168    

 7  Hydrogen 
Sulfide 

0.946871 0.971926 0.999969  

 8  Hydrogen 1.164460 1.616660 1.020340  

 9  Carbon 
Monoxide 

    

 10  Oxygen     

 11  i-Butane  1.250000   

 12  n-Butane 1.013060 1.250000   

 13  i-Pentane  1.250000   

 14  n-Pentane 1.005320 1.250000   

5 8 Propane Hydrogen 1.034787    

 12  n-Butane 1.004900    

7 15 Hydrogen 
Sulfide 

n-Hexane 1.008692 1.028973 0.968130  

 16  n-
Heptane 

1.010126 1.033754 0.962870  

 17  n-Octane 1.011501 1.038338 0.957828  

 18  n-Nonane 1.012821 1.042735 0.952441  

 19  n-Decane 1.014089 1.046966 0.948338  

8 9 Hydrogen Carbon 
Monoxide 

1.100000    
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CID 
(i) 

CID 
(j) 

Component Pair E*ij Uij Kij G*ij 

 10  Oxygen     

 11  i-Butane 1.300000    

 12  n-Butane 1.300000    

B.3.4.2.5 Gross Characterization Method 

The SGERG model expresses the compressibility factor in terms of the molar density 
(d), the mixture's second virial coefficient (Bmix), and the mixture's third virial 
coefficient (Cmix): 
 

Z dmix mixB C d= + +1 2  (p.29,eq.25) 

mix ij
j

N

i

N

i jB B x x=
==

∑∑
11

 
(p.29,eq.26) 

And:  

mix ijk
k

N

j

N

i

N

i j kC C x x x=
===

∑∑∑
111

 
(p.29,eq.27) 

mix CO CO CO N N N CH CH CH

CO N CO N CO CH CO CH N CH N

B B x B x B x
B x x B x x B x

= + +

+ + +
− − −

− − −

2 2 2 2 2 2

2 2 2 2 2 2 2 2

2 2 2

2 2 2
 

(p.30,eq.28) 

mix CO CO CO CO N N N N CH CH CH CH

CO CO N CO N CO CO CH CO CH

CO N N N CO CO CH CH CH CO

N N CH N CH N CH CH CH N

CO N CH CO N CH

C C x C x C x
C x x C x x
C x x C x x
C x x C x x
C x x x

= + +

+ +

+ +

+ +

+

− − − − − −

− − − −

− − − −

− − − −

− −

2 2 2 2 2 2 2 2

2 2 2 2 2 2 2 2

2 2 2 2 2 2 2

2 2 2 2 2

2 2 2 2

3 3 3

2 2

2 2

2 2

3 3

3 3

3 3

6

(p.30,eq.29) 

B.3.4.2.5.1 Interaction Virial Coefficient Terms for Nitrogen and Carbon Dioxide 

The Bij values for the terms involving only nitrogen and carbon dioxide are expressed 
in (dm3/mol) and are given by: 
 

ijB b b b TT= + +0 1 2
2 (p.30,eq.30) 

Similarly, Cijk values for the terms involving only nitrogen and carbon dioxide are 
expressed in (dm6/mol2) and are given by: 
 

ijkC c c c TT= + +0 1 2
2  (p.30,eq.31) 
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B.3.4.2.5.2 Interaction Virial Coefficient Terms for Nitrogen and Carbon Dioxide 

The following table shows the interaction virial coefficient terms for nitrogen and 
carbon dioxide. 

Table B-23 (AGA 8-1992, p.31,Table 7) 

Fluid for Bij b0(dm3/mol) b1(dm3/mol K) b2(dm3/mol K2) 
N2-N2 -0.144600 0.740910*10-3 -0.911950*10-6 

CO2-CO2 -0.868340 0.403760*10-2 -0.516570*10-5 

N2-CO2 -0.339693 0.161176*10-2 -0.204429*10-5 

Fluid for Cijk c0(dm6/mol2) c1(dm6/mol2 K) c2(dm6/mol2 K2) 
N2-N2-N2 0.784980*10-2 -0.398950*10-4 0.611870*10-7 

CO2-CO2-CO2 0.205130*10-2 0.348880*10-4 -0.837030*10-7 

N2-N2-CO2 0.552066*10-2 -0.168609*10-4 0.157169*10-7 

N2-CO2-CO2 0.358783*10-2 0.806674*10-5 -0.325798*10-7 

B.3.4.2.5.3 Interaction Virial Coefficient Terms for the Equivalent Hydrocarbon, CH 

The equation for the second and third interaction virial coefficients for the equivalent 
hydrocarbon are: 
 

CH CH CH CHB B B H B H− = + +0 1 2
2  (p.31,eq.32) 

 

CH CH CH CH CHC C C H C H− − = + +0 1 2
2  (p.31,eq.33) 

B0, B1, B2, C0, C1 and C2, are temperature dependent functions defined as: 

iB ib ib T ib T= + +0 1 2 2   i = 0 1 2, ,  (p.31,eq.34) 

And: 

iC iC iC T iC T= + +0 1 2 2 i = 0 1 2, ,  (p.32,eq.35) 

B.3.4.2.5.4 Virial Coefficient Terms for the Equivalent Hydrocarbon 

The following table shows the virial coefficient terms for the equivalent hydrocarbon. 

Table B-24 (p.32,Table 8) 

 i bi0 bi1 bi2 
B0 (dm3/mol) 0 -0.425468 0.286500*10-2 -0.462073*10-5 

B1 (dm3/kJ) 1 0.877118*10-3 -0.556281*10-5 0.881510*10-8 

B2 (dm3 mol/kJ2) 2 -0.824747*10-6 0.431436*10-8 -0.608319*10-11 
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 i ci0 ci1 ci2 
C0 (dm6/mol2) 0 -0.302488 0.195861*10-2 -0.316302*10-5 

C1 (dm6/mol-kJ) 1 0.646422*10-3 -0.422876*10-5 0.688157*10-8 

C2 (dm6/kJ2) 2 -0.332805*10-6 0.223160*10-8 -0.367713*10-11 

 

N CH
N N CH CHB B BT

2

2 20 72 1 875 10 320
2

5 2
−

− − −= + × −
+

( . . ( ) )
( ) (p.32,eq.36) 

CO CH CO CO CH CHB B B2 2 2
0 865

1
2

− − −= − . ( )  
(p.32,eq.37) 

N CH CH CH CH CH N N NC C CT
2 2 2 2

0 92 0 0013 270 2
1
3

− − − − − −= + −( . . ( ))( )
(p.32,eq.38) 

N N CH N N N CH CH CHC C CT
2 2 2 2 2

0 92 0 0013 270 2
1
3

− − − − − −= + −( . . ( ))( )
(p.33,eq.39) 

CO CH CH CH CH CH CO CO COC C C2 2 2 2
0 92 2

1
3

− − − − − −= . ( )  
(p.33,eq.40) 

CO CO CH CO CO CO CH CH CHC C C2 2 2 2 2
0 92 2

1
3

− − − − − −= . ( )  
(p.33,eq.41) 

CH N CO CH CH CH N N N CO CO COC C C C− − − − − − − −=
2 2 2 2 2 2 2 2

1 10
1
3. ( )  

(p.33,eq.42) 

Pressure can be obtained through P ZRTd=  as: 

P dRT mixB d mixC d= + +( )1 2  (P.33,EQ.43) 

There are two methods used to calculate the Molar Gross Heating Value of the 
Equivalent Hydrocarbon (Hch). 

B.3.4.2.6 Method 1. Input Parameters: Volumetric Gross Heating Value, Relative Density, 
Mole Fraction CO2 

Figure B.2-1 (p.85) outlines the procedures for calculating the molar gross heating 
value of the equivalent hydrocarbon, HCH, and the nitrogen mole fraction, xN2, based 
on the inputs of volumetric gross heating value, relative density, and mole fraction of 
carbon dioxide.  

The compressibility Z0 is initially set to 1. The mole ideal gross heating value is: 
 
HN HVZ RT P0 0 0 0= /  (p.84,B.2-1) 

The molar mass (molecular weight), Mr, of the mixture is:  
M G K MP Z V dr r a air= ( . , . )273 15 0 101325 o o o  (p.86,B.2-2) 
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The mole fraction of the equivalent hydrocarbon is: 

x
M G HN M x M x M

G MCH
r r N CO r N CO r CO

r N

=
− − + −

−
2

1

2 2 2 2 2

2

o
( ) ( ) ( )

( )

 
(p.86,B.2-3) 

The mole fraction of nitrogen is: 
x x xN CH CO2 21= − −  (p.86,B.2-4) 
The molar gross heating value of the equivalent 
hydrocarbon is: 

H HN
xCH

CH

=
o

 

 
 
 
(p.86,B.2-5) 

And the molar mass (molecular weight) of the equivalent hydrocarbon is: 
M G G Hr CH CH( ) = +1 2  (p.86,B.2-6) 

BCH-CH is calculated by: 

CH CH CH CHB B B H B H− = + +0 1 2
2  (p.31,eq.32) 

And Bmix is calculated by: 

mix CO CO CO N N N CH CH CH

CO N CO N CO CH CO CH N CH N

B B x B x B x
B x x B x x B x x

= + +

+ + +
− − −

− − −

2 2 2 2 2 2

2 2 2 2 2 2 2 2

2 2 2

2 2 2
 

(p.30,eq.28) 

The compressibility factor is then updated: 

Z B P
RTnew
mixo

o

o
= +1  

(p.86,B.2-7) 

The calculation procedure is iterative.  

B.3.4.2.7 Method 2. Input Parameters: Relative Density, Mole Fractions of N2 and CO2 

Figure B.2-2 outlines the procedure for calculating the heating value of the equivalent 
hydrocarbon, HCH, based on inputs of relative density at 0°C and 0.101325 MPa and 
the mole fractions of N2 and CO2. In this method the mole fraction of the equivalent 
hydrocarbon is determined by: 

x x xCH N CO= − −1 2 2 (p.87,B.2-8) 

The value of BCH-CH at 0°C and 0.101325 MPa is determined as follows:  

Using an initial estimate of -0.065 dm3/mol for BCH-CH, Bmix at 0°C and 0.101325 MPa 
is calculated using following equations: 

mix CO CO CO N N N CH CH CH

CO N CO N CO CH CO CH N CH N CH

B B x B x B x
B x x B x x B x x

= + +

+ + +
− − −

− − −

2 2 2 2 2 2

2 2 2 2 2 2 2 2

2 2 2

2 2 2

(p.30,eq.28) 
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ijB b b b TT= + +0 1 2
2 (p.30,eq.30) 

N CH
N N CH CHB B BT

2

2 20 72 1 875 10 320
2

5 2
−

− − −= + × −
+

( . . ( ) )
( ) (p.32,eq.36) 

CO CH CO CO CH CHB B B2 2 2
0 865

1
2

− − −= − . ( )  
(p.32,eq.37) 

  

Next, the reference volume at 0°C and 0.101325 MPa is estimated as: 
V Bmix

o = +22 414097.  (p.87,B.2-9) 

The molar mass (molecular weight) of the equivalent hydrocarbon is: 

M
V d G x M x M

xr CH
air r N r N CO r CO

CH
( )

( ) ( )=
− −o o

2 2 2 2  
(p.87,eq.B.2-10) 

From Mr(CH), a new estimation of BCH-CH is obtained by: 
B MCH CH r CH− = −0 0838137 0 00851644. . ( )  (p.87,B.2-11) 

Once Mr(CH) is known, the molar ideal gross heating value of the equivalent 
hydrocarbon is determined by: 

H dCH CH= +134 2153 1067 943. .  (p.87,B.2-12) 

Where: 
d M BCH r CH CH CH= + −( ) / ( . )22 710811  (p.89,B.2-13) 

B.3.4.2.8 Molar Heating Value From Composition 

The molar ideal gross heating value of the “ith” component at the reference condition 
Th,Ph is given by the following relation: 
HN T P SC HF T Pi h h i k k h h

k

0 0( , ) ( , ),= −∑  (p.136,C.4-5) 

Stoichiometric coefficients for complete oxidation and molar ideal gross heating 
value at 25°C, 0.101325MPa. 

Table B-25 (AGA8-1992, p.137, Table C.4-1) 

Specific Stoichiometric Coefficient, SCi,k Ideal Molar 
Gross 

Heating 
Value 

Compound 

Compound Oxygen Water Carbon 
Dioxide 

Sulfur 
Dioxide 

kJ/mol* 

Methane -1 -2 2 1 0 890.63 

Ethane -1 -3.5 3 2 0 1,560.69 

Propane -1 -5 4 3 0 2,219.17 
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Specific Stoichiometric Coefficient, SCi,k Ideal Molar 
Gross 

Heating 
Value 

Compound 

Compound Oxygen Water Carbon 
Dioxide 

Sulfur 
Dioxide 

kJ/mol* 

Isobutane -1 -6.5 5 4 0 2,868.20 

n-Butane -1 -6.5 5 4 0 2,877.40 

Isopentane -1 -8 6 5 0 3,528.83 

n-Pentane -1 -8 6 5 0 3,535.77 

n-Hexane -1 -9.5 7 6 0 4,194.95 

n-Heptane -1 -11 8 7 0 4,853.43 

n-Octane -1 -12.5 9 8 0 5,511.80 

n-Nonane -1 -14 10 9 0 6,171.15 

n-Decane -1 -15.5 11 10 0 6,829.77 

H2S -1 -1.5 1 0 1 562.01 

Hydrogen -1 -0.5 1 0 0 285.83 

CO -1 -0.5 0 1 0 282.98 

Note: The unit given in AGA 8-1992 Table C.4-1 is not correct. 

The molar ideal gross heating value of a dry gas mixture is: 
HN T P SC HF T Pi h h i k k h h

k

0 0( , ) ( , ),= −∑  (p.136,C.4-5) 

 

HN T P x HN T Ph h i i h h
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1

( , ) ( , )=
=
∑  

(p.137,C.4-6) 

At temperature Th
2
: 
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(p.137,C.4-6) 
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  (p.138,C.4-7) 
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  (p.140,C.4-9&C.4-10) 

Ideal gas molar heat capacity coefficients (units, T, K; bk , K
-1;ck, K-2) range from 

273.15°K < T < 298.15°K. 

Table B-26 (AGA 8-1992, p.139,Table C.4-2) 

Compound ak 100bk ckx105 
Methane 4.1947 0.3639 1.49 

Ethane 5.9569 1.377 1.69 

Propane 8.2671 2.286 1.90 

Isobutane 10.824 3.153 0.82 

n-Butane 11.109 2.875 1.82 

Isopentane 13.412 3.540 1.40 

n-Pentane 13.587 3.288 2.98 

n-Hexane 16.134 3.986 3.60 

n-Heptane 18.642 4.786 3.84 

n-Octane 21.192 5.480 4.30 

n-Nonane 23.730 6.172 4.76 

n-Decane 26.280 6.869 5.25 

H2S 4.070 0.118 0.28 

Hydrogen 3.433 0.155 -0.74 

CO 3.503 0.009 0.09 

Helium 2.500 0.000 0.000 

Argon 2.500 0 0 

Oxygen 3.520 0.044 0.28 

Nitrogen 3.502 0.006 0 

SO2 4.707 0.439 0.09 

CO2 4.324 0.580 -0.65 

 
H Liq T P H Liq T P C H O Liq T T

T T
H O h h H O h h p h h

h h

2 22 2 1 1 2 2 1

2 175 29

( ., , ) ( ., , ) ( , .)( )

. ( )

− = −

= −

HN T P HN T P x SC H Liq T P H Liq T Ph h h h i i H O H O h h H O h h
i

NC
0

2 2
0

2 1 2 2 2 1
1

2 2 2
( , ) ( , ) ( ., , ) ( ., , ),= − −

=
∑  

B.3.4.2.8.1 Volumetric Heating Value  
HV T P T P HN T P d T Ph h d d h h d d( , , , ) ( , ) ( , )= 0  (p.142,C.5-1) 

or 
HV T P T P HM T P T Ph h d d h h d d( , , , ) ( , ) ( , )= 0 ρ  (p.142,C.5-1) 
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B.3.4.3 Restrictions and Uncertainties 

This set of equations is only applicable to the gas phase. The temperature range is 
− < <130 400o oC T C  at pressure to 280 MPa. 

Uncertainties for the detail characterization and gross characterization methods are 
almost the same.  

For pressure between: 
• 70 to 140 MPa, uncertainty <1.0% 
• 17 to 70  MPa, uncertainty <0.5% 

 
Temp. -200 to -80° F and 250 to 400°F with pressure up to 17 MPa uncertainty <0.5% 
Temp. -80 to 17° F and 143 to 250°F with pressure up to 12 MPa uncertainty <0.3% 
Temp. -80 to 250°F  pressure  12 to 17 MPa uncertainty <0.3% 
Temp. 17 to 143 °F   pressure up to 12 MPa uncertainty <0.1% 

B.3.4.4 Reference 

AGA Transmission Measurement Committee Report No.8, Compressibility of Natural 
Gas and Other Related Hydrocarbon Gases, Second Edition, November 1992. 

B.3.5 NX-19 

B.3.5.1 NX-19 Symbol Table 

The NX-19 symbol table is shown in Table B-27. 

Table B-27 NX-19 Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

P I psig 0 <_ P   P <_ 5000 
t I °F -40<_ t   t <_ 240 

π O - 0 < π    

τ O - 0 < τ    

Padj - psig 0 < Padj    
tadj - °F -459.67 < tadj     

D - -     
E I -     
Fp I - 0 < Fp    
Ft I - 0 < Ft    
G I - 0 < G  Varies with method used. 
H I BTU/ft3 0 < H     
Fpv O - 0 < Fpv     
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Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Z O - 0 <_ Z   Z <_ 1 
Zb O - 0 <_ Zb   Zb <_ 1 
n I - 1 <_ n    

Tci I °R 0 < Tci    

Pci I psia 0 < Pci    

yN2 I - 0 ≤ yN2 0 ≤ yN2 yN2 ≤ 0.15 yN2 ≤ 1.0 

yCO2 I - 0 ≤ yCO2 0 ≤ yCO2 yCO2 ≤ 0.15 yCO2 ≤ 1.0 

Ft O - 0 < Ft    

Fp O - 0 < Fp    

The component physical properties are shown in the following table. 

Table B-28 Table 5, Component Physical Properties 

Gas Critical 
Pressure (psia) 

Critical 
Temperature 

(0R) 

Ideal Specific 
Gravity 

Ideal Gas Total 
Heating Value 

(3) 
Methane 673 344 0.554 994 

Ethane 712 550 1.038 1,742 

Propane 617 666 1.523 2,479 

Iso-Butane 529 734 2.006 3,203 

n-Butane 551 766 2.006 3,213 

Iso-Pentane 483 830 2.490 3,939 

n-Pentane 485 846 2.490 3,948 

n-Hexane 440 911 2.973 4,684 

n-Heptane 400 972 3.460 5,420 

n-Octane 361 1025 3.943 6,153 

Carbon Dioxide 1072 510(1) 1.519 - 

Nitrogen 492 216(1) 0.967 - 

Air 547 239 1.000 - 

Oxygen 731 278 1.105 - 

Helium 33 10 0.138 - 

Hydrogen 188 60 0.070 319 

Hydrogen Sulfide 1306 678 1.176 630(2) 

(1) Adjusted critical temperatures 

(2) For combustion to gaseous SO2 

(3) Approximate BTU/SCF - 60°F., 30" Hg., sat. 
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B.3.5.2 NX-19 Calculations 

B.3.5.2.1 Supercompressibility Calculation, Fpv 

The supercompressibility calculation is: 

F   =   
Z
Z

B
D

 -  D +  
n

3

1 +  
0.00132pv

b

3.25

=
⎛
⎝
⎜ ⎞

⎠
⎟

π

τ

 

(p. 397, eq. 5) 

Zb = +
⎡
⎣⎢

⎤
⎦⎥

−

1
0 00132

3 25

2.
.τ

 
(Miller, p. 2-30, eq. 2.58) 

( )Z
Z
F B D D n

b

pv
= =

− +2

1
3π

 
(Miller, p. 2-30, eq. 2.57) 

B  =   
3 -  m n
9 m 

 
2

2π
 

(p. 397, eq. 6) 

m  =   0.0330378  -  0.0221323 + 0.0161353-2 -3 -5τ τ τ (p. 397, eq. 7) 

n  =   
0.265827  +  0.0457697  -  0.133185

m

-2 -4 -1τ τ τ 
 

(p. 397, eq. 8) 

π   =   
P  +  14.7

1000
adj  

(p. 397, eq. 9) 

τ  =   
t  +  460

500
adj  

(p. 397, eq. 10) 

P  =   P  Fadj p×  (p. 397, eq. 11) 

( ) 
adj tt   = t + 460 F  - 460⎡ ⎤

⎣ ⎦  (p. 397, eq. 12) 

D  = b +  b  +  B2 3
1/3

 (p. 397, eq. 13) 

b  =   
9 n -  2 m n

54 m 
  -   

E
2 m 

3

3 2π π
 

 

B.3.5.2.2 The “E” Coefficient 

The E coefficient calculation is: 
( ) ( ) ( ) ( )Y  =   A  -  2  +  A   -  2  +  A   -  2  +  A   -  21

2
2

3
3

4π π π π (p. 403, eq. 31) 

(p. 403, eq. 32) 

(p. 403, eq. 33) 
(p. 403, eq. 34) 

(p. 403, eq. 35) 

( ) ( ) ( ) ( ) ( )[ ]U = -1.32 - 2 3-1.483 - 2 - 0.10 - 2 + 0.0833 - 22 2τ π π π π 3 (p. 403, eq. 36) 



B Fluid Property Calculation Methods  User Manual 

 195  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  

The “E” coefficient ranges are shown in the following table. 

Table B-29 The “E” Coefficient 

Region Pressure 
Range (psia) 

Range of π Temperature 
Range (°F) 

Range of τ  Equation For 
E 

1 0 to 2,000 0.0 to 2.0 85 - 240 1.09 - 1.40 E1 

2 0 to 1,300 0.0 to 1.3 -40 - 85 0.84 - 1.09 E2 

3 1,300 to 2,000 1.3 to 2.0 -20 - 85 0.88 - 1.09 E3 

4 1,300 to 2,000 1.3 to 2.0 -40 - -20 0.84 - 0.88 E4 

5 2,000 to 5,000 2.0 to 5.0 -40 - -20 0.84 - 0.88 E5a 

6 2,000 to 5,000 2.0 to 5.0 -20 - 85 0.88 - 1.09 E5b 

7 2,000 to 5,000 2.0 to 5.0 85 - 200 1.09 - 1.32 E5c 

8 2,000 to 5,000 2.0 to 5.0 200 - 400 1.32 - 1.40 E6 

For ranges 5 through 8, if the value of π is greater than 2.0, use π = 2.0 in the 
calculation of the E parameter. However, the actual value of π is used in the 
calculation of the values of Y, A, A1, A2, A3, and U. 

( ) ( ) ( )
20.5 0.5-20 -1.092.3 2

1E =1-0.00075 e 0.0011 -1.09 2.17 1.4 -1.09τπ τ π τ π⎡ ⎤⎣ ⎦ ⎡ ⎤− + −⎣ ⎦  

 (p. 403, eq. 23) 

( ) [ ]
 -20 1.09 - 42.3 2

2E =1-0.00075 2-e  - 1.317 1.09- 1.69-
τ

π π τ π
⎡ ⎤
⎣ ⎦⎡ ⎤ ⎡ ⎤⎣ ⎦⎢ ⎥⎣ ⎦

 

 (p. 403, eq. 24) 

( ) ( ) ( )

( ) ( ) ( )
[ ] [ ]

6-20 1.09-2.3
3

2 3 4

1.25 2

E =1.0-0.00075 2-e +0.455[200 1.09- 0.03249 1.09-

2.0167 1.09- 18.028 1.09- 42.844 1.09- ]

1.3 1.69 2

τπ τ τ

τ τ τ

π π

⎡ ⎤⎣ ⎦⎡ ⎤ − +⎣ ⎦

− +

⎡ ⎤− −⎣ ⎦

 

 (p. 403, eq. 25) 

( ) ( ) ( )

( ) ( ) ( )

[ ] [ ] [ ]2

6-20 1.09-2.3
4

2 3 4

1.25 80 0.88 2

E =1.0-0.00075 2-e +0.455[200 1.09- 0.03249 1.09-

2.0167 1.09- 18.028 1.09- 42.844 1.09- ]

1.3 1.69 2

τ

τ

π τ τ

τ τ τ

π π

⎡ ⎤⎣ ⎦

⎡ ⎤+ −⎢ ⎥⎣ ⎦

⎡ ⎤ − +⎣ ⎦

− +

⎡ ⎤− −⎢ ⎥⎣ ⎦

 

 (p. 403, eq. 26) 
E   =   E  -  Y5a 4  (p. 403, eq. 27) 
E   =   E  -  Y5b 3  (p. 403, eq. 28) 
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E   =   E  -  Y5c 1  (p. 403, eq. 29) 
E   =   E  -  U6 5c  (p. 403, eq. 30) 

B.3.5.3 NX-19 Pressure Adjustment Factor, FP, and Temperature Adjustment Factor, FT 

B.3.5.3.1 The Standard Method 

This method applies when the following conditions are satisfied: 
1. The natural gas specific gravity does not exceed 0.750. 
2. The carbon dioxide content of the natural gas does not exceed 15.0 mole 

percent. 
3. The nitrogen content of the natural gas does not exceed 15.0 mole percent. 

 

F =
156.47

160.8 - 7.22G + KP
P

 
(p. 2, eq. 1) 

K = MP CO2
− 0 392

2
. MN  (p. 2, eq. 2) 

K = y 100%P CO2
− ×0 392

2
. yN   

F =
226.29

99.15 + 211.9G - KT
T

 
(p. 2, eq. 3) 

K = MT CO2
+1 681

2
. MN  (p. 2, eq. 4) 

K = y 100%T CO2
+ ×1 681

2
. yN   

B.3.5.3.2 Analysis Method 

This analysis method is most applicable when the natural gas has a specific gravity 
greater than 0.75. It is the recommended method when the natural gas contains 
appreciable amounts of components like hydrogen sulfide, oxygen, and helium. 
 

P = yc i
i=1

n

Pc i,∑  
(p. 401, eq. 15) 

F = 671.4
PP

c

 (p. 401, eq. 16) 

T = yc i
i=1

n

Tc i,∑  
(p. 401, eq. 17) 

F =
359.46

TT
c

 
(p. 401, eq. 18) 
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B.3.5.4 Restrictions and Uncertainties 

The range and applicability are: 
• pressure, psia  –  14.696 to 5000 
• temperature, F  –  -40 to 240 
• specific gravity  –  0.554 to 1.00 
• carbon dioxide mol %  –  0 to 15 
• nitrogen mol %  –  0 to 15 

B.3.5.5 Reference 

AGA Manual for the Determination of Supercompressibility Factors for Natural Gas, 
Par Research Project NX-19, Extension Range of Supercompressibility Tables, 
December 1962. 

B.3.6 Steam Properties 

B.3.6.1 Steam Properties Symbol Table 

The steam properties symbol table is shown in Table B-30. 

Table B-30 Steam Properties Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

A O J/g     

Abase O J/g     

Aideal gas O J/g     

Aresidual O J/g     

b - -     

B - -     

P I MPa 0  1,500  

T I K 273.15  1,273.15  

Cv O J/mol     

Cp O J/mol     

ρi I g/cm3 0    

δi - -     

τi - -     

The symbols used above are described in the following table. 
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Table B-31 Steam Properties Symbols 

Symbol Description 
A Helmohotz function 

Abase base function 

Aideal gas ideal gas function 

Aresidual residual function 

b molecular parameter 

B molecular parameter 

P pressure 

T temperature 

Cv heat capacity at constant volume 

Cp heat capacity at constant pressure 

ρi density 

δi reduced density 

τi reduced temperature 

B.3.6.2 Notes 

NBS/NRC Steam Tables are adopted here. These tables have been reviewed and 
approved by the Office of Standard Reference Data of the National Bureau of 
Standards and incorporated into the National Standard Reference Data System. The 
National Research Council of Canada contributed through the work of Dr. G.S. Kell. 
The International Association for the Properties of Steam (IAPS), through its Working 
Group I on Equilibrium Properties, contributed by testing and validating the 
formulation and providing on-going critical reviews of the work. The formulation has 
been accepted as the Provisional IAPS Formulation 1982 for the Thermodynamic 
Properties of Ordinary Water Substance for Scientific and General Use. 

B.3.6.3 Equations 

All of the properties can be derived from the following Helmhotz function: 
 

A T A T A T A Tbase residual ideal gas( , ) ( , ) ( , ) ( )ρ ρ ρ= + + −  (p.271,A.1) 

It consists of three parts: the contribution of base, residual, and ideal gas.  

The following molecular data were used: 
• Molar mass M=18.0152 g/mol; Universal gas constant Rc=8.31441 J/(mol⋅K) 
• Specific gas constant R=Rc/M=0.46152 J/(g⋅K), or 4.6152 bar⋅cm3/(g⋅K) 
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The base function is: 

A T RT y
y y

y B
b

RT
P

base( , ) [ ln( )
( )

( )

ln ]

ρ β α β γ

α β ρ

= − − −
−
−

+
+ +
−

+ −

−
− +

+

1 1
1

1
2 1

4

3
2

2

0

(p.272,A.2) 

Where y=bρ/4 is a dimensionless density; α=11; β=133/3; γ=7/2 are geometric 
constants.  

P0=1.01325 bar=1 atm. 

b b T
T

b T
Tj

j

j= +
=
∑1

0 0 3 5

0ln ( )
, ,

 
(p.272,A.3) 

B B T
Tj

j

j=
=
∑
0 1 2 4

0

, , ,

( )  
(p.272,A.4) 

Where T0 = 647.073K 

The residual function consists of 40 terms. 

A T g
k i

T
T

e gresidual
i

i

l i k i
i

i
i
l i

i i
k i

i i( , )
( )

( ) ( ) exp( )( ) ( ) ( ) ( )ρ δ α δ β τρ= − + − −
=

−

=
∑ ∑

1

36
0

37

40
21  

 (p.272,A.5) 

The quantities δi and τi are reduced densities and temperatures, respectively, given 
by: 

δ ρ ρ
ρi

i

i

=
−

 
 

τi
i

i

T T
T

=
−

 
 

The ideal gas function is simple: 

A T RT
C
T

C T C Tideal gas
R

R i
i

R
i

−
=

−= − + + + ∑( ) [ ( ) ln ]1 1
2

3

18
6  

(p.273,A.6) 

Because A(ρ,T) is everywhere a single-valued analytical function, it is straightforward 
to evaluate appropriate derivatives and to obtain, in accord with the first and second 
laws of thermodynamics, closed-form relations for all thermodynamic properties. 
However, only pressure-specific heat capacities are interested here. 

Pressure: 

P A
= ρ ∂

∂ρ
2  

(p.273) 
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P RT
b

y y y
B b
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1
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0 1 2

37

40
2 1

1

4 1
1

1
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1
1

1

1

[
( )

(
( )

) ]

( ) ( ) exp( )[ ( )

( ) ]

( ) ( ( ) ) ( ) ( ( ) )

( ( ) ( ) )

 

Saturated vapor pressure equation is simply as (up to within a degree of the critical 
temperature): 

0.60.1exp(6.3573118 8858.843/ 607.56335 / )sP T T= − +  

The coefficients for the base function are shown in the following table. 

Table B-32 Coefficients for Base Function 

bj (cm3 g-1) j Bj (cm3 g-1) 
0.7478629 0 1.1278334 

-0.3540782 1 -0.5944001 

0 2 -5.010996 

0.007159876 3 0 

0 4 0.63684256 

-0.003528426 5 0 

The coefficients for the residual function are shown in the following table. 

Table B-33 Coefficients for Residual Function 

i k(i) l(i) g(i) (J g-1) 
1 1 1 -530.62968529023 

2 1 2 2,274.4901424408 

3 1 4 787.79333020687 

4 1 6 -69.830527374994 

5 2 1 17,863.832875422 

6 2 2 -39,514.731563338 

7 2 4 33,803.884280753 

8 2 6 -13,855.050202703 

9 3 1 -256,374.36613260 

10 3 2 482,125.75981415 

11 3 4 -341,830.16969660 

12 3 6 122,231.56417448 

13 4 1 1,179,743.3655832 

14 4 2 -2,173,481.0110373 
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i k(i) l(i) g(i) (J g-1) 
15 4 4 1,082,995.2168620 

16 4 6 -254,419.98064049 

17 5 1 -3,137,777.4947767 

18 5 2 5,291,191.0757704 

19 5 4 -1,380,257.7177877 

20 5 6 -251,099.14369001 

21 6 1 4,656,182.6115608 

22 6 2 -7,275,277.3275387 

23 6 4 417,742.46148294 

24 6 6 1,401,635.8244614 

25 7 1 -3,155,523.1392127 

26 7 2 4,792,966.6384584 

27 7 4 409,126.64781209 

28 7 6 -1,362,636.9388386 

29 9 1 696,252.20862664 

30 9 2 -1,083,490.0096447 

31 9 4 -227,228.27401688 

32 9 6 383,654.86000660 

33 3 0 6,883.3257944332 

34 3 3 21,757.245522644 

35 1 3 -2,662.7944829770 

36 5 3 -70,730.418082074 

Table B-34 Coefficients for Residual Function, Continued 

i k (i) l (i) ρi (g cm-3) Ti (K) αi βi gi (J g-1) 

37 2 0 0.319 640. 34 20,000 -0.225 

38 2 2 0.319 640. 40 20,000 -1.68 

39 2 0 0.319 641.6 30 40,000 0.055 

40 4 0 1.55 270. 1,050 25 -93.0 

The coefficients for the ideal gas function are shown in the following table. 

Table B-35 Coefficients for Ideal Gas Function 

i Ci i Ci 
1 1.97302710180×101 10 4.1238460633×10-3 

2 2.09662681977×101 11 -2.7929052852×10-4 

3 -0.483429455355 12 1.4481695261×10-5 

4 6.05743189245 13 -5.6473658748×10-7 

5 2.256023885×101 14 1.620044600×10-8 
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i Ci i Ci 
6 -9.875324420 15 -3.3038227960×10-10 

7 -4.3135538513 16 4.51916067368×10-12 

8 4.581557810×10-1 17 -3.70734122708×10-14 

9 -4.7754901883×10-2 18 1.37546068238×10-16 

B.3.6.4 Restrictions and Uncertainties 

273 15 1273 15. .≤ ≤T K  

Where for T>423.15K the maximum pressure is: 

P MPamax = 1500  

And for 273 15 423 15. .≤ <T K  the maximum pressure is: 

max
( 273.15)100 5

15
T KP MPa

K
−⎡ ⎤= +⎢ ⎥⎣ ⎦

 

The applicable range of viscosity equation is: 

0 1073≤ ≤T K , 0 100≤ ≤P MPa 

The expectation of uncertainties are less than 0.1% except the critical region. 

B.3.6.5 References 

Lester Haar, John S. Gallagher and George S. Kell "NBS/NRC Steam Tables-
Thermodynamic and transport properties and computer programs for vapor and 
liquid states of water in SI units". 1984, Hemisphere, Washington. 

B.3.7 Methane, Ethane, Ethylene, Propane, i-Butane, n-Butane, 
Hydrogen, Argon, Nitrogen, and Oxygen 

The Methane, Ethane, Ethylene, Propane, i-Butane, n-Butane, Hydrogen, Argon, 
Nitrogen and Oxygen symbol table is shown in Table B-36. 

Table B-36 Methane, Ethane, Ethylene, Propane, i-Butane, n-Butane, 
Hydrogen, Argon, Nitrogen and Oxygen Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

P I bar 0  1,000  

T I K 35  100  

ρ O g/cm3 0    
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B.3.7.1 Equations 

The modified BWR equation was used to accurately represent PVT properties of 
Methane, i-Butane, and n-Butane: 

P RT G T G T G G T G T
G T G G T G T G T G G T
G T G T G T G T G T

G T G T G T
G T G T G T G T

= + + + + +

+ + + + + + +

+ + + + +

+ + +

+ + + +

+

ρ ρ

ρ ρ

ρ ρ ρ

ρ ρ γρ

ρ γρ ρ γρ

ρ

2
1 2

1 2
3 4 5

2

3
6 7 8 9

2 4
10 11 12

5
14 15

2 7
16

8
17 18

2

9
19

2 3
20

2
21

3 2

5
22

2
23

4 2 7
24

2
25

3 2

9

[ / / ]
[ / / ] [ / ]
[ / / ] / [ / / ]

/ [ / / ]exp( )
[ / / ]exp( ) [ / / ]exp( )

/

[ / / ]exp( ) [ / / ]exp( )
[ / / / ]exp( )
G T G T G T G T
G T G T G T

26
2

27
4 2 11

28
2

29
3 2

13
30

2
31

3
32

4 2

+ + +

+ + +

γρ ρ γρ

ρ γρ  

The empirical coefficients of the MBWR equation were obtained by least-square fit 
the all the available experimental data. 

Table B-37 Methane, i-Butane, and n-Butane 

 Methane i-Butane n-Butane 
i Gi 

1 0.9898937956e-5 0.1307325972e-2 0.153740104603e-2 

2 0.2199608275e-1 0.3927802742e-1 -0.160980034611e-1 

3 -0.5322788000 -0.3185427394e1 -0.979782459010 

4 0.2021657962e2 0.7608825192e3 0.499660674504e2 

5 -0.2234398926e4 -0.1753919859e6 -0.102115607687e6 

6 0.1067940280e-4 -0.2090019755e-3 0.236032147756e-3 

7 0.1457922469e-3 0.8959557971 -0.137475757093 

8 -0.9265816666 -0.6816710130e3 -0.907038733865e2 

9 0.2915364732e3 -0.1111271045e6 0.385421748213e5 

10 0.2313546209e-6 0.3248737572e-4 -0.349453710700e-5 

11 0.1387214274e-3 -0.1046526456 0.157361122714e-1 

12 0.4780467451e-2 0.6536598969e2 0.102301474068e2 

13 0.1176103833e-4 0.3726503734e-2 0.182335737331e-2 

14 -0.1982096730e-3 0.8553649395 -0.404114307787 

15 -0.2512887756e-1 0.2109987236e3 0.187979855783 

16 0.9748899826e-5 -0.1401267363 0.362088795040e-1 

17 -0.1202192137e-6 0.5213089327e-2 -0.738762248266e-3 

18 0.4128353939e-4 -.1925026382e1 -0.218618590563 

19 -0.7215842918e-6 0.7640067895e-1 0.118802729027e-1 

20 0.5081738255e3 0.3425854273e6 0.706854198713e5 

21 -0.9198903192e5 -0.3373475924e8 -0.219469885796e8 
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 Methane i-Butane n-Butane 
22 -0.2732264677e1 0.1180683444e5 -0.182454361268e4 

23 0.7499024351e5 0.1529683738e9 0.206790377277e9 

24 0.1114060908e-2 0.3323837416e3 0.111757550145e2 

25 0.1083955159e1 0.6423169487e4 0.558779925986e4 

26 -0.4490960312e-4 0.3891706042e1 -0.159579054026e1 

27 -0.1380337847e1 -0.1494755736e6 -0.148034214622e6 

28 -0.2371902232e-7 -0.1720240173e-2 -0.245206328201e-1 

29 0.3761652197e-4 0.2894195375e2 0.218305259309e2 

30 -0.2375166954e-9 0.2002086329e-3 -0.923990627338e-5 

31 -0.1237640790e-7 -0.4448393005e-1 -0.205267776639 

32 0.6766926453e-6 0.8028488415e1 0.387639044820e1 

γ -1/ρc 

The following table shows values for ethane and propane. 

Table B-38 Ethane and Propane 

 Ethane Propane 
i Gi 

1 -0.3204748852e-3 -0.2804337729e-3 

2 0.6529792241e-1 0.1180666107 

3 -0.1669704591e1 -0.3756325860e1 

4 0.1147983381e3 0.5624374521e3 

5 -0.1854721998e5 -0.9354759605e5 

6 0.4994149431e-4 -0.4557405505e-4 

7 -0.4858871291e-1 0.1530044332 

8 0.1225345776e2 -0.1078107476e3 

9 0.8622615988e4 0.2218072099e5 

10 -0.1081290283e-5 0.6629473971e-5 

11 0.6279096996e-2 -0.6199354447e-2 

12 -0.1716912675e1 0.6754207966e1 

13 -0.1640779401e-4 0.6472837570e-3 

14 -0.4356516111e-2 -0.6804325262e-1 

15 -0.1966649699e1 -0.9726162355e1 

16 0.4026724698e-3 0.5097956459e-2 

17 -0.6498241861e-5 -0.1004655900e-3 

18 0.5111594139e-2 0.4363693352e-1 

19 -0.1113010349e-3 -0.1249351947e-2 

20 -0.7157747547e3 0.2644755879e5 

21 -0.1848571024e7 -0.7944237270e7 
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 Ethane Propane 
22 -0.2137365569e3 -0.7299920845e3 

23 0.6275079986e7 0.5381095003e8 

24 -0.9974911056 0.3450217377e1 

25 0.1129115014e3 0.9936666689e3 

26 -0.1026469558e-1 -0.2166699036 

27 -0.5660525915e3 -0.1612103424e5 

28 -0.4209846430e-4 -0.3633126990e-3 

29 0.2374523553e-1 0.1108612343e1 

30 -0.1289637823e-6 -0.1330932838e-4 

31 -0.5423801068e-4 -0.3157701101e-2 

32 0.223971723e-2 0.1423083811 

γ -1/ρc 

The following table shows values for ethylene and hydrogen. 

Table B-39 Ethylene and Hydrogen 

 Ethylene Hydrogen 
i Gi 

1 -0.2146684366683e-2 0.4675528393416e-4 

2 0.1791433722534 0.4289274251454e-2 

3 -0.3675315603930e1 -0.5164085596504e-1 

4 0.3707178934669e3 0.2961790279801 

5 -0.3198282566709e5 -0.3027194968412e1 

6 0.5809379774732e-4 0.1908100320379e-5 

7 -0.7895570824899e-1 -0.1339776859288e-3 

8 0.1148620375835e2 0.3056473115421e-1 

9 0.2713774629193e5 0.5161197159532e1 

10 -0.8647124319107e-5 0.1999981550224e-7 

11 0.1617727266385e-1 0.2896367059356e-4 

12 -0.2731527496271e1 -0.2257803939041e-2 

13 -0.2672283641459e-3 -0.2287392761826e-6 

14 -0.4752381331990e-2 0.2446261478645e-5 

15 -0.6255637346217e1 -0.1718181601119e-3 

16 0.4576234964434e-3 -0.5465142603459e-7 

17 -0.7534839269320e-5 0.4051941401315e-9 

18 0.1638171982209e-1 0.1157595123961e-6 

19 -0.3563090740740e-3 -0.1269162728389e-8 

20 -0.1833000783170e5 -0.4983023605519e1 

21 -0.1805074209985e7 -0.1606676092098e2 
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 Ethylene Hydrogen 
22 -0.4794587918874e3 -0.1926799185310e-1 

23 0.3531948274957e7 0.9319894638928 

24 -0.2562571039155e1 -0.3222596554434e-4 

25 0.1044308253292e3 0.1206839307669e-3 

26 -0.1695303363659e-1 -0.3841588197470e-7 

27 -0.1710334224958e3 -0.4036157453608e-5 

28 -0.2054114462372e-4 -0.1250868123513e-10 

29 0.6727558766661e-2 0.1976107321888e-9 

30 -0.1557168403328e-6 -0.2411883474011e-13 

31 -0.1229814736077e-4 -0.4127551498251e-13 

32 0.4234325938573e-4 0.8917972883610e-12 

γ -0.0172 -0.0041 

The maximum RMS deviation in density is 0.552% for Nitrogen and 0.302% for 
Oxygen. 

Table B-40 Argon 

 Argon 
1 -0.65697312940e-4 

2 0.18229578010e-1 

3 -0.3649470140 

4 0.12320121070e2 

5 -0.86135782740e3 

6 0.79785796910e-5 

7 -0.29114891100e-2 

8 0.75818217580 

9 0.87804881690e3 

10 0.14231459890e-7 

11 0.16741461310e-3 

12 -0.32004479090e-1 

13 0.25617663720e-5 

14 -0.54759349410e-4 

15 -0.45050320580e-1 

16 0.20132546530e-5 

17 -0.16789412730e-7 

18 0.42073292710e-4 

19 -0.54442129960e-6 

20 -0.80048550110e3 

21 -0.13193042010e5 
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 Argon 
22 -0.49549239300e1 

23 0.80921321770e4 

24 -0.98701040610e-2 

25 0.20204415620 

26 -0.16374172050e-4 

27 -0.70389441360e-1 

28 -0.11543245390e-7 

29 0.15559901170e-5 

30 -0.14921785360e-10 

31 -0.10013560710e-8 

32 0.29339632160e-7 

The following table shows values for Oxygen and Nitrogen. 

Table B-41 Oxygen and Nitrogen 

 Oxygen Nitrogen 
i Gi 

1 -0.4365859650e-4 0.138029747465691e-3 

2 0.2005820677e-1 0.108450650134880e-1 

3 -0.4197909916 -0.247132406436209 

4 0.1878215317e2 0.345525798080709e1 

5 -0.1287473398e4 -0.427970769066595e3 

6 0.1556745888e-5 0.106491156699760e-4 

7 0.1343639359e-3 -0.114086707973499e-2 

8 -0.2228415518 0.144490249728747e-4 

9 0.4767792275e3 0.187145756755327e4 

10 0.4790846641e-7 0.821887688683079e-8 

11 0.2462611107e-3 0.236099049334759e-3 

12 -0.1921891680e-1 -0.514480308120135e-1 

13 -0.6978320847e-6 0.491454501366803e-5 

14 -0.6214145909e-4 -0.115162716239893e-3 

15 -0.1860852567e-1 -0.716803724664983e-1 

16 0.2609791417e-5 0.761666761949981e-5 

17 -0.2447611408e-7 -0.113093006621295e-6 

18 0.1457743352e-4 0.373683116683089e-4 

19 -0.1726492873e-6 -0.203985150758086e-6 

20 -0.2384892520e3 -0.171966200898966e4 

21 -0.2301807796e5 -0.121305519974777e5 

22 -0.2790303526e1 -0.988139914142789e1 
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 Oxygen Nitrogen 
23 0.9400577575e4 0.561988689351085e4 

24 -0.4169449637e-2 -0.182304396411845e-1 

25 0.2008497853 -0.259982649847705 

26 -0.1256076520e-4 -0.419189342315742e-4 

27 -0.6406362964e-1 -0.259640667053023e-1 

28 -0.2475580168e-8 -0.125868320192119e-7 

29 0.1346309703e-5 0.104928659940046e-5 

30 -0.1161502470e-10 -0.545836930515201e-10 

31 -0.1034699798e-8 -0.767451167059717e-9 

32 0.2365936964e-7 0.593123287099439e-8 

γ -0.0056 

B.3.7.2 Uncertainties 

The expectations of uncertainties in the computed densities are listed in Table B-42. 

Table B-42 Uncertainties 

 Liquid below Tc Gas below Tc Fluid above Tc Critical region 
Methane 0.2 0.3 0.1 5.0 

i-Butane 0.007 0.007 0.1 2 

n-Butane 0.05 0.4 0.06 3 

B.3.7.3 Reference 

Jacobsen, R.T., Stewart, R.B. and Myers, A.F., "An Equation of Sate for Oxygen and 
Nitrogen", Advances in Cryogenic Engineering, 18(1978):248. 

Younglove, B.A. and Ely, J.F., "Thermophysical Properties of Fluids. II. Methane, 
Ethane, Propane, i-Butane, n-Butane", Journal of Physical and Chemical  Reference 
Data, Vol 16, No.4, 1987. 

B.3.8 Ammonia 

The ammonia symbol table is shown in Table B-43. 

Table B-43 Ammonia Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

P I bar 0  5,000  

T I K 196  750  

ρ O g/cm3 0    
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B.3.8.1 Ammonia Equations 

P RT Q Q
= + +ρ ρ ρ ∂

∂ρ
[ ]1 2

 

Where: 

Q aij
i

ji
c

j= −−

==

−∑∑ ρ τ τ1

1

6

1

9
1( )  

With  τ=500/T, T is the value of temperature in Kelvin's, τc=1.2333498, ρ is the 
density in g/cm3. 

Table B-44 Ammonia Equation Values 

i j aij 
1 -6.453022304053 

2 -13.719926770503 

3 -8.100620315713 

4 -4.880096421085 

5 -12.028775626818 

1 

6 6.806345929616 

1 8.080094367688 

2 14.356920005615 

3 -45.052976699428 

4 -166.188998570498 

5 37.908950229818 

2 

6 -40.7302083372 

1 1.032994880724 

2 55.843955809332 

3 492.016650817652 

4 1737.835999472605 

5 -30.874915263766 

3 

6 71.483530416272 

1 -8.948264632008 

2 -169.777744139056 

3 -1,236.532371671939 

4 -7,812.161168316763 

5 1.779548269140 

4 

6 -38.974610958503 

1 -66.922858820152 5 

2 -1.753943775320 
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i j aij 
3 208.553371335492 

4 21,348.946614397509 

1 247.341745995422 

2 299.983915547501 

3 4,509.080578789798 

6 

4 -37,980.849881791548 

1 -306.557885430971 

2 24.116551098552 

3 -9,323.356799989199 

7 

4 42,724.098530588371 

1 161.791003337459 

2 -507.478070464266 

3 8,139.470397409345 

8 

4 -27,458.710626558130 

1 -27.821688793683 

2 298.812917313344 

3 -2,772.597352058112 

9 

4 7,668.928677924520 

B.3.8.2 Reference 

Haar, L. and Gallagher, J.S., "Thermodynamic Properties of Ammonia", Journal of 
Physical and Chemical Reference Data, 7(30 )1978:635. 

B.3.9 Carbon Dioxide 

The carbon dioxide symbol table is shown in Table B-45.  

Table B-45 Carbon Dioxide Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

P I bar 0  1,000  

T I K 220  700  

ρ O g/cm3 0    

B.3.9.1 Equation of State 

Z bij
j i

j

j

i

i

= + − −
==
∑∑1 1 1

00

9

ω τ ω( ) ( )
 

Where:  ω=ρ/ρl and τ=Tl /Tand ρl=0.01063 mol/cm3 and Tl =304.2K 
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Table B-46 Carbon Dioxide Equation Values 

i j Bij 
0 -0.725854437x100 

1 0.447869183x100 

2 -0.172011999x100 

3 0.446304911x10-2 

4 0.255491571x100 

5 0.594667298x10-1 

6 -0.147960010x100 

7 0.136710441x10-1 

8 0.392284575x10-1 

9 

0 

-0.119872097x10-1 

0 -0.168332974x101 

1 0.126050691x101 

2 -0.183458178x101 

3 -0.176300541x101 

4 0.257414246x101 

5 0.116974683x101 

6 -0.169233071x101 

7 -0.100492330x100 

8 0.441503812x100 

9 

1 

-0.846051949x10-1 

0 0.259587221x100 

1 0.596957049x101 

2 -0.461487677x101 

3 -0.111436705x102 

4 0.750925141x101 

5 0.743706410x101 

6 -0.468219937x101 

7 -0.163653806x101 

8 0.886741970x100 

9 

2 

0.464564370x10-1 

0 0.376945574x100 

1 0.154645885x102 

2 -0.38121926x101 

3 -0.278215446x102 

4 0.661133318x101 

5 0.150646731x102 

6 

3 

-0.313517448x101 
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i j Bij 
7 -0.187082988x101 

0 -0.670755370x100 

1 0.194449475x102 

2 0.360171349x101 

3 -0.271685720x102 

4 -0.242663210x101 

5 

4 

0.957496845x101 

0 -0.871456126x100 

1 0.864880497x101 

2 0.492265552x101 

3 -0.642177872x101 

4 

5 

-0.257944032x101 

0 6 -0.149156928x100 

B.3.9.2 Reference 

Angus, S., Armstrong, B. and de Reuck, K.M., IUPAC international thermodynamic 
tables of the fluid state-Carbon Dioxide. London, Butterworths,1977 

B.3.10 Density of Air 

Air is a special and important fluid. The new AGA 8 can be used for extended 
composition of nitrogen up to 100% and oxygen up to 21%. Therefore, AGA 8 -1992 
detailed method is used to calculate the density of air. Jones listed the composition 
of air as follows. 

Table B-47 Density of Air 

Constituent Abundance (mole fraction) 
Nitrogen(N2) 0.78102 

Oxygen(O2) 0.20946 

Carbon Dioxide(CO2) 0.00033 

Argon(Ar) 0.00916 

Neon(Ne) 0.00001818 

Helium(He) 0.00000524 

Krypton(Kr) 0.00000114 

Xenon(Xe) 0.000000087 

Hydrogen(H2) 0.0000005 

Methane(CH4) 0.0000015 

Nitrous Oxide(N2O) 0.0000003 
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Since the AGA 8 equation does not support Neon, Krypton, Xenon, and Nitrous 
Oxide, the mole fraction of these components are treated to equivalent Argon. 

The calculated density of air using the above method is compared with tabulated 
data given in the Chemical Engineers’ Handbook. The agreement is normally within 
0.1%. 

B.3.10.1 Reference  

Frank E. Jones, “The Air Density Equation and Transfer of Mass Unit”, Journal 
Research of the National Bureau of Standards. Vol. 83, No.5, pp419-428,1978. 

Robert H. Perry and Cecil H. Chilton, Chemical Engineers’ Handbook. Fifth Edition, 
page 3-105, McGraw-Hill Book Company, New York,1973. 

B.4 Viscosity 
The viscosity symbol table is shown in Table B-48. 

Table B-48 Viscosity Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

D  - -     

E - -     

F - -     

FP - -     

FPm  - -     

F°
P - -     

FP - -     

FQm - -     

F°
Q - -     

Mi I g/mol     

Mm I g/mol     

MH I g/mol     

ML I g/mol     

P I bar 0    

Pr O - 0    

∆Pr - bar     

Pcm I bar     

Pvp I bar     

T I K 200 150   

Tr O - .4 .4   
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Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Tc m I K 80  1500 1500 

Vci I      

yi I - 0.0 0.0 1 1 

Zci I - .2 .2 .5 .5 

Ψ O -     

η O µcp 0. 0.0 1000 1000 

ηL O µcp 0.0 0.0 1500 1500 

ξ O -     

Note: There are many viscosity correlation's available in the literature. As compiled 
and evaluated by R.C. Reid, J.M. Prausnitz and Poling, Lucas method may be used 
with the expectation of errors of 0.5 to 1.5% percent for low-pressure viscosity of 
non-polar substances and only requires Tc, Pc and M for non-polar compounds. The 
accuracy of the Lucas method for high-pressure gas mixtures is about 8 to 9 percent. 
Lucas also proposed methods to calculate liquid viscosity. For consistency and 
simplicity, only the Lucas method will be included in this section. 

B.4.1 Gas Viscosity 

Lucas proposed the following correlation based on critical properties: 
ηξ = − −

+ − +

[ . . exp( . )

. exp( . ) . ]

.0 807 0 357 0 449

0 340 4 058 0 018

0 618

0 0

T T

T F F
r r

r P Q

 
(PGL,p.400,eq.9-4.15) 

Where: 
1/ 6

3 40.176 c

c

T
M P

ξ
⎛ ⎞

= ⎜ ⎟
⎝ ⎠

 
(PGL,p.397,eq.9-4.14) 

0
PF  and 0

QF  are two corrections for polar and quantum gas respectively: 

10 =PF  0 0 022≤ <µ r .  (PGL,p.400,eq.9-4.17) 

F ZP c
0 1 721 30 55 0 292= + −. ( . ) .  0 022 0 075. .≤ <µ r (PGL,p.400,eq.9-4.17) 

F Z TP c r
0 1 721 30 55 0 292 0 96 0 1 0 7= + − + −. ( . ) . . ( . ).  0 075. ≤ µ r  

The reduced dipole momentum is calculated as: 

µ
µ

r
c

c

P
T

= 52 46
2

2.  
(PGL,p.400,eq.9-4.16) 

The quantum correction term: 

[ ]{ })12()12(00385.0122.1 /1215.00 −−+= r
M

rQ TsignTQF  (PGL,p.400,eq.9-4.18) 
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Where Q=1.38(He), Q=0.76(H2) and Q=0.52(D2). 

If Tr ≤ 1.0 and Pr < (Pvp/Pc): 
ψ α β= + + − −0 600 0 760 6 990 0 6 1. . ( . . )( )P P Tr r r  PGL,p422,eq.9-6.5) 

With: 
  

α = +3 262 14 98 5 508. . .Pr  

β = +1 390 5 746. . Pr  

If (1<Tr <40.0 ) and (0<Pr ≤ 100): 

11
(1 )

e
r

f d
r r

aP
bP cP

ψ ηξ −

⎡ ⎤
= +⎢ ⎥+ +⎣ ⎦

 
(PGL,p422,eq.9-6.6) 

With: 
a a Ta

T r= 1
2exp( )γ  (PGL,mid. of p.422) 

b a b T br= −( )1 2   

c c Tc
T rr

= 1
2exp( )δ   

d d
T

d T
r

r= 1
2exp( )ε  

 

e = 1 3088.   

f f
T

f T
r

r= 1
2exp( )ζ  

 

 

Table B-49 (PGL, above eq.9-6.7 on p.422) 

a1 0.001245 a2 5.1726 γ -0.3286 

b1 1.6553 b2 1.2723 δ -37.7332 

c1 0.4489 c2 3.0578 ε -7.6351 

d1 1.7368 d2 2.2310 ζ 0.4489 

f1 0.9425 f2 -0.1853   

 

Y =
ψ
ηξ

 (PGL,p.422,eq.9-6.7) 

F
F Y

FP
P

P

=
+ − −1 10 3

0

( )
 

(PGL,p.422,eq.9-6.8) 
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F
F Y Y

FQ
Q

Q

=
+ − −−1 1 0 0070 1 4

0

( ) . (ln )
 

(PGL,p.422,eq.9-6.9) 

Viscosity η at pressure P and temperature T is calculated as follows: 

η
ψ

ξ
=

F FP Q  
(PGL,p.422,eq.9-6.10) 

Where: 

ξ = 0 176 3 4
1 6. ( ) /T

M P
c

c

 
(PGL,p.397,eq.9-4.14) 

For mixture, the following mixing rule should be used: 
T y Tcm i

i
ci= ∑  (PGL,p.411,eq.9-5.18) 

P RT
y Z

yVcm cm

i
i

ci

i ci

=
∑
∑

 

(PGL,p.411,eq.9-5.19) 

M y Mm i
i

i= ∑  (PGL,p.411,eq.9-5.20) 

F y FPm i
i

Pi
0 0= ∑  (PGL,p.411,eq.9-5.21) 

( )0 0
Qm i Qi

i
F y F A= ∑  (PGL,p.411,eq.9-5.22) 

0.87

1 0.01 H

L

MA
M

⎛ ⎞
= − ⎜ ⎟

⎝ ⎠
 

for 
M
M

and yH

L
H> < <9 0 05 0 7. .  

(PGL,p.411,eq.9-5.23) 

Otherwise, A=1. 

B.4.1.1 Reference 

R. C. Reid, J.M. Prausnitz and B. E. Poling, "The Properties of Gases and Liquids", 
Fourth Edition, 1987, McGraw-Hill Book Company, New York. 

This was also checked with the following original papers: 
• K. Lucas, Chem. Ing. Tech., 46:157(1974). 
• K. Lucas, Chem. Ing. Tech. 53:959(1981). 
• K. Lucas, Int.J. Heat Mass Trans., 16:371(1973). 
• K. Lucas, AIChEJ. , 32:139(1986). 
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B.4.2 Viscosity of Water and/or Steam 

In a 1975 release, IAPS announced approval for the following equation for the 
dynamic viscosity of water and steam: 

η ρ η ρ
ρ

ρ
ρ

( , ) ( ) exp[ ( ) ( ) ]*

*

*T T b T
Tij

ji

i j= − −
==

∑∑0
0

4

0

5

1 1  

Where:   η0
1 2

0

3
1 610( ) ( ) [ ( ) ] / ( )*

/
*

T T
T

a T
T

kg smk
k

k= ×
=

− −∑  

ρ*=317.763 kg/m3 ;       T*=647.27K. 

Coefficients ak for the above equation are as shown in the following table. 

Table B-50 Coefficients ak 

Coefficient Value 
a0 0.0181583 

a1 0.0177624 

a2 0.0105287 

a3 -0.0036744 

Coefficients bij for the above equation are as shown in the following table. 

Table B-51 Coefficients bij 

j\\i 0 1 2 3 4 5 
0 0.501938 0.162888 -0.130356 0.907919 -0.551119 0.146543 

1 0.235622 0.789393 0.673665 1.207552 0.0670665 -0.0843370 

2 -0.274637 -0.743539 -0.959456 -0.687343 -0.497089 0.195286 

3 0.145831 0.263129 0.347247 0.213486 0.100754 -0.032932 

4 -0.0270448 -0.0253093 -0.0267758 -0.0822904 0.0602253 -0.0202595 

B.4.3 Restrictions and Uncertainties 

Lucas equations can be used over a wide range of temperatures and pressures, for 
gases and liquids and mixtures, for non-polar and polar substances. 

For pure gas at a low pressure, expect errors of 0.5 to 1.5 percent for non-polar 
compounds and 2 to 4 percent for polar compounds. For gas mixtures, the expected 
errors are within 5%. For dense gases, the expected errors are normally less than 
5%. The expectation of errors for dense gas mixtures are around 8% for both polar 
and non-polar systems. 
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IAPS viscosity equations for water yields values that agree with data to within their 
accuracy over the range 0 ≤ t ≤ 800°C; 0 ≤ P ≤ 1,000 bar. It yields useful estimates 
for values of pressure up to 10,000 bar for t < 100°C and up to 3,500 bar for t ≤ 
560°C. 

B.5 Bubblepoint Pressure 
The bubblepoint pressure symbols are shown in Table B-52. 

Table B-52 Bubblepoint Pressure Symbol Table 

Symbol I/O Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

R - J/mol K 8.314    

P I Pa     

Pc I Pa     

T I K 40  1,000  

Tc I K 40  1,000  

V O cm3/mol     

xi I - 0.0  1.0  

yi I - 0.0  1.0  

φi - - 0.0<    

B.5.1 Equations 

In addition to equal temperature and pressure in both phases, thermodynamic 
conditions for vapor-liquid equilibrium can be simplified as: φ φi i i iy x=  

Where the fugacity coefficient φi can be calculated by either SRK or PR equations of 
state. 

For the SRK equation: 

2ln ( 1) ln (1 ) ( ) ln(1 )i i
i j ij

j

b bb a bz z y a
b V bRT b a V

αφ α
α

⎡ ⎤⎡ ⎤= − − − + − +⎢ ⎥⎢ ⎥⎣ ⎦ ⎣ ⎦
∑  

For the PR equation: 

2 2.414ln ( 1) ln (1 ) ( ) ln
2.828 0.414

i i
i j ij

j

b bb a V bz z y a
b V bRT b a V b

αφ α
α

⎡ ⎤ +⎡ ⎤= − − − + −⎢ ⎥⎢ ⎥ −⎣ ⎦ ⎣ ⎦
∑  
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B.5.2 Vapor Pressure 

B.5.2.1 Antoine 

Equation 1:  ln( / ) ( ) ( ) ( ) ( ) ( ).P P x VPA x VPB x VPC x VPD xvp c = − + + +−1 1 1 5 3 6   
                    x T Tc= −1 /  

Equation 2:  ln ( ) ( ) / ( ) ln ( ) /P VPA VPB T VPC T VPD P Tvp vp= − + + 2  

Equation 3:  ln ( ) ( ) / [ ( )]P VPA VPB T VPCvp = − +  

Where coefficients VPA, VPB, VPC and VPD were taken from, “The Properties of 
Gases and Liquids”. 

B.5.2.2 Reference 

Reid, J.M. Prausnitz and B.Z. Poling, “The Properties of Gases and Liquids”. Fourth 
Edition. McGraw-Hill Book Company. 

B.5.3 Bubblepoint Pressure Calculation Algorithm 

The liquid composition is known but that of the vapor is not. For pressure 
determination, the key starting assumptions are in box 2. The Wilson equation is 
used to estimate initial equilibrium constants. The method iterates at a particular 
pressure until S = Σyi becomes constant. If Σyi is greater than unity, the pressure 
should be incremented for the next series of iterations. If Σyi is less than one, the 
pressure should be reduced for the next series of iterations. The criteria of 
convergency is | Σyi -1| < 10-6.  
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Figure B-1 Bubblepoint Pressure 
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B.5.4 Additional Notes 

For details of both the SRK and PR equation of state, please refer to Section B.2.2 of 
this document. These two equations of state are the most widely used equations of 
state for phase equilibrium calculations. 

For pure fluids like steam, the vapor pressure equation will be used to check if two 
phases will coexist at the given temperature and pressure. 

B.6 Isentropic Exponent 

B.6.1 Basic Equations 

For idealized one-dimensional expansion:  1 2

2 1

k
P V
P V

⎛ ⎞
= ⎜ ⎟

⎝ ⎠
 

Where k is the isentropic exponent.  

For ideal gas:  k
C
C

p
i

v
i=  

For real gas:  
ln

p

s Tv

CP P Vk
V C V P

∂ ∂
∂ ∂

⎛ ⎞ ⎛ ⎞= = −⎜ ⎟ ⎜ ⎟
⎝ ⎠ ⎝ ⎠

 

Where: 

2

2

Vi
v v

V

PC C T dV
T

∂
∂∞

⎛ ⎞
− = − ⎜ ⎟

⎝ ⎠
∫  

2

P v
V T

P PC C T
T V

∂ ∂
∂ ∂

⎛ ⎞ ⎛ ⎞− = − ⎜ ⎟ ⎜ ⎟
⎝ ⎠ ⎝ ⎠

 

For natural gas where the composition is known, the isentropic exponent can be 
calculated from the speed of sound using AGA-10. 

2 wMW
ZRT

κ =  
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B.6.2 Ideal Gas Specific Heat Capacity 
2 3i

PC A BT CT DT= + + +  

Where the coefficients A, B, C and D were taken from, “The Properties of Gases and 
Liquids”.

2
 

i i
V PC C R= −  

R is the gas constant. 

B.6.3 Lee-Kesler BWR Equation 

3 4 3
2 3 3

2( 3 / ) 36
i

v v r

r r r r

C C b b T CE
R T V T V
− +

= − −  

2

1
r r

i i
p p v v r r

r
r rV T

C C C C P PT
R R T V

∂ ∂
∂ ∂

− ⎛ ⎞ ⎛ ⎞−
= − − ⎜ ⎟ ⎜ ⎟

⎝ ⎠ ⎝ ⎠
 

Where: 

4
3 2 21 ( 1 )exp( )
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⎧ ⎫
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2

4
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∂ β
∂
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For the meaning of the symbols and values of parameters, please refer to the 
Section B.2.4, Lee-Kesler BWR Equation. 

                                                 
2 Reid, J.M. Prausnitz and B.Z. Poling, “The Properties of Gases and Liquids”. Fourth Edition. McGraw-Hill 
Book Company. 
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B.6.4 RK Equation 
2

2 2.5

0.75 ln
V

i
V v

v

P a VC C T dV
T T b V b

∂
∂∞

⎛ ⎞
− = − = −⎜ ⎟ +⎝ ⎠

∫  

2
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( )
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2
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a V bP RT
V TV V bV b

∂
∂

+−⎛ ⎞ = +⎜ ⎟ +⎝ ⎠ −
 

3
2

1
( )2V

P R a
T V b V V bT

∂
∂

⎛ ⎞ = +⎜ ⎟ − +⎝ ⎠
 

For the meaning of the symbols and values of parameters, please refer to Section 
B.2.1, Redlich-Kwong Equation of State. 

B.6.5 Reference 

Reid, J.M. Prausnitz and B.Z. Poling, “The Properties of Gases and Liquids.” Fourth 
Edition. McGraw-Hill Book Company. 

Walas, “Phase Equilibrium in Chemical Engineering”. Butterworth Publisher, Boston, 
1985. 

§ 
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C Flow Calculation Methods 

C1 Introduction 

C1.1 Scope 
Appendices C1 to C12 describe the calculation methods used in Flowel to determine 
flow through a differential pressure flow element. 

C1.2 ASME MFC-3M-1989 
ASME MFC-3M-1989 was made as “consistent and technically equivalent as 
practical with ISO 5167-1980”. In addition to ISO 5167-1980, this standard covers a 
considerably broader span of fluids and flowing conditions, and reduces the 
uncertainty in the prediction of the discharge coefficient. This standard specifies the 
geometry and method of use for orifice plates, nozzles, and Venturi tubes to 
determine the rate of the fluid flowing. It also gives necessary information for 
calculating flow rate and its associated uncertainty.  

The following primary devices are covered in ASME MFC-3M-1989: 
• orifice plates, which can be used with the following arrangements of pressure 

taps: 
- flange pressure taps 
- D and D/2 pressure taps 
- corner pressure taps 

• nozzles: 
- ASME long radius nozzles 

• venturi tubes 

C1.2.1 Comparison of ASME MFC-3M-1989 and ISO 5167-1980 

C1.2.1.1 Orifice Plates 

For orifice plates with the above three pressure tappings arrangements, ASME MFC-
3M-1989 provides the same discharge coefficient equation, expansibility equation, 
pressure loss equation and uncertainties in discharge coefficient and expandability 
as ISO 5167-1980. 
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C1.2.1.2 Nozzles 

For nozzles, ASME MFC-3M-1989 provides additional equations for ASME flow 
nozzle.  

The discharge coefficient is: 

0.5
60.9975 0.00653 10

ReD

C β⎛ ⎞
= − ⎜ ⎟

⎝ ⎠
 

While ISO 5167-1980 provides (long radius nozzles): 

C
D

= −
⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 9965 0 00653 106
0 5

. .
Re

.

β
 

Both ISO 5167-1980 and ASME MFC-3M-1989 provide the same equation for 
expansion factor. 

Limit of use for ASME MFC-3M-1989 is: 
• 100 mm ≤ D ≤ 750 mm 
• 104 ≤ ReD ≤ 107 

While ISO 5167-1980 gives: 
• 50 mm ≤ D ≤ 630 mm 
• 104 ≤ ReD ≤ 107 

C1.2.1.3 Venturi Tubes 

For Venturi tubes, ISO 5167-1980 and ASME MFC-3M-1989 give the same 
discharge coefficient value for  "as cast" convergent venturi tube but provide different 
limits of use. 

ISO 5167-1980: 
• 100 mm ≤ D ≤ 800 mm 

• 2x105 ≤ ReD ≤ 2 x106 

This standard: 
• 100 mm ≤ D ≤ 1200 mm 
• 2x105 ≤ ReD ≤ 6 x106 

ISO 5167-1980 and ASME MFC-3M-1989 give the same discharge coefficient value 
for machined convergent venturi tube but provide different limits of use. 
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ISO 5167-1980: 
• 0.4 ≤ β ≤ 0.75 

• 2x105 ≤ ReD≤ 1 x106 

ASME MFC-3M-1989: 
• 0.3 ≤ β ≤ 0.75 
• 2x105 ≤ ReD ≤ 2 x106 

C1.3 ASME/ANSI Standard MFC-7M-1987 
This standard was approved by the American National Standards Institute (ANSI) on 
February 27, 1987. It applies only to the steady flow of single-phase gases and deals 
with devices for which direct calibration experiments have been made, sufficient in 
number and quantity to enable inherent systems of applications to be based on their 
results and coefficients to be given with certain predictable limits of uncertainty. 

This standard applies only to venturi nozzles in which the flow is critical. It provides 
methods to calculate discharge coefficient and real gas critical flow coefficient. It 
illustrates the calculation of the critical flow coefficient in Appendix E of MFC-7M-
1987. 

C1.4 ASME MFC-14M-2003 
ASME MFC-14M-2003, entitled Measurement of Fluid Flow Using Small Bore 
Precision Orifice Meters, applies to orifice meters of 6 mm to 40 mm (¼ to 1½ 
inches) line size. 

ASME MFC-14M-2003 was approved as an American National Standard on 
February 26, 2003. 

C1.5 International Standard ISO 5167-1980(E)  
This standard covers: 

• orifice plates, which can be used with the various following arrangements of 
pressure tappings: 
- corner pressure tappings 
- D and D/2 pressure tappings 
- flange pressure tappings 

• nozzles: 
- ISA 1932 nozzle 
- long radius nozzle 
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• venturi tubes: 
- classical venturi tube 
- venturi-nozzle 

This standard can not be used for pipe sizes less than 50 mm, or more than 1200 
mm, or for pipe Reynolds number below 3150. 

C1.6 International Standard ISO 5167-1-1991(E)  
This standard is a technical revision of ISO 5167-1980(E). It covers the same types 
of primary devices and conditions.  

• orifice plates, which can be used with the various following arrangements of 
pressure tappings: 
- corner pressure tappings 
- D and D/2 pressure tappings 
- flange pressure tappings 

• nozzles: 
- ISA 1932 nozzle 
- long radius nozzle 

• venturi tubes: 
- classical venturi tube 
- venturi-nozzle 

This standard can not be used for pipe sizes less than 50 mm, or more and 1200 
mm, or for pipe Reynolds number below 3150. 

C1.6.1 Difference Between ISO 5167-1980(E) and ISO 5167-1-1991(E) 

ISO 5167-1-1991(E) provides an informative guideline for iterative computations as 
Annex D. 

For orifice plates with corner tappings, the limit of use for β changed from 0.23≤β ≤
0.80 to 0.20≤β ≤0.75. For orifice pates with flange or D and D/2 tappings, the D 
range increased from  50≤D≤760 to 50≤D≤1000.  

The discharge coefficient for ISA 1932 nozzle is changed from:  

[ ]C
D

= − + − +
⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 9900 0 2262 0 000215 0 001125 0 002490
106

4 1 4 7

1 15

. . . . .
Re

. .

.

β β β  

To: [ ]C
D

= − − −
⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 9900 0 2262 0 00175 0 0033
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. . . .
Re

. .

.

β β β  
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C1.7 International Standard ISO 5167-2003 
This revision to ISO-5167 is only a revision of the orifice metering section.  The 
equations for the coefficient of discharge and the expansion factor are changed. 

C1.8 ISO Technical Report ISO/TR 15377:1998 
This technical report, entitled ‘Guidelines for the Specification of Nozzles and Orifice 
Plates Beyond the Scope of ISO 5167-1, covers flow elements such as quadrant 
edged orifice plates, conical edged orifice plates, and vent and drain holes. 

C1.9 British Standard 1042, Part 1, Section 1.2 
This standard describes the measurement of fluid flow in closed conduits and will be 
applied to liquid, vapor or gas flows in the following types of orifice plates: conical 
entrance, quadrant, and eccentric. 

C1.10 American Gas Association Report No.3, Part 1, 3rd 
Ed., 1990 
AGA-3 Part 1 (1990) provides a single reference for engineering equations, 
uncertainty estimations, construction and installation requirements, and standardized 
implementation recommendations for the calculation of flow rate through concentric, 
square-edged, flange-tapped orifice meters. 

AGA-3 Part 1 (1990)  applies to fluids that, for all practical purposes, are considered 
to be clean, single phase, homogeneous, and Newtonian, measured using 
concentric, square-edged, flange-tapped orifice meters and have pipe Reynolds 
numbers of 4000 or greater. 

This new third edition divided the document into four relatively independent parts. 
The part 1 was issued in 1990, part 2 in 1991, and parts 3 and 4 in 1992. Each part 
can be used independently. 

The major change over the second edition is on the discharge coefficient equation. 
The empirical coefficient of discharge equation has been changed with new broad 
data base (with a total of 10192 experimental data points for flange, corner, radius 
tappings). 
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2nd Edition (1985) 
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3rd Edition (1990) 
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L   =   L   =   0.0254
D1 2  

C1.11 American Gas Association Report No.3, 2nd Ed., 1985 
The second edition of AGA 3 has been changed significantly in the format. Buxton 
made a comprehensive comparison analysis of this edition vs. the 1978 edition. 

It provides equations for computing mass flow rate when the density of the fluid 
flowing is known, the volume flow rate when the density of the fluid flowing are 
known, the mass flow rate when the ideal gas relative density of fluid flowing is 
known, the volume flow rate when the ideal gas relative density of fluid flowing is 
known, mass flow rate when the real gas relative density of the fluid flowing is 
known, and the volume flow rate when the real gas relative density of the fluid 
flowing is known. 

C1.12 General Application 
This chapter (C12) contains information on calculating fluid flow in the general case. 
It also contains calculation methods not covered in any of the standards mentioned 
before. Those devices include: 

• concentric orifice plate with flange taps, vena contracta taps, corner taps and 
radius taps 

• eccentric orifice plate with flange taps, vena contracta taps 
• segmental orifice plate with flange taps, vena contracta taps 
• quadrant orifice plate with corner or flange taps 
• conic orifice with corner taps 
• small bore orifice meter runs with flange or corner taps 
• critical flow calculation 

§ 
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C2 ASME Standard MFC-3M-1989 

C2.1 Flow Element Applicability 
The ASME standard is defined for the following flow measurement elements: 

• orifice plates with: 
- flange taps 
- D and D/2 (radius) taps 
- corner taps 

• ASME long radius nozzles: 
- high β ratio nozzles 
- low β ratio nozzles 
- throat tap flow nozzles 

• classical venturi tubes: 
- as-cast convergent section 
- machined convergent section 
- fabricated (welded) convergent section 

ASME MFC-3M-1989 applies to liquid, vapor, or gas flows which are homogenous 
(single phase), turbulent, subsonic and steady with time (a slow pulsation can be 
acceptable). 

C2.2 Calculation of Reynolds Numbers 

C2.2.1 Symbol Table 

The symbol table for calculation of Reynolds Numbers is shown below. 

Table C-1 Calculation of Reynolds Numbers Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

d m 0 < d 0 < d None d < =D 

D m 0 < D 0 < D None None 

qm kg/s 0 ≤ qm 0 ≤ qm None None 

µ Pa-s 0 < µ 0 < µ None None 

Rd - 0 < Rd 0 < Rd None None 
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Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

RD - 0 < RD 0 < RD None None 

β - 0 < β 0 < β β ≤ 1 β ≤ 1 

C2.2.2 Reynolds Number Based on the Upstream Condition of the 
Fluid and the Inside Diameter of the Pipe 

The equation for the Reynolds Number based on the upstream condition of the fluid 
and the inside diameter of the pipe is: 

R
q

DD
m=

4
πµ

 (eq. 1, p. 7) 
 

C2.2.3 Reynolds Number Based on the Orifice or Throat Diameter of 
the Primary Device 

The equations for the Reynolds Number based on the orifice or throat diameter of 
the primary device are: 

d
D

β =  
(Table 1, p. 4) 

D
d

RR
β

=  
(eq. 2, p. 7) 

C2.3 Orifice Plate Discharge Coefficients 

C2.3.1 Symbol Table 

The symbol table for the orifice plant discharge coefficients is shown below. 

Table C-2 Symbols 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

β - 0 < β 0.2 < β β < 0.70 β < 1 §7.1.6.1 

d m None None K < D K < D §3.2 

RD - 0 < RD 2000 < RD RD < 108 None §7.3.2.1 

D m 0 < D 0.0429 < D D < 0.900 None §7.3.2.1 

C - C > 0 None C < 1 None  

 232  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  



C2 ASME Standard MFC-3M-1989  User Manual 

C2.3.2 Calculations 

C2.3.2.1 Base Discharge Coefficients (§7.3.1.1) 

The base discharge coefficients equation is: 

C L

L R D

= + − + −

− ′ +

−

−

0 5959 0 0312 0 1840 0 0900 1

0 0337 91 71

2 1 8
1

4 4

2
3 2 5 0 75

. . . . (

. .

.

. .

β β β

β β

1)β
 (eq. 25, p. 30) 

Where: 

L l
1 = 1

D
 

L l
2 = 2

D
 

′ =
′

=
−L l l E
D2

2 2(
D

)
 

If L1 ≥ 0.4333 then 0.0900 L1 ≡ 0.0390 
• l1 – distance of upstream pressure tap from upstream face of orifice plate 
• l2 – distance of downstream pressure tap from downstream face of orifice 

plate 
• E – thickness of orifice plate 

The valid tap arrangements are defined in paragraphs 7.2.3.4, 7.2.3.5, or 7.2.4. It is 
not permitted to use l1 and l2 which do not match one of the three standardized tap 
arrangements. 

C2.3.2.2 Corner Taps (§7.3.1.1) 

The relative roughness ratio limits for corner taps are given below (§7.2.4.11): 

Table C-3 Relative Roughness Ratio Limits for Corner Taps 

β ≤0.30 0.32 0.34 0.36 0.38 0.40 0.45 0.5 0.6 0.7 

104k/D 25 18.1 12.9 10.0 8.3 7.1 5.6 4.9 4.2 4.0 

 
L L1 2 0= ′ =  (eq. 26, p.30) 
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C2.3.2.3 Flange Taps, D mm≥ 58 6.  (§7.3.1.1) 

The relative roughness limit for flange taps is: 
k

D ≤ × −3 8 10 4.  (§7.2.4.11) 

L L D1 2
10 0254= ′ = −.  (eq. 27a, p. 30) 

C2.3.2.4 Flange Taps 50 8 58 6. m .m D mm≤ ≤  (§7.3.1.1) 

The relative roughness limit for flange taps is: 
k

D ≤ × −3 8 10 4.  (§7.2.4.11) 

L L1 2
10 4333 0 0254= ′ = D−. , .  (eq. 27b, p. 30) 

C2.3.2.5 Radius Taps (D and D/2) (§7.3.1.1) 

The relative roughness limit for radius taps is: 
k

D ≤ × −3 8 10 4.  (§7.2.4.11) 

′ =L2 0 47.  (eq. 28, p. 30) 

Since L1 ≥ 0.4333, 0.0090 L1 ≡ 0.0390 

C2.4 Long Radius Nozzles Discharge Coefficients 

C2.4.1 Symbol Table 

The symbol table for long radius nozzles discharge coefficients is shown below. 

Table C-4 Long Radius Nozzles Discharge Coefficients Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

β - 0 < β varies with design β < 1 §8 

RD - 0 < RD 104 ≤ RD RD ≤ 6 x 106 None §8.4.4 

D m 0 < D 0.1 ≤ D D ≤ 0.75 None §8.4.4 

pf1 Pa 0 < pf1 0 < pf1 None None §5.3.3 

pf2 Pa 0 < pf2 0.75 pf1< p2 pf2 < pf1 None §5.3.3 

C -  C > 0 None C < 1 None  

The standard applies to 3 types of long radius style flow nozzles (§8): 

1. High beta ratio nozzle, ( )0 50 0 80. .≤ ≤β  

2. Low beta ratio nozzle, ( )0 20 0 50. .≤ ≤β  

3. Throat tap flow nozzle, ( )0 25 0 50. .≤ ≤β  

 234  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  



C2 ASME Standard MFC-3M-1989  User Manual 

C2.4.2 Calculations 

C2.4.2.1 Wall Tap Nozzle Discharge Coefficient  (§8.4.1) 

The well tap nozzle discharge coefficient calculation is: 

C
RD

= −
⎛

⎝
⎜
⎜

⎞

⎠
⎟
⎟0 9975 0 00653 106

0 5

. .

.

β
 

(eq. 32, p.35) 

C2.4.2.2 Throat Tap Nozzle Discharge Coefficient (§8.4.2) 

The un-calibrated discharge coefficient of ASME flow nozzles with throat taps is 
given in ANSI/ASME PTC 6 and Steam Turbines Performance Test Codes 1976 
(reaffirmed in 1982 and 1991). 

Discharge Coefficient  @ β = 0.43 (§4.22d) 

The Standard provides the following discharge coefficients for β=0.43, at various 
Reynolds numbers.  

Table C-5 Discharge Coefficients 

Throat Reynolds 
Number x 10-6

Discharge Coefficient Cβ=0.43 

0.10 0.9834 

0.2 0.9909 

0.3 0.9939 

0.4 0.9953 

0.5 0.9961 

0.6 0.9966 

0.8 0.9970 

1.0 0.9972 

2.0 0.9970 

3.0 0.9970 

4.0 0.9972 

5.0 0.9974 

6.0 0.9978 

8.0 0.9980 

10.0 0.9983 

20.0 0.9991 

30.0 0.9994 

40.0 0.9998 
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The following equation was fitted to the above points. The maximum deviation is 
0.03%. 

[ ] [
[ ] [ ]

C R

R R

d d

d d

β = = − + −

+ −

0 43

2

3 4

2 9385202378 2 353680507 05261432417

0 0520709677 0 0019238022

. . . log( ) . log( )

. log( ) . log( )

]R
 

For beta ratios other than 0.43: 

C C= + −=β β0 43 0 011339 0 0049. ( . . )  

C2.5 Classical Venturi Tubes Discharge Coefficients 

C2.5.1 Symbol Table 

The symbol table for classic Venturi tubes discharge coefficients is shown below.  

Table C-6 Classical Venturi Tubes Discharge Coefficients Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

β - 0 < β 0.30 ≤ β β ≤ 0.75 β < 1 §9.5.2 
§9.5.3 

RD - 0 < RD varies with design None §9.5.2 
§9.5.3 

D m 0 < D varies with design None §8.4.4 

C - C > 0 None None C ≤ 1  

The standard applies to 3 types of venturi tubes (§9): 
1. Venturi with an as-cast convergent 
2. Venturi with a machined convergent 
3. Venturi with a fabricated convergent 

C2.5.2 Calculations 

C2.5.2.1 ASME Venturi Tubes With an As-Cast or Fabricated Convergent (§9.5.2) 

The calculation for ASME Venturi tubes with an as-cast or fabricated convergent is: 

0100 1200
2 10 6 105 6

. .≤ ≤

× ≤ ≤ ×

D
RD

 

0 3 0 75. .≤ ≤β  

C = 0.984 

 236  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  



C2 ASME Standard MFC-3M-1989  User Manual 

Note: The current data indicates that venturis may be used with diameters up to 
2.1 meters. 

C2.5.2.2 ASME Venturi Tubes With a Machined Convergent (§9.5.3) 

The calculation for ASME Venturi tubes with a machined convergent is: 

0 050 0 250
2 10 2 105 6

. .≤ ≤

× ≤ ≤ ×

D
RD

 

0 3 0 75. .≤ ≤β  

C = 0.995 

C2.6 Orifice Plate Expansion Factors 

C2.6.1 Symbol Table 

The symbol table for orifice plate expansion factors is shown below. 

Table C-7 Orifice Plate Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

RD - 0 < RD 2000 ≤ RD RD < 108 None §7.3.2.1 

D m 0 < D 0.0429 < D D < 0.900 None §7.3.2.1 

β - 0 < β 0.20 ≤ β β ≤ 0.70 β < 1 §7.1.6.1 

κ - 0 < κ None None None  

P1 Pa 0 < P1 0 < P1 None None  

P2 Pa 0 < P2 varies 
w/fluid 
states 

P2 < P1 None  

∆P Pa 0 ≤ ∆P 0 ≤ ∆P Νone None  

Y - 0 < Y None None None  

Y2 - 0 < Y2 None None None  

C2.6.2 Calculations 

C2.6.2.1 Gas Expansion Factor Based on Upstream Conditions (§7.3.1.2) 

The calculation for the gas expansion factor based on upstream conditions is: 
P

P
2

1
0 75≥ .  

 

∆P P P= −1 2   
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Y
P
P1

4

1
1 0 41 0 35= − +( . . )β

∆
κ

 
(eq. 29, p. 31) 

C2.6.2.2 Gas Expansion Factor Based on Downstream Conditions (§7.3.1.2) 

The calculation for the gas expansion factor based on downstream conditions is: 
P

P
2

1
0 75≥ .  

 

∆P P P= −1 2   

Y
P

P
P
P2

2

4

1
1 1 0 41 0 35= + − +

⎡

⎣⎢
⎤

⎦⎥
∆ ∆

( . . )β
κ

 
(eq. 30, p. 31) 

C2.6.2.3 Liquid Expansion Factor (§3.2.3) 

The liquid expansion factor calculation is: 

Y Y1 2 1= =  

C2.7 ASME Long Radius Nozzles Expansion Factors 

C2.7.1 Symbol Table 

The symbol table for ASME long radius nozzles expansion factors is shown below. 

Table C-8 ASME Long Radius Nozzles Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

RD - 0 < RD 104 ≤ RD RD < 108 None §8.4.4 

D m 0 < D 0.100 < D D < 0.750  None §8.4.4 

β - 0 < β varies with 
design 

β < 1 §8  

κ - 0 < κ None None None  

P1 Pa 0 < P1 0 < P1 None None §5.3.3 

P2 Pa 0 < P2 varies 
w/fluid state 

P2 < P1 None §5.3.3 

∆P Pa 0 ≤ ∆P 0 ≤ ∆P Νone None  

τ  0 < τ 0.75 None τ < 1  

Y - 0 < Y None None None  

Y2 - 0 < Y2 None None None  
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C2.7.2 Calculations 

C2.7.2.1 Gas Expansion Factor Based on Upstream Conditions (§8.4.3) 

The gas expansion factor based on upstream conditions calculation is: 

τ τ= ≥P
P

2

1
0 75, .  

 

0.52 1
4

1 2
4

1 1
1 1

1 k

Y

κ
κ κκτ β τ

κ τ
β τ

−⎡⎡ ⎤ ⎡ ⎤⎡ ⎤
− −⎢ ⎥⎢ ⎥ ⎢ ⎥⎢ ⎥= ⎢ ⎥⎢ ⎥ ⎢ ⎥⎢ ⎥− −

⎢ ⎥−⎢ ⎥⎢ ⎥ ⎢ ⎥⎣ ⎦⎣ ⎦ ⎣ ⎦⎣ ⎦

⎤
 

(eq. 33, p. 35) 

C2.7.2.2 Gas Expansion Factor Based on Downstream Conditions (§8.4.3) 

The gas expansion factor based on downstream conditions calculation is: 

2

1
, 0.75P

Pτ τ= ≥  
 

1 2P P P∆ = −   

0.5
2

2

(1 )PY Y
P
∆

= +  
(eq. 34, p. 35) 

C2.7.2.3 Liquid Expansion Factor (§3.2.3) 

The liquid expansion factor calculation is: 

Y Y1 2 1= =  

C2.8 Classical Venturi Tube Expansion Factor 

C2.8.1 Symbol Table 

The symbol table for classical Venturi tubes expansion factor is shown below. 

Table C-9 Classical Venturi Tube Expansion Factor Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

RD - 0 < RD varies with 
design 

None §9.5.2 
§9.5.3 

 

D m 0 < D varies with 
design 

None §9.5.2  

β - 0 < β 0.30 ≤ β β ≤ 0.75 β < 1 §9.5.2 
§9.5.3 

κ - 0 < κ None None None  
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Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

P1 Pa 0 < P1 0 < P1 None None §5.3.3 

P2 Pa 0 < P2 varies 
w/fluid state 

P2 < P1 None  

∆P Pa 0 ≤ ∆P 0 ≤ ∆P Νone None  

τ  0 < τ None None τ < 1  

Y - 0 < Y None None None  

Y2 - 0 < Y2 None None None  

C2.8.2 Calculations 

C2.8.2.1 Gas Expansion Factor Based on Upstream Conditions (§9.5.4) 

The calculation for gas expansion factor based on upstream conditions is: 

2

1
, 0.75P

Pτ τ= ≥  
 

0.52 1
4

1 2
4

1 1
1 1

1 k

Y

κ
κ κκτ β τ

κ τ
β τ

−⎡⎡ ⎤ ⎡ ⎤⎡ ⎤
− −⎢ ⎥⎢ ⎥ ⎢ ⎥⎢ ⎥= ⎢ ⎥⎢ ⎥ ⎢ ⎥⎢ ⎥− −

⎢ ⎥−⎢ ⎥⎢ ⎥ ⎢ ⎥⎣ ⎦⎣ ⎦ ⎣ ⎦⎣ ⎦

⎤
 

(eq. 33, p. 35) 

C2.8.2.2 Gas Expansion Factor Based on Downstream Conditions (§9.5.4) 

The calculation for gas expansion factor based on downstream conditions is: 

2

1
, 0.75P

Pτ τ= ≥  
 

1 2P P P∆ = −   

0.5
2 1

2

(1 )PY Y
P
∆

= +  
(eq. 34, p. 35) 

C2.8.2.3 Liquid Expansion Factor (§3.2.3) 

The liquid expansion factor calculation is: 

Y Y1 2 1= =  

C2.9 Thermal Expansion Correction 

C2.9.1 Symbol Table 

The symbol table for thermal expansion correction is shown below. 
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Table C-10 Thermal Expansion Correction Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

dmeas m 0< dmeas None None dmeas ≤ Dmeas

Dmeas m 0< Dmeas None None None 

αPE m/m/°C 0 < αPE None None None 

αP m/m/°C 0 < αP None None None 

t °C -273.15 < t None None None 

tmeas °C -273.15 < tmeas tmeas is usually 
assumed to be 
20°C 

  

d m 0<d None None None 

D m 0<D None None None 

C2.9.2 Calculations 

C2.9.2.1 Bore Diameter, d, Temperature Correction 

The calculation for bore diameter temperature correction is: 

[ ]1 PE meas measd t tα⎡ ⎤= + −⎣ ⎦ d  (ASME MFC-3M-1989 eq. 19a, p. 12) 

C2.9.2.2 Pipe Diameter, D, Temperature Correction 

The calculation for pipe diameter temperature correction is: 

[ ]1 P meas measD t tα⎡ ⎤= + −⎣ ⎦ D  (ASME MFC-3M-1989 eq. 19b, p. 12) 

C2.10 Flow Rate Calculation 

C2.10.1 Symbol Table 

The symbol table for flow rate calculation is shown below. 

Table C-11 Flow Rate Calculation Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

dmeas m 0 < dmeas None None dmeas ≤ Dmeas  

Dmeas m 0 < Dmeas varies with 
design 

None   

P1 Pa 0 < P1 0 < P1 None None  

P2 Pa 0 < P2 varies 
w/fluid state 

P2 < P1 None  
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Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

t °C -273.15 < t None None None §4.2 

tmeas °C -273.15 < 
tmeas

None None None §4.2 

αP m/m/°C 0 < αP None None None §4.2 

αPE m/m/°C 0 < αPE None None None §4.2 

∆P Pa 0 < ∆P None None None  

ρB kg/m3 0 < ρB None None None  

ρf1 kg/m3 0 < ρf1 None None None  

ρf2 kg/m3 0 < ρf2 None None None  

C - 0 < C 0 < C C < 1 None  

Y - 0 < Y None None None  

Y2 - 0 < Y2 None None None  

d m 0 < d None None None  

D m 0 < D varies with 
design 

None   

β - 0 < β varies with 
design 

β < 1   

qm kg/s 0 < qm None None None §4.2 

C2.10.2 Calculations (§4.3) 

The actual flow is found by iteration, since C and RD are dependent on the flow rate 
qm.   

( )( )d =  d  1 +  t -  tmeas P meas α E  (eq. 19a, p. 12) 

( )( )D =  D  1 +   t -  tmeas P measα  (eq. 19b, p. 12) 

β =  
d
D

 
 

The above values of d, D, and β should be used to calculate C and Y.  

q  =  fuser
4

 C  d  
2 p 
1 -  m 1

2 f1
4

π ρ
β

Y
∆

 
(eq. 13, p. 11) 

or:  

q  =  fuser
4

 C  d
2 p 
1 -  m 2

2 f2
4

π ρ
β

Y
∆

 
(eq. 14, p. 10) 

Where fuser can be used for various calibration factors. 
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C2.11 Permanent Pressure Loss 

C2.11.1 Symbol Table 

The symbol table for permanent pressure loss is shown below. 

Table C-12 Permanent Pressure Loss Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

C - 0 < C None C < 1 None 

∆P Pa 0 < ∆P None None None 

β - 0 < β varies with primary element β < 1 

φ ° 0 < φ 7° ≤ φ φ ≤ 15° None 

∆ϖ Pa 0 < ∆ϖ None None None 

C2.11.2 Calculations 

C2.11.2.1 Orifice Plate (§7.4) 

The orifice plate calculation is: 

∆ ∆ϖ
β β
β β

 =  p 
1 -   -  C 
1 -   +  C 

4 2

4 2

⎛

⎝
⎜

⎞

⎠
⎟  

(eq. 31, p. 32) 

Note: This equation may generate negative permanent pressure loss if β is out of 
range. 

C2.11.2.2 ASME Flow Nozzles (§8.6) 

The ASME flow nozzle calculation is: 

( )2 3 = 1  +  0.014   -  2.06   +  1.18   pϖ β β β∆ ∆  (eq. 36, p.36) 

C2.11.2.3 ASME Venturi Tube (§9.7) 

For the divergent angle, φ  =  15o: 

ζ β β 2 = 0.436 - 0.86 + 0.59  

For the divergent angle, φ  =  7o: 

ζ β β  = 0.218 - 0.42  + 0.38  2  
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For a divergent angle, 7° ≤ φ ≤ 15 °, assume that linear interpolation will provide an 
accurate pressure loss value. 

( )ζ ζ ζ ζ φ
φ = + −

− °
°− °

⎛
⎝⎜

⎞
⎠⎟7 15 7

7
15 7

 

 
∆ ∆ϖ ζ  =    P  (§9.7) 

§ 
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C3 ASME/ANSI Standard MFC-7M-1987 

C3.1 Flow Element Applicability 
This standard applies to the critical flow measurement of single phase gases, using 
venturi nozzles. The nozzles may have toroidal throats or cylindrical throats. 

C3.2 Calculation of Reynolds Numbers 

C3.2.1 Symbol Table 

The symbol table for the calculation of Reynolds Numbers is shown below. 

Table C-1 Calculation of Reynolds Numbers Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

d m 0 < d 0 < d None d < D 

qm kg/s 0 < qm 0 < qm None None 

µo Pa-s 0 < µo 0 < µo None None 

Rd - 0 < Rd 0 < Rd None None 

C3.2.2 Reynolds Numbers Based on Stagnation Properties and the 
Throat Diameter (§2.2.4) 

The equation for Reynolds Numbers based on stagnation properties and the throat 
diameter is: 

4 m
d

qR dοπµ=  
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C3.3 Discharge Coefficients Calculation 

C3.3.1 Symbol Table 

The symbol table for discharge coefficients calculation is shown below. 

Table C-2 Discharge Coefficients Calculation Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper 
Limit 

Upper 
Domain 

Ref. 

Rd - 0 < Rd varies with device None §7.2.2  

C - 0 < C None C < 1 None  

C3.3.2 Calculations 

C3.3.2.1 Toroidal Throat Discharge Coefficient (§7.2.2) 

The Toroidal throat discharge coefficient calculation is: 

10 10 0 9935
15255 7

0 5< < = −R C
Rd

d
.

.
.  

C3.3.2.2 Cylindrical Throat Discharge Coefficient (§7.2.2) 

The cyndrical throat discharge coefficient calculation is: 

35 10 2 5 10 0 9887

2 5 10 2 0 10 10000
0 2165

5 6

6 7
0 2

. . .

. . .
.

.

× < < × =

× < < × = −

R C

R C
R

d

d
d

 

C3.4 Critical Flow Coefficient 

C3.4.1 Symbol Table 

The symbol table for critical flow coefficient is shown below. 

Table C-3 Critical Flow Coefficient Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

k - 0 < k None None None 

CRi - 0 < CRi None None None 

z - 0 < z None None None 
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C3.4.2 Calculations (§2.2.4) 

C3.4.2.1 Real Gas Critical Flow Function 

The real gas critical flow function calculation is: 

C
z

k
kRi

k
k

=
+

⎛
⎝
⎜

⎞
⎠
⎟

+
−1 2

1

1
1

 

C3.5 Flow Rate Calculation 

C3.5.1 Symbol Table 

The symbol table for flow rate calculation is shown below. 

Table C-4 Flow Rate Calculation Symbol Table 

Symbol Units Lower Domain Lower Limit Upper Limit Upper Domain 

β - 0 < β None β < 0.25 β < 1 

C -     

CRi -     

P Pa 0 < P 0 < P None None 

Z - 0 < Z    

ρ kg/m3 0 < ρ    

qm kg/s 0 < qm    

C3.5.2 Calculations (§3.3) 

The flow rate calculation is: 

q d CC ZPm Ri=
π

ρ
4

2  

§ 
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C4 ASME Standard MFC-14M-2003 

C4.1 Flow Element Applicability 
This ASME standard is applicable to small bore precision orifice meters: 

• orifice plates with corner taps 
• orifice plates with flange taps 
• specially designed orifice meters with integral fittings 

(inline sizes ¼ to 1½  inches (6 mm to 40 mm)) 

C4.2 Calculation of Reynolds Number 
The calculation for Reynolds Number for RD and Rd is found in C2.2. The limit of 
applicability of this standard is for RD greater than 1,000. 

C4.3 Discharge Coefficients 

C4.3.1 Symbol Table 

The symbol table for the orifice plant discharge coefficients is shown below. 

Table C-1 Symbols 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

β - 0 < β 0.1 < β β < 0.80 β < 1 

d m None None d<D d<D 

RD - 0 < RD 1000 < RD none None 

D (corner taps) m 0 < D 0.0064 ≤ D D ≤ 0.0450 None 

D (flange taps) m 0 < D 0.0152 ≤ D D ≤ 0.0450 None 

C - C > 0 None C < 1 None 

While the standard is valid down to line size ¼ inch (6 mm), the discharge coefficient 
for flange taps is valid down to ½ inch (13 mm) and for flange taps down to 1 inch 
(25 mm).  These are taken to be nominal sizes, although this is not stated explicitly in 
the standard. 
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C4.3.2 Corner Taps 

( )4 160.0044 0.01750.5991 0.3155 2 1C
D D

4β β β⎡ ⎤⎛ ⎞= + + + + −⎜ ⎟⎢ ⎥⎝ ⎠⎣ ⎦
 

( )
4

4 160.52 1.16 11.92 16.48 4
DD D R
ββ β⎡ ⎤⎛ ⎞+ − + − +⎜ ⎟⎢ ⎥⎝ ⎠⎣ ⎦

−
 

C4.3.3 Flange Taps 

( ) ( )
4

4 12 4 4 10.5980 0.468 10 1 0.87 8.1
D

C
R
ββ β β β −⎡ ⎤= + + − + +⎣ ⎦  

C4.4 Expansion Factor 

( )4

1
1

0.41 0.35
1

P
Y

P
β

κ

+ ∆
= −  

( )4

2
2

2
2

0.41 0.35
1

1

PPY
P PP

P

β

κ

+ ∆∆
= + −

∆
+

 

C4.5 Thermal Expansion Correction 

C4.5.1 Symbol Table 

The symbol table for thermal expansion correction is shown below. 

Table C-2 Thermal Expansion Correction Symbol Table 

Symbol Units Lower Domain Lower Limit Upper Limit Upper Domain 
dmeas m 0< dmeas None None dmeas ≤ Dmeas

Dmeas m 0< Dmeas None None None 

α2 m/m/°C 0 < α2 None None None 

α1 m/m/°C 0 < α1 None None None 

t °C -273.15 < t None None None 

tmeas °C -273.15 < tmeas tmeas is usually assumed to be 20°C 

d m 0<d None None None 

D m 0<D None None None 
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C4.5.2 Calculations 

C4.5.2.1 Bore Diameter, d, Temperature Correction 

The bore diameter temperature correction calculation is: 

[ ]21 meas measd t tα⎡ ⎤= + −⎣ ⎦ d   

C4.5.2.2 Pipe Diameter, D, Temperature Correction 

The pipe diameter temperature correction is: 

[ ]11 meas measD t t Dα⎡ ⎤= + −⎣ ⎦   

C4.6 Flow Rate Calculation 

C4.6.1 Symbol Table 

The symbol table for the flow rate calculation is shown below. 

Table C-3 Flow Rate Calculation Symbol Table 

Symbol Units Lower Domain Lower Limit Upper Limit Upper Domain 
dmeas m 0 < dmeas  dmeas < Dmeas

Dmeas m 0 < Dmeas  None 

P1 Pa 0 < P1 0 < P1 None None 

P2 Pa 0 < P2 0.75 P1 < P2 P2 < P1 None 

t °C -273.15 < t None None None 

tmeas °C -273.15 < tmeas None None None 

α1 m/m/°C 0 < α1 None None None 

α2 m/m/°C 0 < α2 None None None 

ρ1 kg/m3 0 < ρ1 None None None 

C - 0 < C None C ≤ 1 None 

d m 0 < d varies tap type d ≤ D 

D m 0 < D  None 

∆P Pa 0 < ∆P None None None 

β - 0 < β  β < 1 
Y - 0 < Y None Y ≤ 1 None 

qm kg/s 0 < qm None None None 
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C4.6.2 Calculations (§3.3) 

The actual flow may be found by iteration, since RD and for some primary elements 
C depend on the flow, rate qm. 

[ ]1 PE meas measd t tα⎡ ⎤= + −⎣ ⎦ d   

[ ]1 P meas measD t tα⎡ ⎤= + −⎣ ⎦D    

d = 
D

β  
 

1 2P P P∆ = −   

2
4

2
4 1m

Pq CYdπ ρ
β

∆
=

−
 

C4.7 Permanent Pressure Loss 

C4.7.1 Symbol Table 

The symbol table for permanent pressure loss is shown below. 

Table C-4 Permanent Pressure Loss Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

C - 0 < C None C ≤ 1 None 

∆P Pa 0 < ∆p None None None 

β - 0 < β varies with primary element type β < 1 

φ ° 0 < φ varies with primary element type None 

∆ϖ Pa 0 < ∆ϖ None None None 

§ 
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C5 International Standard ISO 5167-1980 (E) 

C5.1 Flow Element Applicability 
The ISO standard is defined for the following flow measurement elements: 

• orifice plates with: 
- flange taps 
- D and D/2 (radius) taps 
- corner taps 

• nozzles: 
- ISA 1932 nozzle 
- long radius nozzles, including: 

- high β ratio 
- low β ratio 

• venturi tubes: 
- venturi-nozzle 
- classical venturi tubes, including: 

- as-cast convergent section 
- machined convergent section 
- fabricated (welded) convergent section 

The standard applies to liquid, vapor, or gas flows which are homogenous (single 
phase), turbulent, subsonic and steady with time (a slow pulsation can be 
acceptable). 

C5.2 Calculation of Reynolds Numbers 

C5.2.1 Symbol Table 

The symbol table for the calculation of Reynolds Numbers is shown below. 

 252  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  



C5 International Standard ISO 5167-1980 (E)  User Manual 

Table C-1 Calculation of Reynolds Numbers Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

d m 0 < d 0 < d None d < D 

D m 0 < D 0 < D None None 

U1 m/s 0 ≤ U1 0 ≤ U1 None None 

ν1 m2/s 0 < ν1 0 < ν1 None None 

Rd - 0 < Rd 0 < Rd None None 

RD - 0 < RD 0 < RD None None 

β - 0 < β 0 < β β ≤ 1 β ≤ 1 

C5.2.2 Reynolds Number Based on the Upstream Condition of the 
Fluid and the Upstream Diameter of the Pipe (§2.4.2) 

The equation for the Reynolds Number based on the upstream condition of the fluid 
and the upstream diameter of the pipe is: 

R
U D

D = 1

1ν
 

C5.2.3 Reynolds Number Based on the Orifice or Throat Diameter of 
the Primary Device (§2.4.2) 

The equation for the Reynolds Number based on the orifice or throat diameter of the 
primary device is: 

β =
d
D

          

R
R

d
D=

β
 

C5.3 Orifice Plate Discharge Coefficients 

C5.3.1 Symbol Table 

The symbol table for the orifice plate discharge coefficients is shown below.  

Table C-2 Orifice Plate Discharge Coefficients Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper Limit Upper 
Domain 

Ref 

β - 0 < β varies with pressure tappings β < 1 7.3.1 
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Symbol Units Lower 
Domain 

Lower 
Limit 

Upper Limit Upper 
Domain 

Ref 

RD - 0 < RD varies with pressure tappings None 7.3.1 

k m 0 < k None None None  

D m 0 < D varies with pressure tappings None 7.3.1 

C - 0 < C 0 < C C < 1 none  

C5.3.2 Calculations 

C5.3.2.1 Base Discharge Coefficients (§7.3.2.1) 

The base discharge coefficients calculation is: 

C
R

L L
D

= + − +
⎡

⎣⎢
⎤

⎦⎥

+ − − ′−

05959 0 0312 01840 0 0029
10

0 0900 1 0 0337

2 1 8 2 5
6 0 75

1
4 4 1

2
3

. . . .

. ( ) .

. .

.

β β β

β β β

 

Where: 

D
1

1
lL =  

L
l

2 = 2

D
 

D
EllL )

D
2

' −
=

′
= 22 (

 

If L then L: . . .1 10 4333 0 0900 0 0390≥ ≡  
• l1 - distance of upstream pressure tap from upstream face of orifice plate 
• l2 - distance of downstream pressure tap from downstream face of orifice 

plate 
• E - thickness of orifice plate 

The valid tap arrangements are defined in paragraphs 7.2.3.4, 7.2.3.5, or 7.2.4. It is 
not permitted to use l1 and l2 which do not match one of the three standardized tap 
arrangements. 
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C5.3.2.2 Corner Taps  

C5.3.2.2.1 Limits (§7.3.1) 

The corner taps limits are: 
• d ≥ 0.0125   
• 0.050 ≤ D ≤ 1.000   
• 0.23 ≤ β ≤ 0.45 0.45 < β ≤ 0.77 0.77 < β ≤ 0.80 
• 5,000 ≤ RD ≤ 108 10,000 ≤ RD ≤ 108 20,000 ≤ RD ≤ 108

The roughness upper limits for the corner taps are shown in the table below. 

Table C-3 Corner Taps Roughness Upper Limits 

β ≤0.3 0.32 0.34 0.36 0.38 0.4 0.45 0.5 0.6 0.7 0.8 

104k/D 25 18.1 12.9 10.0 8.3 7.1 5.6 4.9 4.2 4.0 3.9 

C5.3.2.2.2 Tap Spacing (§7.3.2.1) 

The tap spacing calculation is: 

L L1 2 0= ′ =  

C5.3.2.3 Flange Taps 

C5.3.2.3.1 Limits (§7.3.1) 

The flange taps limits are: 
• d ≥ 0.0125 
• 0.050 ≤ D ≤ 0.760 
• 0.2 ≤ β ≤ 0.75 
• 1,260 β2 D 103 ≤ RD ≤ 108 

The roughness upper limits for flange taps are shown in the table below. 

Table C-4 Flange Taps Roughness Upper Limits 

β ≤0.3 0.32 0.34 0.36 0.38 0.4 0.45 0.5 0.6 0.7 0.8 

104k/D 25 18.1 12.9 10.0 10.0 10.0 10.0 10.0 10.0 10.0 10.0 

C5.3.2.3.2 Tap Spacing, D > 58.62mm (§7.3.2.1) 

The tap spacing calculation is: 

L L D1 2
10 0254= ′ = −.  
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C5.3.2.3.3 Tap Spacing, 50.8.. ≤ D ≤ 58.62, (§7.3.2.1) 

The tap spacing calculation is: 

L L1 2
10 4333 0 0254= ′ = D−. , .  

C5.3.2.4 Radius Taps (D and D/2) 

C5.3.2.4.1 Limits (§7.3.1) 

The radius taps limits are: 
• d ≥ 0.0125 
• 0.050 ≤ D ≤ 0.760 
• 0.2 ≤ β ≤ 0.75 
• 1,260 β2 D 103 ≤ RD ≤ 108 

The radius taps roughness upper limits are shown below. 

Table C-5 Radius Taps Roughness Upper Limits 

β ≤0.3 0.32 0.34 0.36 0.38 0.4 0.45 0.5 0.6 0.7 0.8 

104k/D 25 18.1 12.9 10 10 10 10 10 10 10 10 

C5.3.2.4.2 Tap Spacing, (§7.3.2.1) 

Since L1 ≥ 0.4333, 0.0090L1 ≡ 0.0390 

L2 = 0.47 

C5.4 Nozzles 

C5.4.1 Symbol Table 

The symbol table for nozzles is shown below. 

Table C-6 Nozzles Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper 
Limit 

Upper 
Domain 

β - 0 < β varies with design β < 1  

RD - 0 < RD varies with design None  

k m 0 < k None None None 

D m 0 < D varies with design None  

C -  0 < C None C < 1 None 
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C5.4.2 Calculations 

C5.4.2.1 ISA 1932 Nozzle 

C5.4.2.1.1 Limits (§8.1.6.1) 

The ISA 1932 nozzle limits are: 
• 0.050 ≤ D ≤ 0.500 
• 0.3 ≤ β < 0.44    0.44 ≤ β ≤ 0.80 
• 70,000 ≤ ReD ≤ 107    20,000 ≤ ReD ≤ 107 

The roughness upper limits are listed in the table below. 

Table C-7 ISA 1932 Nozzle Roughness Upper Limits 

β ≤0.3
5 

0.36 0.38 0.40 0.42 0.44 0.46 0.48 0.50 0.60 0.70 0.77 0.80 

104k
/D 

25 18.6 13.5 10.6 8.7 7.5 6.7 6.1 5.6 4.5 4.0 3.9 3.9 

C5.4.2.1.2 Discharge Coefficients (§8.1.6.2) 

The discharge coefficients calculation is: 

[ ]C
R

D

= − + − +
⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 9900 0 2262 0 000215 0 001125 0 002490
106

4 1 4 7

1 15

. . . . .. .

.

β β β  

C5.4.2.2 Long-Radius Nozzles (§8.2) 

C5.4.2.2.1 Limits (§8.2.5.1) 

The long radius nozzle limits are: 
• 0.050 ≤ D ≤ 0.630 
• 0.2 ≤ β ≤ 0.8 
• 104 ≤ RD ≤ 107 

• k/D ≤ 10 x 10-4 
- high ratio nozzles, 0.25 ≤ β ≤ 0.8 and, (§8.2) 
- low ratio nozzles, 0.20 ≤ β ≤ 0.5 (§8.2) 
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C5.4.2.2.2 Discharge Coefficients (§8.2.5.2) 

The discharge coefficients calculation is: 

C
R

D

= −
⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 9965 0 00653
106

0 5

0 5

. . .

.

β  

C5.5 Classical Venturi Tubes and Venturi Nozzles 

C5.5.1 Symbol Table 

The symbol table for classical Venturi tubes and Venturi nozzles is shown below. 

Table C-8 Classical Venturi Tubes and Venturi Nozzles Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

β - 0 < β varies with design β < 1 

RD - 0 < RD varies with design None 

D m 0 < D varies with design None 

C - 0 < C  C ≤ 1  

The standard applies to 3 types of venturi tubes (§9.1) and Venturi nozzle (§9.2): 
1. Classical Venturi with an as-cast convergent 
2. Classical Venturi with a machined convergent 
3. Classical Venturi with a fabricated (welded) convergent 

C5.5.2 Calculations 

C5.5.2.1 Classical Venturi Tube With an As-Cast or Fabricated Convergent (§9.1.5.2) 

C5.5.2.1.1 Limits 

The limits for the classical venturi tube with an as-cast or fabricated convergent are: 
• 0.100 ≤ D ≤ 0.800 
• 0.3 ≤ β ≤ 0.75 
• 2 x 105 ≤ RD ≤ 2 x 106 

C5.5.2.1.2 Discharge Coefficient 

The discharge coefficient is: 

C = 0.984 
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C5.5.2.2 Classical Venturi Tubes With a Machined Convergent (§9.1.5.3) 

C5.5.2.2.1 Limits 

The limits for the classical venturi tubes with a machined convergent are: 
• 0.050 ≤ D ≤ 0.250 
• 0.4 ≤ β ≤ 0.75 
• 2 x 105 ≤ RD ≤ 1 x 106 

C5.5.2.2.2 Discharge Coefficient 

The discharge coefficient is: 

C = 0.995 

C5.5.2.3 Classical Venturi Tubes with a Fabricated (welded) Convergent (§9.1.5.4) 

C5.5.2.3.1 Limits 

The limits for the classical venturi tubes with a fabricated (welded) convergent are: 
• 0.200 ≤ D ≤ 1.200 
• 0.4 ≤ β ≤ 0.7 
• 2 x 105 ≤ RD ≤ 2 x 106 

C5.5.2.3.2 Discharge Coefficient 

The discharge coefficient is: 

C = 0.985 

C5.5.2.4 Classical Venturi Nozzles 

C5.5.2.4.1 Limits (§9.2.4.1) 

The limits for the classical venturi nozzle are: 
• 0.065 ≤ D ≤ 0.500 
• d ≥ 0.050 
• 0.316 ≤ β ≤ 0.775 
• 1.5 x 105 ≤ RD ≤ 2 x 106 

C5.5.2.4.2 Discharge Coefficient (§9.2.4.2) 

The discharge coefficient is: 

C = −0 9858 0 196 4 5. . .β  
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C5.6 Orifice Plates Expansion Factors 

C5.6.1 Symbol Table 

The symbol table for orifice plates expansion factors is shown below. 

Table C-9 Orifice Plates Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper Limit Upper 
Domain 

Ref. 

β - 0 < β varies with pressure tapping β < 1 §7.3.1 

κ - 0 < κ None None None  

P1 Pa 0 < P1 0 < P1 None None  

P2 Pa 0 < P2 0.75 P1 < P2 P2 < P1 None §5.3.3 

∆P Pa 0 ≤ ∆P 0 ≤ ∆P Νone None  

Y - 0 < Y None Y ≤ 1 None  

C5.6.2 Calculations 

C5.6.2.1 Gas Expansion Factor (§7.3.2.2) 

The gas expansion factor calculations are: 

P
P

2

1
0 75≥ .  

∆P P P= −1 2  

Y
P
P1

4

1
1 0 41 0 35= − +( . . )β

∆
κ

 

C5.6.3 Gas Expansion Factor based on Downstream Conditions (ISO 
5167 (1991) p.23) 

The calculation for the gas expansion factor based on downstream conditions is: 

Y Y
p

p2 1
2

1= +
∆

 

Gas expansion factors based on downstream conditions are not specified in ISO 
5167 (1980). However, ISO 5167 (1991) does support downstream conditions and 
will be implemented in ISO 5167 (1980). 
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C5.6.3.1 Liquid Expansion Factor (§2.4.7) 

The liquid expansion factor is: 

Y = 1 

C5.7 Nozzles Expansion Factors 

C5.7.1 Symbol Table 

The symbol table for the nozzle expansion factors is shown below. 

Table C-10 Nozzles Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

β - 0 < β varies with design β < 1  

κ - 0 < κ None None None  

P1 Pa 0 < P1 0 < P1 None None  

P2 Pa 0 < P2 0.75 P1 < P2 P2 < P1 None §5.3.3 

∆P Pa 0 ≤ ∆P 0 ≤ ∆P Νone None  

τ  0 < τ 0.75 ≤ τ None τ < 1  

Y - 0 < Y None Y ≤ 1 None §2.4.7 

C5.7.2 Calculations 

C5.7.2.1 ISA 1932 Nozzle 

C5.7.2.1.1 Gas Expansion Factor (§8.1.6.3) 

The calculations for the gas expansion factors are: 

τ τ= ≥
p
p

2

1
0 75, .  

Y
k

=
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

κτ
κ

β

β τ

τ
τ

κ
κ
κ

2
4

4
2

1
1
2

1
1

1

1
1

 

C5.7.2.1.2 Liquid Expansion Factor (§2.4.7) 

The liquid expansion factor is: 

Y = 1 
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C5.7.2.2 Long Radius Nozzles 

C5.7.2.2.1 Gas Expansion Factor (§8.2.5.3) 

The long radium nozzles gas expansion factor calculations are: 

τ τ= ≥
p
p

2

1
0 75, .  

Y
k

=
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

κτ
κ

β

β τ

τ
τ

κ
κ
κ

2
4

4
2

1
1
2

1
1

1

1
1

 

C5.8 Classical Venturi Tubes and Venturi Nozzles 
Expansion Factor 

C5.8.1 Symbol Table 

The symbol table for the classical venturi tubes and venturi nozzles expansion factor 
is shown below. 

Table C-11 Classical Venturi Tubes/Nozzles Expansion Factor Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

β - 0 < β varies with design β < 1  

κ - 0 < κ None None None  

p1 Pa 0 < p1 0 < p1 None None  

p2 Pa 0 < p2 0.75 p1 < p2 p2 < p1 None §5.3.3 

∆p Pa 0 ≤ ∆p 0 ≤ ∆p Νone None  

τ  0 < τ None None τ < 1  

Y - 0 < Y None Y ≤ 1 None  

C5.8.2 Calculations 

C5.8.2.1 Classical Venturi Tube 

C5.8.2.1.1 Gas Expansion Factor (§9.1.6) 

The gas expansion factor calculations are: 

τ τ= ≥
p
p

2

1
0 75, .  
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Y
k

=
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

κτ
κ

β

β τ

τ
τ

κ
κ
κ

2
4

4
2

1
1
2

1
1

1

1
1

 

C5.8.2.2 Venturi Nozzle 

C5.8.2.2.1 Gas Expansion Factor (§9.1.6) 

The gas expansion factor calculation is: 

τ τ= ≥
p
p

2

1
0 75, .  

Y
k

=
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

κτ
κ

β

β τ

τ
τ

κ
κ
κ

2
4

4
2

1
1
2

1
1

1

1
1

 

C5.9 Thermal Expansion Correction 
ISO 5167 requires temperature compensation to be applied to d and D, but does not 
provide a method to do so, therefore, the correction stated in ASME MFC-3M-1989 
will be applied. 

C5.9.1 Symbol Table 

The symbol table for thermal expansion correction is shown below. 

Table C-12 Thermal Expansion Correction Symbol Table 

Symbol Units Lower Domain Lower Limit Upper Limit Upper 
Domain 

dmeas m 0< dmeas None None dmeas ≤ Dmeas

Dmeas m 0< Dmeas None None None 

αPE m/m/°C 0 < αPE None None None 

αP m/m/°C 0 < αP None None None 

t °C -273.15 < t None None None 

tmeas °C -273.15 < tmeas tmeas is usually assumed to be 20°C 

d m 0<d None None None 

D m 0<D None None None 
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C5.9.2 Calculations 

C5.9.2.1 Bore Diameter, d, Temperature Correction 

The bore diameter temperature correction calculation is: 

[ ]1 PE meas measd t tα⎡ ⎤= + −⎣ ⎦ d  (ASME MFC-3M-1989 eq. 19a, p. 12) 

C5.9.2.2 Pipe Diameter, D, Temperature Correction 

The pipe diameter temperature correction is: 

[ ]1 P meas measD t tα⎡ ⎤= + −⎣ ⎦ D  (ASME MFC-3M-1989 eq. 19b, p. 12) 

C5.10 Flow Rate Calculation 

C5.10.1 Symbol Table 

The symbol table for the flow rate calculation is shown below. 

Table C-13 Flow Rate Calculation Symbol Table 

Symbol Units Lower Domain Lower Limit Upper Limit Upper 
Domain 

dmeas m 0 < dmeas varies with  primary element type dmeas < Dmeas

Dmeas m 0 < Dmeas varies with primary element type None 

P1 Pa 0 < P1 0 < P1 None None 

P2 Pa 0 < P2 0.75 P1 < P2 P2 < P1 None 

t °C -273.15 < t None None None 

tmeas °C -273.15 < tmeas None None None 

αP m/m/°C 0 < αP None None None 

αPE m/m/°C 0 < αPE None None None 

ρ1 kg/m3 0 < ρ1 None None None 

C - 0 < C None C ≤ 1 None 

d m 0 < d varies with primary element type d ≤ D 

D m 0 < D varies with primary element type None 

∆P Pa 0 < ∆P None None None 

β - 0 < β varies with primary element type  β < 1 
Y - 0 < Y None Y ≤ 1 None 

qm kg/s 0 < qm None None None 
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C5.10.2 Calculations (§3.3) 

The actual flow may be found by iteration, since RD and for some primary elements 
C depend on the flow, rate qm. 

[ ]1 PE meas measd t tα⎡ ⎤= + −⎣ ⎦ d  (ASME MFC-3M-1989 eq. 19a, p. 12) 

[ ]1 P meas measD t tα⎡ ⎤= + −⎣ ⎦ D   (ASME MFC-3M-1989 eq. 19b, p. 12) 

d = 
D

β  
 

1 2P P P∆ = −   

The above values of d, D, and β should be used to calculate C and Y . 

q  =  
4

 C  D  
2 P 
1 -  m 1

2 1
4

π
β

ρ
β

Y 2 ∆
  or  4

122
2m  - 1

 P 2 D  C 
4

 = q
β

ρβπ ∆Y  

C5.11 Permanent Pressure Loss 

C5.11.1 Symbol Table 

The symbol table for permanent pressure loss is shown below. 

Table C-14 Permanent Pressure Loss Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

C - 0 < C None C ≤ 1 None 

∆P Pa 0 < ∆p None None None 

β - 0 < β varies with primary element type β < 1 

φ ° 0 < φ varies with primary element type None 

∆ϖ Pa 0 < ∆ϖ None None None 

C5.11.2 Calculations 

C5.11.2.1 Orifice Plates (§7.4) 

The orifice plate calculation is: 

∆ ∆ϖ
β β

β β
  P 

1 -   -  C 

1 -   +  C 

4 2

4 2
≈

⎛

⎝
⎜

⎞

⎠
⎟ 
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The above equation may generate negative permanent pressure loss. If the 

calculated ∆ϖ  is too low, the following equation will be used: 

( )∆ ∆ϖ β  P ≈ −1 1 9.  

C5.11.2.2 Nozzles 

C5.11.2.2.1 ISA 1932 Nozzle (§8.1.8) 

The ISA 1932 nozzle calculation is: 

∆ ∆ϖ
β β
β β

  P 
1 -   -  C 
1 -   +  C 

4 2

4 2
≈

⎛

⎝
⎜

⎞

⎠
⎟ 

C5.11.2.2.2 Long Radius Nozzle (§8.2.7) 

The long radius nozzle calculation is: 

∆ ∆ϖ
β β
β β

  P 
1 -   -  C 
1 -   +  C 

4 2

4 2
≈

⎛

⎝
⎜

⎞

⎠
⎟ 

C5.11.2.3 Classical Venturi Tubes and Venturi Nozzles 

C5.11.2.3.1 Classical Venturi Tubes (§9.1.9.2) 

ISO 5167 provides graphs of pressure loss for guidance only. The ASME MFC-3M-
1989 methods will be used to calculate the pressure loss. 

For the divergent angle, φ  =  15°: 
ζ β β 2 = 0.436 - 0.86 + 0.59  (ASME MFC-3M-1989, p.42) 

For the divergent angle, φ  =  7o: 
ζ β β  = 0.218 - 0.42  + 0.38  2  (ASME MFC-3M-1989, p.42) 

For a divergent angle, 7° ≤ φ ≤ 15°, assume that linear interpolation will provide an 
accurate pressure loss value. 

( )ζ ζ ζ ζ φ
φ = + −

− °
°− °

⎛
⎝⎜

⎞
⎠⎟7 15 7

7
15 7

 
 

∆ ∆ϖ ζ  =    p (ASME MFC-3M-1989, p.42) 

C5.11.2.3.2 Venturi Nozzles (§9.2.6) 

Although §9.2.1.3 allows the divergent angle to be as large as 30°, the permanent 
pressure loss calculation will use a maximum of 15° as limited in §9.2.6. 
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ISO 5167 provides graphs of pressure loss for guidance only.  The ASME MFC-3M-
1989 methods will be used to calculate the pressure loss. 

For the divergent angle, φ  =  15°: 
ζ β β 2 = 0.436 - 0.86 + 0.59  (ASME MFC-3M-1989, p.42) 

For the divergent angle, φ  =  7°: 
ζ β β  = 0.218 - 0.42  + 0.38  2  (ASME MFC-3M-1989, p.42) 

For a divergent angle, 7° ≤ φ ≤ 15°, assume that linear interpolation will provide an 
accurate pressure loss value. 

( )ζ ζ ζ ζ φ
φ = + −

− °
°− °

⎛
⎝⎜

⎞
⎠⎟7 15 7

7
15 7

 
 

∆ ∆ϖ ζ  =    p (ASME MFC-3M-1989, p.42) 

C5.12 Uncertainties 
This section intentionally left blank. 

§ 
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C6.1 Flow Element Applicability 
The ISO standard is defined for the following flow measurement elements: 

• orifice plates with: 
- flange taps 
- D and D/2 (radius) taps 
- corner taps 

• nozzles: 
- ISA 1932 nozzle 
- long radius nozzles, including: 

- high β ratio nozzles 
- low β ratio nozzles 

• venturi tubes: 
- venturi-nozzle 
- classical venturi tubes, including: 

- as-cast convergent section 
- machined convergent section 
- fabricated (welded) convergent section 

The standard applies to liquid, vapor, or gas flows which are homogenous (single 
phase), turbulent, subsonic and steady with time (a slow pulsation can be 
acceptable). 

C6.2 Calculation of Reynolds Numbers 

C6.2.1 Symbol Table 

The symbol table for the calculation of Reynolds Numbers is shown below. 

Table C-1 Calculation of Reynolds Numbers Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

d m 0 < d 0 < d None d < D 

D m 0 < D 0 < D None None 
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Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

U1 m/s 0 ≤ U1 0 ≤ U1 None None 

ν1 m2/s 0 < ν1 0 < ν1 None None 

Rd - 0 < Rd 0 < Rd None None 

RD - 0 < RD 0 < RD None None 

β - 0 < β 0 < β β ≤ 1 β ≤ 1 

µ1 kg/m-sec 0 < µ 0 < µ None None 

C6.2.2 Reynolds Number Based on the Upstream Condition of the 
Fluid and the Upstream Diameter of the Pipe (§3.3.2) 

The calculation for the Reynolds Number based on the upstream condition of the 
fluid and the upstream diameter of the pipe is: 

ReD
mU D q
D

= =1

1 1

4
ν πµ

 

C6.2.3 Reynolds Number Based on the Orifice or Throat Diameter of 
the Primary Device (§3.3.2) 

The calculation for the Reynolds Number based on the orifice or throat diameter of 
the primary device is: 

β =
d
D

 

R
R

d
D=

β
 

C6.3 Orifice Plate Discharge Coefficients 

C6.3.1 Symbol Table 

The symbol table for the orifice plate discharge coefficients is shown below. 

Table C-2 Orifice Plate Discharge Coefficients Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

Ref 

β - 0 < β varies with pressure tappings β < 1 §8.3.1 

RD - 0 < RD varies with pressure tappings None §8.3.1 

k m 0 < k None None None  
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Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

Ref 

D m 0 < D varies with pressure tappings None §8.3.1 

C - 0 < C 0 < C C < 1 None  

C6.3.2 Calculations 

C6.3.2.1 Base Discharge Coefficients (§8.3.2.1) 

The calculation for base discharge coefficients is: 

C

L L
D

= + − +
⎡

⎣
⎢

⎤

⎦
⎥

+ − − ′−

05959 0 0312 01840 0 0029 10

0 0900 1 0 0337

2 1 8 2 5
6 0 75

1
4 4 1

2
3

. . . .
Re

. ( ) .

. .
.

β β β

β β β

 

Where: 

L l
D1
1=  

′ =
′

L
l
D2
2  

If L L: . . .1 10 4333 0 0900 0 0390≥ ≡then  
• l1 - distance of upstream pressure tap from upstream face of orifice plate 
• l2 - distance of downstream pressure tap from downstream face of orifice 

plate 
• E - thickness of orifice plate 

The valid tap arrangements are defined in paragraphs 8.2. It is not permitted to enter 
into equation pairs of values L1 and L´2 which do not match one of the three 
standardized tap arrangements. 

C6.3.2.2 Corner Taps 

C6.3.2.2.1 Limits (§8.3.1) 

The corner taps limits are: 
• d ≥ 0.0125 
• 0.050 ≤ D ≤ 1.0 
• 0.2 ≤ β ≤ 0.45         β > 0.45 
•            R5000DR ≥ D ≥ 10,000 

The roughness upper limits for the corner taps are shown below. 
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Table C-3 Corner Tap Roughness Upper Limits 

β ≤0.3 0.32 0.34 0.36 0.38 0.4 0.45 0.5 0.6 0.75 

104k/D 25 18.1 12.9 10.0 8.3 7.1 5.6 4.9 4.2 4.0 

C6.3.2.2.2 Tap Spacing (§8.3.2.1) 

The tap spacing calculation is: 

L1 = L´2 = 0 

C6.3.2.3 Flange Taps 

C6.3.2.3.1 Limits (§8.3.1) 

The flange tap limits are: 
•  d ≥ 0 0125.
• 0.050 ≤ D ≤ 1.000 
• 0 2 0 75. .≤ ≤β  

• R DxD ≥ 1260 102 3β  

The roughness upper limits for the flange taps are shown below. 

Table C-4 Flange Taps Roughness Upper Limits 

β ≤0.3 0.32 0.34 0.36 0.38 0.4 0.45 0.5 0.6 0.75 

104k/D 25 18.1 12.9 10.0 8.3 7.1 5.6 4.9 4.2 4.0 

C6.3.2.3.2 Tap Spacing, D > 58.62mm (§8.3.2.1) 

The tap spacing calculation is: 

L1 = L´2 = 0.0254D-1 

C6.3.2.3.3 Tap Spacing, 50.8mm ≤ D ≤ 58.62mm (§8.3.2.1) 

The tap spacing calculations are: 

L1 = 0.4333 

L´2 = 0.0254D-1 

C6.3.2.4 Radius Taps (D and D/2) 

C6.3.2.4.1 Limits (§8.3.1) 

The radius taps limits are: 
•  d ≥ 0 0125.

 271  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  



User Manual  C6 International Standard ISO 5167-1-1991 (E) 

• 0.050 ≤ D ≤ 1.000 
• 0 2 0 75. .≤ ≤β  

• R DD ≥ 1260 2β  

Note: D is in mm. 

The roughness upper limits for the radius taps are shown below. 

Table C-5 Radius Taps Roughness Upper Limits 

β ≤0.3 0.32 0.34 0.36 0.38 0.4 0.45 0.5 0.6 0.75 

104k/D 25 18.1 12.9 10.0 8.3 7.1 5.6 4.9 4.2 4.0 

C6.3.2.4.2 Tap Spacing (§8.3.2.1) 

The tap spacing is: 

Since L1 ≥ 0.4333, 0.0090L1 ≡ 0.0390 

L´2 = 0.47 

C6.4 Nozzles 

C6.4.1 Symbol Table 

The symbol table for nozzles is shown below. 

Table C-6 Nozzles Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

β - 0 < β varies with design β < 1 

ReD - 0 < RD varies with design None 

k m 0 < k None None None 

D m 0 < D varies with design None 

C -  0 < C None C <1 None 

C6.4.2 Calculations 

C6.4.2.1 ISA 1932 Nozzle 

C6.4.2.1.1 Limits (§9.1.6.1) 

The ISA 1932 nozzle limits are: 
• 0.050 ≤ D ≤ 0.500 
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• 0.3 ≤ β < 0.44  0.44 ≤ β ≤ 0.80 
• 70,000 ≤ RD ≤ 107 20,000 ≤ RD ≤ 107 

The roughness upper limits for the ISA 1932 nozzle are shown in the table below. 

Table C-7 ISA 1932 Nozzle Roughness Upper Limits 

β ≤0.3
5 

0.36 0.38 0.40 0.42 0.44 0.46 0.48 0.50 0.60 0.70 0.77 0.80 

104 

k/D 
25 18.6 13.5 10.6 8.7 7.5 6.7 6.1 5.6 4.5 4.0 3.9 3.9 

C6.4.2.1.2 Discharge Coefficients (§9.1.6.2) 

The discharge coefficient calculation is: 

[ ]C
D

= − − −
⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 9900 0 2262 0 00175 0 0033
106

4 1 2 4 15

1 15

. . . .
Re

. .

.

β β β  

C6.4.2.1.3 Expansibility (§9.1.6.3) 

The expansibility calculation is: 

ε κτ
κ

β
β τ

τ
τ

κ

κ

κ κ

1

2 4

4 2

1 1 2

1
1

1
1

1
=

−
⎛
⎝
⎜

⎞
⎠
⎟

−
−

⎛
⎝
⎜

⎞
⎠
⎟

−
−

⎛
⎝
⎜

⎞
⎠
⎟

⎡

⎣
⎢

⎤

⎦
⎥

−/

/

( )/ /

 

(for  p2/ p1≥0.75) 

C6.4.2.2 Long-Radius Nozzles 

The long radius nozzles include: 
• high ratio nozzles, 0.25 ≤ β ≤ 0.8, and (§9.2.1) 
• low ratio nozzles, 0.20 ≤ β ≤ 0.5  (§9.2.1) 

C6.4.2.2.1 Limits (§9.2.6.1) 

The long radium nozzle limits are: 
• 0.050 ≤ D ≤ 0.630 
• 0.2 ≤ β ≤ 0.8 
• 104 ≤ RD ≤ 107 
• k/D ≤ 10 x 10-4 
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C6.4.2.2.2 Discharge Coefficients (§9.2.6.2) 

The discharge coefficients calculation is: 

C
R

D

= −
⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 9965 0 00653
106

0 5

0 5

. . .

.

β  
(for upstream Reynolds Number) 

or  

C
R

d

= −
⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 9965 0 00653
106 0 5

. .

.

 
(for throat Rd) 

C6.5 Venturi Tubes and Venturi Nozzles 

C6.5.1 Symbol Table 

The symbol table for venturi tubes and venturi nozzles is shown below. 

Table C-8 Venturi Tubes/Nozzles Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

β - 0 < β varies with design β < 1 

ReD - 0 < ReD varies with design None 

D m 0 < D varies with design None 

C - C > 0 None C ≤ 1 None 

The standard applies to 3 types of venturi tubes (§10.1) and Venturi Nozzle (§10.2): 
1. Venturi with an as-cast convergent, 
2. Venturi with a machined convergent, and 
3. Venturi with a fabricated (welded) sheet-iron convergent. 

C6.5.2 Calculations 

C6.5.2.1 Classical Venturi Tube With an As-Cast Convergent (§10.1.5.2) 

C6.5.2.1.1 Limits 

The limits for the classical venturi tube with an as-cast convergent are: 
• 0.100 ≤ D ≤ 0.800 
• 0.3 ≤ β ≤ 0.75 
• 2 x 105 ≤ RD ≤ 2 x 106 
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C6.5.2.1.2 Discharge Coefficient 

The discharge coefficient is: 

C = 0.984 

C6.5.2.2 Classical Venturi Tubes With a Machined Convergent (§10.1.5.3) 

C6.5.2.2.1 Limits 

The limits for the classical venturi tube with a machined convergent are: 
• 0.050 ≤ D ≤ 0.250 
• 0.4 ≤ β ≤ 0.75 
• 2 x 105 ≤ RD ≤ 1 x 106 

C6.5.2.2.2 Discharge Coefficient 

The discharge coefficient is: 

C = 0.995 

C6.5.2.3 Classical Venturi Tubes With a Rough Welded Convergent (§10.1.5.4) 

C6.5.2.3.1 Limits 

The limits for the classical venturi tube with a rough welded convergent are: 
• 0.200 ≤ D ≤ 1.200 
• 0.4 ≤ β ≤ 0.7 
• 2 x 105 ≤  ReD ≤  2 x 106 

C6.5.2.3.2 Discharge Coefficient 

The discharge coefficient is: 

C = 0.985 

C6.5.2.4 Venturi Nozzle 

C6.5.2.4.1 Limits (§10.2.4.1) 

The limits for the venturi nozzle are: 
• 0.065 ≤ D ≤ 0.500 
• d ≤ 0.050 
• 0.316 ≤ β ≤ 0.775 
• 1.5 x 105 ≤ RD ≤ 2 x 106 
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C6.5.2.4.2 Discharge Coefficient (§10.2.4.2) 

The discharge coefficient is: 

C = −0 9858 0 196 4 5. . .β  

C6.6 Orifice Plate Expansion Factors 

C6.6.1 Symbol Table 

The symbol table for orifice plate expansion factors is shown below. 

Table C-9 Orifice Plate Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

β - 0 < β varies with design β < 1 §7.3.1 

κ - 0 < κ None None None  

p1 Pa 0 < p1 0 < p1 None None §5.3.3 

p2 Pa 0 < p2 0.75 p1 < p2 p2 < p1 None §5.3.3 

∆p Pa 0 ≤ ∆p 0 ≤ ∆p Νone None  

Y - 0 < Y None Y ≤ 1 None §2.4.7 

C6.6.2 Gas Expansion Factor based on Upstream Conditions 
(§8.3.2.2) 

The calculation for gas expansion factors based on upstream conditions is: 

Y
p
p1

4

1
1 0 41 0 35= − +( . . )β

κ
∆

 

In addition to other limit conditions, the above equation is only applicable for  
p2/p1 ≥ 0.75. 

This formula is a result of testing on air, steam, and natural gas. There are no known 
objections to applying it to other gases. 

C6.6.3 Gas Expansion Factor based on Downstream Conditions 
(§8.3.2.2) 

The calculation for gas expansion factors based on downstream conditions is: 

Y Y
P

P2 1
2

1= +
∆
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C6.6.4 Liquid Expansion Factor (§3.3.5) 

The liquid expansion factor is: 

Y = 1 

C6.7 Nozzles Expansion Factors 

C6.7.1 Symbol Table 

The symbol table for nozzles expansion factors is shown below. 

Table C-10 Nozzles Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

β - 0 < β varies with design β < 1  

κ - 0 < κ None None None  

P1 Pa 0 < P1 0 < P1 None None  

P2 Pa 0 < P2 0.75 P1 < P2 P2 < P1 None  

∆P Pa 0 ≤ ∆P 0 ≤ ∆P Νone None  

τ  0 < τ 0.75 ≤ τ None τ < 1  

Y - 0 < Y None Y ≤ 1 None §2.4.7 

C6.7.2 Calculations 

C6.7.2.1 ISA 1932 Nozzle 

C6.7.2.1.1 Gas Expansion Factor (§8.1.6.3) 

The gas expansion factor calculations are: 

τ τ= ≥
p
p

2

1
0 75, .  

Y
k

=
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

κτ
κ

β

β τ

τ
τ

κ
κ
κ

2
4

4
2

1
1
2

1
1

1

1
1

 

C6.7.2.1.2 Liquid Expansion Factor (§2.4.7) 

The liquid expansion factor is: 

Y = 1 
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C6.7.2.2 Long Radius Nozzles 

C6.7.2.2.1 Gas Expansion Factor (§8.2.5.3) 

The gas expansion factor calculations are: 

τ τ= ≥
p
p

2

1
0 75, .  

Y
k

=
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
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−
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−
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C6.7.2.2.2 Liquid Expansion Factor (§2.4.7) 

The liquid expansion factor is: 

Y = 1 

C6.8 Classical Venturi Tubes and Venturi Nozzles 
Expansion Factor 

C6.8.1 Symbol Table 

The symbol table for the classical venturi tubes and venturi nozzles expansion factor 
is shown below. 

Table C-11 Classical Venturi Tubes/Nozzles Expansion Factor Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

β - 0 < β varies with design β < 1  

κ - 0 < κ None None None  

p1 Pa 0 < p1 0 < p1 None None  

p2 Pa 0 < p2 0.75 p1 < p2 p2 < p1 None §5.3.3 

∆p Pa 0 ≤ ∆p 0 ≤ ∆p Νone None  

τ  0 < τ None None τ < 1  

Y - 0 < Y None Y ≤ 1 None  
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C6.8.2 Calculations 

C6.8.2.1 Classical Venturi Tube 

C6.8.2.1.1 Gas Expansion Factor (§9.1.6) 

The gas expansion factor calculations are: 

τ τ= ≥
p
p

2

1
0 75, .  

Y
k

=
−

⎡
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C6.8.2.1.2 Liquid Expansion Factor (§2.4.7) 

The liquid expansion factor is: 

Y = 1 

C6.8.2.2 Venturi Nozzle 

C6.8.2.2.1 Gas Expansion Factor (§9.1.6) 

The venturi nozzle gas expansion factor calculations are: 

τ τ= ≥
p
p

2

1
0 75, .  

Y
k

=
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

κτ
κ

β

β τ

τ
τ

κ
κ
κ

2
4

4
2

1
1
2

1
1

1

1
1

 

C6.8.2.2.2 Liquid Expansion Factor (§2.4.7) 

The nozzle liquid expansion factor is: 

Y = 1 
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C6.8.3 Uncertainties (§8.3.3) 

For all three types of tappings, assume that β, D, C, RD and k/D are known without 
error, the relative uncertainty of the value of C is equal to: 
0.6% for β ≤ 0 6.  
β% for 0 6 0 75. .< ≤β  
uncertainty in Y1   

4
1

∆P
P

 
  

C6.9 Thermal Expansion Correction 
ISO 5167 requires temperature compensation to be applied to d and D, but does not 
provide a method to do so. Therefore, the corrections stated in ASME MFC-3M-1989 
will be applied. 

C6.9.1 Symbol Table 

The symbol table for thermal expansion correction is shown below. 

Table C-12 Thermal Expansion Correction Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

dmeas m 0< dmeas None None dmeas ≤ Dmeas

Dmeas m 0< Dmeas None None None 

αPE m/m/°C 0 < αpE None None None 

αp m/m/°C 0 < αp None None None 

t °C -273.15 < t None None None 

tmeas °C -273.15 < tmeas tmeas is usually assumed to be 
20°C 

 

d m 0<d None None None 

D m 0<D None None None 

C6.9.2 Calculations 

C6.9.2.1 Bore Diameter, d, Temperature Correction 

The bore diameter temperature correction calculation is: 

[ ]1 PE meas measd t tα⎡ ⎤= + −⎣ ⎦ d  (ASME MFC-3M-1989 eq. 19a, p. 12) 
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C6.9.2.2 Pipe Diameter, D, Temperature Correction 

The pipe diameter temperature correction calculation is: 

[ ]1 p meas measD t tα⎡ ⎤= + −⎣ ⎦ D  (ASME MFC-3M-1989 eq. 19b, p. 12) 

C6.10 Flow Rate Calculation 

C6.10.1 Symbol Table 

The symbol table for flow rate calculation is shown below. 

Table C-13 Flow Rate Calculation Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper Domain 

dmeas m 0 < dmeas varies with primary element type dmeas < Dmeas

Dmeas m 0 < Dmeas varies with primary element type None 

P1 Pa 0 < P1 0 < P1 None None 

P2 Pa 0 < P2 0.75 P1 < P2 P2 < P1 None 

t °C -273.15 < t None None None 

tmeas °C -273.15 < tmeas None None None 

αP m/m/°C 0 < αP None None None 

αPE m/m/°C 0 < αPE None None None 

ρ1 kg/m3 0 < ρ1 None None None 

C - 0 < C None C ≤ 1 None 

d m 0 < d varies with primary element type None 

D m 0 < D varies with primary element type None 

∆P Pa 0 < ∆P None None None 

β - 0 < β varies with primary element β < 1 

Y - 0 < Y None Y ≤ 1 None 

qm kg/s 0 < qm None None None 

C6.10.2 Calculations (§5.3) 

The actual flow is found by iteration, since RD and for some primary elements C are 
dependent on the flow rate qm. 

q  =  
4

 C  d  
2 P 
1 -  m

2 1
4

π ρ
β

Y1

∆
    or   q  =  

4
 C  d  

2 P 
1 -  m

2 2
4

π ρ
β

Y2

∆
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Where Y2 and ρ2 are referred  to the downstream conditions; d and D should use the 
working condition value or with correction terms. 

C6.11 Permanent Pressure Loss 

C6.11.1 Symbol Table 

The symbol table for permanent pressure loss is shown below. 

Table C-14 Permanent Pressure Loss Symbol Table 

Symbol Units Lower Domain Lower Limit Upper Limit Upper 
Domain 

C - 0 < C None C ≤ 1 None 

∆P Pa 0 < ∆P None None None 

β - 0 < β varies with primary element type β < 1 

φ ° 0 < φ varies with primary element type None 

∆ω Pa 0 < ∆ω None None None 

C6.11.1.1 Calculations 

C6.11.2 Orifice Plate (§8.4.1) 

The orifice plate calculation is: 

∆ ∆ϖ
β β
β β

  P 
1 -   -  C 
1 -   +  C 

4 2

4 2
=

⎛

⎝
⎜

⎞

⎠
⎟  

C6.11.3 Nozzles 

C6.11.3.1 ISA 1932 Nozzle (§9.1.8) 

The ISA 1932 nozzle calculation is: 

∆ ∆ϖ
β β
β β

  P 
1 -   -  C 
1 -   +  C 

4 2

4 2
=

⎛

⎝
⎜

⎞

⎠
⎟  

C6.11.3.2 Long Radius Nozzle (§9.2.8) 

∆ ∆ϖ
β β
β β

  P 
1 -   -  C 
1 -   +  C 

4 2

4 2
=

⎛

⎝
⎜

⎞

⎠
⎟  
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C6.11.4 Classical Venturi Tubes and Venturi Nozzles 

C6.11.4.1 Classical Venturi Tubes (§10.1.9.2) 

ISO 5167 provides graphs of pressure loss for guidance only. The ASME MFC-3M-
1989 equations will be used to calculate the pressure loss. 

For the divergent angle, φ  =  15°: 
ζ β β 2 = 0.436 - 0.86 + 0.59  (ASME MFC-3M-1989, p.42) 

For the divergent angle, φ  =  7°: 
ζ β β  = 0.218 - 0.42  + 0.38  2  (ASME MFC-3M-1989, p.42) 

For a divergent angle, 7° ≤ φ ≤ 15°, assume that linear interpolation will provide an 
accurate pressure loss value. 

( )ζ ζ ζ ζ φ
φ = + −

− °
°− °

⎛
⎝⎜

⎞
⎠⎟7 15 7

7
15 7

 
 

∆ ∆ϖ ζ  =    P  (ASME MFC-3M-1989, p.42) 

C6.11.4.2 Venturi Nozzles (§10.2.6)* 

ISO 5167 provides graphs of pressure loss for guidance only.  The ASME MFC-3M-
1989 equations will be used to calculate the pressure loss. 

* Note: although §10.2.1.4 allows the divergent angle to be as large as 30°, the 
permanent pressure loss calculation will use a maximum of 15° since the equations 
of ζ are not known to be valid outside this range. 

For the divergent angle, φ  =  15°: 
ζ β β 2 = 0.436 - 0.86 + 0.59   

For the divergent angle, φ  =  7°: 
ζ β β  = 0.218 - 0.42  + 0.38  2   

For a divergent angle, 7° ≤ φ ≤ 15°, assume that linear interpolation will provide an 
accurate pressure loss value. 

( )ζ ζ ζ ζ φ
φ = + −

− °
°− °

⎛
⎝⎜

⎞
⎠⎟7 15 7

7
15 7

 
 

∆ ∆ϖ ζ  =    P  (ASME MFC-3M-1989, p.42) 

§ 
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C7 International Standard ISO 5167-1-2003 (E) 

C7.1 Flow Element Applicability 
The ISO standard is defined for the following flow measurement elements: 

• orifice plates with: 
- flange taps 
- D and D/2 (radius) taps 
- corner taps 

• nozzles: 
- ISA 1932 nozzle 
- long radius nozzles, including: 

- high β ratio nozzles 
- low β ratio nozzles 

• venturi tubes: 
- venturi-nozzle 
- classical venturi tubes, including: 

- as-cast convergent section 
- machined convergent section 
- fabricated (welded) convergent section 

The standard applies to liquid, vapor, or gas flows which are homogenous (single 
phase), turbulent, subsonic and steady with time (a slow pulsation can be 
acceptable). 

C7.2 Calculation of Reynolds Numbers 

C7.2.1 Symbol Table 

The symbol table for the calculation of Reynolds Numbers is shown below. 

Table C-1 Calculation of Reynolds Numbers Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

d m 0 < d 0 < d None d < D 

D m 0 < D 0 < D None None 
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Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

U1 m/s 0 ≤ U1 0 ≤ U1 None None 

ν1 m2/s 0 < ν1 0 < ν1 None None 

Rd - 0 < Rd 0 < Rd None None 

RD - 0 < RD 0 < RD None None 

β - 0 < β 0 < β β ≤ 1 β ≤ 1 

µ1 kg/m-sec 0 < µ 0 < µ None None 

C7.2.2 Reynolds Number Based on the Upstream Condition of the 
Fluid and the Upstream Diameter of the Pipe (§3.3.2) 

The calculation for the Reynolds Number based on the upstream condition of the 
fluid and the upstream diameter of the pipe is: 

ReD
mU D q
D

= =1

1 1

4
ν πµ

 

C7.2.3 Reynolds Number Based on the Orifice or Throat Diameter of 
the Primary Device (§3.3.2) 

The calculation for the Reynolds Number based on the orifice or throat diameter of 
the primary device is: 

β =
d
D

 

R
R

d
D=

β
 

C7.3 Orifice Plate Discharge Coefficient 

C7.3.1 Symbol Table 

The symbol table for the orifice plate discharge coefficients is shown below. 

Table C-2 Orifice Plate Discharge Coefficients Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

Ref 

β - 0 < β varies with pressure tappings β < 1 §8.3.1 

RD - 0 < RD varies with pressure tappings None §8.3.1 

k m 0 < k None None None  
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Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

Ref 

D m 0 < D varies with pressure tappings None §8.3.1 

C - 0 < C 0 < C C < 1 None  

C7.3.2 Calculations 

C7.3.2.1 Base Discharge Coefficients (§8.3.2.1) 

The calculation for base discharge coefficients is: 

( )
0.7 0.36 6

2 8 3.510 100.5961 0.0261 0.216 0.000521 0.0188 0.0063
Re ReD D

C Aββ β β
⎡ ⎤ ⎛

= + − + + + ⎜ ⎟⎢ ⎥
⎞

⎣ ⎦ ⎝

( )( )

⎠

( )1 1

4
10 7 ' ' 1.1 1.3

2 240.043 0.080 0.123 1 0.11 0.031 0.8
1

L Le e A M Mβ β
β

− −+ + − − − −
−

 

Where D<71.12 mm (2.8 in.) the following term is added: 

( )0.011 0.075 2.8
25.4
Dβ ⎛ ⎞+ − −⎜ ⎟

⎝ ⎠
 

Where: 

L l
D1
1=  

′ =
′

L
l
D2
2  

'
' 2
2

0.8

2
1

19,000
ReD

LM

A

β

β

=
−

⎛ ⎞
= ⎜ ⎟

⎝ ⎠

 

Where: 
• l1 - distance of upstream pressure tap from upstream face of orifice plate 
• l2 - distance of downstream pressure tap from downstream face of orifice 

plate 

For corner taps: 

'
1 2 0L L= =  
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For D and D/2 taps (radius taps): 

1
'
2

1

0.47

L

L

=

=
 

For flange taps: 

'
1 2

25.4L L
D

= =  

The valid tap arrangements are defined above.  It is not permitted to enter into 
equation pairs of values L1 and L´2 which do not match one of the three standardized 
tap arrangements. 

C7.4 Orifice Plate Expansion Factor 
The expansion factor is valid where p2/p1 ≥ 0.75. 

( )
1

4 8 2

1

1 0.351 0.256 0.93 1 pY
p

κ
β β

⎡ ⎤
⎛ ⎞⎢ ⎥= − + + − ⎜ ⎟⎢ ⎥⎝ ⎠⎢ ⎥⎣ ⎦

 

C7.5 Nozzles 

C7.5.1 Symbol Table 

The symbol table for nozzles is shown below. 

Table C-3 Nozzles Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

β - 0 < β varies with design β < 1 

ReD - 0 < RD varies with design None 

k m 0 < k None None None 

D m 0 < D varies with design None 

C -  0 < C None C <1 None 
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C7.5.2 Calculations 

C7.5.2.1 ISA 1932 Nozzle 

C7.5.2.1.1 Limits (§9.1.6.1) 

The ISA 1932 nozzle limits are: 
• 0.050 ≤ D ≤ 0.500 
• 0.3 ≤ β < 0.44  0.44 ≤ β ≤ 0.80 
• 70,000 ≤  RD ≤ 107 20,000 ≤  RD ≤ 107 

The roughness upper limits for the ISA 1932 nozzle are shown in the table below. 

Table C-4 ISA 1932 Nozzle Roughness Upper Limits 

β ≤0.3
5 

0.36 0.38 0.40 0.42 0.44 0.46 0.48 0.50 0.60 0.70 0.77 0.80 

104k
/D 

25 18.6 13.5 10.6 8.7 7.5 6.7 6.1 5.6 4.5 4.0 3.9 3.9 

C7.5.2.1.2 Discharge Coefficients (§9.1.6.2) 

The discharge coefficient calculation is: 

[ ]C
D

= − − −
⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 9900 0 2262 0 00175 0 0033
106

4 1 2 4 15

1 15

. . . .
Re

. .

.

β β β  

C7.5.2.1.3 Expansibility (§9.1.6.3) 

The expansibility calculation is: 

ε κτ
κ

β
β τ

τ
τ

κ

κ

κ κ

1

2 4

4 2

1 1 2

1
1

1
1

1
=

−
⎛
⎝
⎜

⎞
⎠
⎟

−
−

⎛
⎝
⎜

⎞
⎠
⎟

−
−

⎛
⎝
⎜

⎞
⎠
⎟

⎡

⎣
⎢

⎤

⎦
⎥

−/

/

( )/ /

 

(for  p2/ p1 ≥ 0.75) 

C7.5.2.2 Long-Radius Nozzles 

The long radius nozzles include: 
• high ratio nozzles, 0.25 ≤ β ≤ 0.8, and (§9.2.1) 
• low ratio nozzles, 0.20 ≤ β ≤ 0.5  (§9.2.1) 
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C7.5.2.2.1 Limits (§9.2.6.1) 

The long radius nozzle limits are: 
• 0.050 ≤ D ≤ 0.630 
• 0.2 ≤ β ≤ 0.8 
• 104 ≤ RD ≤ 107 

• k/D ≤ 10 x 10-4 

C7.5.2.2.2 Discharge Coefficients (§9.2.6.2) 

The discharge coefficients calculation is: 

C
R

D

= −
⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 9965 0 00653
106

0 5

0 5

. . .

.

β  
(for upstream Reynolds Number) 

or  

C
R

d

= −
⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 9965 0 00653
106 0 5

. .

.

 
(for throat Rd) 

C7.6 Venturi Tubes and Venturi Nozzles 

C7.6.1 Symbol Table 

The symbol table for venturi tubes and venturi nozzles is shown below. 

Table C-5 Venturi Tubes/Nozzles Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

β - 0 < β varies with design β < 1 

ReD - 0 < ReD varies with design None 

D m 0 < D varies with design None 

C - C > 0 None C ≤ 1 None 

The standard applies to 3 types of venturi tubes (§10.1) and Venturi Nozzle (§10.2): 
1. Venturi with an as-cast convergent 
2. Venturi with a machined convergent 
3. Venturi with a fabricated (welded) sheet-iron convergent 
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C7.6.2 Calculations 

C7.6.2.1 Classical Venturi Tube With an As-Cast Convergent (§10.1.5.2) 

C7.6.2.1.1 Limits 

The limits for the classical venturi tube with an as-cast convergent are: 
• 0.100 ≤ D ≤ 0.800 
• 0.3 ≤ β ≤ 0.75 
• 2 x 105 ≤  RD ≤  2 x 106 

C7.6.2.1.2 Discharge Coefficient 

The discharge coefficient is: 

C = 0.984 

C7.6.2.2 Classical Venturi Tubes With a Machined Convergent (§10.1.5.3) 

C7.6.2.2.1 Limits 

The limits for the classical venturi tube with a machined convergent are: 
• 0.050 ≤ D ≤ 0.250 
• 0.4 ≤ β ≤ 0.75 
• 2 x 105 ≤  RD ≤  1 x 106 

C7.6.2.2.2 Discharge Coefficient 

The discharge coefficient is: 

C = 0.995 

C7.6.2.3 Classical Venturi Tubes With a Rough Welded Convergent (§10.1.5.4) 

C7.6.2.3.1 Limits 

The limits for the classical venturi tube with a rough welded convergent are: 
• 0.200 ≤ D ≤ 1.200 
• 0.4 ≤ β ≤ 0.7 
• 2 x 105 ≤  ReD ≤  2 x 106 

C7.6.2.3.2 Discharge Coefficient 

The discharge coefficient is: 

C = 0.985 
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C7.6.2.4 Venturi Nozzle 

C7.6.2.4.1 Limits (§10.2.4.1) 

The limits for the venturi nozzle are: 
• 0.065 ≤ D ≤ 0.500 
• d ≤ 0.050 
• 0.316 ≤ β ≤ 0.775 
• 1.5 x 105 ≤  RD ≤  2 x 106 

C7.6.2.4.2 Discharge Coefficient (§10.2.4.2) 

The discharge coefficient is: 

C = −0 9858 0 196 4 5. . .β  

C7.7 Orifice Plate Expansion Factors 

C7.7.1 Symbol Table 

The symbol table for orifice plate expansion factors is shown below. 

Table C-6 Orifice Plate Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

β - 0 < β varies with design β < 1 §7.3.1 

κ - 0 < κ None None None  

p1 Pa 0 < p1 0 < p1 None None §5.3.3 

p2 Pa 0 < p2 0.75 p1 < p2 p2 < p1 None §5.3.3 

∆p Pa 0 ≤ ∆p 0 ≤ ∆p None None  

Y - 0 < Y None Y ≤ 1 None §2.4.7 

C7.7.2 Gas Expansion Factor based on Upstream Conditions 
(§8.3.2.2) 

The calculation for gas expansion factors based on upstream conditions is: 

Y
p
p1

4

1
1 0 41 0 35= − +( . . )β

κ
∆

 

In addition to other limit conditions, the above equation is only applicable for  
p2/ p1≥0.75. 
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This formula is a result of testing on air, steam and natural gas. There are no known 
objections to applying it to other gases. 

C7.7.3 Gas Expansion Factor based on Downstream Conditions 
(§8.3.2.2) 

The calculation for gas expansion factors based on downstream conditions is: 

Y Y
P

P2 1
2

1= +
∆

 

C7.7.4 Liquid Expansion Factor (§3.3.5) 

The liquid expansion factor is: 

Y = 1 

C7.8 Nozzles Expansion Factors 

C7.8.1 Symbol Table 

The symbol table for nozzles expansion factors is shown below. 

Table C-7 Nozzles Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

β - 0 < β varies with design β < 1  

κ - 0 < κ None None None  

P1 Pa 0 < P1 0 < P1 None None  

P2 Pa 0 < P2 0.75 P1 < P2 P2 < P1 None  

∆P Pa 0 ≤ ∆P 0 ≤ ∆P Νone None  

τ  0 < τ 0.75 ≤ τ None τ < 1  

Y - 0 < Y None Y ≤ 1 None §2.4.7 
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C7.8.2 Calculations 

C7.8.2.1 ISA 1932 Nozzle 

C7.8.2.1.1 Gas Expansion Factor (§8.1.6.3) 

The gas expansion factor calculations are: 

τ τ= ≥
p
p

2

1
0 75, .  

Y
k

=
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

κτ
κ

β

β τ

τ
τ

κ
κ
κ

2
4

4
2

1
1
2

1
1

1

1
1

 

C7.8.2.1.2 Liquid Expansion Factor (§2.4.7) 

The liquid expansion factor is: 

Y = 1 

C7.8.2.2 Long Radius Nozzles 

C7.8.2.2.1 Gas Expansion Factor (§8.2.5.3) 

The gas expansion factor calculations are: 

τ τ= ≥
p
p

2

1
0 75, .  

Y
k

=
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

κτ
κ

β

β τ

τ
τ

κ
κ
κ

2
4

4
2

1
1
2

1
1

1

1
1

 

C7.9 Classical Venturi Tubes and Venturi Nozzles 
Expansion Factor 

C7.9.1 Symbol Table 

The symbol table for the classical venturi tubes and venturi nozzles expansion factor 
is shown below. 

 293  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  



User Manual  C7 International Standard ISO 5167-1-2003 (E) 

Table C-8 Classical Venturi Tubes/Nozzles Expansion Factor Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref. 

β - 0 < β varies with design β < 1  

κ - 0 < κ None None None  

p1 Pa 0 < p1 0 < p1 None None  

p2 Pa 0 < p2 0.75 p1 < p2 p2 < p1 None §5.3.3 

∆p Pa 0 ≤ ∆p 0 ≤ ∆p Νone None  

τ  0 < τ None None τ < 1  

Y - 0 < Y None Y ≤ 1 None  

C7.9.2 Calculations 

C7.9.2.1 Classical Venturi Tube 

C7.9.2.1.1 Gas Expansion Factor (§9.1.6) 

The gas expansion factor calculations are: 

τ τ= ≥
p
p

2

1
0 75, .  

Y
k

=
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

κτ
κ

β

β τ

τ
τ

κ
κ
κ

2
4

4
2

1
1
2

1
1

1

1
1

 

C7.9.2.1.2 Liquid Expansion Factor (§2.4.7) 

The liquid expansion factor is: 

Y = 1 

C7.9.2.2 Venturi Nozzle 

C7.9.2.2.1 Gas Expansion Factor (§9.1.6) 

The venturi nozzle gas expansion factor calculations are: 

τ τ= ≥
p
p

2

1
0 75, .  
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Y
k

=
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−
−

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

⎡
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⎤
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⎥

−
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κ

β

β τ

τ
τ

κ
κ
κ

2
4

4
2

1
1
2

1
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1

1
1

 

C7.9.2.2.2 Liquid Expansion Factor (§2.4.7) 

The nozzle liquid expansion factor is: 

Y = 1 

C7.9.3 Uncertainties (§8.3.3) 

For all three types of tappings, assume that β, D, C, RD and k/D are known without 
error, the relative uncertainty of the value of C is equal to: 
0.6% for β ≤ 0 6.  
β% for 0 6 0 75. .< ≤β  
uncertainty in Y1   

4
1

∆P
P

 
  

C7.10 Thermal Expansion Correction 
ISO 5167 requires temperature compensation to be applied to d and D, but does not 
provide a method to do so. Therefore, the corrections stated in ASME MFC-3M-1989 
will be applied. 

C7.10.1 Symbol Table 

The symbol table for thermal expansion correction is shown below. 

Table C-9 Thermal Expansion Correction Symbol Table 

Symbol Units Lower Domain Lower Limit Upper Limit Upper 
Domain 

dmeas m 0< dmeas None None dmeas ≤ Dmeas

Dmeas m 0< Dmeas None None None 

αPE m/m/°C 0 < αPE None None None 

αp m/m/°C 0 < αp None None None 

t °C -273.15 < t None None None 

tmeas °C -273.15 < tmeas tmeas is usually assumed to be 20°C  

d m 0<d None None None 

D m 0<D None None None 
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C7.10.2 Calculations 

C7.10.2.1 Bore Diameter, d, Temperature Correction 

The bore diameter temperature correction calculation is: 

[ ]1 PE meas measd t tα⎡ ⎤= + −⎣ ⎦ d  (ASME MFC-3M-1989 eq. 19a, p. 12) 

C7.10.2.2 Pipe Diameter, D, Temperature Correction 

The pipe diameter temperature correction calculation is: 

[ ]1 p meas measD t tα⎡ ⎤= + −⎣ ⎦ D  (ASME MFC-3M-1989 eq. 19b, p. 12) 

C7.11 Flow Rate Calculation 

C7.11.1 Symbol Table 

The symbol table for flow rate calculation is shown below. 

Table C-10 Flow Rate Calculation Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper Limit Upper Domain 

dmeas m 0 < dmeas varies with primary element type dmeas ≤ Dmeas

Dmeas m 0 < Dmeas varies with primary element type None 

P1 Pa 0 < P1 0 < P1 None None 

P2 Pa 0 < P2 0.75 P1 < P2 P2 < P1 None 

t °C -273.15 < t None None None 

tmeas °C -273.15 < tmeas None None None 

αP m/m/°C 0 < αP None None None 

αPE m/m/°C 0 < αPE None None None 

ρ1 kg/m3 0 < ρ1 None None None 

C - 0 < C None C ≤ 1 None 

d m 0 < d varies with primary element type None 

D m 0 < D varies with primary element type None 

∆P Pa 0 < ∆P None None None 

β - 0 < β varies with primary element β < 1 

Y - 0 < Y None Y ≤ 1 None 

qm kg/s 0 < qm None None None 
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C7.11.2 Calculations (§5.3) 

The actual flow is found by iteration, since RD and for some primary elements C are 
dependent on the flow rate qm. 

q  =  
4

 C  d  
2 P 
1 -  m

2 1
4

π ρ
β

Y1

∆
 

or 

q  =  
4

 C  d  
2 P 
1 -  m

2 2
4

π ρ
β

Y2

∆
 

Where Y2 and ρ2 are referred  to the downstream conditions; d and D should use the 
working condition value or with correction terms. 

C7.12 Permanent Pressure Loss 

C7.12.1 Symbol Table 

The symbol table for permanent pressure loss is shown below. 

Table C-11 Permanent Pressure Loss Symbol Table 

Symbol Units Lower Domain Lower Limit Upper Limit Upper 
Domain 

C - 0 < C None C ≤ 1 None 

∆P Pa 0 < ∆P None None None 

β - 0 < β varies with primary element type β < 1 

φ ° 0 < φ varies with primary element type None 

∆ω Pa 0 < ∆ω None None None 

C7.12.1.1 Calculations 

C7.12.2 Orifice Plate (§8.4.1) 

The orifice plate calculation is: 

∆ ∆ϖ
β β
β β

  P 
1 -   -  C 
1 -   +  C 

4 2

4 2
=

⎛

⎝
⎜

⎞

⎠
⎟  
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C7.12.3 Nozzles 

C7.12.3.1 ISA 1932 Nozzle (§9.1.8) 

The ISA 1932 nozzle calculation is: 

∆ ∆ϖ
β β
β β

  P 
1 -   -  C 
1 -   +  C 

4 2

4 2
=

⎛

⎝
⎜

⎞

⎠
⎟  

C7.12.3.2 Long Radius Nozzle (§9.2.8) 

∆ ∆ϖ
β β
β β

  P 
1 -   -  C 
1 -   +  C 

4 2

4 2
=

⎛

⎝
⎜

⎞

⎠
⎟  

C7.12.4 Classical Venturi Tubes and Venturi Nozzles 

C7.12.4.1 Classical Venturi Tubes (§10.1.9.2) 

ISO 5167 provides graphs of pressure loss for guidance only. The ASME MFC-3M-
1989 equations will be used to calculate the pressure loss. 

For the divergent angle, φ  =  15°: 
ζ β β 2 = 0.436 - 0.86 + 0.59  (ASME MFC-3M-1989, p.42) 

For the divergent angle, φ  =  7°: 
ζ β β  = 0.218 - 0.42  + 0.38  2  (ASME MFC-3M-1989, p.42) 

For a divergent angle, 7° ≤ φ ≤ 15°, assume that linear interpolation will provide an 
accurate pressure loss value. 

( )ζ ζ ζ ζ φ
φ = + −

− °
°− °

⎛
⎝⎜

⎞
⎠⎟7 15 7

7
15 7

 
 

∆ ∆ϖ ζ  =    P  (ASME MFC-3M-1989, p.42) 

C7.12.4.2 Venturi Nozzles (§10.2.6) 

ISO 5167 provides graphs of pressure loss for guidance only.  The ASME MFC-3M-
1989 equations will be used to calculate the pressure loss. 

Note: Although §10.2.1.4 allows the divergent angle to be as large as 30°, the 
permanent pressure loss calculation will use a maximum of 15° since the equations 
of ζ are not known to be valid outside this range. 

For the divergent angle, φ  =  15°: 
ζ β β 2 = 0.436 - 0.86 + 0.59   
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For the divergent angle, φ  =  7°: 
ζ β β  = 0.218 - 0.42  + 0.38  2   

For a divergent angle, 7° ≤ φ ≤ 15°, assume that linear interpolation will provide an 
accurate pressure loss value. 

( )ζ ζ ζ ζ φ
φ = + −

− °
°− °

⎛
⎝⎜

⎞
⎠⎟7 15 7

7
15 7

 
 

∆ ∆ϖ ζ  =    P  (ASME MFC-3M-1989, p.42) 

§ 
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C8 American Gas Association Report No.3, 
Part1, 3rd Ed., 1990 

C8.1 Flow Element Applicability 
At the time of initial publication, three standards organizations have approved AGA-3 
Part 1 (1990)  for orifice metering: 
1. American Gas Processors Association  Report No. 3, Third Edition 
2. American Petroleum Institute   API 14.3 
3. Gas Processors Association   GPA 8185-90 

In May, 1991, Part 1 was approved by the American National Institute ANSI/API 
2350; Part 1. 

AGA-3 Part 1 (1990) applies to steady-state mass flow. The flowing fluid has the 
following properties: 

• clean 
• single phase 
• Newtonian 

The standard provides the design, construction, and installation specifications for 
orifice meters having the following characteristics: 

• flange tapped 
• concentric 
• square-edged 

The orifice meters must be nominal 2-inch schedule 160 or larger pipe diameters. 

C8.2 Calculation of Reynolds Numbers 

C8.2.1 Symbol Table 

The symbol table for the calculation of Reynolds Numbers is shown below. 
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Table C-1 Calculation of Reynolds Numbers 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

D m 0 < D 0 < D None None 

qm kg/s 0 ≤ qm 0 ≤ qm None None 

µ Pa-s 0 < µ 0 < µ None None 

RD - 0 < ReD 0 < ReD None None 

C8.2.2 Reynolds Number (§1.7.3) 

The Reynolds Number calculation is: 

R
q
DD
m=

4
πµ

 
(eq. 1-20, p. 14) 

C8.3 Orifice Plate Discharge Coefficients 

C8.3.1 Symbol Table 

The symbol table for orifice plate discharge coefficients is shown below. 

Table C-2 Orifice Plate Discharge Coefficients Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper Limit Upper 
Domain 

Ref 

β - 0 < β 0.1 < β β < 0.75 β < 1 p.13 

RD - 0 < RD 4000 < RD RD < 3.6 x 107 None p. 12 

d m 0 < d 0.0114 < d d < 0.675 d < D p.13 

D m 0 < D 0.0429 < D D < 0.9000 None p.13 

Cd(FT) - Cd(FT) > 0 None Cd(FT) ≤ 1 None  

C8.3.2 Calculations 

C8.3.2.1 Base Discharge Coefficient (§1.7.2) 

The base discharge coefficient calculations are: 

β  =   
d
D

 
 

( ) C  0.0049A+0.0210+
R

 100.000511+FTC  FTC 4
0.7

D

6

i=d β
β

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
⎟
⎠
⎞⎜

⎝
⎛⎟

⎠
⎞⎜

⎝
⎛

 (eq. 1-9, p.13) 

( ) ( )C   =  C  +  i iFT CT UPSTRM +  DNSTRM  (eq. 1-10, p.13) 

( ) ( )C   =   0.5961 +  0.0291  -  0.2290  +  0.003 1 -   Mi
2 8

1CT β β β  (eq. 1-11, p.13) 
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( )( )UPSTRM  =   0.0433 +  0.0712 e -  0.1145 e 1- 0.23A B-8.5L -6.0L1 1 (eq. 1-13, p.13) 

( ) ( )DNSTRM = -0.0116 M - 0.52 M   1 -  0.14 A2 2
1.3 1.1β  (eq. 1-14, p.13) 

B  =   
1 -  

4

4

β
β

 
(eq. 1-15, p.13) 

M   =   max(2.8 -  
D

0.0254
 ,  0.0)1  

(eq. 1-16, p.13) 

M   =   
2 L

1 -  2
2

β
 

(eq. 1-17, p.13) 

A =
19000

RD

0.8
β⎛

⎝
⎜

⎞

⎠
⎟  

(eq. 1-18, p.13) 

C  =   
10
R

6

D

0.35⎛

⎝
⎜

⎞

⎠
⎟  

(eq. 1-19, p.13) 

L   =   L   =   
0.0254

D1 2  
 

C8.4 Orifice Plate Expansion Factors 

C8.4.1 Symbol Table 

The symbol table for orifice plate expansion factors is shown below. 

Table C-3 Orifice Plate Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

β - 0 < β varies with fluid state β < 1 

κ - 0 < κ None None None 

Pf1 Pa 0 < Pf1 0 < Pf1 None None 

Pf2 Pa 0 < Pf2 varies with 
fluid state 

Pf2 < Pf1 None 

∆P Pa 0 < ∆P 0 < ∆P varies with 
fluid state 

None 

Y1 - 0 < Y1 None None None 
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C8.4.2 Calculations 

C8.4.2.1 Upstream Gas Expansion Factor (§1.8.1) 

The upstream gas expansion factor calculations are: 

β  =   
d
D

 
 

0.1 ≤ β ≤ 0.75 (p.17) 
0.8Pf1 < Pf2 (p.17) 
∆P < 0.20P f1 (p.17) 

( )Y x
1

4 11 0 41 0 35= − +. . β
κ

 
(eq. 1-24, p. 18) 

When the upstream static pressure is measured: 

x
P

Pf
1

1

=
∆

 
(eq. 1-25, p. 18) 

When the downstream static pressure is measured: 

x
P

P Pf
1

2

=
+

∆
∆

 
(eq. 1-26, p. 18) 

C8.4.2.2 Downstream Gas Expansion Factor (§1.8.2) 

The downstream gas expansion factor calculation is: 

Y Y
P Z
P Z

x
k

P Z
P Z

f f

f f

f f

f f
2 1

4 11 2

2 1

1 2

2 1

1 0 41 35= = − +
⎡
⎣⎢

⎤
⎦⎥( . . )β  

where, 

x
P

P Pf
1

2

=
+

∆
∆

 

Zf1, Zf2 are fluid compressibility factors at upstream and downstream pressure taps, 
respectively. 

Note: If the user defined the gas mixture and selected a density method, Flowel 
automatically calculates Zf1 and Zf2. These two values are presented on the AGA 3 
factors report. If there is no mixture defined for the tag, or no density method defined, 
Flowel will ask the user to input Zf1 and Zf2.  

C8.4.2.3 Liquid Expansion Factor (§1.6) 

Y1 1000= .  
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C8.5 Thermal Expansion Correction 
AGA 3 provides the following temperature correction factors for the pipe diameter 
and orifice bore. 

C8.5.1 Symbol Table 

The symbol table for thermal expansion correction is shown below. 

Table C-4 Thermal Expansion Correction Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

dr m 0< dr None None None 

Dr m 0< Dr None None None 

αPE m/m/°C 0 < αPE None None None 

αP m/m/°C 0 < αP None None None 

t °C -273.15 < t None None None 

tr °C -273.15 < tr tr is usually assumed to be 20°C 

d m 0<d None None None 

D m 0<D None None None 

C8.5.2 Calculations 

C8.5.2.1 Bore Diameter, d, Temperature Correction 

The bore diameter temperature correction calculation is: 

[ ]1 PE rd t tα⎡ ⎤= + −⎣ ⎦ rd  (eq. 1-7, p. 11) 

C8.5.2.2 Pipe Diameter, D, Temperature Correction 

The pipe diameter temperature correction calculation is: 

[ ]1 P r rD t tα⎡ ⎤= + −⎣ ⎦ D  (eq. 1-8, p. 11) 

C8.6 Flow Rate Calculation 

C8.6.1 Symbol Table 

The symbol table for flow rate calculation is shown below. 
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Table C-5 Flow Rate Calculation Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

dr m 0 < dr None None dr < Dr

Dr m 0 < Dr None None None 

P1 Pa 0 < P1 0 < P1 None None 

P2 Pa 0 < P2 0.8 P1 < P2 P2 < P1 None 

t °C -273.15 < t None None None 

tr °C -273.15 < tr None None None 

αP m/m/°C 0 < αP None None None 

αPE m/m/°C 0 < αPE None None None 

ρ1 kg/m3 0 < ρ1 None None None 

C - 0 < C None C ≤ 1 None 

d m 0 < d 0.0114 < d None None 

D m 0 < D 0.0429 < D  None 

∆P Pa 0 < ∆P None ∆P < 0.20 P1 None 

β - 0 < β 0.1 < β β < 0.75 β < 1 

Y - 0 < Y None None None 

qm kg/s 0 < qm None None None 

C8.6.2 Calculations (§1.6) 

The actual flow is found by iteration, since C and RD are dependent on the flow rate 
qm. 

d t tPE r r= + −1 α d

D

 (eq. 1-7, p. 11) 

[ ][ ]D t tPE r r= + −1 α  (eq. 1-8, p. 11) 

β =  
d
D

 
 

∆P P P= −1 2   

The above values of d, D, and β should be used to calculate C and Y. 

q  =  
4

 C  d
2 P 
1 -  m

2 1
4

π ρ
β

Y1

∆
 

(eq. 1-1, p. 10) 

or  

q  =  
4

 C  d
2 P 
1 -  m

2 2
4

π ρ
β

Y2

∆
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C8.7 Permanent Pressure Loss 

C8.7.1 Symbol Table 

The symbol table for permanent pressure loss is shown below. 

Table C-6 Permanent Pressure Loss Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

C - 0 < C None None None 

∆P Pa 0 < ∆P None None None 

β - 0 < β None None β < 1 

∆ϖ Pa 0 < ∆ϖ None None None 

C8.7.2 Calculations 

AGA 3 does not provide a method to estimate the permanent pressure loss.  
Therefore, the equation provided by ISO 5167 (1991) is applied. 

C8.7.2.1 Orifice Plate (ISO 5167 - 1- 1991 (E) §8.4.1) 

The orifice plate calculation is: 

∆ ∆ϖ
β β

β β
  P 

1 -   -  C 

1 -   +  C 

4 2

4 2
≈

⎛

⎝
⎜
⎜

⎞

⎠
⎟
⎟  

C8.8 AGA 3 - 1992 (Part 3) Factors 
Volume flow rate: 

Qv Fn Fc Fse Y F F F F F P hw C P hwpb tb tf gr pv f f= + =( ) '  

Where: 
Fn = numeric conversion factor 
Fc + Fse = discharge coefficient 
Y = gas expansion factor 
Fpb = base pressure factor 
Ftf = flowing temperature factor 
Fgr = real gas relative density factor 
Fpv = supercompressibility factor 
Pf = absolute flowing pressure 
Qv = volume flow rate at base condition of Tb and Pb 
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Fn =  N T Dv
2  

Tv =
−

1
1 4β

 

Where: 
Fc + Fse = discharge coefficient 
Y = gas expansion factor 

F
Ppb

b
=

14 73.
 

F
T

tb
b=

518 67.
 

F
Ttf

f
=

518 67.
 

F
Grgr =
1

 

F
Z
Zpv

b

f
=  

Where: 
Tb = base temperature in degrees Rankine °R 
Tf = flowing temperature in degrees Rankine °R 
Pb = base pressure, in pounds force per square inch 
Gr = real gas relative density at base conditions 
Zb = compressibility factor at base condition 
Zf = compressibility at flowing conditions (upstream/downstream) 
N = unit conversion factor 

Notes: 
1. AGA 3 defined the factors approach based upon English (Imperial) unit system. 

Flowel extended those definitions to any combination of units except mass flow 
rate units. 

2. AGA 3 factors are only applicable for gas (vapor) systems with a volumetric flow 
rate. 

§ 
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C9 British Standard BS 1042 – Measurement 
of Fluid Flow in Closed Conduits: Part 1, 
Section 1.2 

C9.1 Flow Element Applicability 
This standard will be applied to liquid, vapor, or gas flows in the following types of 
orifice plates: 

• conical entrance 
• quadrant 
• eccentric 

C9.2 Calculation of Reynolds Numbers 

C9.2.1 Symbol Table 

The symbol table for the calculation of Reynolds Numbers is shown below. 

Table C-1 Calculation of Reynolds Numbers Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

D m 0 < D varies with device None 

qm kg/s 0 < qm 0 < qm None None 

µ Pa-s 0 < µ 0 < µ None None 

RD - 0 < RD varies with device None 

C9.2.2 Reynolds Number (§BS 1042, Section 1.1) 

The Reynolds Number calculation is: 

R
q
DD
m=

4
πµ
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C9.3 Orifice Plate Limits and Discharge Coefficients 

C9.3.1 Symbol Table 

The symbol table for orifice plate limits and discharge coefficients is shown below. 

Table C-2 Orifice Plate Limits and Discharge Coefficients Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

β - 0 < β varies with device β < 1 

RD - 0 < RD varies with device None 

D m 0 < D varies with device None 

C - 0 < C varies with device C < 1 

C9.3.2 Calculations 

C9.3.2.1 Conical Entrance with Corner Taps (§7) 

C9.3.2.1.1 Limits (§7.2) 

The limits are: 
• d > 0.006 
• D ≤ .500 
• 0.1 ≤ β ≤ 0.316 
• 80 ≤ RD ≤ 2x105β 

C9.3.2.1.2 Discharge Coefficient (§7.5.1) 

The discharge coefficient is: 

C = 0.734 

C9.3.2.2 Quadrant Edge with Corner Taps or Flange Taps (§8) 

C9.3.2.2.1 Limits (§8.2) 

The limits are: 
• d ≥ 0.015 
• D ≤ 0.500 
• 0.245 ≤ β ≤ 0.6 
• RD ≤ 105β 
• 0.046 ≤ Cβ2(1-β4)-0.5 ≤ 0.326 
• RD (min) = 1000β + 9.4 x 106 (β - 0.24)8 
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C9.3.2.2.2 Discharge Coefficients (§8.5.1) 

The discharge coefficient is: 

C = 0.73823 + 0.3309β - 1.1615β2 + 1.5084β3

C9.3.2.3 Eccentric with Corner Taps (§9) 

C9.3.2.3.1 Limits (§9.2) 

The limits are: 
• d ≥ 0.050 
• 0.1 ≤ D ≤ 1.000 
• 0.46 ≤ β ≤ 0.84 
• 2 x 105β2 ≤ RD ≤ 106β 

C9.3.2.3.2 Discharge Coefficients (§9.4.1) 

The discharge coefficient is: 

C = 0.9355 - 1.6889β + 3.0428β2 - 1.7989β3

C9.4 Orifice Plates Expansion Factors 

C9.4.1 Symbol Table 

The symbol table for orifice plates expansion factors is shown below. 

Table C-3 Orifice Plates Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

κ - 0 < κ None None None 

Pf1 Pa 0 < P1 0 < P1 None None 

Pf2 Pa 0 < P2 0.75 P1 < P2 P2 < P1 None 

∆P Pa 0 ≤ ∆P 0 ≤ ∆P Νone None 

Y1 - 0 < Y1 None None None 

Y2 - 0 < Y2 None None Y ≤ 1 

τ - 0 < τ None None τ < 1 
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C9.4.2 Calculations 

C9.4.2.1 Conical Entrance (§7.5.2) 

C9.4.2.1.1 Upstream Gas Expansion 

The upstream gas expansion calculation is: 

τ =
P
P

1

2
 

( )
( )

Y

P
P

1

4

1

2
4

4
2

1
1
2

1 0 41 0 35
1

1

1

1
1

2
=

− + +
−

⎛

⎝

⎜
⎜

⎞

⎠

⎟
⎟

−

−

⎛

⎝

⎜
⎜

⎞

⎠

⎟
⎟

−
−

⎛

⎝

⎜
⎜

⎞

⎠

⎟
⎟

⎡

⎣

⎢
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⎢

⎤

⎦

⎥
⎥
⎥

⎧

⎨
⎪⎪

⎩
⎪
⎪

⎫

⎬
⎪⎪

⎭
⎪
⎪

−

. . β
κ

κτ
κ

β

β τ

τ
τ

κ

κ

κ
κ∆

 

C9.4.2.1.2 Downstream Gas Expansion 

The downstream gas expansion calculation is: 

Y Y
P

P2 1
2

1= +
∆

 

C9.4.2.1.3 Liquid 

The liquid calculation is: 

Y Y1 2 1= =  

C9.4.2.2 Quadrant with Corner Taps or Flange Taps (§8.5.2) and Eccentric with Corner 
Taps (§9.4.3) 

C9.4.2.2.1 Upstream Gas Expansion 

The upstream gas expansion calculation is: 

( )Y
P
P1

4

1
1 0 41 0 35= − +. . β

κ
∆
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C9.4.2.2.2 Downstream Gas Expansion 

The downstream gas expansion calculation is: 

Y Y
P

P2 1
2

1= +
∆

 

C9.4.2.2.3 Liquid 

Y Y1 2 1= =  

C9.5 Thermal Expansion Correction 

C9.5.1 Symbol Table 

The symbol table for thermal expansion correction is shown below. 

Table C-4 Thermal Expansion Correction Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

dr m 0< dr None None None 

Dr m 0< Dr None None None 

αPE m/m/°C 0 < αPE None None None 

αP m/m/°C 0 < αP None None None 

t °C -273.15 < t None None None 

tr °C -273.15 < tr tr is usually assumed to be 20°C 

d m 0<d None None None 

D m 0<D None None None 

C9.5.2 Calculations 

C9.5.2.1 Bore Diameter, d, Temperature Correction 

The bore diameter temperature correction calculation is: 

d t tPE r r= + −1 α d  

C9.5.2.2 Pipe Diameter, D, Temperature Correction 

The pipe diameter temperature correction is: 

D t tp r= + −1 α Dr  
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C9.6 Flow Rate Calculation 

C9.6.1 Symbol Table 

The symbol table for flow rate calculation is shown below. 

Table C-5 Flow Rate Calculation Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

dr m 0 < dmeas varies with primary element type dr < Dr

Dr m 0 < Dmeas varies with primary element type None 

P1 Pa 0 < P1 0 < P1 None None 

P2 Pa 0 < P2 varies with fluid 
state 

P2 < P1 None 

t °C -273.15 < t None None None 

tr °C -273.15 < tr None None None 

αP m/m/°C 0 < αP None None None 

αPE m/m/°C 0 < αPE None None None 

ρ1 kg/m3 0 < ρ1 None None None 

C - 0 < C None None None 

d m 0 < d varies with primary element type None 

D m 0 < D varies with primary element type None 

∆P Pa 0 < ∆P None None None 

β - 0 < β varies with primary element β < 1 

Y - 0 < Y None None Y ≤ 1 

qm kg/s 0 < qm None None None 

C9.6.2 Calculations 

The actual flow may be found by iteration, since C and RD may depend on the flow 
rate qm. 

d t tPE r r= + −1 α d  

D t tp r= + −1 α Dr  

β =  
d
D

 

∆P P P= −1 2  

The above values of d, D, and β should be used to calculate C and Y. 
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q  =  
4

 C  d  
2 P 
1 -  m

2 1
4

π
β

ρ
β

Y1
2 ∆

 

C9.7 Permanent Pressure Loss 

C9.7.1 Symbol Table 

The symbol table for permanent pressure loss is shown below. 

Table C-6 Permanent Pressure Loss Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

C - 0 < C None None None 

∆P Pa 0 < ∆P None None None 

β - 0 < β Varies with primary element β < 1 

∆ϖ Pa 0 < ∆ϖ None None None 

C9.7.2 Calculations 

BS 1042 Section 1.2 does not provide a method to estimate the permanent pressure 
loss. Therefore the equation provided by ISO 5167 (1991) is applied. 

C9.7.2.1 Orifice Plate (§7.4) 

The orifice plate calculation is: 

∆ ∆ϖ
β β
β β

  P 
1 -   -  C 
1 -   +  C 

4 2

4 2
≈

⎛

⎝
⎜

⎞

⎠
⎟ 
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C10 ISO TR 15377 

C10.1 Flow Element Applicability 
The title of this report is “Measurement of fluid flow by means of pressure differential 
devices – Guidelines for the specification of nozzles and orifice plates beyond the 
scope of ISO 5167-1.” It contains an update to BS1042, where the devices are not 
included in ISO 5167-1. Implemented equations from this standard are for the 
following types of orifice plates: 

• conical entrance 
• quadrant 
• eccentric 

C10.2 Calculation of Reynolds Numbers 

C10.2.1 Symbol Table 

The symbol table for the calculation of Reynolds Numbers is shown below. 

Table C-1 Calculation of Reynolds Numbers Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

D m 0 < D varies with device None 

qm kg/s 0 < qm 0 < qm None None 

µ Pa-s 0 < µ 0 < µ None None 

RD - 0 < RD varies with device None 

C10.2.2 Reynolds Number (§BS 1042, Section 1.1) 

The Reynolds Number calculation is: 

R
q
DD
m=

4
πµ
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C10.3 Orifice Plate Limits and Discharge Coefficients 

C10.3.1 Symbol Table 

The symbol table for orifice plate limits and discharge coefficients is shown below. 

Table C-2 Orifice Plate Limits and Discharge Coefficients Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

β - 0 < β varies with device β < 1 

RD - 0 < RD varies with device None 

D m 0 < D varies with device None 

C - 0 < C varies with device C < 1 

C10.3.2 Calculations 

C10.3.2.1 Conical Entrance with Corner Taps (§7) 

C10.3.2.1.1 Limits (§7.2) 

The limits are: 
• d > 0.006 
• D ≤ .500 
• 0.1 ≤ β ≤ 0.316 
• 80 ≤ RD ≤ 2x105β 

C10.3.2.1.2 Discharge Coefficient (§7.5.1) 

The discharge coefficient is: 

C = 0.734 

C10.3.2.2 Quadrant Edge with Corner Taps or Flange Taps (§8) 

C10.3.2.2.1 Limits (§8.2) 

The limits are: 
• d ≥ 0.015 
• D ≤ 0.500 
• 0.245 ≤ β ≤ 0.6 
• RD ≤ 105β 
• 0.046 ≤ Cβ2(1-β4)-0.5 ≤ 0.326 
• RD (min) = 1000β + 9.4 x 106 (β - 0.24)8 
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C10.3.2.2.2 Discharge Coefficients (§8.5.1) 

The discharge coefficient is: 

C = 0.73823 + 0.3309β - 1.1615β2 + 1.5084β3

C10.3.2.3 Eccentric with Corner Taps (§9) 

C10.3.2.3.1 Limits (§9.2) 

The limits are: 
• d ≥ 0.050 
• 0.1 ≤ D ≤ 1.000 
• 0.46 ≤ β ≤ 0.84 
• 2 x 105β2 ≤ RD ≤ 106β 

C10.3.2.3.2 Discharge Coefficients (§9.4.1) 

The discharge coefficient is: 

C = 0.9355 - 1.6889β + 3.0428β2 - 1.7989β3

C10.4 Orifice Plates Expansion Factors 

C10.4.1 Symbol Table 

The symbol table for orifice plates expansion factors is shown below. 

Table C-3 Orifice Plates Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

κ - 0 < κ None None None 

Pf1 Pa 0 < P1 0 < P1 None None 

Pf2 Pa 0 < P2 0.75P1 < P2 P2 < P1 None 

∆P Pa 0 ≤ ∆P 0 ≤ ∆P Νone None 

Y1 - 0 < Y1 None None None 

Y2 - 0 < Y2 None None Y ≤ 1 

τ - 0 < τ None None τ < 1 
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C10.4.2 Calculations 

C10.4.2.1 Conical Entrance (§7.5.2) 

C10.4.2.1.1 Upstream Gas Expansion 

The upstream gas expansion calculation is: 

τ =
P
P

1

2
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C10.4.2.1.2 Downstream Gas Expansion 

The downstream gas expansion calculation is: 

Y Y
P

P2 1
2

1= +
∆

 

C10.4.2.1.3 Liquid 

The liquid calculation is: 

Y Y1 2 1= =  

C10.4.2.2 Quadrant with Corner Taps or Flange Taps (§8.5.2) and Eccentric with Corner 
Taps (§9.4.3) 

C10.4.2.2.1 Upstream Gas Expansion 

The upstream gas expansion calculation is: 

( )Y
P
P1

4

1
1 0 41 0 35= − +. . β

κ
∆
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C10.4.2.2.2 Downstream Gas Expansion 

The downstream gas expansion calculation is: 

Y Y
P

P2 1
2

1= +
∆

 

C10.4.2.2.3 Liquid 

Y Y1 2 1= =  

C10.5 Thermal Expansion Correction 

C10.5.1 Symbol Table 

The symbol table for thermal expansion correction is shown below. 

Table C-4 Thermal Expansion Correction Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

dr m 0<dr None None None 

Dr m 0<Dr None None None 

αPE m/m/°C 0 < αPE None None None 

αP m/m/°C 0 < αP None None None 

t °C -273.15 < t None None None 

tr °C -273.15 < tr tr is usually assumed to be 20°C 

d m 0<d None None None 

D m 0<D None None None 

C10.5.2 Calculations 

C10.5.2.1 Bore Diameter, d, Temperature Correction 

The bore diameter temperature correction calculation is: 

d t tPE r r= + −1 α d  

C10.5.2.2 Pipe Diameter, D, Temperature Correction 

The pipe diameter temperature correction is: 

D t tp r= + −1 α Dr  
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C10.6 Flow Rate Calculation 

C10.6.1 Symbol Table 

The symbol table for flow rate calculation is shown below. 

Table C-5 Flow Rate Calculation Symbol Table 

Symbol Units Lower 
Domain 

Lower  
Limit 

Upper 
 Limit 

Upper 
Domain 

dr m 0 < dmeas varies with primary element type dr < Dr

Dr m 0 < Dmeas varies with primary element type None 

P1 Pa 0 < P1 0 < P1 None None 

P2 Pa 0 < P2 varies with fluid 
state 

P2 < P1 None 

t °C -273.15 < t None None None 

tr °C -273.15 < tr None None None 

αP m/m/°C 0 < αP None None None 

αPE m/m/°C 0 < αPE None None None 

ρ1 kg/m3 0 < ρ1 None None None 

C - 0 < C None None None 

d m 0 < d varies with primary element type None 

D m 0 < D varies with primary element type None 

∆P Pa 0 < ∆P None None None 

β - 0 < β varies with primary element β < 1 

Y - 0 < Y None None Y ≤ 1 

qm kg/s 0 < qm None None None 

C10.6.2 Calculations 

The actual flow may be found by iteration, since C and RD may depend on the flow 
rate qm. 

d t tPE r r= + −1 α d  

D t tp r= + −1 α Dr  

β =  
d
D

 

∆P P P= −1 2  

The above values of d, D, and β should be used to calculate C and Y. 
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q  =  
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C10.7 Permanent Pressure Loss 

C10.7.1 Symbol Table 

The symbol table for permanent pressure loss is shown below. 

Table C-6 Permanent Pressure Loss Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

C - 0 < C None None None 

∆P Pa 0 < ∆P None None None 

β - 0 < β Varies with primary element β < 1 

∆ϖ Pa 0 < ∆ϖ None None None 

C10.7.2 Calculations 

BS 1042 Section 1.2 does not provide a method to estimate the permanent pressure 
loss.  Therefore the equation provided by ISO 5167 (1991) is applied. 

C10.7.2.1 Orifice Plate (§7.4) 

The orifice plate calculation is: 

∆ ∆ϖ
β β
β β

  P 
1 -   -  C 
1 -   +  C 

4 2

4 2
≈

⎛

⎝
⎜
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⎠
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C11 American Gas Association Report No.3, 
Second Ed., 1985 

C11.1 Flow Element Applicability 
Four standards organizations approved this standard for the orifice metering of 
natural gas in 1985, these are: 
1. American National Standards Institute ANSI/API 2530, 
2. American Gas Association  Report No. 3, Second Edition, 
3. American Petroleum Institute  API 2530 
4. Gas Processors Association  GPA 8185-85 

The third edition of this standard, issued in 1990, supersedes this edition. 

This standard applies to steady-state mass flow. The flowing fluid has the following 
properties: 

• clean 
• single phase 
• Newtonian 

The standard provides the design, construction, and installation specifications for 
orifice meters having the following characteristics: 

• flange tapped or pipe tapped 
• concentric 
• square-edged 

The orifice meters must be nominal 1.6 inch inside diameter or larger. 

C11.2 Calculation of Reynolds Numbers 

C11.2.1 Symbol Table 

The symbol table for the calculation of Reynolds Numbers is shown below. 
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Table C-1 Calculation of Reynolds Numbers Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

d m 0 < d 0 < d None None 

V m/sec 0 < qm 0 < qm None None 

µ Pq
-s 0 < µ 0 < µ None None 

ρf kg/m3 0 < ρf 0 < ρf None None 

Rd - 0 < Rd 0 < Rd None None 

C11.2.2 Bore Reynolds Number (§5.2.2) 

The bore Reynolds Number calculation is: 

R
Vd

d =
ρ

µ
 

(eq. 16, p. 27) 

C11.3 Flow Coefficients 

C11.3.1 Symbol Table 

The symbol table for the flow coefficients is shown below. 

Table C-2 Flow Coefficients Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

d m 0 < d None None d < D 

D m 0 < D 0.0406 ≤ D D ≤ 0.762     (1) None 

Rd - 0 < Rd 4000 < Rd    
(2) None None 

β - 0 < β 0.10 < β β < 0.75 β < 1 

Notes:  
1. Although the standard does not specify an upper limit for pipe diameter, a pipe 

diameter of 0.762 will generate a warning message. A pipe diameter of 0.762 
was selected since the largest pipe diameter used to calculate factors in the 
appendix was 0.762 nom. (30 inches). 

2. Although the standard does not specify a lower limit for Reynolds number, a 
Reynolds number below 4,000 will generate a warning message. A Reynolds 
number of 4,000 was selected since this value is generally accepted as the value 
required for turbulent flow. 
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C11.3.2 Calculations 

C11.3.2.1 Flange Tap Flow Coefficient, Ke, 0.10 < β < 0.75 (§5.2.1) 

The flange tap flow coefficient calculations are: 

β =
d
D

meas

meas
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(eq. 9, p. 26) 

C11.3.2.2 Pipe Tap Flow Coefficient, Ke, 0.10 < β < 0.75 (§5.2.1) 

The pipe tap flow coefficient calculation is: 
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(eq. 10, p. 26) 
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C11.3.2.3 Flow Coefficient at Infinite Reynolds Number, Ko (§5.2.1) 

The flow coefficient at infinite Reynolds Number calculations are: 

e

6
meas

K= 15E1+
d (10 )

oK  
(eq. 11, p. 27) 

Where:  
2 3830 5000 9000 4200E d Bβ β β⎡ ⎤= − + − +⎣ ⎦  (eq. 12, p. 27) 

Where:  

0.5
530

0.0254

B
D

=
⎛ ⎞
⎜ ⎟
⎝ ⎠

  (for flange taps) 
(eq. 13, p. 27) 

875 75

0.0254

B
D

=
⎛ ⎞
⎜ ⎟
⎝ ⎠

+   (for pipe taps) 
(eq. 14, p. 27) 

C11.3.2.4 Flow Coefficient at Specified Reynolds Number, K (§5.2.1) 

The flow coefficient at specified Reynolds Number calculation is: 

K =  K 1+ E
Ro

d

⎡

⎣
⎢

⎤

⎦
⎥  

(eq. 15, p. 27) 

C11.4 Orifice Plates Gas Expansion Factors 

C11.4.1 Symbol Table 

The symbol table for orifice plate gas expansion factors is shown below. 

Table C-3 Orifice Plates Gas Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

β - 0 < β varies with pressure taps β < 1 

κ - 0 < κ None None None 

P1 psia 0 < P1 0 < P1 None None 

P2 psia 0 < P2 0 < P2 P2 < P1 None 

x1 - 0 < x1 None None None 

x2 - 0 < x2 None None None 

Y1 - 0 < Y1 None Y1 ≤ 1   

Y2 - 0 < Y2 None Y2 ≤ 1 None 
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C11.4.2 Calculations 

C11.4.2.1 Upstream Expansion Factor for Flange Taps, 0.1 < β < 0.80 (§5.2.6.1) 

The upstream expansion factor for flange taps calculation is: 

( )Y x
1

4 11 0 41 0 35= − +. . β
κ

 
(eq. 17, p. 28) 

Where: 

x
P P

P1
1 2

1
=

−
 

(eq. 18, p. 28) 

C11.4.2.2 Upstream Expansion Factor for Pipe Taps, 0.1 < β < 0.70 (§5.2.6.1) 

The upstream expansion factor for pipe taps calculation is: 

(( ))Y x
1

2 5 13 11 0 333 1145 0 7 12= − + + +. . .β β β
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(eq. 18, p. 28) 

Where: 

x
P P

P1
1 2

1
=

−
 

(eq. 18, p. 28) 

C11.4.2.3 Downstream Expansion Factor for Flange Taps, 0.1 < β < 0.80 (§5.2.6.2) 

The downstream expansion factor for flange taps calculation is: 
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(eq. 20, p. 29) 
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(eq. 21, p. 29) 

Where: 

x
P P

P2
1 2

2
=

−
 

(eq. 23, p. 29) 

C11.4.2.4 Downstream Expansion Factor for Pipe Taps, 0.2 < β < 0.67 (§5.2.6.2) 

The downstream expansion factor for pipe taps calculation is: 
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(eq. 20, p. 29) 
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(eq. 22, p. 29) 
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Where: 

x
P P

P2
1 2

1
=

−
 

(eq. 23, p. 29) 

C11.4.2.5 Liquid Expansion Factor (§5.2) 

The liquid expansion factor is: 

Y Y1 2 1 000= = .  

C11.5 Thermal Expansion Correction 

C11.5.1 Symbol Table 

The symbol table for thermal expansion correction is shown below. 

Table C-4 Thermal Expansion Correction Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

dr m 0< dr None None None 

Dr m 0<Dr None None None 

αPE m/m/°C 0 < αPE None None None 

αP m/m/°C 0 < αP None None None 

t °C -273.15 < t None None None 

tr °C -273.15 < tr tr is usually assumed to be 20°C 

d m 0<d None None None 

D m 0<D None None None 

C11.5.2 Calculations 

C11.5.2.1 Bore Diameter, d, Temperature Correction 

The bore diameter temperature correction calculation is: 

d t tPE r r= + −1 α d  

C11.6 Flow Rate Calculation 

C11.6.1 Symbol Table 

The symbol table for flow rate calculation is shown below. 
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Table C-5 Flow Rate Calculation Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

dr m 0 < dr   dr < Dr

Dr m 0 < Dr   None 

P1 Pa 0 < P1 0 < P1 None None 

P2 Pa 0 < P2 0.8P1 < P2 P2 < P1 None 

t °C -273.15 < t None None None 

tr °C -273.15 < tr None None None 

αP m/m/°C 0 < αP None None None 

αPE m/m/°C 0 < αPE None None None 

ρ1 kg/m3 0 < ρ1 None None None 

C - 0 < C None C ≤ 1 None 

d m 0 < d 0.0114 < d None None 

D m 0 < D 0.0406 ≤ D D ≤ 0.762 None 

∆P Pa 0 < ∆P None None None 

β - 0 < β 0.1 < β β < 0.75 β < 1 

Y - 0 < Y None None None 

qm kg/s 0 < qm None None None 

C11.6.2 Calculations (§1.6) 

The actual flow is found by iteration, since C and RD are dependent on the flow rate 
qm. 

d t tPE r r= + −1 α d  

β =  
d
D

 

∆P P P= −1 2  

The above values of d, D, and β should be used to calculate C and Y. 

q  =  
4

 C  d
2 P 
1 -  m

2 1
4

π ρ
β
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∆
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C11.7 Permanent Pressure Loss 

C11.7.1 Symbol Table 

The symbol table for permanent pressure loss is shown below. 

Table C-6 Permanent Pressure Loss Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

C - 0 < C None None None 

∆P Pa 0 < ∆P None None None 

β - 0 < β varies with primary element β < 1 

∆ϖ Pa 0 < ∆ϖ None None None 

C11.7.2 Calculations 

AGA 3 does not provide a method to estimate the permanent pressure loss. The 
equation provided by ISO 5167 (1991) is applied. 

C11.7.2.1 Orifice Plate (§8.4) 

∆ ∆ϖ
β β
β β

 =  P 
1 -   -  C 
1 -   +  C 

4 2

4 2

⎛

⎝
⎜

⎞

⎠
⎟  

The above equation may generate negative permanent pressure loss under certain 
conditions (normally with a higher β value or discharge coefficient). If this occurs, the 
following equation, which is also part of ISO 5167 (1991), standard is used. 

( )∆ ∆ϖ β =  P 1 1 9− .  

C11.8 AGA 3 Factors 
Volume flow rate: 

[ ]Q C hw Pv f= '
.0 5
 

Where: 
Qv = volume flow rate at base conditions 
hw = differential pressure 
Pf = absolute static pressure; could be measured downstream or upstream 

And:      C F F Y F F F F Fb r pb tb tf gr pv'=  
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Where: 
C’ = orifice flow constant 
Fb = basic orifice factor 
Fr = Reynolds Number factor 
Y = gas expansion factor 
Fpb = pressure base factor 
Ftb = temperature base factor 
Ftf = flowing temperature factor 
Fgr = real gas relative density factor 
Fpv = supercompressibility factor 

F Nd Kb o= 2  

Where: 
d = bore diameter 

K
K

E
d

o
e=

+1
15
106( )

 

F
E
Rr

d
= +1  

Where: 
Y = upstream Y1

 = downstream Y2

F
Ppb

b
=

14 73.
  F

T
tb

b=
519 67.

  F
Ttf

f
=

519 67.
   

F
Ggr

r
=

1
  F

Z
Zpv

b

f
=  

 

Where: 
N = unit conversion factor 

§ 
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C12 General Application 

C12.1 Orifice Plate Discharge Coefficients 

C12.1.1 Concentric Orifice Plate With Corner Taps, Flange Taps, or 
Radius Taps 

Discharge coefficients for orifice plates using corner taps, flange taps, or radius 
pressure taps are given in Section C12.5 of this appendix, and are based on ISO 
5167 (1991). 

C12.1.2 Concentric Orifice Plate With Pipe Taps 

C12.1.2.1 Symbol Table 

The symbol table for concentric orifice plate with pipe taps is shown below. 

Table C-1 Concentric Orifice Plate with Pipe Taps Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

D m 0 < D 0.0428 ≤ D D ≤ 0.9 None Miller, p.9-54 

d m 0 < d  0 < d d < 0.45 d < D  

qm kg/s 0 ≤ qm 0 ≤ qm None None  

µ Pa-s 0 < µ 0 < µ None None  

C - 0 < C 0 < C C ≤ 1.0 None  

RD - 0 < RD 104 ≤ RD RD ≤ 107 None Miller, p.9-54 

β - 0 < β 0.2 ≤ β β ≤ 0.5 β < 1 Miller, p.9-54 

C12.1.2.2 Calculations (Miller, p. 9-15) 

The concentric orifice plate with pipe taps calculations are: 

β  =   
d
D
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R   =   
4q

DD
m

πµ

C  =   0.5959 +  0.461   +   0.48   +   0.039 
1 -

  +   
91.71 

R
 2.1  8

4
D

0.75β β
β

β
β

 

 4  2.5⎛

⎝
⎜

⎞

⎠
⎟  

C12.1.3 Concentric Orifice Plate With Vena Contracta Taps 

C12.1.3.1 Symbol Table 

The symbol table for concentric orifice plate with vena contracta taps is shown 
below. 

Table C-2 Concentric Orifice Plate with Vena Contracta Taps Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

D m 0 < D 0.0429 ≤ D None None * 

d m 0 < d 0 < d None d < D  

qm kg/s 0 < qm 0 < qm None None  

µ Pa-s 0 < µ 0 < µ None None  

C - 0 < C 0 < C C ≤ 1 None  

RD - 0 < RD 104β < RD None None * 

β - 0 < β 0.2 < β β < 0.75 β < 1 ∗ 

C12.1.3.2 Calculations (Fluid Meters Their Theory and Application, ASME p. 65)* 

The calculations for the concentric orifice plate with vena contracta taps are: 

β  =   
d
D

 
 

R   =   
4q

DD
m

πµ
  

C  =   K  1 - 4 β  (§I-5-37) 

K K bo= + λ  (§I-5-39) 

λ = 1000 / RD  (§I-5-39) 

K
D Do = +

⎛
⎝
⎜

⎞
⎠
⎟ +

⎛
⎝
⎜

⎞
⎠
⎟

+ +

⎛

⎝

⎜
⎜
⎜
⎜

⎞

⎠

⎟
⎟
⎟
⎟

0 5922 0 4252
0 0006

0 0254
0 01

0 0254

1252
2

4 1. .
.

.
.

.

.
β

β β 6

)16

 

(eq. I-5-80) 

(b D= + + + +0 00025 0 002325 175 10 24 12. . .β β β β  (eq. I-5-81) 
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C12.1.4 Eccentric Orifice Plate With Flange Taps 

C12.1.4.1 Symbol Table 

The symbol table for the eccentric orifice plate with flange taps is shown below. 

Table C-3 Eccentric Orifice Plate with Flange Taps Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

D m 0 < D 0.1 < D D < 0.35 None Miller, p.9-137 

d m 0 < d 0.03 < d d < 0.26 d < D d < D 

qm kg/s 0 ≤ qm 0 ≤ qm None None  

µ Pa-s 0 < µ 0 < µ None None  

C - 0 < C None C < 1 None  

RD - 0 < RD 104 < RD RD < 106 None Miller, p.9-137 

β - 0 < β 0.3 < β β < 0.75 β < 1 Miller, p.9-137 

C12.1.4.2 Calculations (Miller, p. 9-15) 

The calculations for the eccentric orifice plate with flange taps are: 

β  =   
d
D

 

R   =   
4q

DD
m

πµ
 

C12.1.4.2.1 180° Taps (Diametrically Opposed) 

The calculation for 180° taps is: 

D ≤  0.1 

C  =   0.5875 +  0.3813   +   0.6898   -   0.1963 
1 -

 -  0.3366   

           +  7.3 -15.7  +  170.8  -  399.7  +  332.2 
R

  

 2.1  8
 4

4
3

2 3 4

D
0.75

β β β
β

β

β β β β

 
⎛
⎝
⎜

⎞
⎠
⎟

⎡

⎣
⎢

⎤

⎦
⎥

 

D > 0.1 
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C  =   0.5949 +  0.4078   +   0.0547   +   0.0955 
1 -

 -  0.5608   

           +  -139.7 +  1328.8  -  4228.2  +  5691.9  -  2710.4 
R

  

 2.1  8
 4

4
3

2 3 4

D
0.75

β β β
β

β

β β β β

 
⎛
⎝
⎜

⎞
⎠
⎟

⎡

⎣
⎢

⎤

⎦
⎥

 

C12.1.4.2.2 90° Taps 

The calculation for 90° taps is: 

D <_ 0.1 

C  =   0.6284 +  0.1462   -   0.8464   +   0.2603 
1 -

 -  0.2886   

           +  69.1 - 469.4  +  1245.6  -  1287.5  +  486.2 
R

  

 2.1  8
 4

4
3

2 3 4

D
0.75

β β β
β

β

β β β β

 
⎛
⎝
⎜

⎞
⎠
⎟

⎡

⎣
⎢

⎤

⎦
⎥

 

D > 0.1 

C  =   0.6276 +  0.0828   +   0.2739   -   0.0934 
1 -

 -  0.1132   

           +  
-103.2 +  898.3  -  2557.3  +  2977  -  1131.3 

R
  

 2.1  8
 4

4
3

2 3 4

D
0.75

β β
β

β
β

β β β β

 

⎛

⎝
⎜

⎞

⎠
⎟

⎡

⎣
⎢

⎤

⎦
⎥

 

C12.1.5 Eccentric Orifice Plate With Vena Contracta Taps 

C12.1.5.1 Symbol Table 

The symbol table for eccentric orifice plate with vena contracta taps is shown below. 

Table C-4 Eccentric Orifice Plate with Vena Contracta Taps Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

D m 0 < D 0.1 < D D < 0.35 None Miller, p.9-137 

d m 0 < d 0.03 < d d < 0.26 d < D d < D 

qm kg/s 0 ≤ qm 0 ≤ qm None None  

µ Pa-s 0 < µ 0 < µ None None  

C - 0 < C None C < 1 None  

RD - 0 < RD 104 < RD RD < 106 None Miller, p.9-137 

β - 0 < β 0.3 < β β < 0.75 β < 1 Miller, p.9-137 
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C12.1.5.2 Calculations (Miller, p. 9-15) 

The calculations for the eccentric orifice plate with vena contracta taps are: 

β  =   
d
D

 

R   =   4q
DD
m

πµ
 

C12.1.5.2.1 180° Taps (Diametrically Opposed) 

The calculations for the 180° taps are: 

D <_ 0.1 

  
R

 900.3 +  1388.6 -  821.5 +  207- 23.3 +           

   0.2845 - 
- 1

 0.1170  +   0.2879  -   0.1851 + 0.6261  =  C

0.75
D

432

3
4

4 
8 2.1 

⎥
⎥
⎦

⎤

⎢
⎢
⎣

⎡

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
 

ββββ

β
β

βββ

 

D > 0.1 

C  =   0.6276 +  0.0828   +   0.2739   -   0.0934 
1 -

 -  0.1132   

           +  55.7 -  471.4  +  1721.8  -  2722.6  +  1569.4 
R

  

 2.1  8
 4

4
3

2 3 4

D
0.75

β β β
β

β

β β β β

 
⎛
⎝
⎜

⎞
⎠
⎟

⎡

⎣
⎢

⎤

⎦
⎥

 

C12.1.5.2.2 90° Taps 

The calculations for the 90° taps are: 

D <_ 0.1 

C  =   0.5917 +  0.3061   +   0.3406   -   0.1019 
1 -

 -  0.2715   

           +  -69.3 +  556.9  -  1332.2  +  1303.7  -  394.8 
R

  

 2.1  8
 4

4
3

2 3 4

D
0.75

β β β
β

β

β β β β

 
⎛
⎝
⎜

⎞
⎠
⎟

⎡

⎣
⎢

⎤

⎦
⎥

 

D > 0.1 
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Note: Miller, p. 9-16, states the Reynold's number term should be: 

C  =   0.6016 +  0.3312   -   1.5581   +   0.6510 
1 -

 -  0.7308   

           +  52.8 -   434.2  +  1571.2  -  2460.9  +  1420.2
R

  

 2.1  8
 4

4
3

2 3 8

D
0.75

β β β
β

β

β β β β

 
⎛
⎝
⎜

⎞
⎠
⎟

⎡

⎣
⎢

⎤

⎦
⎥

 
 

The previous seven discharge coefficient equations have β8 as β4. Therefore, the 
following equation will be used: 

C  =   0.6016 +  0.3312   -   1.5581   +   0.6510 
1 -

 -  0.7308   

           +  52.8 -   434.2  +  1571.2  -  2460.9  +  1420.2 
R

  

 2.1  8
 4

4
3

2 3 4

D
0.75

β β β
β

β

β β β β

 
⎛
⎝
⎜

⎞
⎠
⎟

⎡

⎣
⎢

⎤

⎦
⎥

 

C12.1.6 Segmental Orifice Plate With Flange Taps 

C12.1.6.1 Symbol Table 

The symbol table for the segmental orifice plate with flange taps is shown below. 

Table C-5 Segmental Orifice Plate with Flange Taps Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

D m 0 < D 0.15 < D D < 0.35 None Miller, p.9-36 

d m 0 < d 0 < d None d < D  

qm kg/s 0 ≤ qm 0 ≤ qm None None  

µ Pa-s 0 < µ 0 < µ None None  

C - 0 < C 0 < C C < 1 None  

DC m 0 < DC None None DC < D  

HS m 0 < HS None None HS < D  

RD - 0 < RD 104 < RD RD < 106 None  

β - 0 < β 0.35 < β β < 0.75 None  
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C12.1.6.2 Calculations 

C12.1.6.2.1 Segment Height (Miller, p. 10-40) 

The calculations for segment height are: 

D
DC=
0 98.

 

β
β

πc
c

s

c

s

c

s

c

s

c

d
D

H
D

H
D

H
D

H
D

= = = −
⎛

⎝
⎜

⎞

⎠
⎟ − −

⎛

⎝
⎜

⎞

⎠
⎟ −

⎛

⎝
⎜

⎞

⎠
⎟

⎛

⎝
⎜

⎞

⎠
⎟

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥0 98

1
1

2
2 1

2 2
1

2
1

2

.
arccos  

C12.1.6.2.2 Discharge Coefficient (Miller, p. 9-16) 

The calculations for discharge coefficient are: 

D <_ 0.1 

C  =   0.5866 +  0.3917   +   0.7586   -   0.2273 
1 -

 -  0.3343    2.1  8
 4

4
3β β

β
β

β
 

⎛

⎝
⎜

⎞

⎠
⎟

 

D > 0.1 

C  =   0.6037 +  0.1598   -   0.2918   +   0.0244 
1 -

 -  0.0790    2.1  8
 4

4
3β β β

β
β

 
⎛
⎝
⎜

⎞
⎠
⎟  

C12.1.7 Segmental Orifice Plate With Vena Contracta Taps 

C12.1.7.1 Symbol Table 

The symbol table for segmental orifice plate with vena contracta taps is shown 
below. 

Table C-6 Segmental Orifice Plate with Vena Contracta Taps 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

D m 0 < D 0.15 < D D < 0.35 None Miller, p.9-36 

d m 0 < d 0 < d None d < D  

qm kg/s 0 ≤ qm 0 ≤ qm None None  

µ Pa-s 0 < µ 0 < µ None None  

C - 0 < C 0 < C C < 1 None  

DC m 0 < DC None None DC < D  
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Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

HS m 0 < HS None None HS < D  

RD - 0 < RD 104 < RD RD < 106 None  

β - 0 < β 0.35 < β β < 0.75 None  

C12.1.7.2 Calculations 

C12.1.7.2.1 Segment Height (Miller, p. 10-40) 

The calculations for segment height are: 

D
DC=
0 98.

 

β β
πc

c

s

c

s

c

s

c

s

c

d
D

H
D

H
D

H
D

H
D

= = = −
⎛
⎝
⎜

⎞
⎠
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⎛
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⎜

⎞
⎠
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⎝
⎜

⎞
⎠
⎟

⎛

⎝
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⎜
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⎡

⎣
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⎢
⎢

⎤

⎦
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⎥
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⎤

⎦

⎥
⎥
⎥

0 98
1 1 2 2 1 2
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arccos  

C12.1.7.2.2 Discharge Coefficient (Miller, p. 9-16) 

The calculations for discharge coefficient are: 

D <_ 0.1 

C  =   0.5925 +  0.3380   +   0.4016   -   0.1046 
1 -

 -  0.3212    2.1  8
 4

4
3β β β

β
β

 
⎛
⎝
⎜

⎞
⎠
⎟  

D > 0.1 

C  =   0.5922 +  0.3932   +   0.3412   -   0.0569 
1 -

 -  0.4628    2.1  8
 4

4
3β β β

β
β

 
⎛
⎝
⎜

⎞
⎠
⎟  

C12.1.8 Quadrant Orifice Plate With Corner Taps or Flange Taps 

C12.1.8.1 Symbol Table 

The symbol table for quadrant orifice plate with corner taps or flange taps is shown 
below. 

Table C-7 Quadrant Orifice Plate with Corner/Flange Taps Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper 
Limit 

Upper 
Domain 

Ref 

D m 0 < D 0.025 < D D < 0.75 None Miller, p.9-136 
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Symbol Units Lower 
Domain 

Lower Limit Upper 
Limit 

Upper 
Domain 

Ref 

d m 0 < d 0 < d None d < D  

qm kg/s 0 ≤ qm 0 ≤ qm None None  

µ Pa-s 0 < µ 0 < µ None None  

C - 0 < C 0 < C C < 1 None  

RD - 0 < RD RD(min) < RD RD < 105β None Shell, p.68 

β - 0 < β 0.24 < β β < 0.6 β ≤ 1  

RD(min) = 1000β + 9.4 x 106 (β - 0.24)8

C12.1.8.2 Discharge Coefficient (Miller, p. 9-17) 

The calculations for discharge coefficient are: 

D ≥  0.04 

β  =   
d
D

 

C  =   0.7746 -  0.1334   +   1.4098   +   0.0675 
1 -

 +  0.3865    2.1  8
 4

4
3β β β

β
β

 
⎛
⎝
⎜

⎞
⎠
⎟  

C12.1.9 Conical Orifice with Corner Taps 

C12.1.9.1 Symbol Table 

The symbol table for the conical orifice with corner taps is shown below. 

Table C-8 Conical Orifice with Corner Taps Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

D m 0 < D 0.025 < D None None Miller, p.9-136 

d m 0 < d 0 < d d < D None  

qm kg/s 0 ≤ qm 0 ≤ qm None None  

µ Pa-s 0 < µ 0 < µ None None  

C - 0 < C 0 < C C < 1 None  

RD - 0 < RD None None None Miller, p.9-136 

β - 0 < β 0.1 < β β < 0.316 β < 1 Miller, p.9-136 

C12.1.9.2 Discharge Coefficient (Miller, p. 9-17) 

The calculations for discharge coefficient are: 
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D ≥  0.025 mm 

β  =   
d
D

 

R   =   
4q

DD
m

πµ
 

250   R   5000     C = 0.734 Dβ β≤ ≤ ⇒  

5000   R   200000    C = 0.730 Dβ β≤ ≤ ⇒  

C12.1.10 Small Bore Orifice (Small Diameter Orifice) Meter Runs With 
Flange Taps 

C12.1.10.1 Symbol Table 

The symbol table for the small bore orifice meter runs with flange taps is shown 
below. 

Table C-9 Small Bore Orifice Meter Runs with Flange Taps Symbol Table 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

D m 0 < D 0.0254 ≤ D D ≤ 0.0381 None Fluid Meters, P.214 

d m 0 < d 0 < d d < D None  

qm kg/s 0 ≤ qm 0 ≤ qm None None  

µ Pa-s 0 < µ 0 < µ None None  

C - 0 < C 0 < C C < 1 None  

RD - 0 < RD 1,000 < RD None None Fluid Meters, P.214 

β - 0 < β 0.1 < β β < 0.8 β < 1 Fluid Meters, P.214 

C12.1.10.2 Discharge Coefficient (Fluid Meters, P.214) 

The calculations for the discharge coefficient are: 

β  =   
d
D

 

R   =   
4q

DD
m

πµ
 

( )[ ]( ) ( )( )
C = 0.5980 + 0.468 1- +  

0.87 + 8.1 1-4 4 0.5
4 4 0.5

β β β
β β

+ 10 12
0 5RD

.  
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C12.1.11 Small Bore Orifice (Small Diameter Orifice) Meter Runs With 
Corner Taps 

C12.1.11.1 Symbol Table 

The symbol table for small bore orifice meter runs with corner taps is shown below. 

Table C-10 Small Bore Orifice Meter Runs with Corner Taps 

Symbol Units Lower 
Domain 

Lower 
Limit 

Upper 
Limit 

Upper 
Domain 

Ref 

D m 0 < D 0.0254 ≤ D D ≤ 0.0381 None Fluid Meters, P.214 

d m 0 < d 0 < d d < D None  

qm kg/s 0 ≤ qm 0 ≤ qm None None  

µ Pa-s 0 < µ 0 < µ None None  

C - 0 < C 0 < C C < 1 None  

RD - 0 < RD 1,000 < RD None None Fluid Meters, P.214 

β - 0 < β 0.1 < β β < 0.8 β < 1 Fluid Meters, P.214 

C12.1.11.2 Discharge Coefficient (Fluid Meters, P.214) 

The calculations for the discharge coefficient are: 

β  =   
d
D

 

R   =   
4q

DD
m

πµ
 

( ) ( )

( ) ( )

C = 0.5991+  
0.11176

D
+ 0.3155 +  

0.4445
D

1- +

                          
13.2

D
 

1-

4 4 0.5

4
4 0.5

⎛
⎝
⎜

⎞
⎠
⎟ +

⎡
⎣⎢

⎤
⎦⎥

− + −
⎛
⎝
⎜

⎞
⎠
⎟ +

⎡
⎣⎢

⎤
⎦⎥

β β β

β β
β

2

0192 16 48
29 46

4

16

16
0 5. .

.
.D RD

 

Note: When calculating C, D is in mm. 

C12.1.12 Restriction Orifice Plates 

The Discharge Coefficient for restriction orifice plates is based on ISO 5167 (1991) 
for orifice plates with flange taps. Refer to Appendix C6, Section C6.3.2.3.  
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C12.2 Nozzles 

C12.2.1 ISA 1932 Nozzle Discharge Coefficient 

The Discharge Coefficient for ISA 1932 nozzles is calculated based on ISO 5167 
(1991). Refer to §6.4.2.1 of the appendices. 

C12.2.2 Long Radius Nozzle Discharge Coefficient 

The Discharge Coefficients for both high-ratio and low-ratio nozzles are based on 
ISO 5167 (1991). Refer to §6.4.2.2 of the appendices. 

C12.3 Classical Venturi Tubes and Venturi Nozzles 

C12.3.1 Classical Venturi Tube with as-Cast Convergent Discharge 
Coefficients 

Discharge Coefficients for classical venturi tubes with as-cast convergent is based 
on ISO 5167 (1991). Refer to §6.5.2.1.1 of the appendices. 

C12.3.2 Classical Venturi Tube With a Machined Convergent 
Discharge Coefficients 

Discharge Coefficients for classical venturi tubes with a machined convergent is 
based on ISO 5167 (1991).  Refer to §6.5.2.2.1 of the appendices. 

C12.3.3 Classical Venturi Tube With Rough Welded Convergent 
Discharge Coefficients 

Discharge Coefficients for classical venturi tubes with a rough welded convergent is 
based on ISO 5167 (1991).  Refer to §6.5.2.3.1 of the appendices. 

C12.3.4 Venturi Nozzle Discharge Coefficients 

Discharge Coefficient for a venturi nozzle is based on ISO 5167 (1991). Refer to 
§6.5.2.4.2 of the appendices. 

C12.4 Orifice Plate Thickness Calculation 

C12.4.1 Symbol Table 

The symbol table for the orifice plate thickness calculation is shown below. 
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Table C-11 Orifice Plate Thickness Calculation Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

D m 0 < D 0 < D None None 

∆P Pa 0 < ∆P 0 < ∆P None None 

β - 0 < β 0 < β None β < 1 

σy Pa 0 < σy 0 < σy None None 

tmin m 0 < tmin 0.003 < tmin None None 

C12.4.2 Plate Thickness Calculations 

The plate thickness calculation is: 

( )t
P

D
y

min
. .

≥
−⎡

⎣
⎢
⎢

⎤

⎦
⎥
⎥

0 681 0 651
1

2β
σ

∆
 

(Miller, p. 10-4, eq. 10.2) 

Notes:  
1. The calculated tmin will be compared with the value in the following table and the 

larger of the two values will be adopted. 
This method is used for all standards. 

2. The thickness calculation does not apply to cryogenic applications. 

Table C-12 Minimum Recommended Thickness of Orifice Plates (mm) 

 Internal Diameter of Pipe (mm)
Differential 
Pressure  
(in kPa) 

 
76.2 and less 

 
150 

 
250 

 
500 

 
800 

 β < 0.5 

< 249 3.18 3.18 4.76 9.53 12.7 

< 49.8 3.18 3.18 3.18 6.35 9.53 

< 24.9 3.18 3.18 3.18 6.35 9.53 

 β > 0.5 

< 249 3.18 3.18 4.76 9.53 12.7 

< 49.8 3.18 3.18 3.18 4.76 9.53 

< 24.9 3.18 3.18 3.18 4.76 6.35 

(Application: Part II of Fluid Meters, 6th ed. 1971, ASME p.198) 
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C12.5 Gas Expansion Factors 

C12.5.1 Symbol Table 

The symbol table for the gas expansion factors is shown below. 

Table C-13 Gas Expansion Factors Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

β - 0 < β Varies Varies β < 1 

κ - 0 < κ 1 < κ κ < 5 None 

P1 Pq 0 < P1 0 < P1 None None 

P2 Pq 0 < P2 0 < P2 P2 < P1 None 

x1 - 0 < x1 None None None 

x2 - 0 < x2 None None None 

Y1 - 0 < Y1 None Y1 ≤ 1 None 

Y2 - 0 < Y2 None Y2 ≤ 1 None 

C12.5.2 Concentric Orifice Plate With Corner Taps, Flange Taps or 
Radius Taps 

Gas expansion factors for orifice plates using corner taps, flange taps, or radius taps 
are given in §5.6 of the appendices, and are based on ISO 5167 (1991). 

C12.5.3 Concentric Orifice Plate With Vena Contracta Taps 

 (Application: Part II of Fluid Meters, 6th ed. 1971, ASME p.208) 

The calculations for the concentric orifice plate with vena contracta taps are: 

x1 
1

 =   
p

P
∆

 

( )Y
x

1
4 1  =   1 -  0.41 + 0.35  β

κ
 

x2 
2

 =   
p

P
∆

 

( )Y x
x

x2 2
4

2

  =   1+  -  0.41 + 0.35  
1+

2

β
κ

1
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C12.5.4 Concentric Orifice Plate With Pipe Taps (Miller, p. 9-56) 

The calculations for the concentric orifice plate with pipe taps are: 

x1 
1

 =   
p

P
∆

 

( )( )Y
x

1
2 5 13 1  =   1 -  0.333 +  1.145  +  0.7  +  12  β β β

κ
   

x2 
2

 =   
p

P
∆

 

( )[ ]Y
x

2 2
2

2

  =   1+ x  -  0.333 +1.145  
1+ x

2

β β β
κ

+ +0 7 125 13.  

C12.5.5 Eccentric Orifice Plate with Corner Taps, Flange 180° Offset 
Taps, Flange 90° Offset Taps, Vena Contracta 180° Offset or 
Vena Contracta 90° Offset (Miller, p. 9-56) 

The calculations are: 

x1 
1

 =   
p

P
∆

 

( )Y
x

1
3 1  =   1 -  0.1926 +  0.574 + 0.9675 - 4.24  β β β β

κ
2 4362+ .  

x2 
2

 =   
p

P
∆

 

( )Y
x

2 2
2

2

  =   1+ x  -  0.1926 + 0.574  
1+ x

2

β β β β
κ

+ − +0 9675 4 24 3623 4. . .  

C12.5.6 Segmental Orifice Plate with Flange taps or Vena Contracta 
Taps 

The gas expansion equation was determined by curve fitting the data in Application: 
Part II of Fluid Meters, 6th ed.1971, Figure II-III-12, ASME p.213. 

x1 
1

 =   
p

P
∆
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( )Y
x

1
3 1  =   1 -  0.741 +  1.850 - 4.940 +5.998  β β β β

κ
2 42 409− .  

x2 
2

 =   
p

P
∆

 

Y   =  Y  1+ x2 1 2  

Note: Y2 uses the form given in ISO 5167 (1991). 

C12.5.7 Quadrant Edged Orifice Plate with Corner Taps or Flange 
Taps 

Gas expansion factors for orifice plates using corner taps or flange taps are given in 
§6.4 of the appendices, and are based on ISO 5167 (1991). 

C12.5.8 Conical Orifice Plate with Corner Taps 

Gas expansion factors for orifice plates using corner taps are given in §6.4 of the 
appendices, and are based on ISO 5167 (1991). 

C12.5.9 Small Bore Orifice (Small Diameter) Meter Runs With Flange 
Taps 

Miller (p. 10-35) recommends that the gas expansion factor for a square-edged 
orifice with pipe taps be used. Refer to §9.5.4. of the appendices. 

C12.5.10 Small Bore Orifice (Small Diameter) Meter Runs With Corner 
Taps 

Miller (p. 10-35) recommends that the gas expansion factor for a square-edged 
orifice with flange, corner or radius taps be used. Refer to §5.6 of the appendices. 

C12.5.11 ISA 1932 Nozzle with Corner Taps 

Gas expansion factors for the ISA 1932 nozzle are calculated based on ISO 5167 
(1991). Refer to §3.8.2.1 of the appendices. 

C12.5.12 Long Radius Nozzle with Radius Taps, Wall Taps or Throat 
Taps 

Gas expansion factors for the long radius nozzle are calculated based on ISO 5167 
(1991). Refer to §6.5 of this document. 

 346  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  



C12 General Application  User Manual 

C12.5.13 Classical Venturi Tube with Throat Taps 

Gas expansion factors for the classical venturi tube are calculated based on ISO 
5167 (1991). Refer to §6.6 of this document. 

C12.5.14 Venturi Nozzle with Throat Taps 

Gas expansion factors for the venturi nozzle are calculated based on ISO 5167 
(1991). Refer to §6.6 of this document. 

C12.5.15 Restriction Flow Devices: Concentric Orifice with Pipe Taps 

Gas expansion factors for restriction orifice plates are given in §9.5.3 of this 
document. 

C12.6 Correction Factor for Steam Quality (Gas-Liquid) 
Flows 

C12.6.1 Symbol Table 

The symbol table for the correction factor for steam quality flows is shown below. 

Table C-14 Correction Factor for Steam Quality Flows Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

ρg1 kg/m3 0 < ρg1 None None None 

ρiq kg/m3 0 < ρl None None None 

∆P Pq 0 < ∆P None None None 

Fx - None None None None 

∆Pg Pq 0 < ∆P None None None 

Y1  0 ≤ Y1 0.98 ≤ Y varies w/device Y ≤ 0 

β - 0 < β 0.25 ≤ β β ≤ 0.5 β ≤ 1 

RD - 0 100,000 < RD None None 

Cg - 0 < C varies with device None  

x - 0 < x 0.95 < x None None 

C12.6.2 Calculations (Miller, p. 9-76) 

The two phase correction factor is based on the work of Murdock. The mass flow 
equation is: 

M,TC 1 14
q   =  

4 1
x g

Cg F Y Pπ ρ
β

∆
−

 
(Miller, p. 9-77, eq. 9.89) 
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The quality of a gas/liquid mixture is defined as: 
Mass of GasX  =  

Total Mass of Mixture
 

 

The quality correction factor is defined as: 

( )
F   =   1

X +  1.26 1 -  X  
x

g1

liq

ρ
ρ

 
(Miller, p. 9-77, eq. 9.87) 

The discharge coefficient is calculated at the Reynolds number defined by the dry 
gas flow rate.  The dry gas flow rate is given as: 

( ) ( )q  =   X qM g M TC
 (Miller, p. 9-77, eq. 9.86) 

The gas expansion factor, Y1, is calculated based on the dry gas differential 
pressure. 

( )
g 2

g1

liq

P  =  
1.26 1 - X1+   X

P
ρ
ρ

∆
∆

⎡ ⎤⎡ ⎤
⎢ ⎥⎢ ⎥

⎣ ⎦⎢ ⎥⎣ ⎦

 
(Miller, p. 9-78, eq. 9.91) 

C12.7 Drain Hole Correction Factor 

C12.7.1 Symbol Table 

The symbol table for the drain hole correction factor is shown below. 

Table C-15 Drain Hole Correction Factor Symbol Table 

Symbol Units Lower 
Domain 

Lower Limit Upper Limit Upper 
Domain 

d m 0 < d None None d < D 

dDH m 0 < dDH None dDH < 0.1 d None 

β - 0 < β None None β < 1 

FDH - 0 < FDH None None None 

C12.7.2 Calculations 

C12.7.2.1 Square Edged Drain Hole in Orifice Plates 

The calculation for the square edged drain hole in the orifice plates is: 
2

DH4
DH d

d  - 1 + 1  =  F ⎟
⎠
⎞

⎜
⎝
⎛ β  

(Miller, p. 9-79, eq. 9.99) 

 348  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  



C12 General Application  User Manual 

C12.7.2.2 Square Edged Drain Hole in Nozzles and Venturis 

The calculation for the square edged drain hole in nozzles and venturis is: 

F   =   1 +  0.6 1 -   
d

dDH
4 DH

2

 ⎛
⎝⎜

⎞
⎠⎟

β  
(Miller, p. 9-79, eq. 9.100) 

C12.7.2.3 Round Edged Drain Hole in Orifice Plates 

The calculation for the round edged drain hole in orifice plates is: 

F   =   1 +  1.66 1 -   
d

dDH
4 DH

2

 ⎛
⎝⎜

⎞
⎠⎟

β  
(Miller, p. 9-79, eq. 9.101) 

C12.7.2.4 Round Edged Drain Hole in Nozzles and Venturis 

The calculation for the round edged drain hole in nozzles and venturis is: 

F   =   1 +  1 -   
d

dDH
4 DH

2

 ⎛
⎝⎜

⎞
⎠⎟

β  
(Miller, p. 9-80, eq. 9.102) 

C12.8 Permanent Pressure Loss 

C12.8.1 Symbol Table 

The symbol table for permanent pressure loss is shown below. 

Table C-16 Permanent Pressure Loss Symbol Table 

Symbol Units Lower 
Domain 

Lower  
Limit 

Upper 
 Limit 

Upper 
Domain 

C - 0 < C None C < 1 None 

β - 0 < β varies with device β < 1 

∆P Pa 0 < ∆P varies with device None 

ϖ Pa 0 < ϖ None None ϖ < ∆P 

C12.8.2 Calculations 

C12.8.2.1 Square Edged Orifice Plates with Flange Taps, Radius Taps and Corner Taps 

Permanent pressure loss is calculated following ISO 5167. Refer to §4.11.2.1 of the 
appendices. 
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C12.8.2.2 Square Edged Orifice Plates with Pipe Taps and Quadrant Edged Orifice Plates 

Miller recommends the following for square-edged and quadrant-edged orifice plates. 
2 3(1 0.24 0.52 0.16 ) Pϖ β β β= − − − ∆  (Miller, p. 6-38) 

C12.8.2.3 ISA 1932 Nozzles and Long Radius Nozzles (High and Low Ratios) with Radius 
Taps 

Permanent pressure loss is calculated following ISO 5167 (1991). Refer to Section 
C2.11.2.3 of the appendices. 

C12.8.2.4 Long Radius Low Ratio nozzles with Throat Taps 

Permanent pressure loss is calculated following ASME MFC-3M-1989. Refer to 
Section C2.11.2.2 of the appendices. 

C12.8.2.5 Venturi Tubes and Venturi Nozzles 

Permanent pressure loss is calculated following ASME Standard MFC-3M-1989.  
Refer to Section C2.11.2.3 of the appendices. 

C12.9 Vena Contracta Location 
Note: Currently this calculation is not implemented. 

C12.9.1 Symbol Table 

The symbol table for vena contracta location is shown below. 

Table C-17 Vena Contracta Location Symbol Table 

Symbol Units Lower Domain Lower Limit Upper Limit Upper Domain 

β - 0 < β   β < 1 

D m 0 < D    

x m 0 < x    

C12.9.2 Vena Contracta Location Calculations 

Vena contracta locations for square edged, segmental, and eccentric orifice plates 
were determined by curve fitting to figure II-III-3 and figure II-III-8, Application Part II 
of Fluid Meters, AMSE, 6th. ed, 1971. 
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C12.9.2.1 Concentric Orifice Plates 

The concentric orifice plates calculation is: 

( )( )x
D = + − + −11265 0 7118 0 9644 1571. . . .β β β  

C12.9.2.2 Eccentric Orifice Plates 

The eccentric orifice plates calculation is: 

( )( )x
D = + − + −10699 12443 36310 3651. . . .β β β  

C12.9.2.3 Segmental Orifice Plates 

The segmental orifice plates calculation is: 

( )( )( )x
D = + − + + − +1643 61431 18 639 24 04 10 494. . . . .β β β β  

C12.10 Critical Flow Calculations 

C12.10.1 Symbol Table 

The symbol table for critical flow calculations is shown below. 

Table C-18 Critical Flow Calculations Symbol Table 

Symbol Units Lower Domain Lower Limit Upper Limit Upper 
Domain 

d m 0 < d None None d < D 

D m 0 < D None None None 

tp m 0 < tp None None tp < D 

β - 0 < β varies with device β < 1 

Rd - 0 < Rd None None None 

P1 Pa 0 < P1 P2 < P1 None None 

P2 Pa 0 < P2 None P2 < P1 None 

Pv Pa 0 < Pv None None None 

κ - 0 < κ None None None 

ρ ° 0 < ρ None None None 

Z - 0 < Z None None None 

C - 0 < C None C < 1 None 

Qm kg/s 0 < Q None None None 
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C12.10.2 Discharge Coefficients 

C12.10.2.1 Orifice Plate 1d to 6d Thick 

The discharge coefficient for the orifice plate, 1d to 6d thick is: 
d t d Cp≤ ≤ =6 0 83932.  (Miller, p. 13-23, eq. 13.23) 

C12.10.2.2 Orifice Plate 6d to 20d Thick 

The discharge coefficient for the orifice plate, 6d to 20d thick is: 
6 20 0 899d t d Cp≤ ≤ = .  (Miller, p. 13-30) 

C12.10.3 Liquid Calculations 

Liquid choked flow only occurs when a cavitation barrier exists in the flow device. 
The design pressure drop is given by Miller as: 

1 vP P P∆ = −  (Miller, p. 13-29, eq. 13.26) 

C12.10.4 Critical Flow Function 

The critical flow function calculation is: 

Y   =   
Z

 2
 +  1cr

+1
-1κ

κ

κ
κ⎛

⎝⎜
⎞
⎠⎟

⎛
⎝⎜

⎞
⎠⎟

 

(Miller, p. 13-5, eq. 13.14) 

C12.10.5 Flow Rate Calculation 

Note: C could be a function of Re and/or β therefore iteration would be required. 
2

cr
dQm  =  C  Y  Z P
4

ρ
π

 
(ASME/ANSI standard MFC-7M-1987, p. 5) 

C12.11 Gas Sonic Flow Rate Check 

C12.11.1 Symbol Table 

The symbol table for gas sonic flow rate check is shown below. 

Table C-19 Gas Sonic Flow Rate Check Symbol Table 

Symbol Units Lower Domain Lower Limit Upper Limit Upper Domain 
k - 1 < k None None None 

P1 Pq 0 < P1 None None None 

Ps Pq 0 < Ps None Ps < P1 None 
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C12.11.2 Calculation 

Although the following equation applies strictly to ASME long-radius nozzles and a 
thick square-edged orifice (Miller, p.13-25), the equation has been extended to all the 
differential pressure devices as a means to provide a check for sonic flow rates. 

 

P
P

k

k
k

s

k
k

k
k

= +
⎛
⎝⎜

⎞
⎠⎟

−
+

⎛
⎝⎜

⎞
⎠⎟

⎡

⎣

⎢
⎢

⎤

⎦

⎥
⎥

−

+
−

1

1

1
1 4

2
1

1
2

2
1

β

 

(Miller, p. 13-24, eq. 13, 24) 

At sonic flow rates and greater, the equations used in this program to calculate flow 
rate are no longer valid. 

§ 
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C13 References 
Each reference in the text has a name and page number or paragraph number with 
it. For example, “(Miller, P.49)” would indicate that the entry is referenced from the 
book by R.W. Miller, on page 49. 

The following references are acknowledged as sources, and are directly quoted 
within this manual: 

• AGA Report No.3, Orifice Metering of Natural Gas and Other Related 
Hydrocarbon Fluids, Part 1, General Equations and Uncertainty Guidelines, 
Third Edition, Oct. 1990, It’s also called API Manual of Petroleum 
Measurement Standard, Chapter 14.3 and GPA 8185-90. 

• AGA Report No.3, Orifice Metering of Natural Gas and Other Related 
Hydrocarbon Fluids, Part 2, Specifications and Installation Requirements,  
Fourth Edition, April 2000, It’s also called API Manual of Petroleum 
Measurement Standard, Chapter 14.3 and GPA 8185-92, ANSI/API 2530-92. 

• AGA Report No.3, Orifice Metering of Natural Gas and Other Related 
Hydrocarbon Fluids, Part 3, Natural Gas Applications, Third Edition, Aug. 
1992, It’s also called API Manual of Petroleum Measurement Standard, 
Chapter 14.3 and GPA 8185-92, ANSI/API 2530-92. 

• AGA Report No.3, Orifice Metering of Natural Gas and Other Related 
Hydrocarbon Fluids, Second Edition, Aug. 1985, It’s also called API Manual 
of Petroleum Measurement Standard, Chapter 14.3, GPA 8185-85 and 
ANSI/API 2530. 

• AGA Report No. 8, Compressibility Factors of Natural Gas and Other Related 
Hydrocarbon Gasses, Second Edition Nov. 1992. 

• AGA Report No. 10, Speed of Sound in Natural Gas and Other Related 
Hydrocarbon Gasses, 2003. 

• ASME MFC-3M-1989, Measurement of Fluid Flow in Pipes Using Orifice, 
Nozzle and Venturi, New York, 1990. 

• ASME Fluid Meter, 6th Edition, ASME, New York, 1971. 
• ASME/ANSI MFC-7M-1987, Measurement of Gas Flow by Means of Critical 

Flow Venturi Nozzles,  New York, 1987. 
• ASME MFC 14M-2003, Measurement of Fluid Flow Using Small Bore 

Precision Orifice Meters, April 2003. 
• ANSI/ASME PTC 6-1976, Steam Turbines, Yew York, 1982 (Reaffirmed in 

1991). 
• BS 1024: Section 1.2, 1989, Measurement of Fluid Flow in Closed Conduit, 

1989. 
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• ISO 5167-1, Measurement of Fluid Flow by Means of Pressure Differential 
Devices, Part 1: Orifice plates, nozzles and venturi tubes inserted in circular 
cross-section conduits running full, First Edition, Switzerland, 1991. 

• ISO 5168, Measurement of Fluid Flow --Estimation of Uncertainty of Flow 
Rate Measurement, First Edition, Switzerland, 1978. 

• ISO 5167-1, Measurement of Fluid Flow by Means of orifice plates, nozzles 
and venturi tubes inserted in circular cross-section conduits running full, First 
Edition, Switzerland, 1980. 

• ISO/TR15377:1998, Measurement of Fluid Flow by means of pressure-
differential devices – Guidelines for the specification of nozzles and orifice 
plates beyond the scope of ISO 5167-1. 

• R.W. Miller  Flow Measurement Engineering Handbook, Second Edition, 
McGraw-Hill, New York, 1989. 

• R.W. Miller  Flow Measurement Engineering Handbook, Third Edition, 
McGraw-Hill, New York, 1996. 

§ 
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D Other Formulas and Calculations 

D.1 Atmospheric Pressure Calculation 
The atmospheric pressure is calculated by the following equation: 

P = − × + × − ×− − −101325 120155107 10 5 75887513 10 127825937 104 9 2 13. . . .y y y 3 
 
Where: P = pressure (bar) 
 y = altitude (m) 

The equation is a curve fitting of the data presented in the CRC Handbook of 
Chemistry and Physics 64th Edition, 1983-1984, p.F-155 to F-157. In order to 
convert the pressure into the required unit given the selected units of altitude, 
appropriate conversion factors are applied. 

The atmospheric pressure is used when a gauge flowing pressure unit is selected 
(designated by the suffix “-g”, i.e., bar-g) to calculate an absolute pressure. 

absolute pressure = flowing gauge pressure + atmospheric pressure 

The absolute pressure can be required in other calculations. 

D.2 Definition of C´ 
C´ is defined as: 
 

p
flowrateC′ =

∆
 (for liquid) 

P Pf

flowrateC′ =
∆

 (for gas) 

Where: Pf is in absolute units.  

If you select a gauge pressure unit (i.e., psig) Flowel automatically converts to the 
corresponding absolute pressure unit (e.g. psia) before calculating C'. 
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D.3 Uncertainty 
The uncertainty calculation uses the root of sum of squares method. The equation is 
as follows:  

0.52 24
2 2 2 2 2 2

4 4

1 1 14 4
1 4 4 1q C Y d P DE E E E E E Eρ

β
β β∆

⎡ ⎤⎛ ⎞ ⎛ ⎞
⎢ ⎥= + + + + +⎜ ⎟ ⎜ ⎟− −⎢ ⎥⎝ ⎠ ⎝ ⎠⎣ ⎦

 

(eq.15, ISO 5168, 1978, p.19) 

 
Where: E = percentage uncertainty in variable 
 Q = flow rate 
 C = discharge coefficient 
 Y = expansibility coefficient 
 d = bore diameter of orifice 
 ρ = density of fluid 
 ∆P = differential pressure 
 D = inside pipe diameter 
 β = beta ratio 

The value of EC and EY are determined by the standard (e.g., AGA 3 (1985)).  These 
values depend primarily on the element type selected and cannot be altered by the 
users.  Ed and ED are initially set to the value given in the standard selected, but they 
can be re-defined by the user (see Chapter 3, User Reference for details).  By 
default, Eρ and E∆P are initially set to zero; however, the user may assign other 
values. 

Notes: 
1. A flow calculation must precede an uncertainty calculation. 
2. If the limiting variable range is exceeded, no uncertainty is calculated. 
3. For critical flow applications, no uncertainty is calculated. 
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The uncertainty tables for each standard are listed in Table D-1 below. 

Table D-1 Uncertainty Tables 

Element Range of Limiting 
Variable 

Variable Uncertainty in Variable (+/- %) 

AGA 3 (1992) 
Orifice Plate – 

standard 
β > 0.175 C 

( )
0.8

8

D

40001 1 0.5600 0.255 1.9316
R

β β
⎛ ⎞⎛ ⎞
⎜ ⎟+ − +⎜ ⎟⎜ ⎟⎝ ⎠⎝ ⎠

 
Orifice Plate – 

standard 
β ≤ 0.175 C 

( )1 1
4000

0 7000 10550
0 8

+
⎛

⎝
⎜

⎞

⎠
⎟

⎛

⎝
⎜
⎜

⎞

⎠
⎟
⎟ −R D

.

. . β  

Orifice Plate – 
standard 

β ≤ 0.75 Y P4
P

∆⎛ ⎞
⎜ ⎟
⎝ ⎠

 

Orifice Plate – 
standard 

 D 0.5 

Orifice Plate – 
standard 

d ≤ 0.00635m d 0.00000762m
d

 

Orifice Plate – 
standard 

0.006375m ≤ d ≤ 
0.009525m 

d 0.001016m
d

 

Orifice Plate – 
standard 

0.009527m ≤ d ≤ 0.0254µ d 0.00127m
d

 

Orifice Plate – 
standard 

0.0254m < d d 0.05 

AGA 3 (1985) 
Orifice Plate – 

standard  
(flange taps) 

0.15 < β < 0.70 C
1 4− β

 0.5 

Orifice Plate – 
standard (pipe taps) 

0.20 < β < 0.67 C
1 4− β

 0.75 

Orifice Plate – 
standard  

(flange taps) 

0.10 < β < 0.8 Y 0.5 

Orifice Plate – 
standard (pipe taps) 

0.10 < β < 0.7 Y 0.5 

Orifice Plate – 
standard  

(flange taps) 

β = 0.75 D 0.5 

Orifice Plate – 
standard (pipe taps) 

β = 0.75 D 0.2 

Orifice Plate – 
standard 

d ≤ 0.000635m d 0.000762m
d

 

Orifice Plate – 
standard 

0.0006357m ≤ d ≤ 
0.009523m 

d 0.001016m
d
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Element Range of Limiting 
Variable 

Variable Uncertainty in Variable (+/- %) 

Orifice Plate – 
standard 

0.009527m ≤ d 

≤0.0254µ 

d 0.00127m
d

 

Orifice Plate – 
standard 

0.0254µ<d d 0.05 

ISO 5167 (1991) 
Orifice plate – 

standard (all taps) 
β ≤ 0.6 C 0.6 

Orifice plate – 
standard (all taps) 

0.6 < β ≤ 0.75 C β 

Orifice plate – 
standard (all taps) 

 Y 
4

∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Orifice plate – 
standard (all taps) 

 D 0.3 

Orifice plate – 
standard (all taps) 

 d 0.05 

Nozzle – ISA 1932 β ≤ 0.6 C 0.8 

Nozzle – ISA 1932 0.6 < β C 2β - 0.4 
Nozzle – ISA 1932  Y 

2
∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Nozzle – ISA 1932  D 2 
Nozzle – ISA 1932  d 0.05 

Nozzle – Long 
Radius  

(high or low ratio) 

0.2 < β < 0.8 C 2.0 

Nozzle – Long 
Radius  

(high or low ratio) 

 Y 
2

∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Nozzle – Long 
Radius  

(high or low ratio) 

 D 2 

Nozzle – Long 
Radius  

(high or low ratio) 

 d 0.05 

Venturi (cast)  C 0.7 
Venturi (machined)  C 1.0 

Venturi (welded)  C 1.5 
Venturi (all types)  Y ( )4 100 8+ β

∆P
P

 

Venturi (all types)  D 2 
Venturi (all types)  d 0.1 

Venturi Nozzle  C 12 15 4. .+ β  

Venturi Nozzle  Y ( )4 100 8+ β
∆P
P
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Element Range of Limiting 
Variable 

Variable Uncertainty in Variable (+/- %) 

Venturi Nozzle  D 2 
Venturi Nozzle  c 0.1 

ISO 5167 (1980) 
Orifice Plate – 

Standard (all taps) 
β ≤ 0.6 C 0.6 

Orifice Plate – 
Standard  

(corner taps) 

0.6 < β < 0.8 C β 

Orifice Plate – 
Standard (flange or 

radius taps) 

0.6 < β ≤ 0.75 C β 

Orifice Plate – 
Standard (all taps) 

β ≤ 0.6 Y 
4

∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Orifice Plate – 
Standard  

(corner taps) 

0.75 < β ≤ 0.8 Y 
8

∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Orifice Plate – 
Standard (all taps) 

 D 0.3 

Orifice Plate – 
Standard (all taps) 

 d 0.05 

Nozzle – ISA 1932 β ≤ 0.6 C 0.8 

Nozzle – ISA 1932 0.6 < β C 2β - 0.4 
Nozzle – ISA 1932  Y 

2
∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Nozzle – ISA 1932  D 0.3 
Nozzle – ISA 1932  d 0.05 

Nozzle – Long 
Radius  

(high or low ratio) 

0.2 < β < 0.8 C 2.0 

Nozzle – Long 
Radius  

(high or low ratio) 

 Y 
2

∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Nozzle – Long 
Radius  

(high or low ratio) 

 D 0.3 

Nozzle – Long 
Radius  

(high or low ratio) 

 d 0.05 

Venturi (cast)  C 0.7 

Venturi (machined)  C 1.0 

Venturi (welded)  C 1.5 

Venturi (all types)  Y ( )4 100 8+ β
∆P
P

 

Venturi (all types)  D 2 
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Element Range of Limiting 
Variable 

Variable Uncertainty in Variable (+/- %) 

Venturi (all types)  d 0.1 

Venturi Nozzle 0.065m ≤ D ≤ 0.500m 

0.050m ≤ d 

0.316 ≤ β ≤ 0.775 

1.5 x 105 ≤ RD ≤ 2 x 106

C
1 4− β

 12 15 4. .+ β  

Venturi Nozzle  Y ( )4 100 8+ β
∆P
P

 

Venturi Nozzle  D 0.3 

Venturi Nozzle  d 0.05 

ASME MFC-3M 
Orifice plate 

(all taps) 
10000 < RD ≤ 108

0.2 < β ≤ 0.6 

0.0429m ≤ D ≤ 0.900m 

C 0.6 

Orifice plate  
(all taps) 

10000 < RD ≤ 108

0.6 < β < 0.75 

0.0429m ≤ D ≤ 0.900m 

C β 

Orifice plate  
(all taps) 

2000 < RD ≤ 10000 

0.2 < β < 0.75 

0.0429m ≤ D ≤ 0.900m 

C 0.6 + β 

Orifice plate  
(all taps) 

 Y 
4

∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Orifice plate  
(all taps) 

 D 0.25 

Orifice plate  
(all taps) 

0.025m ≤ d d 0.05 

Orifice plate  
(all taps) 

0.010m ≤ d < 0.025m d 0 01.
d

 

Nozzle – long radius 
(high ratio - wall tap) 

0.1m ≤ D ≤ 0.750m 

0.50 ≤ β ≤ 0.80 

104 ≤ RD ≤ 6x106

0.75 ≤ P2/P1

C 2.0 

Nozzle – long radius 
(low ratio - wall tap) 

0.1m ≤ D ≤ 0.750m 

0.20 ≤ β ≤ 0.50 

104 ≤ RD ≤ 6x106

0.75 ≤ P2/P1

C 2.0 

Nozzle – long radius 
(throat tap) 

0.1m ≤ D ≤ 0.750m 

0.25 ≤ β < 0.50 

104 ≤ RD ≤ 6x106

0.75 ≤ P2/P1

C 0.25 
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Element Range of Limiting 
Variable 

Variable Uncertainty in Variable (+/- %) 

Nozzle – long radius 
(all types) 

 Y 
2

∆P
P1

⎛

⎝
⎜

⎞

⎠
⎟ 

Nozzle – long radius 
(throat tap) 

 D 0.25 

Nozzle – long radius 
(throat tap) 

 d 0.05 

Venturi (all types)  C 1.0 
Venturi (all types)  Y ( )4 100 8+ β

∆P
P

 

Venturi (all types)  D 0.25 
Venturi (all types)  d 0.1 

BS 1042 
Orifice plate  

(conical entrance) 
 C 2 

Orifice plate  
(conical entrance) 

 Y 33(1-Y) 

Orifice plate  
(conical entrance) 

 D 0.3 

Orifice plate  
(conical entrance) 

 d 0.05 

Orifice plate 
(quadrant edged) 

0.316 < β C 2 

Orifice plate 
(quadrant edged) 

β ≤ 0.316 C 2.5 

Orifice plate 
(quadrant edged) 

β ≤ 0.6 Y 
4

∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Orifice plate 
(quadrant edged) 

 D 0.3 

Orifice plate 
(quadrant edged) 

 d 0.1 

Orifice plate 
(eccentric) 

β ≤ 0.75 C 1 

Orifice plate 
(eccentric) 

0.75 < β C 2 

Orifice plate 
(eccentric) 

 Y 
4

∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Orifice plate 
(eccentric) 

 D 0.3 

Orifice plate 
(eccentric) 

 d 0.05 

Note: For all general methods, other than those referenced to a standard, the default 
uncertainty of d and D is zero. 
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The discharge coefficients and expansion coefficients for general standards are 
shown in Table D-2 and Table D-3. 

Table D-2 Discharge Coefficients – General Standard 

Element Range of Limiting 
Variable 

Variable Uncertainty in Variable 
(+/- %) 

Orifice plate – Standard 
(corner, flange or radius taps) 

 
See ISO 5167 (1991) 

Orifice plate – Standard   
(pipe taps) 

0.0429m ≤ D ≤ 0.900m 

0.2 ≤ β ≤ 0.5 

104 ≤ RD ≤ 107

C 0.8 

Orifice plate – Standard  
(pipe taps) 

0.0429m ≤ D ≤ 0.900m 

0.51 ≤ β ≤ 0.7 

104 ≤ RD ≤ 107

C 1.6 

Orifice plate – Standard  
(vena contracta taps) 

0.0429m ≤ D ≤ 0.900m 

0.2 ≤ β ≤ 0.6 

104 ≤ RD ≤ 107

C 0.6 

Orifice plate – Standard  
(vena contracta taps) 

0.0429m ≤ D ≤ 0.900m 

0.6 ≤ β ≤ 0.75 

104 ≤ RD ≤ 107

C β 

Orifice plate – Standard  
(vena contracta taps) 

0.0429m ≤ D ≤ 0.900m 

0.2 < β ≤ 0.75 

2x103 ≤ RD ≤ 104

C 0.6 + β 

Orifice plate – Eccentric  
(flange or vena contracta taps) 

0.100m ≤ D ≤ 0.150m 

0.35 ≤ β ≤ 0.75 

104 ≤ RD ≤ 106

C 2 

Orifice plate – Eccentric  
(flange or vena contracta taps) 

0.150m ≤ D ≤ 0.350m 

0.35 ≤ β ≤ 0.75 

104 ≤ RD ≤ 106

C 1.5 

Orifice plate – Segmental 
(flange or vena contracta taps) 

0.150m ≤ D ≤ 0.350m 

0.35 ≤ β ≤ 0.75 

104 ≤ RD ≤ 106

C 2 

Orifice plate – Quadrant Edged 
(corner or flange taps) 

0.025m ≤ D ≤ 0.750m 

0.24 ≤ β ≤ 0.6 

 2 

Orifice Plate – conical entrance 0.025m < D 

0.1 ≤ β ≤ 0.316 

C 2 

Honed Orifice Meter Run 0.012m ≤ D ≤ 0.040m 

0.1 ≤ β ≤ 0.8 
1000 < RD

C 0.75 

All nozzles and Venturis  
See ISO 5167 (1991) 
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Table D-3 Expansion Coefficients 

Element Variable Uncertainty in Variable (+/- %) 
Orifice plate – Conical entrance, quadrant edged or 

honed meter run (all tap types) 
Y 

4
∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Orifice plate – Standard  (pipe taps) Y 
8

∆P
P

⎛
⎝
⎜

⎞
⎠
⎟  

Orifice plate – Standard (vena contracta taps) Y 
4

∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

Orifice plate – Eccentric or Segmental (all tap types) Y 8
∆P
P

⎛
⎝
⎜

⎞
⎠
⎟ 

D.4 Conversion Factors 
The conversion factors for various volumetric flow rate, mass flow rate, density, 
temperature, absolute pressure, length, viscosity, gross heating value, and thermal 
expansion conversions are listed in Table D-4 to Table D-12. 

Table D-4 Volumetric Flow Rate Conversions 

To Convert From To Multiply or Divide1 By 
USGPS L/sec 3.785412* 

NUSGPS L/sec 3.785412* 

SUSGPS L/sec 3.785412* 

USGPM L/sec 3.785412*60/ 

NUSGPM L/sec 3.785412*60/ 

SUSGPM L/sec 3.785412*60/ 

USGPH  L/sec 3.785412*3600/  

NUSGPH  L/sec 3.785412*3600/  

SUSGPH  L/sec 3.785412*3600/  

USGPD  L/sec 3.785412*24/3600/  

NUSGPD  L/sec 3.785412*24/3600/  

SUSGPD  L/sec 3.785412*24/3600/  

USBPH  L/sec 42*3.785412*3600/  

NUSBPH  L/sec 42*3.785412*3600/  

SUSBPH  L/sec 42*3.785412*3600/  

USBPD  L/sec 42*3.785412*24/3600/  

NUSBPD  L/sec 42*3.785412*24/3600/  

SUSBPD  L/sec 42*3.785412*24/3600/  

IMPGPS  L/sec 4.546087*  

NIMPGPS  L/sec 4.546087*  

SIMPGPS  L/sec 4.546087*  
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To Convert From To Multiply or Divide1 By 
IMPGPM  L/sec 4.546087*60/  

NIMPGPM  L/sec 4.546087*60/  

SIMPGPM  L/sec 4.546087*60/  

IMPGPH  L/sec 4.546087*3600/  

NIMPGPH  L/sec 4.546087*3600/  

SIMPGPH  L/sec 4.546087*3600/  

IMPGPD  L/sec 4.546087*24/3600/  

NIMPGPD  L/sec 4.546087*24/3600/  

SIMPGPD  L/sec 4.546087*24/3600/  

IMPBPH  L/sec 36*4.546087*3600/  

NIMPBPH  L/sec 36*4.546087*3600/  

SIMPBPH  L/sec 36*4.546087*3600/  

IMPBPD  L/sec 36*4.546087*24/3600/  

NIMPBPD  L/sec 36*4.546087*24/3600/  

SIMPBPD  L/sec 36*4.546087*24/3600/  

CFS  L/sec  .03531467/  

SCFS  L/sec  .03531467/  

NCFS  L/sec  .03531467/  

CFM  L/sec  .03531467/60/  

SCFM  L/sec  .03531467/60/  

NCFM  L/sec  .03531467/60/  

CFH  L/sec  .03531467/3600/  

SCFH  L/sec  .03531467/3600/  

NCFH  L/sec  .03531467/3600/  

CFD  L/sec  .03531467/24/3600/  

SCFD  L/sec  .03531467/24/3600/  

NCFD  L/sec  .03531467/24/3600/  

L/sec  L/sec 1*  

NL/sec  L/sec 1*  

SL/sec  L/sec 1*  

L/min  L/sec 60/  

NL/min  L/sec 60/  

SL/min  L/sec 60/  

L/hr  L/sec  3600/  

NL/hr  L/sec  3600/  

SL/hr  L/sec  3600/  

L/day  L/sec 24/3600/  

NL/day  L/sec 24/3600/  

SL/day  L/sec 24/3600/  
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To Convert From To Multiply or Divide1 By 
m3/sec  L/sec 1000*  

Sm3/sec  L/sec 1000*  

Nm3/sec  L/sec 1000*  

m3/min  L/sec 1000*60/  

Sm3/min  L/sec 1000*60/  

Nm3/min  L/sec 1000*60/  

m3/hr  L/sec 1000*3600/  

Sm3/hr  L/sec 1000*3600/  

Nm3/hr  L/sec 1000*3600/  

m3/day  L/sec 1000*24/3600/  

Sm3/day  L/sec 1000*24/3600/  

Nm3/day  L/sec 1000*24/3600/  

hL/hr  L/sec 100*3600/  

NhL/hr  L/sec 100*3600/  

ShL/hr  L/sec 100*3600/  

hL/day  L/sec 100*24/3600/  

NhL/day  L/sec 100*24/3600/  

ShL/day  L/sec 100*24/3600/  
1 To determine whether to multiply or divide, identify the last character in 
this column. If the character is *, multiply; if the character is /, divide. 

Mass flow rate conversions are listed below. 

Table D-5 Mass Flow Rate Conversions 

To Convert From To  Multiply or Divide1 By 
lb/sec  kg/sec 2.204623/ 

lb/min  kg/sec 2.204623/60/ 

lb/hr  kg/sec 2.204623/3600/ 

lb/day  kg/sec 2.204623/24/3600/ 

ton/sec  kg/sec 2000*2.204623/ 

ton/min  kg/sec 2000*2.204623/60/ 

ton/hr  kg/sec 2000*2.204623/3600/ 

ton/day  kg/sec 2000*2.204623/24/3600/ 

kg/sec  kg/sec 1*  

kg/min  kg/sec 60/ 

kg/hr  kg/sec 3600/ 

kg/day  kg/sec 3600/24/ 

tonne/sec  kg/sec 1000* 

tonne/min  kg/sec 1000*60/ 

tonne/hr  kg/sec  1000*3600/ 
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To Convert From To  Multiply or Divide1 By 
tonne/day  kg/sec 1000*3600/24/ 
1 To determine whether to multiply or divide, identify the last character in 
this column. If the character is *, multiply; if the character is /, divide. 

Density conversions are listed in the table below. 

Table D-6 Density Conversions 

To Convert From To  Multiply or Divide1 By 
kg/m3  kg/m3 1* 

kg/dm3  kg/m3 1000* 

g/cm3  kg/m3 1000* 

lb/ft3  kg/m3 .06242797/ 
1 To determine whether to multiply or divide, identify the last character in 
this column. If the character is *, multiply; if the character is /, divide. 

Temperature conversions are listed below. 

Table D-7 Temperature Conversions 

To Convert From To  Formula 
DEG F  DEG C  (DEG F-32)/1.8 

DEG R  DEG C  (DEG R-459.67)/1.8 

DEG C  DEG C  1 

DEG K  DEG C  DEG K -273.15 

Absolute pressure conversions are listed in the table below. 

Table D-8 Absolute Pressure Conversions 

To Convert From To  Multiply By 
mm-H2O (60 Deg F) kPa 0.00980315* 

atm  kPa  101.325* 

kPa  kPa  1* 

MPa  kPa  1000* 

kg/cm2  kPa 6.894757*14.22334* 

psia  kPa  6.894757* 

in-H2O (60 Deg F) kPa 0.249* 

Bar  kPa  100* 

Length conversions are listed in the table below. 
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Table D-9 Length Conversions 

To Convert From To  Multiply By 
mm  mm  1* 

cm  mm  10* 

m  mm  1000* 

micron  mm  0.001* 

in  mm  25.4* 

ft  mm  304.8* 

yd  mm  914.4* 

Viscosity conversions are listed in the following table. 

Table D-10 Viscosity Conversions 

To Convert From To  Multiply or Divide1 By 
Pa.sec  cP  1000* 

mPa.sec  cP 1* 

gm/cm.sec  cP  100* 

P  cP  100* 

cP  cP  1* 

kg/m.hr  cP  3.60/ 

lb/ft.sec  cP  0.000672/ 

lb/ft.hr  cP  2.419/ 

lb/in.sec  cP  0.000056/ 

gmf.sec/cm2  cP  0.0000102/ 

lbf.sec/in2  cP  0.000000145/ 

N.sec/m2  cP  1000* 
1 To determine whether to multiply or divide, identify the last character in 
this column. If the character is *, multiply; if the character is /, divide. 

Gross heating value conversions are listed in the table below. 

Table D-11 Gross Heating Value Conversions 

To Convert From To  Multiply or Divide1 By 
kJ/dm3  MJ/m3  1* 

kJ/m3  MJ/m3  1000/ 

MJ/m3  MJ/m3  1* 

Btu/ft3  MJ/m3  28.316846592/1.055056* 

Btu/in3  MJ/m3  0.016387064/1.055056* 

kcal/m3  MJ/m3  1000/4.1841* 
1 To determine whether to multiply or divide, identify the last character in 
this column. If the character is *, multiply; if the character is /, divide. 
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Thermal expansion conversions are listed in the table below. 

Table D-12 Thermal Expansion Conversions 

To Convert From To  Multiply or Divide1 By 
mm/(mm C)  mm/(mm C)   1* 

in/(in F)  mm/(mm C)   1.8/ 
1 To determine whether to multiply or divide, identify the last character in 
this column. If the character is *, multiply; if the character is /, divide. 

§ 
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A 

About, 67 
Activation Warning Message, 31 
Add Materials, 108 
Adding Your Logo to the Datasheet, 76, 104 
AGA 3 Factors, 325 

Report, 67 
AGA 8 

1985 Compressibility, 163 
1992 Compressibility, 172 
Gas Mixture Characterization, 170 

AGA 8 (1985) 
Detailed, 83 
HV, CO2, N2, 86 
SG, CH4, CO2, N2, 86 
SG, CO2, N2, 86 
SG, HV, CO2, 86 

AGA 8 (1992) 
Detailed, 83 
SG, CO2, N2, 87 
SG, HV, CO2, 87 

American Gas Association, See  AGA 
Report No.3, 2nd Ed., 1985, 226, 318 
Report No.3, Part 1, 3rd Ed., 1990, 296 
Report No.3, Part 1, 3rd Ed., 1990, 224 

Ammonia, 204 
Argon, 198 
ASME 

Long Radius Nozzles Gas Expansion Factors, 234 
MFC-3M-1989, 220 
Standard MFC-14M-2003, 244 
Standard MFC-3M-1989, 227 

ASME/ANSI Standard MFC-7M-1987, 222, 241 
Atmospheric Pressure, 33, 68 

Calculation, 352 
Authorization, See Site Authorization 

B 

Basic Installation, 5 
British Standard 1042, 224 
British Standard BS 1042 - Measurement of Fluid Flow in Closed Conduits, 304 
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Bubblepoint, 137, 146 
Pressure, 214 

Calculation Algorithm, 215 

C 

C´, Definition of, 352 
Calculate, 41, 69 

Options, 72 
Solve For, 71 
Using, 72 

Calculate Data, 74 
Entering Data, 75, 94 
Print, 76, 95, 104 

Calculation of Reynolds Numbers, 227 
Calculation Standards, See Standards and Calculations 
Carbon Dioxide, 206 
Changing Licensing, 8 
Classical Venturi Tube Gas Expansion Factor, See Gas Expansion Factor 
Classical Venturi Tubes 

and Venturi Nozzles, 254 
and Venturi Nozzles Gas Expansion Factor, 258, 274, 289 
Discharge Coefficients, 232 
Gas Expansion Factor, 235 

Color, 76, See Setting RGB Colors 
Concentric Orifice Plate Gas Expansion Factor, See Gas Expansion Factor 
Contact Information, 1 
Conversion 

Factors, 360 
Process, 65 

Copy a Fluid, 98 
Copy Protection ─ Crypkey, 31 
Create 

New Job, 33 
New Tag, 34 

Critical Flow 
Calculations, 347 
Coefficient, 242 

CrypKey 
Copy Protection, 31 
Tips and Tricks, 33 
Troubleshooting, 29 

Customer Service, 1 
Customizing the Program, 51 

D 

Default 
Base Conditions, 34, 78 
Element, 79 
Settings for the Job, 33 
Units, 79 

Setting, 33 
Define 

Mixture, 98, 113 
New Job, 115 
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New Tag Dialog Box, 36 
Definition of C´, 352 
Delete 

Fluid, 98 
Job, 115 
Materials, 109 

Density 
Calculations, 159 
Calculator, 44, 72, 81 
of Air, 208 

Design Philosophy, 3 
Dialog Box 

Define New Tag, 36 
Flow Calculation, 42 
Fluid Maintenance, 53 
Graph, 47 
Main Flowel Screen, 31 
Material Maintenance, 52 
Meter Run, 39 
Pipe Maintenance, 51 

Difference between ISO 5167-1980(E) and ISO 5167-1-1991(E), 223 
Discharge Coefficient Calculation, 242 
Discharge Coefficients 

ASME/ANSI Standard MFC-7M-1987, 242 
Classical Venturi Tubes 

ASME Standard MFC-3M-1989, 232 
ASME Venturi Tubes With a Machined Convergent 

ASME Standard MFC-3M-1989, 233 
ASME Venturi Tubes With an As-Cast or Fabricated Convergent 

ASME Standard MFC-3M-1989, 232 
Cylindrical Throat 

ASME/ANSI Standard MFC-7M-1987, 242 
Long Radius ASME Nozzles 

ASME Standard MFC-3M-1989, 230 
Throat Tap 

ASME Standard MFC-3M-1989, 231 
Wall Tap 

ASME Standard MFC-3M-1989, 231 
Nozzles 

General Application, 338 
International Standard ISO 5167-1-1991(E), 268 
International Standard ISO 5167-1-2003(E), 283 
ISA 1932 Nozzle 

General Application, 338 
International Standard ISO 5167-1-1991(E), 269 
International Standard ISO 5167-1-2003(E), 284 
International Standard ISO 5167-1980(E), 253 

Long Radius Nozzle 
General Application, 338 
International Standard ISO 5167-1-1991(E), 270 
International Standard ISO 5167-1-2003(E), 285 
International Standard ISO 5167-1980(E), 254 

Orifice Plates 
American Gas Association Report No.3, Part 1, 3rd Ed., 1990, 297 
ASME Standard MFC-3M-1989, 228 
Base Discharge Coefficient 

American Gas Association Report No.3, Part 1, 3rd Ed., 1990, 297 
ASME Standard MFC-3M-1989, 229 
International Standard ISO 5167-1-1991(E), 266 
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International Standard ISO 5167-1-2003(E), 282 
International Standard ISO 5167-1980(E), 250 

Concentric Orifice Plate 
With Corner Taps, Flange Taps, or Radius Taps 

General Application, 327 
With Pipe Taps 

General Application, 327 
With Vena Contracta Taps 

General Application, 328 
Conical Entrance with Corner Taps 

British Standard BS 1042, 305, 312 
Conical Orifice With Corner Taps 

General Application, 335 
Corner Taps 

ASME Standard MFC-3M-1989, 229 
International Standard ISO 5167-1-1991(E), 266 
International Standard ISO 5167-1980(E), 251 

Eccentric Orifice Plate With Flange Taps 
General Application, 329 

Eccentric Orifice Plate With Vena Contracta Taps 
General Application, 330 

Eccentric with Corner Taps 
British Standard BS 1042, 306, 313 

Flange Taps 
ASME Standard MFC-3M-1989, 230 
International Standard ISO 5167-1-1991(E), 267 
International Standard ISO 5167-1980(E), 251 

General Application, 327 
International Standard ISO 5167-1-1991(E), 265 
International Standard ISO 5167-1-2003(E), 281 
International Standard ISO 5167-1980(E), 249 
Quadrant Edge with Corner Taps or Flange Taps 

British Standard BS 1042, 306, 313 
Quadrant Orifice Plate With Corner Taps or Flange Taps 

General Application, 334 
Radius Taps 

ASME Standard MFC-3M-1989, 230 
International Standard ISO 5167-1-1991(E), 267 
International Standard ISO 5167-1980(E), 252 

Segmental Orifice Plate 
With Flange Taps 

General Application, 332 
With Vena Contracta Taps 

General Application, 333 
Small Bore Orifice (Small Diameter Orifice) Meter Runs 

With Corner Taps 
General Application, 337 

With Flange Taps 
General Application, 336 

Toroidal Throat 
ASME/ANSI Standard MFC-7M-1987, 242 

Venturi 
Classical Venturi Nozzles 

International Standard ISO 5167-1980(E), 255 
Classical Venturi Tube 

With a Fabricated (welded) Convergent 
International Standard ISO 5167-1980(E), 255 

With a Machined Convergent 
International Standard ISO 5167-1-1991(E), 271 
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International Standard ISO 5167-1-2003(E), 286 
International Standard ISO 5167-1980(E), 255 

With a Machined Convergent Discharge Coefficients 
General Application, 338 

With a Rough Welded Convergent 
International Standard ISO 5167-1-1991(E), 271 
International Standard ISO 5167-1-2003(E), 286 

With an As-Cast Convergent 
International Standard ISO 5167-1-1991(E), 271 
International Standard ISO 5167-1-2003(E), 286 

With an As-Cast or Fabricated Convergent 
International Standard ISO 5167-1980(E), 254 

With As-Cast Convergent Discharge Coefficients 
General Application, 338 

With Rough Welded Convergent Discharge Coefficients 
General Application, 338 

General Application, 338 
Venturi Nozzle 

Discharge Coefficients-General Application, 338 
International Standard ISO 5167-1-1991(E), 272 
International Standard ISO 5167-1-2003(E), 287 

E 

Edit Materials, 108 
Element Type, 39 
Emerson Process Management Contact Information, 1 
Entering Data, 103 
Error Message, 24, 28, 29, 30, 31 
Ethane, 198 
Ethylene, 198 
Exact 

Bore Size, 88 
Calculate, 71 

Differential Pressure, 90 
Calculate, 71 

Flow Rate, 90 
Calculate, 71 

Example 
1 – How to Determine the New Size for an Orifice Plate, 54 
2 ─ How to Determine Volumetric Flow Rate at Standard Conditions, 60 

Exit, 91 
Export 

Fluid, 91 
Job, 92 
Tag, 92 

F 

Features, 2 
Convenience, 3 
Optional, 3 

File Menu, 93 
Flow Calculation 

Dialog Box, 42 
Methods, 220 
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Flow Rate Calculation, 237 
Flowel Data Sheet, 94 
Flowel Database, 33 

Backup, 33 
Move, 33 

Flowel Error Message, 24, 28, 29 
Fluid, 95 

Maintenance, 52, 98 
Dialog Box, 53 

Property Calculation Methods, 142 
Report, 99 
Settings, 36 
State, 37, 96 
Type, 38, 96 

All, 96 
Common Fluids, 96 
General Mixture, 97 
Natural Gas, 97 
Other, 98 

Formulas and Calculations, 352 

G 

Gas Expansion Factor 
ASME Long Radius Nozzles 

ASME Standard MFC-3M-1989, 235 
Classical Venturi Tubes 

ASME Standard MFC-3M-1989, 236 
General Application, 340 

Classical Venturi Tube with Throat Taps, 343 
Concentric Orifice Plate 

With Corner Taps, Flange Taps or Radius Taps, 340 
With Pipe Taps, 341 
With Vena Contracta Taps, 340 

Conical Orifice Plate with Corner Taps, 342 
Eccentric Orifice Plate with Corner Taps, Flange 180° Offset Taps, Flange 90° Offset Taps, Vena Contracta 180° 

Offset or Vena Contracta 90° Offset, 341 
ISA 1932 Nozzle with Corner Taps, 342 
Long Radius Nozzle with Radius Taps, Wall Taps or Throat Taps, 342 
Quadrant Edged Orifice Plate with Corner Taps or Flange Taps, 342 
Restriction Flow Devices 

Concentric Orifice with Pipe Taps, 343 
Segmental Orifice Plate with Flange taps or Vena Contracta Taps, 341 
Small Bore Orifice (Small Diameter) Meter Runs 

With Corner Taps, 342 
With Flange Taps, 342 

Venturi Nozzle with Throat Taps, 343 
Nozzles 

ISA 1932 
International Standard ISO 5167-1-1991(E), 273 
International Standard ISO 5167-1-2003(E), 289 
International Standard ISO 5167-1980(E), 257 

Long Radius 
International Standard ISO 5167-1-1991(E), 274 
International Standard ISO 5167-1-2003(E), 289 
International Standard ISO 5167-1980(E), 258 

Orifice Plates 
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American Gas Association Report No.3, Part 1, 3rd Ed., 1990, 299 
ASME Standard MFC-3M-1989, 233, 234 
Conical Entrance 

British Standard BS 1042 - Measurement of Fluid Flow in Closed Conduits, 307, 314 
Flange Taps 

American Gas Association Report No.3, 2nd Ed., 1985, 322 
International Standard ISO 5167-1-1991(E), 272 
International Standard ISO 5167-1-2003(E), 287, 288 
International Standard ISO 5167-1980(E), 256 
Pipe Taps 

American Gas Association Report No.3, 2nd Ed., 1985, 322 
Quadrant w/Corner or Flange Taps 

British Standard BS 1042 - Measurement of Fluid Flow in Closed Conduits, 307, 308, 314, 315 
Venturi 

Classical Venturi 
International Standard ISO 5167-1-1991(E), 275 
International Standard ISO 5167-1-2003(E), 290 
International Standard ISO 5167-1980(E), 258 

Venturi Nozzle 
International Standard ISO 5167-1-1991(E), 275 
International Standard ISO 5167-1-2003 (E), 290 
International Standard ISO 5167-1980(E), 259 

Glossary of Terms, 139 
Graph, 99 

Dialog Box, 47 

H 

Help 
Content, 101 
Desk, 1 
Index, 101 
Menu, 101 

How to 
Contact Emerson, 1 
Use Help, 101 

Hydrogen, 198 

I 

i-Butane, 198 
Ideal Gas Method, SGi, Zf, 87 
Ideal Gas Specific Heat Capacity, 218 
Import 

Fluid, 102 
Job, 102 
Tag, 102 

Installing 
Basic Procedure, 5 
Network, 2 
Network Server, 10 

International Standard ISO 5167-1-1991(E), 223, 264 
International Standard ISO 5167-1-2003(E), 280 
International Standard ISO 5167-1980(E), 222, 248 
International Standard ISO 5167-2003, 224 
Introduction, 1 
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IP Address, 17 
ISA S-20 Data Sheet, 48, 103 
Isentropic Exponent, 73, 105, 147, 217 
ISO Technical Report, 224 
IUPAC Carbon Dioxide, 85 

J 

Jobs Summary, 106 

L 

Lee-Kesler BWR Equation, 153, 218 
Liquid Method, SG, Density H2O, 88 
Logo 

Add to the Datasheet, 76, 104 
Long Radius ASME Nozzles Discharge Coefficients, 230 

M 

Main Menu, 107 
Material, 39 

Maintenance, 52, 107 
Dialog Box, 52 

Menu, See Main Menu 
Meter Run, 109 

Dialog Box, 39 
Element, 110 
Pipe, 111 
Pressure Taps, 111 
Settings, 39 

Methane, 198 
Mixture Definition, 112 
Modified Peng-Robinson Equation of State, 151 
Modified Rackett Equation, 158 
Molecular Weight Method, MW, Zf, 88 
MySQL Database, 33 

N 

NBS 
Ammonia, 85 
Argon, 85 
Ethane, 85 
Ethylene, 85 
Hydrogen, 85 
i-Butane, 85 
Methane, 85 
Nitrogen, 85 
Oxygen, 85 
Propane, 85 

NBS/NRC Steam Equation, 84 
n-Butane, 198 
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Network 
Installation, 2 
Server Installation, 10 

New Job, 114 
Creating a, 33 
Define New Job, 115 
Delete Job, 115 
New Tag, 115 

New Tag, 115 
Copy, 117 
Create a, 34 
Define New Tag, 116 
Delete, 117 
Flowel's method, 118 

Next Button, 32, See also Previous Button 
Nitrogen, 198 
Nomenclature, See Glossary of Terms 
Nozzle Discharge Coefficients, See Discharge Coefficients 
Nozzle Gas Expansion Factor, 257, 273, 288, See Gas Expansion Factor 
NX-19, 188 

Detailed, 84 

O 

Open 
Job, 118 
Tag, 119 

Option Ordering, 120 
Optional Package, 3 
Options 

Density Calculator, 72 
Menu, 121 
Viscosity, 72 

Orifice Plate 
1d to 6d Thick, 348 
6d to 20d Thick, 348 
Discharge Coefficients, 228 
Gas Expansion Factor, 233, 256 

Orifice Plate Gas Expansion Factor, See Gas Expansion Factor 
Other Formulas and Calculations, 352 
Oxygen, 198 

P 

Permanent Pressure Loss, 239 
Classical Venturi Tubes 

International Standard ISO 5167-1-1991(E), 279 
International Standard ISO 5167-1-2003 (E), 294 
International Standard ISO 5167-1980(E), 262 

General Application 
ISA 1932 Nozzles and Long Radius Nozzles (High and Low Ratios) with Radius Taps, 346 
Long Radius Low Ratio Nozzles with Throat Taps, 346 
Square Edged Orifice Plates with Flange Taps, Radius Taps and Corner Taps, 345 
Square Edged Orifice Plates with Pipe Taps and Quadrant Edged Orifice Plates, 346 
Venturi Tubes and Venturi Nozzles, 346 

ISA 1932 Nozzle 
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International Standard ISO 5167-1-1991(E), 278 
International Standard ISO 5167-1-2003 (E), 294 
International Standard ISO 5167-1980(E), 262 

Long Radius Nozzle 
International Standard ISO 5167-1-1991(E), 278 
International Standard ISO 5167-1-2003 (E), 294 
International Standard ISO 5167-1980(E), 262 

Orifice Plates 
American Gas Association Report No.3, Part 1, 3rd Ed., 1990, 302 
ASME Standard MFC-3M-1989, 239 
International Standard ISO 5167-1-1991(E), 278 
International Standard ISO 5167-1-2003 (E), 293 
International Standard ISO 5167-1980(E), 261 
Pipe Taps 

American Gas Association Report No.3, 2nd Ed., 1985, 325 
Quadrant w/Corner or Flange Taps 

British Standard BS 1042 - Measurement of Fluid Flow in Closed Conduits, 310, 317 
Venturi Nozzle 

International Standard ISO 5167-1-1991(E), 279 
International Standard ISO 5167-1-2003 (E), 294 
International Standard ISO 5167-1980(E), 262 

Pipe Maintenance, 51, 121 
Add a Nominal, 122 
Add a Schedule, 122 
Delete a Nominal, 123 
Delete a Schedule, 124 
Dialog Box, 51 
Edit a Schedule, 123 

Pipe Selection, 40 
Plate Thickness, 338 
Pressure Taps, 39 
Previous Button, 32, See also Next Button 
Print 

All, 124 
Current Tag Specification Sheet, 49 
Fluid, 99 
Options, 49 
Paper Format, 126 
Preview, 50, 126 
Printer Setup, 126 
Setup, 50 
Spec., 127 
Tag, 127 

Propane, 198 
PVT 

Properties, 142 
Property-Generalized Methods, 147 
Property-Specialized Methods, 162 

R 

Real Gas Method, SGr, Zair, 88 
Recommended Hardware/Software Requirements, 4 
Redlich-Kwong 

Equation of State, 147 
Equation with Wichert-Aziz Correction for Sour Natural Gases, 162 

Redlich-Kwong (Wichert-Aziz), 84 
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Reference, 67 
Requirements 

Hardware, 4 
Software, 4 

Restriction Orifice Plates, 337 
RK Equation, 219 
Rounded Bore Size, 129 

Calculate, 72 

S 

Select Pipe, 40 
Selection Lists, 114 
Setting 

Atmospheric Pressure, 33 
Default Base Conditions, 34 
Default Units, 33 
Default Values, 33 
Fluids, 36 
Meter Run, 39 
RGB Colors, 77 
Significant Digits, 34 

Significant Digits, 34, 130 
Site Authorization, 7 
Site Key, 32 
Spec. Sheet, 131 
Specific Gravity Calculations, 161 
Specification Sheets and Reports, 47 
Standards and Calculations, 2 
Starting Flowel, 33 
Steam Properties, 193 

T 

Thickness, 39 
Plate, 338 

Thomson-Brobst-Hankinson Equations, 155 
Toolbar, 132 

Use, 31, 132 
Training Services, See Tutorial, Chapter 2 
Transfer Authorization, 134 
Troubleshooting, 24 

Crypkey, 29 
Flowel, 24 
Windows Error Messages, 29 

Tutorial, 30 
About, 30 
One Time Through, 30 
Start Tutorial, 30 

Typographic Conventions, 1 

U 

Uncertainty, 135, 353 

 380  
Emerson Process Management 3007536  2005-May-02 Rev 0 
Flowel 4 Development and Marketing  



E Index  User Manual 

Upgrade From Earlier Version, 9 
Used Resources, 136 
User Data Menu, 137 
User Group 

Define, 20 
Manage, 21 

User Management, 19, 21 
Utility, 19 

User Manual, 1 
User Reference, 67 

V 

Vapor Pressure, 45, 137, 215 
Vapor Pressure/Bubblepoint, 73 
Venturi Discharge Coefficients, See Discharge Coefficients 
Viscosity, 45, 72, 138, 147, 209 

Gas, 210 
of Water and/or Steam, 213 
Restrictions and Uncertainties, 213 

W 

Windows Error Message, 30, 31 
Windows Menu, 138 
Windows Registry Error, 29 
Worksheet Menu, 138 

Z 

Zoom, 75, 95, 104 

 

§ 
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